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Chapter 1. Solution overview

Smarter water management means enabling water utilities to better manage their water and assets by
using insights from the water network, the environment, and from stakeholders. In particular, the success
of a water enterprise is dependent on having a fully functioning and productive asset base, reducing
operational and maintenance costs, minimizing outages, and ensuring a high quality of service.

IBM® Intelligent Operations for Water is a product in the IBM Intelligent Water Family from the IBM
Smarter Cities® Software Solutions portfolio, which is a collection of industry solutions software designed
for effective supervision and coordination of operations.

IBM Intelligent Operations for Water provides an intelligent dashboard for a water management
organization. It displays information on water infrastructure and events. Underlying the solution is a set
of carefully constructed variability points, including programming and data models, that can be
programmed and configured to meet the needs of different types of water management scenarios and
organizations.

IBM Intelligent Operations for Water is built on concepts of visualization, information services, and data
integration. The application integrates the Water Information Hub asset with IBM Intelligent Operations
Center and leverages multiple components from IBM Intelligent Operations Center. With IBM Intelligent
Operations for Water, input data is ingested from external SCADA systems via WebSphere® Message
Broker and is stored in an operational (and historical) database. IBM Intelligent Operations for Water
provides executives and managers with real-time and historical views into the status of a set of domains.
The domain views enable you to anticipate events and optimize operations.

IBM Intelligent Operations for Water can extend its semantic model to cater to different data models
ingested from varying customers. IBM Intelligent Operations for Water interacts with underlying
operation and information systems through gateways, maintaining separation of roles and responsibilities
for the domains of an organization.

Based on the water organization's requirements, key performance indicators and custom reports can be
generated from the real-time data and historical data. IBM Intelligent Operations for Water uses water
industry frameworks and data from Enterprise Asset Management (EAM) systems, water consumption
databases, and Geographical Information Systems (GIS), to provide the following benefits:
v Single view to monitor asset and infrastructure data.
v Visualization of current and historical asset system data.
v Integration of data from disparate water systems.
v Filtering display results.
v Targeted monitoring of the health of the water network. An interactive heat map enables you to

monitor the overall health of the water network and drill down on water key performance indicators.
v Provides stakeholder collaboration, notification, and operational management capabilities.

IBM Intelligent Operations for Water can help provide a common view of operations that transcends
individual systems, devices and departments, aggregating and integrating data from various sources.
Once data is reconciled and collated, water operational and executive personnel can visualize information
in an intuitive fashion to quickly identify anomalies, trends, and patterns. Personnel can view information
about a map that shows critical events and monitors key resources.

IBM Intelligent Operations for Water runs on top of the IBM Intelligent Operations Center, which is a
software solution designed for effective supervision and coordination of operations. IBM Intelligent
Operations Center provides the base platform for IBM Intelligent Operations for Water.

© Copyright IBM Corp. 2012 1



IBM Intelligent Operations for Water can be deployed in two ways, either on premise or as a cloud-based
offering. IBM Intelligent Operations for Water can also be integrated with other products in the IBM
Smarter Cities Software Solutions portfolio.

Intended audience
This information center is intended for people who are using, installing, administering, and maintaining
IBM Intelligent Operations for Water. It also contains implementation documentation for customizing the
solution and integrating the external water management systems that IBM Intelligent Operations for
Water requires.

This information center assumes that users have prior knowledge of, or proficiency with, the prerequisite
software. Training for these base products is outside the scope of this information center. If you require
training for these products, ask your systems integrator or IBM representative where you can obtain
information about base component training opportunities.

You can find links to the component product documentation in the “Additional information” on page 231
page of the References section.

Features
IBM Intelligent Operations for Water provides water management information and analytics that help
monitor and manage water infrastructure, optimize reliability and performance, reduce operating
expenses, and improve service provision to city, corporate and domestic water users.

IBM Intelligent Operations for Water provides you with real time, map-based information, and
spatial-temporal analytics that you can use to analyze the performance of your water management
systems, assets, and networks. The available information and analytics help you to manage water
maintenance initiatives and to identify potential problems before they occur.

IBM Intelligent Operations for Water is prepackaged with implementation content and sample data that
can be used to familiarize you with end-to-end data flows. The simulated environment provides
education and shortens the adoption and implementation cycle.

The following table describes the features of IBM Intelligent Operations for Water in more detail.

Table 1. The features of IBM Intelligent Operations for Water.

Feature Capabilities

Dashboard v Use a role-based dashboard to provide quick views of
the critical operating alerts and Key Performance
Indicators (KPIs).

v Manage day-to-day operations and improve longer
term planning.

v Current and historical data views.

v Centralized, comprehensive, and configurable
platform.

v Provides on-demand geographical visibility, analysis,
and reporting, for current, future, and historic water
data.
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Table 1. The features of IBM Intelligent Operations for Water. (continued)

Feature Capabilities

Performance and optimization v Take advantage of sensor-based data which is collected
in a data warehouse and optionally displayed on a
dashboard.

v Monitor performance and optimization of SCADA
systems to track real time data on water management
and to identify cost savings opportunities.

v Use advanced statistical analysis along with best
practices to enable the identification of areas of
improvement and potential for optimization of water
management.

v Gain insight and ability to analyze historical patterns
of water conditions in critical link areas.

Asset management v Display information about equipment, water assets,
network and infrastructure.

v Interrogate water related assets to obtain status.

Workflow management v My Activities portlet - view role-based activities and
standard operating procedures as a gateway to
handling incidents and work orders.

Collaboration v Immediate access to a contact list on all pages enabling
team collaboration and city wide communication.

v Visibility of notifications - view changes in KPI that
are available in interface. Related and unrelated events
display in an area available for view on a map.

Security v Integrates with historians not directly with SCADA
systems.

v Uses a role-based single sign on.

Data integration and storage v Integrates data from disparate water and data capture
systems by using integration protocols recognized by
the industry.

v Water information model core and basic platform for
visualization and analysis of water and event data.

v Model manager integrates multiple SCADA, meter,
and sensor systems in network.

v Model manager provides a metadata view of the water
infrastructure and defined KPIs.

Extendable highly customizable model v Programming model is extendable to support future
unknown facets of the water management world.

v Scalability and reusability of Intelligent Cities
products.
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Table 1. The features of IBM Intelligent Operations for Water. (continued)

Feature Capabilities

Visualization v View system maps and filters on the map.

v Turn on and off layers for display on a map.

v Visualize and filter assets by district metered areas.

v View ingested GIS data representing asset types that
are defined in the model manager.

v View pipe network, meter turnouts, sewer network,
pumping station location, individual meter location.

v View key performance indicators to monitor events
such as: waste water removal, dry weather overflows,
wet weather maximization, efficiency of collection
systems. Track key measurements like Flow, Water
Quality, Energy Consumption, Pump Efficiency,
Pressure.

Installation utility v A prerequisite check is incorporated in the installation
script. When you run the command to install the IBM
Intelligent Operations for Water, prerequisite checking
is performed automatically to ensure that the required
IBM Intelligent Operations Center Fix Pack 1 is
installed.

v The installation script also detects if a previous version
of the IBM Intelligent Operations for Water is installed
in your environment.

v The installation program logs all steps executed by the
installer and, when finished, returns a successful log
message.

v A post-installation validation check is automatically
carried out to ensure that the installation was
successful.

Globalization In addition to English, the IBM Intelligent Operations for
Water product and online help is available in the
following languages: Brazilian Portuguese, French,
German, Korean, Simplified Chinese and Traditional
Chinese, Spanish, Japanese, and Italian. The information
center is available in the following languages: Brazilian
Portuguese, French, German, Korean, Simplified Chinese
and Spanish.

Users and benefits
IBM Intelligent Operations for Water is designed for water operations and management personnel to help
optimize and more efficiently manage water systems, assets, and networks across a geographically
dispersed infrastructure.

The following table describes the users and associated benefits of using IBM Intelligent Operations for
Water.
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Table 2. Benefits of IBM Intelligent Operations for Water

If you are an ... This software can help you ....

Operator v Identify and act on conflicts and issues shown on
maps, dashboards, and alerts.

v Manage events by adding new events, editing existing
events, canceling events, and escalating events to
incidents.

v Monitor assets and key performance indicators (KPIs).

v Communicate quickly and easily on matters of
importance.

v Monitor status, create and edit events and incidents to
be shown in lists.

v Notify appropriate manager or executives and issue
alerts.

v Communicate quickly and easily in emergencies and
other situations requiring a response.

Executive v Gain an executive level summary of events and
incidents through maps, dashboards, and alerts.

v Determine measures of organizational success with
KPIs.

v Identify and track issues using reports.

v Direct priorities and implementation of policy using
data provided.

Related concepts:
“User roles and responsibilities” on page 37
IBM Intelligent Operations for Water implements security by limiting access to features and data based
on user roles.

Components
IBM Intelligent Operations for Water is built on concepts of visualization, information services, and data
integration. The application integrates the Water Information Hub asset with IBM Intelligent Operations
Center and leverages multiple components from IBM Intelligent Operations Center. Multiple functional
components are specific to IBM Intelligent Operations for Water.

The following table describes the functional components that are specific to IBM Intelligent Operations
for Water.

Table 3. IBM Intelligent Operations for Water functional components and their capabilities

Functional component Capability

Model manager Extends the core IBM Intelligent Operations for Water
semantic model to allow meaningful queries and
granular filtering validation.

Reporting (Cognos) Generates customized reports that are generated from
stored data.

Event engine (event and KPI preprocessor) Integrates the key performance indicators (KPIs) that
relate to a specific environment.
Note: These KPIs can be atomic or roll-up. An atomic
KPI must be capable of being calculated (typically) from
information that a sensor or meter provides.

Chapter 1. Solution overview 5



Table 3. IBM Intelligent Operations for Water functional components and their capabilities (continued)

Functional component Capability

Standard operating procedures Provides access to water-related standard operating
procedures.

Historical reporting data store Creates reporting and operational data stores that are
based on the sensors and their measurement types and
measurement values.

Messaging infrastructure Implements IBM Intelligent Operations for Water
streams, such as data from devices, sensors, and meters,
as well as the measurement type and measurement
values that these sensors provide.

Figure 1 shows the IBM Intelligent Operations for Water functional components and their relationships.

Samples
IBM Intelligent Operations for Water provides samples that show the features that are available in IBM
Intelligent Operations for Water, and how to use them.

Figure 1. IBM Intelligent Operations for Water functional components and their relationships
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IBM Intelligent Operations for Water 1.5 system comes with an optional sample set of data illustrating its
use for waste water operations. The provided data allows for validation of the installed IBM Intelligent
Operations for Water 1.5 by exercising all the customizable points within the programming model. The
following samples are provided.
v An extension to the initial semantic model that provides asset types for waste water. For example,

River Gauges, Rain Gauges, Waste Water Plants, Combined Sewer Overflow (CSO) Diversion
Structures, Trunk Line Monitors, and Lift Stations.

v A set of connected resources (connected sewers) to display on the Map in the form of Resource
Description Framework (RDF) files.

v A set of sample assets is provided based on the above asset types.
v Linkages are provided to measurement and measurement values for the above assets.
v Waste water table structures are provided for managing alerting and events.
v Sample Key Performance Indicators (KPIs) are provided based on Storm Water Overflow Management,

Fixed Asset Repair and Management and Waste Water Treatment and Recycling.
v Sample standard operating procedures are provided that are automatically triggered on certain waste

water related events. For example, a CSO Diversion Structure high water level.
v Sample Tivoli® Netcool/Impact policies are provided that handle incoming reading values, and trigger

alerts, events, sample KPIs and standard operating procedures. The Tivoli Netcool/Impact policies are
available on the event server.

The waste water sample files are available in the: /opt/IBM/iss/iow/samples directory on their respective
servers. For example, the model manager files are available on the management node, and the monitor
samples are available on the application server. If you load the sample data during the installation
process, the files are deployed and available for your education and learning.

Samples provided by IBM Intelligent Operations Center are also available to IBM Intelligent Operations
for Water. IBM Intelligent Operations for Water also provides sample users for security configuration. All
samples are available to further understand the capabilities of IBM Intelligent Operations for Water and
to ensure that the installed system operates correctly.
Related concepts:
“Customizing asset types and instance” on page 136
Assets types such as sensors and meters are central to the infrastructure of water management systems.
Using the IBM Intelligent Operations for Water semantic model, you can distinguish between asset types.
Changes to the infrastructure, for example adding asset types, requires that you update the model
instance. Use the tasks in this section to customize the IBM Intelligent Operations for Water semantic
model to your implementation.
“Defining asset types” on page 136
Use the information in this section to define asset types.
Related information:
Sample KPIs in Intelligent Operations Center

Asset samples
Sample waste water asset types, sample assets based on those types, and sample measurement and
measurement values for assets are provided when you install the waste water sample content along with
IBM Intelligent Operations for Water Version 1.5. The data provides a model instance of data in a
geographic region. The data consists of 57 items of the various asset types that are listed. A sample
pipeline asset instances RDF file that describes the pipe network is also provided.

Table 4. Sample asset data

Sample Description

Asset types Transmitter Level, Indicator Flow, Pump Centrifugal,
Flow Meter, CSO Diversion Structure, Pipe, Junction
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Table 4. Sample asset data (continued)

Sample Description

Asset measurements CSO Level, Rain Gauge, Waste water plant influent flow
rate, CSO overflow volume year to date

Measurement status No reading, Critical, Caution, Acceptable

Logical zones Zone 1, Zone 2

Alert and event samples
Sample waste water table structures for managing alerting and events are provided when you install IBM
Intelligent Operations for Water Version 1.5. The sample data includes alert and event samples for, for
example, Combined Sewer Overflow (CSO). An event is posted when a CSO reaches 70 percent of its
overflow height and when a CSO reaches 100 percent of its overflow height.

KPI samples
Sample waste water KPIs are provided when you install IBM Intelligent Operations for Water version 1.5.

Table 5. Summary of Sample KPIs

Sample KPI Description

Storm Water Overflow Management v Dry weather sewer overflows

v Dry weather sewer overflows prevented

v Wet weather collection system maximization

Waste Water Treatment and Recycling v Total volume of waste water treated

v Volume of waste water treatment plant effluent
recycled

v Wet weather waste water plant maximization

Fixed Asset Repair and Management v Cumulative number of pump starts and stops

v Cumulative pump runtime

v Number of feet of sewer inspected

Storm Water Overflow Management

Storm Water Overflow Management groups three KPIs:
1. Dry weather sewer overflows

v Overflow volume the past seven days counts the number of dry weather sewer overflows that have
occurred during the past seven days.

v Overflow volume this month counts the number of dry weather sewer overflows that have occurred
during the current month.

v Overflows the past seven days totals the discharge volume for all dry weather sewer overflows that
have occurred during the past seven days.

v Overflows this month totals the discharge volume for all dry weather sewer overflows that have
occurred during the current month.

2. Dry weather sewer overflows prevented
v Overflows prevented the past seven days counts the number of dry weather sewer overflows that have

been prevented during the past seven days.
v Overflows prevented this month counts the number of dry weather sewer overflows that have been

prevented during the current month.
3. Wet weather collection system maximization
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v Actual compared to typical overflow volume calculates the percentage the corrected combined sewer
overflow volume amount (by rainfall) is over or under the typical combined sewer overflow
volume amount.

v Actual compared to typical overflow volume as a percentage calculates the difference between the
corrected combined sewer overflow volume amount (by rainfall) and the typical combined sewer
overflow volume amount.

Waste Water Treatment and Recycling

Waste Water Treatment and Recycling groups three KPIs:
1. Total volume of waste water treated
2. Volume of waste water treatment plant effluent recycled
3. Wet weather waste water plant maximization

v Discharge volume the past seven days counts the volume of waste discharged during the past seven
days.

v Discharge volume this monthcounts the volume of waste discharged during the past month.
v Waste water treatment plant discharge less than specified volume the past seven days calculates the

discharge flow rate during the past seven days.
v Waste water treatment plant discharge less than specified volume the past month calculates the discharge

flow rate during the past month.

The Wet weather waste water plant maximization KPI counts the number of times the Waste Water
Treatment Plant does not reach a specified discharge flow rate during wet weather and an overflow
condition at the Combined Sewer Overflow (CSO). IBM Intelligent Operations for Water processes the
KPI in the following way.
v IBM Intelligent Operations for Water collects rain gauge, waste water treatment plant, and sewer

overflow data readings from sensors and meters.
v When IBM Intelligent Operations for Water receives a rain gauge reading, a policy that is defined in

Tivoli Netcool/Impact determines if it is wet weather now, and sets the wet weather indicator.
v When IBM Intelligent Operations for Water receives a waste water plant reading, the policy that is

defined in Tivoli Netcool/Impact calculates the plant flow rate and stores the rate temporarily.
v When IBM Intelligent Operations for Water receives a reading from the defined CSO diversion

structure, the policy defined in Tivoli Netcool/Impact calculates the overflow volume of the CSO,
composes a CAP event and sends the event to IBM WebSphere Business Monitor .

v IBM WebSphere Business Monitor calculates the KPI and sends the notification to WebSphere Portal for
display in the portal.

Fixed Asset Repair and Management

Fixed Asset Repair and Management groups three KPIs:
1. Cumulative number of pump starts and stops
2. Cumulative pump runtime
3. Number of feet of sewer inspected

Standard operating procedure samples
Sample standard operating procedures, workflows, and resources are provided when you install IBM
Intelligent Operations for Water Version 1.5.
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Table 6. Standard operating procedure samples

Standard operating procedure Description

PLUSIDWSOP Process to prevent dry weather sewer overflow. A
procedure that is invoked to prevent a Combined Sewer
Overflow (CSO) from occurring. It is automatically
invoked if a 70 percent CSO weir height event is
triggered.

PLUSIDWSOC Dry weather sewer overflow confirm. A procedure that is
invoked after an overflow occurs in a combined sewer.
The procedure allows the manager to confirm that the
overflow has occurred.
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Chapter 2. Installing and configuring

IBM Intelligent Operations for Water is a solution that runs on top of the IBM Intelligent Operations
Center. IBM Intelligent Operations for Water provides a deployment wizard that installs the package into
the existing IBM Intelligent Operations Center and underlying environment. After deploying the IBM
Intelligent Operations for Water package, some additional configuration is required.

Preparing for installation
Before deploying IBM Intelligent Operations for Water, understand the IBM Intelligent Operations for
Water system configuration and ensure that the prerequisites are met for the environment.
Related tasks:
“Deploying the solution” on page 23
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.
“Installing the solution” on page 22
Installing IBM Intelligent Operations for Water involves several steps. A deployment wizard is provided
to deploy and install IBM Intelligent Operations for Water.

System configuration
IBM Intelligent Operations for Water deployment wizard installs the product on top of the IBM
Intelligent Operations Center production environment. IBM Intelligent Operations Center is a prerequisite
for IBM Intelligent Operations for Water.

IBM Intelligent Operations for Water is installed on IBM Intelligent Operations Center 1.5. For
information about IBM Intelligent Operations Center 1.5 system services, see the related information.
Related tasks:
“Installing the solution” on page 22
Installing IBM Intelligent Operations for Water involves several steps. A deployment wizard is provided
to deploy and install IBM Intelligent Operations for Water.
Related information:
IBM Intelligent Operations Center system services

Hardware requirements
There are no additional hardware requirements for deploying IBM Intelligent Operations for Water, as the
product is installed on top of the existing servers in the IBM Intelligent Operations Center cluster.

IBM Intelligent Operations Center hardware requirements

The hardware requirements of the IBM Intelligent Operations Center servers that IBM Intelligent
Operations for Water is installed on top of are defined in the IBM Intelligent Operations Center
Information Center. These are the minimum hardware requirements. The IBM Intelligent Operations
Center cluster might require additional resources, depending on any additional IBM Smarter Cities
Software Solutions that are deployed in this environment.
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Related tasks:
“Installing the solution” on page 22
Installing IBM Intelligent Operations for Water involves several steps. A deployment wizard is provided
to deploy and install IBM Intelligent Operations for Water.
“Preparing the installation management server” on page 15
You must prepare the server that runs the installation of IBM Intelligent Operations for Water before you
start the deployment wizard. The installation management server is only required during the deployment
process.
Related information:
IBM Intelligent Operations Center hardware requirements

IBM Intelligent Operations for Water system requirements

IBM Intelligent Operations Center system requirements

Software requirements
The servers and clients involved in the deployment of IBM Intelligent Operations for Water must meet
the minimum software requirements. This includes the IBM Intelligent Operations Center servers that
IBM Intelligent Operations for Water is installed onto and the installation management server that the
IBM Intelligent Operations for Water installer runs from.

Server software requirements

The software requirements of the IBM Intelligent Operations Center servers that IBM Intelligent
Operations for Water is installed on top of are defined in the IBM Intelligent Operations Center
Information Center.

Client software requirements

The IBM Intelligent Operations for Water solutions interface supports a number of browsers. Some
browsers can be used with limitations.

IBM Intelligent Operations for Water has been tested, and is supported, on the following browsers:
v Microsoft Internet Explorer 8.x (32-bit only)
v Microsoft Internet Explorer 9.x (32-bit only)
v Mozilla Firefox 10 ESR

Internet Explorer Compatibility View

IBM Intelligent Operations for Water does not support Internet Explorer 8 or Internet Explorer 9
Compatibility View.

Internet Explorer 8.x performance

Users might experience slow performance using Internet Explorer 8.x.

To avoid this problem, use Internet Explorer 9.x or Firefox 10 ESR.

Users might also experience problems when working with the Water Conservation Portal using
Internet Explorer 8.x. Internet Explorer 9.x is required for users of Water Conservation Portal. To avoid
any issues, use Internet Explorer 9.x.
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Minimum screen resolution

IBM Intelligent Operations for Water is designed to run at a minimum 1280 x 800 screen resolution.
Related tasks:
“Installing the solution” on page 22
Installing IBM Intelligent Operations for Water involves several steps. A deployment wizard is provided
to deploy and install IBM Intelligent Operations for Water.
“Preparing the installation management server” on page 15
You must prepare the server that runs the installation of IBM Intelligent Operations for Water before you
start the deployment wizard. The installation management server is only required during the deployment
process.
Related information:
IBM Intelligent Operations Center software requirements
IBM Intelligent Operations Center browser requirements

IBM Intelligent Operations for Water system requirements

IBM Intelligent Operations Center system requirements

Media packaging
You can order IBM Intelligent Operations for Water as a package of DVDs or obtain it through Passport
Advantage®.

The IBM Intelligent Operations for Water V1.5 product is listed under the IBM Intelligent Water Family.
The offering includes the following items:
v IBM Intelligent Operations for Water V1.5 Multilingual DVD
v IBM Intelligent Operations Center V1.5 Multilingual DVD
Related tasks:
“Installing the solution” on page 22
Installing IBM Intelligent Operations for Water involves several steps. A deployment wizard is provided
to deploy and install IBM Intelligent Operations for Water.
“Preparing the installation media” on page 16
Before you run the IBM Intelligent Operations for Water deployment wizard, you must first obtain and
prepare the installation media.
Related information:

IBM Intelligent Operations for Water Passport Advantage download page

IBM Passport Advantage

Installing the IBM Intelligent Operations Center
Before installing IBM Intelligent Operations for Water, you must first install the IBM Intelligent
Operations Center.

About this task

The IBM Intelligent Operations Center is required by IBM Intelligent Operations for Water. It is not
possible to install IBM Intelligent Operations for Water without first deploying and configuring the IBM
Intelligent Operations Center. The IBM Intelligent Operations Center must be running during the
installation of IBM Intelligent Operations for Water.
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Procedure

Install, configure, and verify the IBM Intelligent Operations Center using the steps outlined in the IBM
Intelligent Operations Center Information Center. See the related information.

What to do next

Install the required interim fix and prepare the IBM Intelligent Operations Center servers before you start
the IBM Intelligent Operations for Water installer.
Related tasks:
“Preparing the IBM Intelligent Operations Center servers”
Before you start the deployment of IBM Intelligent Operations for Water, you must first prepare the
existing IBM Intelligent Operations Center environment.
Related information:
Installing and configuring

Preparing the IBM Intelligent Operations Center servers
Before you start the deployment of IBM Intelligent Operations for Water, you must first prepare the
existing IBM Intelligent Operations Center environment.

About this task

The IBM Intelligent Operations Center must be running during the installation of IBM Intelligent
Operations for Water. Some of the IBM Intelligent Operations Center services are automatically restarted
by the installer. To avoid a disruption in service, it is recommended that users of the IBM Intelligent
Operations Center be logged off the system during the IBM Intelligent Operations for Water installation
period.

Procedure
1. Make sure that all of the IBM Intelligent Operations Center servers are started. Use the Platform

Control Tool in IBM Intelligent Operations Center to control the services.
2. Query the status of all of the IBM Intelligent Operations Center servers to ensure that they are started

before the installation begins. If any of the IBM Intelligent Operations Center components are not
started, the installation of IBM Intelligent Operations for Water does not complete successfully. Use
the System Verification Checks in IBM Intelligent Operations Center to determine the operational
status of IBM Intelligent Operations Center services.

3. Verify that you can access the IBM Intelligent Operations Center portal by logging on as the
administrator using the following URL:
http://application_server_hostname/wpsv70/wps/myportal

In the IBM Intelligent Operations Center portal you can see the Intelligent Operations Center link on
the top navigation bar.

What to do next

After the IBM Intelligent Operations Center environment is configured and all servers are up and
running, you are ready to start preparing the IBM Intelligent Operations for Water.
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Related tasks:
“Installing the IBM Intelligent Operations Center” on page 13
Before installing IBM Intelligent Operations for Water, you must first install the IBM Intelligent
Operations Center.
“Preparing the installation management server”
You must prepare the server that runs the installation of IBM Intelligent Operations for Water before you
start the deployment wizard. The installation management server is only required during the deployment
process.
Related information:
Controlling the services in IBM Intelligent Operations Center
Starting the components in IBM Intelligent Operations Center
Stopping the components in IBM Intelligent Operations Center
Performing system verification checks

Preparing the installation management server
You must prepare the server that runs the installation of IBM Intelligent Operations for Water before you
start the deployment wizard. The installation management server is only required during the deployment
process.

Before you begin

Review the hardware and software requirements of the installation management server.

Procedure
1. Install and configure a new server running the Linux operating system, according to the minimum

software and hardware requirements.
2. Temporarily disable any firewall security that is currently running on the server.
3. Restart the system.
4. Configure the network settings of the server so that it can communicate with all of the existing IBM

Intelligent Operations Center server nodes.
5. Test the connectivity of the server to and from all other servers in the environment:

a. From the new server, ping each of the IBM Intelligent Operations Center server nodes, by using
their host names to ensure that they are reachable.

b. From each of the existing IBM Intelligent Operations Center server nodes, ping the impending
IBM Intelligent Operations for Water by using the host name to ensure that it is reachable.

c. Contact your local network administrator to resolve any connectivity issues.

What to do next

Prepare the installation media before you start the deployment of IBM Intelligent Operations for Water.
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Related concepts:
“Hardware requirements” on page 11
There are no additional hardware requirements for deploying IBM Intelligent Operations for Water, as the
product is installed on top of the existing servers in the IBM Intelligent Operations Center cluster.
“Software requirements” on page 12
The servers and clients involved in the deployment of IBM Intelligent Operations for Water must meet
the minimum software requirements. This includes the IBM Intelligent Operations Center servers that
IBM Intelligent Operations for Water is installed onto and the installation management server that the
IBM Intelligent Operations for Water installer runs from.
Related tasks:
“Preparing the IBM Intelligent Operations Center servers” on page 14
Before you start the deployment of IBM Intelligent Operations for Water, you must first prepare the
existing IBM Intelligent Operations Center environment.
“Preparing the installation media”
Before you run the IBM Intelligent Operations for Water deployment wizard, you must first obtain and
prepare the installation media.

Preparing the installation media
Before you run the IBM Intelligent Operations for Water deployment wizard, you must first obtain and
prepare the installation media.

Before you begin

There are two forms of installation media for deploying IBM Intelligent Operations for Water:
v Product installation DVD
v Licensed customers can download the installation package from the IBM® Passport Advantage® website

See the link at the end of this page for more information about the Passport Advantage software package
numbers and download links.
Related concepts:
“Media packaging” on page 13
You can order IBM Intelligent Operations for Water as a package of DVDs or obtain it through Passport
Advantage.
Related tasks:
“Deploying the solution” on page 23
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.
“Preparing the installation management server” on page 15
You must prepare the server that runs the installation of IBM Intelligent Operations for Water before you
start the deployment wizard. The installation management server is only required during the deployment
process.
Related information:

IBM Intelligent Operations for Water Passport Advantage download page

Preparing the installation DVD
The IBM Intelligent Operations for Water installation DVD contains all the files required to start the
deployment. You must first mount the DVD on to the installation management server.
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About this task

This task is not required if you are using the IBM Intelligent Operations for Water downloaded
installation media to run the installation.

To mount a CD-ROM on Linux operating systems, you must issue the mount command. Depending on
your system configuration, you might need root user authority for this procedure.

Procedure

Insert the DVD into the drive and enter the following command:
mount -t iso9660 -o ro /dev/cdrom /cdrom

Note: /cdrom represents the mount point of the DVD folder. This folder must exist prior to using the
mount command.

Results

Your DVD file system is mounted. View the contents of the installation DVD by placing the disc into the
drive and enter the cd /cdrom command where /cdrom is the mount point directory.

What to do next

The installation management server is now ready to run the IBM Intelligent Operations for Water
deployment wizard and deploy the solution.
Related tasks:
“Deploying the solution” on page 23
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.

Preparing the downloaded installation package
The IBM Intelligent Operations for Water installation package contains all the files required to start the
deployment. You must first copy and extract the required installation files and directory structure onto
the installation management server before you begin the deployment.

About this task

This task is not required if you are using the IBM Intelligent Operations for Water product DVD media to
run the installation.

Procedure
1. Log on to the IBM Intelligent Operations for Water installation management server as the root user.
2. Create a new directory to contain the temporary installation files and directory structure, for example

/images.
3. Copy the IBM Intelligent Operations for Water installation package into the new directory that you

created in the previous step.
4. From the operating system command line, go to the directory where you just copied the installation

package.
5. Extract the installer by using the following command:

tar -xvf CIA2SML.tar
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Results

The installation management server is now ready to run the IBM Intelligent Operations for Water
deployment wizard and deploy the solution. The installation starts from the directory into which you
have just extracted the installation package.

What to do next

The IBM Intelligent Operations for Water installation management server is now ready to run the IBM
Intelligent Operations for Water deployment wizard and deploy the solution.
Related tasks:
“Deploying the solution” on page 23
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.

Installing and configuring semantic model services
IBM Intelligent Operations for Water provides a semantic model services application and sample model.
This service needs to be installed and configured prior to use.

Configuring the Jazz team server
The IBM Intelligent Operations for Water semantic model services is installed on a Jazz team server. The
Jazz team server needs to be configured before the IBM Intelligent Operations for Water semantic model
services are installed.

About this task

The IBM Intelligent Operations for Water architecture needs to be installed before configuring the Jazz
team server.

Procedure
1. In a web browser go to http://management_host:82/jts/setup where management_host is the fully

qualified host name of the management server.
2. Log on with the user ID iicsystemuser and password passw0rd.
3. Click Next.
4. On the Configure Public URI page, provide a Public URI Root value in the form

https://management_host:9448/jts and select I understand that once the Public URI is set, it
cannot be modified.. Click Next.

5. Click Test Connection. A message should be displayed that the configuration test was successful.
6. Click Next to save the settings and continue.
7. Configure the database on the Configure Database page.

a. Select DB2 for Database Vendor.
b. Select JDBC for Connection Type.
c. Enter the DB2 database password defined as the DEFAULT.PWD.DB2 property in the topology

properties file for JDBC Password. Ignore the displayed password message.
d. For JDBC Location enter //db_host:50005/JTS:user=db2inst5;password={password}; where

db_host is the host name of the data server. The {password} string must be entered as shown. Do
not substitute with a password value.

e. Click Test Connection. If an error occurs, check and correct any entries. If the entries are correct,
make sure the database services are started on the data server using the Platform Control Tool.

f. After a message is displayed that no Jazz tables are present in the database, click Create Tables.
Processing will take several minutes to complete.

g. Click Next.
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8. On the Enable E-mail Notification page set the value to Disabled and click Next.

9. The Register Applications page should display "No new applications detected." Click Next.
10. Select LDAP for the User Registry Type in Step 1 on the Setup User Registry page.
11. In Step 2 configure LDAP for the Jazz Team Server registry.

a. Enter ldap://mgmt_host:389 for LDAP Registry Location where mgmt_host is the fully qualified
host name of the management server.

b. Enter OU=USERS,OU=SWG,O=IBM,C=US for Base User DN.
c. Enter userId=uid,name=cn,emailAddress=mail for User Property Names Mapping.
d. Enter OU=GROUPS,OU=SWG,O=IBM,C=US for Base Group DN.
e. For Jazz to LDAP Group Mapping make sure the value is set to JazzAdmins=JazzAdmins,

JazzUsers=JazzUsers, JazzDWAdmins=JazzDWAdmins, JazzProjectAdmins=JazzProjectAdmins,
JazzGuests=JazzGuests.

f. Enter cn for Group Name Property.
g. Enter cn for Group Member Property.

12. Click Test Connection. If a warning message is displayed, click show details. If the warning is about
the mail property you can ignore the message.

13. For Client Access License Type select IBM Integrated Information Core - IIC Model Server.
14. Click Next.
15. For Configure Data Warehouse select the I do not wish to configure the data warehouse at this

time checkbox.
16. Click Finish on the Summary page.

Results

The Jazz team server is operational.

Installing semantic model services
The semantic model services and a sample application are provided with IBM Intelligent Operations for
Water.

About this task

Configuration of the Jazz Team Server on the management server is required before using the semantic
model services.

Procedure
1. In a web browser go to http://management_host:82/jts/admin where management_host is the

fully-qualified host name of the management server.
2. On the Server Administration page, click Server > Configuration > Register Applications.
3. Click Add on the Registered Applications page.
4. Add the Model Server application on the Add Application page.

a. Enter Model Server for Application Name.
b. Enter http://management_host:82/modelserver/scr, where management_host is the fully qualified

host name of the management server, for Discovery URL.
c. Enter a value of your choice for Consumer Secret This value will be used to provide access to the

application. The value should be treated with the same security as a password.
d. Enter iicsystemuser for Functional ID

The Application Type will change to Model Server.
5. If there are no errors, click Finish.
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Verifying semantic model services configuration
A semantic model services sample application is provided with IBM Intelligent Operations for Water and
can be used to verify the correct installation and configuration of the semantic model services.

Procedure
1. Prepare the sample model files.

a. On the installation server find the iic15_2_stagebuildtoserver.xx.jar file in the install_media
directory.

b. Expand the iic15_2_stagebuildtoserver.xx.jar file into a directory of your choice. In the rest of
these steps this directory is referred to as model_home.

2. Install the sample model.
a. In a web browser on the server where model_home is located, go to http://mgmt_host:82/iic/

console where mgmt_host is the fully-qualified host name of the management server.
b. Log on as the iicsystemuser user with passw0rd as the password.
c. Click Model Manager > Ontologies > Browse.
d. Navigate to the install_media/ioc/image/IIC/install/modelServices/post_install/ directory.
e. Open the rsm.owl file.
f. Click Load. The file will be loaded.
g. Click Model Manager > Ontologies > Browse.
h. Navigate to the install_media/ioc/image/IIC/install/modelServices/post_install/ directory.
i. Open the modelServer.owl file.
j. Click Load. The file will be loaded.
k. Click Model Manager > Ontologies > Browse.
l. Navigate to the install_media/ioc/image/IIC/install/ktpRuntimeServices/post_install/

directory.
m. Open the kpi.owl file.
n. Click Load. The file will be loaded.
o. Click Model Manager > Load > Browse

p. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
q. Open the IBMOilDownstreamSampleRDF.xml file.
r. Click Load. The file will be loaded.
s. Click Model Manager > Load > Browse

t. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
u. Open the IBMOilUpstreamSampleRDF.xml file.
v. Click Load. The file will be loaded.
w. Click Model Manager > Load > Browse

x. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
y. Open the IBMOilDownstreamSampleReferenceRDF.xml file.
z. Click Load. The file will be loaded.
aa. Click Model Manager > Load > Browse

ab. Navigate to the install_media/ioc/image/IIC/samples/rdf/rsm/ directory.
ac. Open the IBMOilUpstreamSampleReferenceRDF.xml file.
ad. Click Load. The file will be loaded.

3. Verify that the sample model is correctly installed.
a. Click Model Manager > Query > Query. A predefined query will run. An XML structure will be

displayed with the query results. The top level tag should be spargl and have secondary tags head
and results.
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b. Click Model Explorer and make sure you can browse the model.
4. Use the model to verify the installation of model manager.

a. In a web browser on the management server, go to http://mgmt_host:82/iic/ibmoil where
mgmt_host is the fully-qualified host name of the management server.

b. Click IBM Oil Company > Variables. Web service URLs are displayed.

Results

The semantic model services and IBMOil sample model are installed.

Improving semantic model services performance
Configure the semantic model services provided by IBM Intelligent Operations for Water to improve
performance when running queries against models.

Procedure
1. In a web browser go to http://management_host:82/iic/console where management_host is the

fully-qualified host name of the management server.
2. Add the property values in Table 7 to the OPCWEBSERVICE category.

Table 7. OPCWEBSERVICE properties

Property Value

cache.browse.timetolive.second 3600

cache.timetolive.second 2592000

cache.wait.second.after.create.action 1

3. Update or add the following properties and values in Table 8 in the RSM category.

Table 8. RSM properties

Property Value

mvmViewPath.0 http://iec.ch/TC57/CIMgeneric# ISA95_Enterprise##http://iec.ch/TC57/
CIMgeneric# RSM_OrganizationalEntity.ManagesAspectOf_PhysicalEntity
##iec.ch/TC57/CIMgeneric# ISA95_Site##http://iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.contains_PhysicalEntity##http:// iec.ch/TC57/CIMgeneric#
ISA95_Area##http://iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.contains_PhysicalEntity##http:// iec.ch/TC57/CIMgeneric#
ISA95_ProductionUnit##http:// iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.ManagedBy_OrganizationalEntity##http://
iec.ch/TC57/CIMgeneric# RSM_OrganizationalEntity##http://
iec.ch/TC57/CIMgeneric# RSM_OrganizationalEntity.has_measurement##http://
iec.ch/TC57/CIM-generic#RSM_Measurement##http:// iec.ch/TC57/
CIMgeneric# RSM_Measurement.HasA_MeasurementValue##http://
iec.ch/TC57/CIM-generic#RSM_MeasurementValue

mvmViewPath.1 http://iec.ch/TC57/CIMgeneric# ISA95_Enterprise##http://iec.ch/TC57/
CIMgeneric# RSM_OrganizationalEntity.ManagesAspectOf_PhysicalEntity
##iec.ch/TC57/CIMgeneric# ISA95_Area##http://iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.contains_PhysicalEntity##http:// iec.ch/TC57/CIMgeneric#
ISA95_ProductionUnit##http://iec.ch/TC57/CIMgeneric#
ISA95_WorkCenter.Contains_Equipment##http:// iec.ch/TC57/CIMgeneric#
RSM_WorkEquipment##http:// iec.ch/TC57/CIMgeneric#
RSM_PhysicalEntity.has_measurement##http:// iec.ch/TC57/CIM-
generic#RSM_Measurement##http:// iec.ch/TC57/CIMgeneric#
RSM_Measurement.HasA_MeasurementValue##http:// iec.ch/TC57/CIM-
generic#RSM_MeasurementValue

mvmDownLevelPreRequest 3
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Table 8. RSM properties (continued)

Property Value

mvmCacheProperty.0 cim:RSM_IdentifiedObject.name

mvmMaxQueryURI 500

mvmMaxSparqlEntry 4000

4. Click Publish. The new and modified properties will be saved.
5. Restart the semantic model services using the Platform Control Tool.
6. In a web browser go to http://management_host:82/iic/console where management_host is the

fully-qualified host name of the management server.
7. Make any solution or application-specific changes as needed. If changes are required, the changes will

be identified in the product or solution documentation.

Installing the solution
Installing IBM Intelligent Operations for Water involves several steps. A deployment wizard is provided
to deploy and install IBM Intelligent Operations for Water.

Before you begin

The installation of IBM Intelligent Operations for Water requires an installation management server to run
the deployment wizard on. The installation management server must be able to connect to and from the
IBM Intelligent Operations Center servers. The IBM Intelligent Operations Center environment provides
the middleware required by IBM Intelligent Operations for Water.

The IBM Intelligent Operations for Water installation management server can be a physical hardware
server or a virtual machine running on a VMware Server. It can also be a server in the cloud, if the IBM
Intelligent Operations Center environment is also deployed in the cloud. Make sure that the installation
management server meets the minimum hardware and software requirements.

About this task

The deployment wizard performs several deployment steps:
v Component selection
v Specification of the IBM Intelligent Operations Center installation location
v Review of deployment progress, status messages and results

When the deployment of IBM Intelligent Operations for Water is complete, the installation management
server is no longer required. The installation profile can be optionally saved for later reference, and is
useful for future upgrades that are required.
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Related concepts:
“Preparing for installation” on page 11
Before deploying IBM Intelligent Operations for Water, understand the IBM Intelligent Operations for
Water system configuration and ensure that the prerequisites are met for the environment.
“System configuration” on page 11
IBM Intelligent Operations for Water deployment wizard installs the product on top of the IBM
Intelligent Operations Center production environment. IBM Intelligent Operations Center is a prerequisite
for IBM Intelligent Operations for Water.
“Hardware requirements” on page 11
There are no additional hardware requirements for deploying IBM Intelligent Operations for Water, as the
product is installed on top of the existing servers in the IBM Intelligent Operations Center cluster.
“Software requirements” on page 12
The servers and clients involved in the deployment of IBM Intelligent Operations for Water must meet
the minimum software requirements. This includes the IBM Intelligent Operations Center servers that
IBM Intelligent Operations for Water is installed onto and the installation management server that the
IBM Intelligent Operations for Water installer runs from.
“Media packaging” on page 13
You can order IBM Intelligent Operations for Water as a package of DVDs or obtain it through Passport
Advantage.

Deploying the solution
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.

Before you begin

Prepare the installation media before you start the deployment wizard. You must also perform the
prerequisite tasks that are outlined in this information center. The following list describes specific
prerequisite tasks that are required.
v Ensure that the IBM Intelligent Operations Center is completely installed, that all IBM Intelligent

Operations Center servers are operational.
v Ensure that all the IBM Intelligent Operations Center System Verification checks run successfully. See

the related checklist link.
v Configure the Jazz team server. See the related task.
v Install and verify the Semantic model services and configuration. See the related task.
v Globally unlock the files for the Tivoli Netcool/Impact server. Follow these steps:

1. Log on to the following URL as admin. The password is netcool.
http://eventserver:9080/nci/login_main.jsp

2. Click Global, and then click Unlock.
3. Log off.

Note: Logging off is very important. Otherwise, items do not stay unlocked.

About this task

Run the deployment wizard on the IBM Intelligent Operations for Water on which you prepared the
installation media.

The deployment wizard requires the following information from the existing IBM Intelligent Operations
Center environment:
v The location of the IBM Intelligent Operations Center 1.5 installer. For example: /opt/IBM/IOC/BA/ioc.
v The Java home directory. For example: /opt/ibm/java-i386-60
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v The password used by the IBM Intelligent Operations Center installer when installing IBM Intelligent
Operations Center.

Procedure
1. Download IBM Intelligent Operations for Water in Passport Advantage or use the product DVD

media to run the deployment.
2. Extract the CIA2SML.tar file to the Installation server, and run ./launchpad.sh under the

Offering_Setup folder. The welcome panel of the IBM Intelligent Operations for Water deployment
wizard is displayed with information about the installation process.

3. If you have not installed Installation Manager 1.5.3, select Install IBM Installation Manager. If
Installation Manager 1.5.3 is installed, select Install IBM Intelligent Operations for Water.

4. Click Install IBM Installer Manager to install Installation Manager 1.5.3.

Note: If Installation Manager 1.5.3 is already installed, click Install IBM Intelligent Operations for
Water.

5. Optional: Add the repository to Installation Manager before you begin the deployment by
completing the following steps:
a. Start Installation Manager

b. Select File > Preferences... > Repositories.
c. Enter the service repository location and click Apply.

6. Click Install IBM Intelligent Operations for Water to start the deployment.
7. On the Install Packages panel, select the package to install and click Next to continue.
8. Accept the license agreement and click Next, then Next again to continue.
9. On the Install Packages panel, select the features to install:

a. Click Utility Base to install the core features of IBM Intelligent Operations for Water.
b. Optional: Click Waste Water Content to install the sample data for the IBM Intelligent Operations

for Water waste water deployment.
c. To continue to the next deployment panel, click Next.

10. On the Configuration for IBM Intelligent Operations for Water 1.5.0.0 panel, enter:
a. Location of the IBM Intelligent Operations Center 1.5 installer.
b. Location of the Java home directory, which is version 6.0 or later.
c. Password used by the IBM Intelligent Operations Center installer during the installation of IBM

Intelligent Operations Center 1.5.
d. Confirm the password again and then click Next to continue.

11. The Summary Panel displays a summary of all selected tasks and an estimation of the time it takes
to complete the deployment. Click Install to start the installation.

Note: The deployment process can take several minutes. Allow the process to continue, even if you
do not observe movement of the progress bar.

Results

IBM Intelligent Operations for Water is installed.

Note: If the IBM Intelligent Operations for Water installation fails using the IBM Installation Manager,
and you manually resolve the problem and wish to continue the installation, you can use the
command-line installation method. See the related task.

24 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



What to do next

Verify the installation to ensure the solution is correctly deployed and working with the IBM Intelligent
Operations Center.
Related concepts:
“Preparing for installation” on page 11
Before deploying IBM Intelligent Operations for Water, understand the IBM Intelligent Operations for
Water system configuration and ensure that the prerequisites are met for the environment.
Related tasks:
“Preparing the installation media” on page 16
Before you run the IBM Intelligent Operations for Water deployment wizard, you must first obtain and
prepare the installation media.
“Verifying the deployment” on page 26
Verify the installation of IBM Intelligent Operations for Water to ensure the solution is correctly deployed
and working with the IBM Intelligent Operations Center.
“Post-installation configuration” on page 27
After successfully completing the installation of IBM Intelligent Operations for Water, additional steps are
required to configure the solution.
“Deploying from the command line”
The IBM Intelligent Operations for Water solution package can be deployed when the IBM Intelligent
Operations Center base architecture is deployed.
Related information:
Installation checklists
Configuring the Jazz team server
The IBM Intelligent Operations for Water semantic model services is installed on a Jazz team server. The
Jazz team server needs to be configured before the IBM Intelligent Operations for Water semantic model
services are installed.
Installing and configuring semantic model services
IBM Intelligent Operations for Water provides a semantic model services application and sample model.
This service needs to be installed and configured prior to use.

Deploying from the command line
The IBM Intelligent Operations for Water solution package can be deployed when the IBM Intelligent
Operations Center base architecture is deployed.

Procedure
1. Extract the SOLUTION.zip file into the IOC_Installer/spec directory.

When extracted, the files should be in the /opt/IBM/IOC/BA/ioc directory if you used the
/opt/IBM/IOC/BA/ioc directory for the IBM Intelligent Operations Center installation. If the directory
does not exist, review your IBM Intelligent Operations Center installation logs to determine the
location of the IOC_Installer/spec directory.

Note: The SOLUTION.zip and water_wih_solution.zip files are located in the command-line
subdirectory within the /install/image directory.

2. Extract the water_wih_solution.zip file into the /waterbuild directory on theInstallation server.

Note: The water_wih_solution.zip file is located in the command-line subdirectory within
the/install/image directory.

3. Import the IBM Intelligent Operations for Water solution. Run this command:
/opt/IBM/IOC/BA/ioc/bin/ba.sh importSolution -f /waterbuild/water_wih_solution.zip -p password

4. Install the IBM Intelligent Operations for Water solution. Run this command:
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/opt/IBM/IOC/BA/ioc/bin/ba.sh installSolution -s water_wih -p password

Where password is the administrator password specified when the IBM Intelligent Operations for
Water deployment wizard was run.

5. If an error is displayed, check the install.log file for details. Correct any errors. Rerun the command.

What to do next

Log on to the portal to verify that IBM Intelligent Operations for Water was successfully deployed.
Related concepts:
“Known problems and solutions” on page 223
Some common problems with IBM Intelligent Operations for Water are documented, along with their
solutions or workarounds. If you have a problem with IBM Intelligent Operations for Water, review the
problem-solution topics to determine if a solution is available to the problem that you are experiencing.
The problem-solution topics are categorized according to the type of issue.
Related tasks:
“Deploying the solution” on page 23
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.

Verifying the deployment
Verify the installation of IBM Intelligent Operations for Water to ensure the solution is correctly deployed
and working with the IBM Intelligent Operations Center.

About this task

Verify that you can access the IBM Intelligent Operations for Water portal by logging on as the
administrator. Use the following procedure to start a new browser session and access the IBM Intelligent
Operations Center. You can also access the solution from other IBM Smarter Cities Software Solutions
installed in your environment. From the main navigation bar at the top of the portal, select Intelligent
Water.

Procedure
1. Enter the URL into the address field of the browser.

Note: The fully qualified domain name is required in the URL, for example, http://
application_server_hostname/wpsv70/wps/myportal. If you use the IP address instead of the
registered fully qualified domain, some portlets do not display correctly.

2. On the login page, enter your user ID and password.
3. Click Sign In.

Results

Only the pages, features, and data that you have permission to access are displayed. Contact your
administrator if you require more access.

What to do next

The system is now ready for post-installation configuration.
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Related tasks:
“Deploying the solution” on page 23
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.
“Post-installation configuration”
After successfully completing the installation of IBM Intelligent Operations for Water, additional steps are
required to configure the solution.

Post-installation configuration
After successfully completing the installation of IBM Intelligent Operations for Water, additional steps are
required to configure the solution.
Related tasks:
“Deploying the solution” on page 23
IBM Intelligent Operations for Water provides a deployment wizard to install IBM Intelligent Operations
for Water into an existing environment that is running the IBM Intelligent Operations Center.
“Verifying the deployment” on page 26
Verify the installation of IBM Intelligent Operations for Water to ensure the solution is correctly deployed
and working with the IBM Intelligent Operations Center.

Starting WebSphere Message Broker processes
Using administrative tools, you can start the WebSphere Message Broker processes.

About this task

When IBM Intelligent Operations for Water has successfully installed, the WebSphere MQ Manager and
WebSphere Message Broker processes are running. However, when you reboot the servers, it is
recommended that you check to ensure the processes are still running. If not, you must start the
processes.

Restriction: You must logged on as the appropriate user to complete the tasks. Message Queue tasks are
performed by user mqm. Message Broker tasks are performed by user mqmconn.

Procedure
1. Log on to the IBM Intelligent Operations Center event server.
2. Run the following command to check the status of the WebSphere MQ Manager.

/opt/mqm/bin/dspmq

3. Run the following command to start the WebSphere MQ Manager: WIH.MB.QM.
/opt/mqm/bin/strmqm WIH.MB.QM

4. Run the following command to check the status of the WebSphere Message Broker: WIH_BROKER
source /opt/IBM/mqsi/8.0.0.0/bin/mqsiprofile
/opt/IBM/mqsi/8.0.0.0/bin/mqsilist

5. Run the following command to start the WebSphere Message Broker: WIH_BROKER.
/opt/IBM/mqsi/8.0.0.0/bin/mqsistart WIH_BROKER
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Related tasks:
“Checking the Netcool/OMNIbus probes”
Using administrative tools, you can check that the Netcool/OMNIbus probes for IBM Intelligent
Operations for Water and IBM Intelligent Operations Center are operational.

Checking the Queue Manager and Message Broker status
You can use a VNC client to check that the necessary queue managers, their listeners, and message
brokers are operational.

Procedure
1. Using a VNC client to log on to the Event server, run the following command to open MQ Explorer:

[root@event-ioc ~}# xhost +
[root@event-ioc ~]# su - mqm
[mqm@event-ioc ~]$ strmqcfg
[mqm@event-ioc ~]$

2. On the MQ Explorer - Navigator tab, expand Queue Managers and ensure that the following queue
managers and their listeners are running:
v IOC.MB.QM
v WIH.MB.QM

To check the status of the listener for each queue manager, expand the queue manager and select
Advanced > Listeners.

3. Ensure that the IOC_BROKER and WIH_BROKER are running. Run the following command: If the
brokers are not running, run the following command:
[root@event-ioc bin]# su - mgmconn
[mqmconn@event-ioc ~]$ cd /opt/IBM/mqsi/8.0.0.0/bin
[mqmconn@event-ioc bin]$ source mqsiprofile

If the brokers are not running, start them by running the following command:
[mqmconn@event-ioc bin]$ ./mqsilist
[mqmconn@event-ioc bin]$ ./mqsistart WIH_BROKER
[mqmconn@event-ioc bin]$ ./mqsistart IOC_BROKER

Checking the Netcool/OMNIbus probes
Using administrative tools, you can check that the Netcool/OMNIbus probes for IBM Intelligent
Operations for Water and IBM Intelligent Operations Center are operational.

Procedure
1. Log in to the Event server as root. Optionally, log in to the Event server as an administrator and use

the sudo command to run the required commands if you are unable to log in as root.
2. Verify the status of the Netcool/OMNIbus probes. Run this command:

ps auxww |grep water_wih
ps auxww |grep ioc_xml

If no processes are running, you must start the probes manually.
a. Start the ioc_xml probe. Run this command:

/opt/IBM/netcool/omnibus/probes/nco_p_xml -name ioc_xml -propsfile
/opt/IBM/netcool/omnibus/probes/linux2x86/ioc_xml.props &

You can also use the IOCControl management tools to start the ioc_xml probe. See the related task.
b. Start the water_wih probe. Run this command:

/opt/IBM/iss/iow/omnibus/startXmlProbe.sh

3. Repeat the commands in step 2 to verify the status of the Netcool/OMNIbus probes.
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4. Go to the following URL to check that the appropriate WebSphere MQ Manager and WebSphere
Message Broker processes are running:
https://solutionsid.rtp.raleigh.ibm.com/cities15/topic/com.ibm.water.doc/install_start_wmb.html

Related tasks:
“Starting WebSphere Message Broker processes” on page 27
Using administrative tools, you can start the WebSphere Message Broker processes.
Starting and stopping the Tivoli Netcool/OMNIbus probe

Enabling the events record
Using administrative tools, you can enable record event management in order to manage event activity in
IBM Intelligent Operations for Water. Use the information in this task to enable event monitoring on the
application server.

Procedure
1. Log on to WebSphere Application Server at the following URL:

https://appserver:9043/ibm/console

2. Select Applications > Monitor Services > Recorded Events Management > Enable/Disable Events
Record.

3. Select the local host and click Enable Events Record to enable event monitoring.

Configuring the timezone of the monitoring model
Using administrative tools, you can synchronize the timezone settings in the monitor model with the host
operating system timezone settings

Procedure
1. Extract all content from water_wih_monitor_models.zip located at: topology\

water_wih_solution_samples\MONITOR_Sample_Data\content\models in the water solution installer.
2. Import the business monitoring projects into Rational® Application Developer using the installed IBM

WebSphere Business Monitor development toolkit.
3. Set the correct timezone for each KPI model to match your host timezone settings.
4. Generate a monitor J2EE project and export the monitor model EAR file.
5. Update the monitor model application in IBM WebSphere Business Monitor server.

Deleting sample users
IBM Intelligent Operations for Water includes sample users. For security reasons, delete the sample users
after IBM Intelligent Operations for Water is installed.

About this task

The WebSphere Portal administrator manages user accounts in the Administration portal. Use the
following procedure to delete the sample users that are included with IBM Intelligent Operations for
Water.

Procedure
1. Log on to the portal as administrator (wpsadmin) using the following URL:

http://app_server_ur/wpsv70/wps/myportal

2. Click Administration.
3. Click Access > Users and Groups.
4. Click the delete icon for the following users:

v gkooper (Gwen Kooper)
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v jharckness (Jac Harckness)
v eharper (Eoin Harper)

Important: Do not delete the following required users. If you delete them, IBM Intelligent Operations
for Water and the IBM Intelligent Operations Center will not operate properly.
v admin
v iicsystemuser
v maxadmin
v maxintadm
v maxreg
v notesadmin
v resAdmin1
v resDeployer1
v resMonitor1
v rtsAdmin
v rtsConfig
v rtsUser
v taiuser
v SRMSELFSERVICEUSR
v wasadmin
v waswebadmin
v wpsadmin
v wpsbind
v All user IDs beginning with "PM"

Related concepts:
Chapter 3, “Securing the solution,” on page 37
Securing IBM Intelligent Operations for Water is an important consideration. To ensure that the system is
secure, you must manage who can access the system and assign the correct level of access within the
solution.
“Sample users” on page 43
During the deployment of IBM Intelligent Operations for Water, sample users are created with
corresponding responsibilities and access permissions.

Getting started with the solution
Use the information in this section to get started with the IBM Intelligent Operations for Water solution.
By working with the sample demonstration and data provided with the solution, you can quickly get
familiar with the capabilities and tasks performed when using the solution.

Checking the sample system is operational
Complete the steps in this section to verify that the sample system is operational and all scripts are
available to start working with data in the content pack.

Before completing the steps in this section, check that all IBM Intelligent Operations Center servers are
operational. To work with the sample system, the application server, database server, event server and
management server must be operational.

To download the scripts, please go to the URL in the related information.

Note: For demonstration purposes, all systems use password: passw0rd unless otherwise indicated.
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Related information:

IBM Intelligent Operations for Water APAR PO00035

IBM Intelligent Operations for Water APAR PO00170

Extracting the demonstration scripts
The IBM Intelligent Operations for Water sample requires demonstration scripts that are used to set up
your environment so that you can perform some common tasks. Use the information in this topic to
access the demonstration scripts.

Procedure

To locate and extract the demonstration scripts, download the APARs and follow the installation steps.
Related information:

IBM Intelligent Operations for Water APAR PO00035

IBM Intelligent Operations for Water APAR PO00170

Starting the Simulator
IBM Intelligent Operations for Water provides a simulation tool that monitors incoming folders, parses
CSV files, and sends data readings. You can use the Simulator to check operational data flows sourced
from external systems. To begin working with the demonstration scripts, you must start the Simulator.

About this task

The Simulator is installed on the application server in the directory: /opt/IBM/iss/iow/apps/simulator.

Procedure

To start the simulator, type
cd /opt/IBM/iss/iow/apps/simulator/
./run_simulator.sh

Loading the KPI thresholds
To start familiarizing with KPIs and how they are used in the sample solution, you must load and set up
sample KPI thresholds. The IBM Intelligent Operations for Water demonstration system contains sample
KPI thresholds for the Combined Sewer Overflow diverter.

About this task

You need to perform this procedure only once per system.

Procedure
1. On the application server, open a command line as db2inst1 user if it is not already opened. For

example, su - db2inst1

2. Type cd /opt/IBM/iss/iow/apps/simulator/demoscripts

3. Type the db2 connect to wihdb user db2inst1 command.
4. Type the passw0rd password.
5. Type the db2 -tf set_csolevel_thresholds.sql command.

Checking mapped key measurements
When working with the Combined Sewer Overflow diverter sample, you must check that the mapped
key measurements are set up properly before performing water tasks.
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About this task

Set up the mapped key measurement for the Combined Sewer Overflow diverter. The diverter (CSO003)
should map to http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2 for
the purposes of the demonstration.

You need to perform this procedure only once per system.

Procedure
1. From the data server, log on as root and type the following commands:

xhost +
su - db2inst1
db2cc &

2. Expand All Databases, expand WIH_DB, select Tables, search for the table named
KEY_MEASUREMENT_CONFIG, and find the record corresponding to CSO003.

Note: KEY_MEASUREMENT_CONFIG and KEY_MEASUREMENT_RDFID (see Step 3) are under the
WIH schema.

3. When you locate the record, change the second column, KEY_MEASUREMENT_RDFID to
http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2.

Checking that servers are operational
Use the information in this topic to verify that all servers are operational.

Procedure
1. From the management server, log in as root: su - ibmadmin

2. Switch to the scripts directory: cd /opt/IBM/ISP/mgmt/scripts and enter the ./iopmgmt.sh status
all passw0rd command.

3. Select one of the following steps depending on whether no servers are running, only some servers are
running, or all servers are running:
a. If no servers are running, enter ./iopmgmt.sh start all passw0rd

b. If only some servers are running, enter ./iopmgmt.sh stop all passw0rd, then enter ./iopmgmt.sh
start all passw0rd

c. If all servers are running, continue to the next topic.

Checking Message Queue Manager Broker is running
Check that the Message Queue Manager Broker is running on the event server.

Procedure
1. From the event server, log in as root: su - mqm

2. Switch to the bin directory: cd /opt/mqm/bin and enter the ./dspmq command to show queues.
3. If the WIH.MB.QM is not running, start the broker by entering ./strmqm WIH.MB.QM.
4. Enter the ./dspmq command again to verify the broker has started.

Checking Message Queue SI Broker is started
Check that the Message Queue SI broker is started.

Procedure
1. From the event server, log on as root. You should be logged on as mqm on the event server.

To log on as mqm, type su - mqm from a command line.
2. Switch to the bin directory cd /opt/IBM/mqsi/8.0.0.0/bin

3. Check the source profile. Type source ./mqsiprofile
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4. Check the list of running processes. Type ./mqsilist

5. If both IOC_BROKER and WIH_BROKER are not running, start both processes by typing ./mqsistart
WIH_BROKER or ./mqsistart IOC_BROKER

6. Verify the processes are running by typing ./mqsilist

Checking Netcool probes are running
Check that the Netcool probes are running.

Procedure
1. To check IBM Intelligent Operations Center, from the event server log in as root. Enter ps auxww |

grep ioc_xml

2. If only the grep command is returned, start the XML probe with the command: /opt/IBM/netcool/
omnibus/probes/nco_p_xml -name ioc_xml -propsfile /opt/IBM/netcool/omnibus/probes/linux2x86/
ioc_xml.props &

3. To check WIH, enter ps auxww | grep water_wih

4. If only the grep command is returned, start the XML probe with the command: /opt/IBM/iss/iow/
omnibus/startXmlProbe.sh

Running a demonstration using the sample
Use the information in this section to familiarize with the solution interface and demonstration data to
perform typical tasks when using IBM Intelligent Operations for Water.

IBM Intelligent Operations for Water has many different water management use cases. IBM Intelligent
Operations for Water takes advantage of semantic models so that different contextual relationships
between assets that are related to waste water, water source and distribution, ports and harbors, and
water management can be accommodated.

IBM Intelligent Operations for Water KPIs are used to track events such as Dry Weather Sewer
Overflows. Using the sample data provided you can simulate how to trigger events. The Dry Weather
Sewer Overflow example is one of many examples available in the content pack. Each content pack for
IBM Intelligent Operations for Water contains specific sets of KPIs, asset models, reports, standard
operating procedure, event triggers, and other artifacts.

In the demonstration, you work with KPI samples and simulate a task where water operators prevent a
Dry Weather Sewer Overflow. Executive users confirm the overflow event. When working with the KPI
samples, you begin with all pertinent KPIs having a green status. If a Dry Weather Sewer Overflow KPI
is NOT green, you might need to reset the database. To view a KPI, double-click the item in the KPI map
to display the KPI hierarchy in the Details portlet.

In the demonstration, you also work with the key elements in IBM Intelligent Operations for Water
interface including the Map and Details portlets on the Operations view.
v The Map portlet provides contextual information about water assets and is used to track events. Many

objects are displayed on the map including Combined Sewer Overflow diversion structures (CSO), rain
gauges, and the pipe network. Using the Filter options, you can select the content to display. You can
select events, and various types of assets in the system. The asset types are configurable and are not
limited to the samples displayed in the interface. You can also select from a pre-configured list of
logical zones. The zones can be pressure management zones, district metering areas (DMAs), zip codes,
or other regions.

v The Details portlet expands on IBM Intelligent Operations Center and contains the Events tab and
Asset tab. The Asset tab tracks the assets that are displayed in the map and the key measurements that
are associated with the assets. The Details portlet shows measurement names, values, and trends. The
Details portlet indicates whether a measurement is not read in a while (keyed to a configurable timeout
period) and can indicate whether a particular measurement reaches warning or critical levels.
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Preparing to run the scripts
Use the information in this topic to set up your system to run the demonstration scripts.

Procedure
1. If you are not already running the simulator, log on to the application server as root and type

cd /opt/IBM/iss/iow/apps/simulator/
./run_simulator.sh

Keep the window open because useful status information about the records is displayed.

Note: You can check if the simulator is already running by typing ps -ef | grep simulator

2. Go to the demoscripts directory.
a. Log on as root and type xhost + to ensure you can use the X-windows programs.
b. Type su - db2inst1.
c. Change to the demoscripts directory: cd /opt/IBM/iss/iow/apps/simulator/demoscripts.

3. Continue to the steps in the related task.
Related information:
Familiarizing with the solution interface
Use the information in this topic to familiarize with the solution interface.

Familiarizing with the solution interface
Use the information in this topic to familiarize with the solution interface.

Procedure
1. Open a web browser. Enter the URL http://<applicationserverhost>/wpsv70/wps/portal, and select

the Water solution.
2. Explore the Executive tab.
3. Explore the Operator tab.
4. View the common portlets.

The Notifications portlet displays important water KPI-related events.
The My Activities portlet displays standard operating procedure that are started when certain events
begin, such as a warning level breach for a key measurement.
The Contacts portlet is used for communication and collaboration within the system.

5. Continue with the steps in the related task.
Related information:
Triggering a changing event
Using the demonstration data and the tools available, you can simulate changes to measurement
readings. You can view the impact of those events in the solution interface when triggering a Dry
Weather Sewer Overflow warning.

Triggering a changing event
Using the demonstration data and the tools available, you can simulate changes to measurement
readings. You can view the impact of those events in the solution interface when triggering a Dry
Weather Sewer Overflow warning.

Procedure
1. Use the built in Simulator to provide values to the rain gauges.
2. From the application server, navigate to the demoscripts directory: cd /opt/IBM/iss/iow/apps/

simulator/demoscripts
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3. Simulate that the weather has been dry for 24 hours by sending a zero reading value to
neighborhood rain gauges for both today and yesterday. Log on as db2inst1, and run the following
two scripts in sequence to display records in the run_simulator.sh window.
./make_it_dry_yesterday.sh
./make_it_dry_today.sh

4. The zero values are displayed for the rain gauges on the Assets tab in the Details portlet and also in
the pop-up on the map.

5. Start with a normal reading on Combined Sewer Overflow diverter (CSO003). Run the
./cso_acceptable.sh script. The CSO003 status is Green on the Assets list and Map.

6. Trigger a water level rise in Combined Sewer Overflow diverter (CSO003). Run the
./cso_warning.sh script. The CSO003 status changes to Yellow on the Assets list and Map. In
addition, on the map, an event pop-up warning is displayed to state that the Combined Sewer
Overflow has reached 75% of the water level. The warning is displayed in both the events list and
on the Map.

7. A standard operating procedure is created in the My Activities portal in response to the rising water
level. The standard operating procedure is configured using the Administration panel of IBM
Intelligent Operations for Water. To complete each step in the standard operating procedure, open
the procedure by clicking the left arrow. Click Start > Finish for each step until the activity is no
longer displayed. It may take some time to register each step.

8. When the standard operating procedure has completed, the KPI system registers the event as a
Prevented Dry Weather Sewer Overflow. View the event in the Notifications portlet. The counters for
Prevented Dry Weather Sewer Overflows are increased.

9. Switch to the Executive page. Check the KPI status is green as the Prevented Dry Sewer Overflow
has been avoided.

10. To simulate a series of events when an overflow can not be avoided, run the ./cso_critical.sh
script. Switch to the Operator page to view the status turn from Yellow to Red.

11. If the standard operating procedure does not start immediately, run the ./cso_acceptable.sh script
to confirm the overflow has occurred. An activity is displayed to confirm that the overflow has
occurred.

12. Confirm the Dry Weather Sewer Overflow by opening the task in the My Activities portlet.
13. Click Start > Finish on the Dry Weather Sewer Overflow to confirm the task. The event is also

displayed on the Events tab and Map. A red border surrounds the Combined Sewer Overflow and
an event icon is displayed to show the event.
See the related task for information about the Executive view of the Dry Weather Sewer Overflow
event.

Related information:
Viewing the response to events in the solution interface
By opening the Executive page in the solution interface, you can view the response to the simulated
event.

Viewing the response to events in the solution interface
By opening the Executive page in the solution interface, you can view the response to the simulated
event.

Procedure
1. Click the Executive tab.
2. The Dry Weather Sewer Overflow KPI status is displayed in Red to indicate that a Dry Weather Sewer

Overflow has occurred.

Resetting the sample demonstration
When the demonstration has concluded, you must reset the demonstration for subsequent use.
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Procedure
1. Clear the KPI notifications. In the Notifications portlet, click the top checkbox to select all

notifications. Right-click a notification, and select Close Alert.
2. Clear all Events. In the Details portlet, select the Events tab. Select each event in the list, right click,

and select Cancel Event. Click OK on the pop-up window, and wait for the window to display.
Repeat the step until all events are cleared.

3. Reset the database for the Dry Weather Sewer Overflow KPI. You must perform this task as the Dry
Weather Sewer Overflow maintains a Red status if a Dry Weather Sewer Overflow happened within
the last week. Complete the following steps to reset the KPI system and so ignore that the Dry
Weather Sewer Overflow occurred. To do this:
a. In your web browser, open the URL http://<application_server>:9060/ibm/console. Accept the

certificate and log on as waswebadmin/passw0rd.
b. Navigate to Applications > Application Types > Monitor Models.
c. Click the Version column. For example, click 2012-04-22T17:01:40 of column

Storm_Water_SSO_CSO_Management.
d. Click Manage Schema.
e. Click Run Delete Schema Script.

f. Click Run Create Schema Script.
g. Click Monitor Models in the breadcrumbs area to return to the initial page for that Monitor

service.
h. Select Storm_Water_SSO_CSO_Management, click Stop, and wait for confirmation that the

service has stopped. A red Stopped icon appears to the right of the service. Then click Start to
restart the service. The Dry Weather Sewer Overflow KPI should return to green in the Executive
view.
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Chapter 3. Securing the solution

Securing IBM Intelligent Operations for Water is an important consideration. To ensure that the system is
secure, you must manage who can access the system and assign the correct level of access within the
solution.

Securing the base architecture

Because IBM Intelligent Operations for Water is a solution that runs on top of the IBM Intelligent
Operations Center, set the high-level security settings through the IBM Intelligent Operations Center. For
details on the various options available, see the security section of the IBM Intelligent Operations Center
Information Center.

Securing the data import

The importing of data into IBM Intelligent Operations for Water is performed on the IBM Intelligent
Operations Center event and management server. Ensure that the method used to connect and transfer
data on to this server is secure. For more information, see the related links at the end of this topic.

Securing the portal

The following topics explain how to secure the solution and manage user access to the IBM Intelligent
Operations for Water portal.
Related concepts:
Chapter 4, “Integrating the solution,” on page 45
Products and services can be integrated with IBM Intelligent Operations for Water.
Related information:
Securing the IBM Intelligent Operations Center
Cyber hygiene
Securing the model

User roles and responsibilities
IBM Intelligent Operations for Water implements security by limiting access to features and data based
on user roles.

The security model and user access roles of IBM Intelligent Operations for Water are consistent with the
IBM Intelligent Operations Center and other IBM Smarter Cities Software Solutions.

To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. A user is made a member of a user role
group by the administrator.

Table 1 shows the authorized pages, portlets, and responsibilities of the user roles of IBM Intelligent
Operations for Water.
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Table 9. The roles of IBM Intelligent Operations for Water.

User role (role group) Authorized pages Authorized responsibilities

Water Operator Operator: Operations view

City: Water Conservation view

View the Map.

View Details.

View Notifications.

View City View: Water
Conservation.

Note: The Water Operator can
view the City: Water Conservation
page only and is unable to view the
Citizen: Water Conservation page in
the portal. The Water Operator can
only view the Citizen: Water
Conservation page if the Water
Operator also has the Water Consumer
role and has an account in the system.

View My Activities.

Send and receive Sametime® messages.

Water Executive Executive: Status view

City: Water Conservation view

View Status.

View the Key Performance Indicator
Drill Down.

View Notifications.

View My Activities.

View City View.

Note: The Water Executive can
view the City: Water Conservation
page only and is unable to view the
Citizen: Water Conservation page in
the portal. The Water Operator can
only view the Citizen: Water
Conservation page if the Water
Executive also has the Water Consumer
role and has an account in the system.

Send and receive Sametime messages.

Water Consumer Citizen: Water Conservation
view

View the Citizen: Water
Conservation page.
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Table 9. The roles of IBM Intelligent Operations for Water. (continued)

User role (role group) Authorized pages Authorized responsibilities

Water Administrator All preceding pages and
Administrator pages.

All preceding responsibilities.
Additionally, a user of this role can:

Configure the page layout.

Configure portlets, including

v Map

v Details

v Status

v Key Performance Indicator Drill
Down

v Notification

v My Activities

v Contacts

v City: Water Conservation

v Citizen: Water Conservation

Related concepts:
“Users and benefits” on page 4
IBM Intelligent Operations for Water is designed for water operations and management personnel to help
optimize and more efficiently manage water systems, assets, and networks across a geographically
dispersed infrastructure.
Related tasks:
“Adding users and groups”
To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. Use the Administration portal to add
users and groups to IBM Intelligent Operations for Water.
“Viewing or modifying group membership” on page 41
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.

Adding users and groups
To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. Use the Administration portal to add
users and groups to IBM Intelligent Operations for Water.

Before you begin

Choose from one of the following IBM Intelligent Operations for Water roles that provides the access
level that your users or groups require:
v Water Operator
v Water Executive
v Water Administrator

v Water Consumer
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IBM Intelligent Operations for Water users must also be members of the following IBM Intelligent
Operations Center user category groups:
v ioc_base_rescue
v ioc_base_safety
v ioc_base_meteorological
v ioc_base_chemical
v ioc_base_radiological
v ioc_base_infrastructure
v ioc_base_fire
v ioc_base_explosive
v ioc_base_health
v ioc_base_other
v ioc_base_environmental
v ioc_base_security
v ioc_base_transportation
v ioc_base_nuclear
v ioc_base_biological
v ioc_base_geophysical

See the related links at the end of this topic for more information about the roles of IBM Intelligent
Operations for Water and about IBM Intelligent Operations Center groups.

About this task

You can add new users and groups to IBM Intelligent Operations for Water. You can also add users and
groups from an existing Lightweight Directory Access Protocol (LDAP) directory source that is configured
to work with the underlying IBM Intelligent Operations Center. For more information about how to
import LDAP directory users into the solution, see the IBM Intelligent Operations Center Information
Center.

Procedure
1. Log on to the solution portal as a portal administrator, for example, wpsadmin or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the page, click Administration.
3. On the sidebar menu, expand the Access submenu, and click Users and Groups.
4. Click All Portal User Groups. The list of role groups for IBM Intelligent Operations for Water, the

IBM Intelligent Operations Center, and any other IBM Smarter Cities Software Solutions installed in
this environment are displayed.

5. Scroll through the list to find the user group role that you would like to assign to your users.
6. Select the required IBM Intelligent Operations for Water role group by clicking it. The IDs of the

existing group members are listed.
7. Add the user to the group using one of the following steps:

v To add a new user, click New User and complete the required Profile Management fields.
v To add an existing user or group of users, click Add Member and select one or more users or

groups from the list.
8. Click OK.

40 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



Results

The recently added users or groups appear in the membership list of the user role group. The users are
authorized to access the solution portal according to the permissions assigned to the role group selected.

What to do next

If the users also require access to the IBM Intelligent Operations Center and other IBM Smarter Cities
Software Solutions installed in this environment, add them to the relevant user roles for those solutions.
For more information, see the security topics in the information center for the IBM Intelligent Operations
Center or the other IBM Smarter Cities Software Solutions you have deployed.
Related concepts:
“User roles and responsibilities” on page 37
IBM Intelligent Operations for Water implements security by limiting access to features and data based
on user roles.
Related tasks:
“Viewing or modifying group membership”
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.
Related information:
Importing users and groups into the IBM Intelligent Operations Center
User category groups and data permissions

Viewing or modifying group membership
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.

About this task

Use the following procedure to add or remove existing users from IBM Intelligent Operations for Water
user role groups. Users removed from an IBM Intelligent Operations for Water user role group can still
continue to access the IBM Intelligent Operations Center and any other IBM Smarter Cities Software
Solutions. For more information about how to completely delete a user and revoke their access to the
entire portal and all solutions running in this environment, see the related links.

Procedure
1. Log on to the solution portal as a portal administrator, for example, wpsadmin or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the page, click Administration.
3. On the sidebar menu, expand the Access submenu, and click Users and Groups.
4. Click All Portal User Groups. The list of role groups for IBM Intelligent Operations for Water, the

IBM Intelligent Operations Center, and any other IBM Smarter Cities Software Solutions installed in
this environment are displayed.

5. Click one of the following IBM Intelligent Operations for Water user role groups that you would like
to view or modify. You can scroll to the next page to find the required user role group that you are
interested in.
v Water Administrator
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v Water Operator
v Water Executive

v Water Consumer
6. A table containing all the users and groups that have been assigned to the user role are displayed.

You can perform several actions by clicking the icons at the end of each row for the user you are
interested in.
v To remove a user or group, click the Delete icon on the row for that user.
v To view all other roles that the selected user or group has been assigned, click the View

membership icon on the row for that user.
v To add an existing portal user or group to this role, click Add Member and select the user or

groups to be added.
v To create a new portal user and add them to the role, click New User and complete the required

fields.
v To create a new portal group and add the group to this role, click New Group and complete the

required fields.
7. To finish and return to IBM Intelligent Operations for Water, on the main navigation bar at the top of

the portal, click More... and then select Intelligent Water.
Related concepts:
“User roles and responsibilities” on page 37
IBM Intelligent Operations for Water implements security by limiting access to features and data based
on user roles.
Related tasks:
“Adding users and groups” on page 39
To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. Use the Administration portal to add
users and groups to IBM Intelligent Operations for Water.

Removing users or groups
If a user or group no longer requires access to the solution, you can remove them from IBM Intelligent
Operations for Water. You can also remove a user or group from the entire solution including the IBM
Intelligent Operations Center and any other IBM Smarter Cities Software Solutions deployed in the
environment.

Procedure
1. To remove a user or group from only the IBM Intelligent Operations for Water solution, see Viewing

or modifying groups.

Note: Removing a user from the IBM Intelligent Operations for Water user role groups does not affect
any access the user may have to the IBM Intelligent Operations Center and any other IBM Smarter
Cities Software Solutions installed in this environment.

2. To completely remove a user or group from the entire system, see the security section of the IBM
Intelligent Operations Center Information Center.
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Related tasks:
“Viewing or modifying group membership” on page 41
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.
Related information:
Deleting a user or group in the IBM Intelligent Operations Center

Sample users
During the deployment of IBM Intelligent Operations for Water, sample users are created with
corresponding responsibilities and access permissions.

IBM Intelligent Operations for Water includes the following sample users.

Name User ID User role

Gwen Kooper gkooper Water Operator

Water Consumer

Jac Harckness jharckness Water Executive

Eoin Harper eharper Water Administrator

By default, the sample users only have access to the IBM Intelligent Operations for Water solution.

If the sample users require access to the IBM Intelligent Operations Center and other IBM Smarter Cities
Software Solutions installed in this environment, they must be added to the relevant user roles for those
solutions.
Related tasks:
“Deleting sample users” on page 29
IBM Intelligent Operations for Water includes sample users. For security reasons, delete the sample users
after IBM Intelligent Operations for Water is installed.
Related information:
User roles and access in the IBM Intelligent Operations Center

Viewing or modifying user profiles
View or edit the profile of a user to set or reset any of the user profile attributes including password,
name, email, and language. You cannot change the user ID.

About this task

The portal administrator can view or edit user profiles by using the Administration portal. Select the
user from the authenticated portal users list to open the user profile and change profile details.

Note: Each user can also change their own profile by clicking Edit My Profile on the top navigation bar
of the portal.

Procedure
1. Log on to the solution portal as a portal administrator, for example, wpsadmin or another user who is

a member of the wpsadmins portal group.
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2. On the main navigation bar at the top of the page, click Administration.
3. On the sidebar menu, expand the Access submenu, and click Users and Groups.
4. Click All Authenticated Portal Users. A table containing all existing users is displayed.
5. Find the user that you are interested in. Click the edit icon on the row for that user, to display their

Profile Management page. The attribute fields for the user profile are displayed.
6. Optional: To change the password for the user, enter a new password in the New Password: and

Confirm Password: fields.
7. You can add, edit, or delete information in any of the remaining fields.
8. To submit the changes you have made, click OK.

Results

The user profile is updated with the changes you submitted.

Setting the password policy
Tivoli Access Manager installed with the IBM Intelligent Operations Center provides a default for how
long a password can be used before it must be changed. Set a different password policy if the default
value is not acceptable

Procedure
1. On the IBM Intelligent Operations Center management server, access the Tivoli Access Manager

WebSEAL Web Portal Manager at the following URL:
http://management_server_hostname:9061/ibm/console

2. Log on with the IBM Intelligent Operations Center administrator ID and password created when the
IBM Intelligent Operations Center was installed.

3. Click Tivoli Access Manager > Web Portal Manager > Users > Show Global User Policy.
4. Enter the Tivoli Access Manager administrator ID and password created when the IBM Intelligent

Operations Center was installed.
5. Click Show Global User Policy.
6. Specify the maximum password age desired for the system.
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Chapter 4. Integrating the solution

Products and services can be integrated with IBM Intelligent Operations for Water.

IBM Intelligent Operations for Water provides a public web service interface when you are writing or
testing applications. You can use any HTTP client in any programming language to query metadata about
your water infrastructure. You can access the URLs and any HTTP client in any programming language
to interact with the API.

For information about other solution integration points, refer to the links at the end of the page.
Related concepts:
Chapter 3, “Securing the solution,” on page 37
Securing IBM Intelligent Operations for Water is an important consideration. To ensure that the system is
secure, you must manage who can access the system and assign the correct level of access within the
solution.
“Customizing data integration” on page 135
The IBM Intelligent Operations for Water solution provides extension options that you can use to
customize the data that is made visible to users. Working with the model manager, you can define what
infrastructure, assets, measurements, and values are presented in the interface, and determine how to
integrate that data with components in the solution. Use the information in this topic to familiarize with
model customization and extensions.
“Customizing data import and operational storage” on page 150
With IBM Intelligent Operations for Water, you can build a customized data consolidation plan to gather
and reconcile data from many sources. Use the information in this section to customize data population.
“Customizing data processing” on page 153
You can customize data processing in IBM Intelligent Operations for Water to suit the requirements of
your operational and executive staff. By specifying and implementing user specific Key Performance
Indicators (KPIs), you can establish service level agreements and key measurements to meet the
performance needs of your organization and key stakeholders.
Related information:
Overview of Integration in Intelligent Operations Center
Reference information in Intelligent Operations Center

IBM developerWorks article: Developing KPIs (Part 1)

IBM developerWorks article: Developing KPIs (Part 2)

Software Development Kit (SDK) Overview
IBM Intelligent Operations for Water provides a software development kit (SDK) for developers.

Model

Many software development companies provide an application framework that enables developers to
create custom applications by using a set of reusable components. The IBM Intelligent Operations for
Water SDK follows the same model. You can use the SDK to create your own customized applications
that are additional to the core applications provided on the platform. Use the applications to perform
tasks that you are interested in. For example, you can create applications to handle flood management or
measure water quality.
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Features

The IBM Intelligent Operations for Water SDK has the following features:
v A set of underlying interfaces and a programming model to enable application development.
v One simple way to build applications on the IBM Intelligent Operations for Water 1.5.0.2.
v Detailed documents that are targeted at developers of IBM Intelligent Operations for Water who are

working in research, lab services, GBS, and with client partners.
v A simplified route for productizing IBM Intelligent Operations for Water assets that add value to the

business.

SDK Architecture

The following diagram of the IBM Intelligent Operations for Water SDK architecture shows the functional
components and their relationships.
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Figure 2. IBM Intelligent Operations for Water SDK Architecture
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Application Tiers

The following table describes the tiers in the IBM Intelligent Operations for Water SDK.

Tier Name Description

1 External System The External System tier contains
SCADA System A and SCADA
System B. SCADA systems are
centralized to monitor and control
entire sites. The tier can also contain
Application Messaging Interface
(AMI) systems, Enterprise Asset
Management (EAM) systems, and
Customer Relationship Management
(CRM) systems.

2 IBM Intelligent Operations for Water
Persistence Stores

The IBM Intelligent Operations for
Water Persistence Stores tier contains
an Analytical Store, Reporting Store,
Operating Store, and Geospatial
Store. External systems interact with
persistence stores by way of the
event server broker. The SDK
provides extensions to the WebSphere
Business Modeler. The SDK provides
database extensions and content
packs in the tier.

3 IOC Subsystems The IBM Intelligent Operations
Center Subsystems tier contains a
Key Performance Indicator (KPI)
engine, a Collaboration Subsystem, a
Reports and Analytics Subsystem, a
Model Manager Subsystem, and a
Subsystem Relationship Model (SRM)
Subsystem. The SDK provides
Custom KPIs and Custom
Analytics/Reports in the tier.

4 Applications - Core and Custom The Applications tier provides an
SDK API to build core and custom
applications. APIs include the Model
Access Service, Reading Service,
Render Service, Model Exploration
Service, ASK Service, and the Water
Information Hub.

5 Clients The Clients tier has an Executive
View and a Client View. The Clients
tier enables uses to integrate their
applications into the client tier.

Web Service Interface
IBM Intelligent Operations for Water provides an Application Programming Interface (API) based on
Representational State Transfer (REST) principles. You can use the API to build and test your own
applications.

Overview
To successfully use the IBM Intelligent Operations for Water REST API, you must understand how to
construct a URL and interpret the response.
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All resources and operations that are exposed by the REST API are accessible through a hierarchy of
endpoints for each IBM Intelligent Operations for Water service that is published on the server. Your
request can be any of the following HTTP methods. All requests require you to authenticate.
v Retrieve resources with the GET method. GET is like a select statement and retrieves information,

returning JSON or XML format. The method's parameters are typically appended to the request URI.
v Create or update resources with the POST or PUT method. When POST is called, you pass in JSON or

XML that contains your method’s parameters.
v Delete resources with the DELETE method. The method's parameters are typically appended to the

request URI.

Base URI

IBM Intelligent Operations for Water API URIs use the following base URI format:
<protocol>://<hostname>:<port_number>/ibm/water/api/<name>-service/<resource>

v protocol is either http or https
v hostname is the hostname of the application server
v port_number is the port number of WebSEAL. For example, 80 for http and 443 for https.
v name is the component name
v resource is the name of the resource

An example of the IBM Intelligent Operations for Water API URI:
http://app.ioc.ibm.com/ibm/water/api/reading-service/realtime

Status codes

Table 1 lists the possible response status codes.

Table 10. Possible response status codes

HTTP Status Code Description

200 (OK) Returned by a successful GET, PUT, or POST request.

204 (No Content) Returned by a successful DELETE request.

400 (Bad Request) Returned when supplied data is invalid or missing (that
is, any input validation errors).

403 (Forbidden) Returned with the user is not authorized to call the
requested API.

404 (Not Found) Returned by a GET, PUT, or DELETE request where the
resource does not exist.

409 (Conflict) Returned by a PUT request where the last modified time
supplied by the user does not match the current value.

500 (Internal Server Error) Something went wrong that cannot be represented by
one of the other status codes. Use this code as a last
resort if something goes wrong.

Response formats

The IBM Intelligent Operations for Water can respond to requests in various formats. Table 2 lists the
response formats.
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Table 11. Response formats

Response Format Request Header

JSON Accept: application/json

XML Accept: application/xml

Using the REST API
The IBM Intelligent Operations for Water REST API is a hierarchy of resources.

The resource hierarchy contains a number of services, including the Model Access Service, Reading
Service, Render Service, Model Exploration Service, and ASK Service. The following is a file based
representation of the resource hierarchy:
/ibm/water/api

/ibm/water/api/model-service/<resource>
/ibm/water/api/reading-service/<resource>
/ibm/water/api/render-service/<resource>
/ibm/water/api/topicmaps-service/<resource>

/askws /<resource>

Model Access Service resources
Model Access Service resources are used to access semantic models. You can use the services to make
SPARQL queries, to update the model, and to retrieve detailed information about specific RDF objects.
The Model Access Service can also query resources, such as asset types, measurement values, assets,
measurement, and contained-assets and connects-assets relationships.

query:

The query resource runs SPARQL queries on the model. In the Water REST API, query is one of the
Model Access Service resources.

Method

GET.

Resource URI
/ibm/water/api/model-service/query?sparql=<sparql>

Request Body

Not applicable.

Response

SPARQL query results in XML or JSON format. Please reference the standards at the URL:
http://www.w3.org/TR/rdf-sparql-XMLres/.

Resource Parameter

The resource has the following parameter.

Parameter Description

sparql The SPARQL query string.
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Examples

The following examples demonstrate how to use the query resource to call services and return either an
XML or JSON response. Assume that the examples are using the following URL: http://app-
ioc.cn.ibm.com/ibm/water/api/model-service/query?sparql=<sparql>

In the examples, the service accepts the SPARQL query string using the parameter named sparql. The
following sample SPARQL query string is passed to the service:
select * where {
?a ?b ?c
} limit 10

The query string is encoded in the following URL:
http://app-ioc.cn.ibm.com/ibm/water/api/model-service/query?
sparql= select%20*%20where%20%7B%0A%20%3Fa%20%3Fb%20%3Fc%0A%7D%20limit%2010

Example 1: Call the service and get a XML response

The example calls the service and gets an XML response. It uses the following method, URL, and Accept
request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/query? sparql= select%20*%20where

%20%7B%0A%20%3Fa%20%3Fb%20%3Fc%0A%7D%20limit%2010
v Accept: application/xml.

In the example, you get the following XML response:
<sparql xmlns="http://www.w3.org/2007/SPARQL/results#">
<head>
<variable name="a"></variable>
<variable name="b"></variable>
<variable name="c"></variable>
</head>
<results>
<result>
<binding name="a">
<uri>http://cityName#Pipe1248</uri>
</binding>
<binding name="b">
<uri>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</uri>
</binding>
<binding name="c">
<uri>http://iec.ch/TC57/CIM-generic#RSM_IdentifiedObject</uri>
</binding>
</result>
<result>
<binding name="a">
<uri>http://cityName#Pipe1248</uri>
</binding>
<binding name="b">
<uri>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</uri>
</binding>
<binding name="c">
<uri>http://cityName#Pipe</uri>
</binding>
</result>
...
</results>
</sparql>
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Example 2: Call the service and get a JSON response

The example calls the service and gets a JSON response. It uses the following method, URL, and Accept
request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/query? sparql= select%20*%20where

%20%7B%0A%20%3Fa%20%3Fb%20%3Fc%0A%7D%20limit%2010
v Accept: application/json.

In this example, you get the following JSON response:
{
"head": {
"variable": [{
"name": "a"
},
{
"name": "b"
},
{
"name": "c"
}]
},
"results": {
"result": [{
"binding": [{
"uri": "http://cityName#Pipe1248",
"name": "a"
},
{
"uri": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "b"
},
{
"uri": "http://iec.ch/TC57/CIM-generic#RSM_IdentifiedObject",
"name": "c"
}]
},
{
"binding": [{
"uri": "http://cityName#Pipe1248",
"name": "a"
},
{
"uri": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "b"
},
{
"uri": "http://cityName#Pipe",
"name": "c"
}]
},
......
]
}

}

update:

The update resource runs SPARQL updates on the model. In the Water REST API, update is one of the
Model Access Service resources.
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Resource URI
/ibm/water/api/model-service/update

Resource Properties

Not applicable.

Response

No response.

Resource Parameters

The resource has the following parameter:

Parameter Description

sparql The SPARQL query string.

Example 1: Update using SPARQL

The following example demonstrates how to use the update resource. Assume the service is using the
following URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/update.

The request body is the SPARQL query string.
PREFIX rdf:<http://www.w3.org/1999/02/22-rdf-syntax-ns#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
insert {
<http://example.org#foo> rdf:type cim:RSM_WorkEquipment
} where{
}

Example 2: Use POST to call the resource

The example demonstrates how to use POST to call the update resource. It uses the method, URL, and
Accept request-header:
v Method: POST
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/update
v Response: status 204 no content indicate the SPARQL update success.

properties:

The properties resource retrieves the properties of a model object. In the Water REST API, properties is
one of the Model Access Service resources.

Method

GET.

Resource URI
/ibm/water/api/model-service/properties?id=<id>

Request Body

Not applicable.
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Response

The response is a list of properties in XML or JSON format.

Resource Parameters

Retrieves properties of a model object.

Parameter Description

sparql The SPARQL query string.

id The ID of the model object.

Examples

The following examples demonstrate how to use the properties resource. Assume the service is using the
following URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/properties.

Example 1: Retrieve properties in XML format

The example uses properties to retrieve the properties of object, http://cityName#Pipe558, in XML
format. It uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/properties?id=http%3A%2F

%2FcityName%23Pipe588
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<modelObject xmlns="http://www.ibm.com/iss/iow/services/modelaccess">
<id>http://cityName#Pipe588</id>
<property>

<id>http://iec.ch/TC57/CIM-generic#RSM_IdentifiedObject.name</id>
<name>RSM_IdentifiedObject.name</name>
<value>Pipe588</value>

</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_PhysicalEntity.TypeOfPhysicalEntity</id>
<name>RSM_PhysicalEntity.TypeOfPhysicalEntity</name>
<value>WorkEquipment</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_PhysicalEntity.has_Location</id>
<name>RSM_PhysicalEntity.has_Location</name>
<value>http://cityName#Pipe588-Location</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_UnnamedObject.mrid</id>
<name>RSM_UnnamedObject.mrid</name>
<value>Pipe588</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.Contains_Equipment</id>
<name>RSM_WorkEquipment.Contains_Equipment</name>
<value>http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.Contains_Equipment</id>
<name>RSM_WorkEquipment.Contains_Equipment</name>
<value>http://cityName#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation</value>
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</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.TypeOfEquipment</id>
<name>RSM_WorkEquipment.TypeOfEquipment</name>
<value>Pipe</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connected_workEquipment</id>
<name>RSM_WorkEquipment.connected_workEquipment</name>
<value>http://cityName#Junction265</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connects_WorkEquipment</id>
<name>RSM_WorkEquipment.connects_WorkEquipment</name>
<value>http://cityName#Junction265</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connects_WorkEquipment</id>
<name>RSM_WorkEquipment.connects_WorkEquipment</name>
<value>http://cityName#Junction268</value>
</property>
<property>

<id>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connects_workEquipment</id>
<name>RSM_WorkEquipment.connects_workEquipment</name>
<value>http://cityName#Junction264</value>
</property>
<property>
<id>http://iec.ch/TC57/CIM-generic#hasDirectType</id>
<name>hasDirectType</name>
<value>http://cityName#Pipe</value>
</property>
<property>

<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://cityName#Pipe</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#ISA95_WorkLocation</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#ISO15926_FunctionalLocation</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#MIMOSA_Agent</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#MIMOSA_Segment</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#RSM_FunctionalLocation</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#RSM_IdentifiedObject</value>
</property>
<property>
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<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#RSM_MaintainableItem</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#RSM_PhysicalEntity</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#RSM_ResourceMember</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#RSM_UnnamedObject</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://www.epanet.org#EPANET_Entity</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://www.epanet.org#EPANET_Link</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://www.epanet.org#EPANET_Pipe</value>
</property>
<property>
<id>http://www.w3.org/1999/02/22-rdf-syntax-ns#type</id>
<name>type</name>
<value>http://www.ibm.com/water/wih#WIH_Pipeline_Asset</value>
</property>

</modelObject>

Example 2: Retrieve properties in JSON format

This example uses properties to retrieve of the object, http://cityName#Pipe558, in JSON format.
Assume the service is using the following URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-
service/properties.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/properties?id=http%3A%2F

%2FcityName%23Pipe588
v Accept: application/json

In this example, you get the following JSON response:
"id": "http://cityName#Pipe588",
"property": [{
"id": "http://iec.ch/TC57/CIM-generic#RSM_IdentifiedObject.name",
"name": "RSM_IdentifiedObject.name",
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"value": "Pipe588"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_PhysicalEntity.TypeOfPhysicalEntity",
"name": "RSM_PhysicalEntity.TypeOfPhysicalEntity",
"value": "WorkEquipment"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_PhysicalEntity.has_Location",
"name": "RSM_PhysicalEntity.has_Location",
"value": "http://cityName#Pipe588-Location"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_UnnamedObject.mrid",
"name": "RSM_UnnamedObject.mrid",
"value": "Pipe588"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.Contains_Equipment",
"name": "RSM_WorkEquipment.Contains_Equipment",
"value": "http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.Contains_Equipment",
"name": "RSM_WorkEquipment.Contains_Equipment",
"value": "http://cityName#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.TypeOfEquipment",
"name": "RSM_WorkEquipment.TypeOfEquipment",
"value": "Pipe"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connected_workEquipment",
"name": "RSM_WorkEquipment.connected_workEquipment",
"value": "http://cityName#Junction265"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connects_WorkEquipment",
"name": "RSM_WorkEquipment.connects_WorkEquipment",
"value": "http://cityName#Junction265"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connects_WorkEquipment",
"name": "RSM_WorkEquipment.connects_WorkEquipment",
"value": "http://cityName#Junction268"
},
{
"id": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.connects_workEquipment",
"name": "RSM_WorkEquipment.connects_workEquipment",
"value": "http://cityName#Junction264"
},
{
"id": "http://iec.ch/TC57/CIM-generic#hasDirectType",
"name": "hasDirectType",
"value": "http://cityName#Pipe"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://cityName#Pipe"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#ISA95_WorkLocation"
},
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{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#ISO15926_FunctionalLocation"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#MIMOSA_Agent"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#MIMOSA_Segment"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#RSM_FunctionalLocation"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#RSM_IdentifiedObject"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#RSM_MaintainableItem"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#RSM_PhysicalEntity"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#RSM_ResourceMember"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#RSM_UnnamedObject"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://www.epanet.org#EPANET_Entity"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://www.epanet.org#EPANET_Link"
},
{
"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://www.epanet.org#EPANET_Pipe"
},
{
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"id": "http://www.w3.org/1999/02/22-rdf-syntax-ns#type",
"name": "type",
"value": "http://www.ibm.com/water/wih#WIH_Pipeline_Asset"
}]

asset-types:

The asset-types resource retrieves a list of asset types. The resource is a subclass of RSM_WorkEquipment.
In the Water REST API, asset-types is one of the Model Access Service resources.

Method

GET.

Resource URI
/ibm/water/api/model-service/asset-types?prefix=<prefix>&id=<id>

Request Body

Not applicable.

Response

A list of asset types in XML or JSON format.

Resource Parameters

The asset-types resource uses the optional parameters in the following table.

Optional Parameter Description

prefix The prefix of the asset type; for example, the city name prefix,
http://cityName#.

id The ID of the asset type; for example the pipe prefix, http://cityName#Pipe.

Examples

This section provides examples of how you can use asset-types.

Sample Model

In the examples, you can assume that the model is imported to the model server. In addition, the model
defines several sensor meter assets and pipeline assets in the prefix, http://cityName#. The example
model is as follows:
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#" xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xml:base="http://cityName">

<!-- Sensor Meter Types -->
<rdf:Description rdf:about="http://cityName#RainGauge">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
<rdfs:label xml:lang="en">Rain Gauge</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_SensorMeter_Asset" />
<rdfs:comment>Rain Gauge</rdfs:comment>
</rdf:Description>

<rdf:Description rdf:about="http://cityName#CSODiversionStructure">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
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<rdfs:label xml:lang="en">CSO Diversion Structure</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_SensorMeter_Asset" />
<rdfs:comment>CSO Diversion Structure</rdfs:comment>
</rdf:Description>

<rdf:Description rdf:about="http://cityName#LiftStation">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
<rdfs:label xml:lang="en">Lift Station</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_SensorMeter_Asset" />
<rdfs:comment>Lift Station</rdfs:comment>
</rdf:Description>

<rdf:Description rdf:about="http://cityName#RiverGauge">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
<rdfs:label xml:lang="en">River Gauge</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_SensorMeter_Asset" />
<rdfs:comment>River Gauge</rdfs:comment>
</rdf:Description>

<rdf:Description rdf:about="http://cityName#WastewaterPlant">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
<rdfs:label xml:lang="en">Wastewater Plant</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_SensorMeter_Asset" />
<rdfs:comment>Wastewater Plant</rdfs:comment>
</rdf:Description>

<rdf:Description rdf:about="http://cityName#TrunkLineMonitor">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
<rdfs:label xml:lang="en">Trunk Line Monitor</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_SensorMeter_Asset" />
<rdfs:comment>Trunk Line Monitor</rdfs:comment>
</rdf:Description>

<!-- Pipeline Types -->
<rdf:Description rdf:about="http://cityName#Pipe">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
<rdfs:label xml:lang="en">Pipe</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.epanet.org#EPANET_Pipe" />
<rdfs:comment>Pipe</rdfs:comment>
</rdf:Description>

<rdf:Description rdf:about="http://cityName#Junction">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class" />
<rdfs:label xml:lang="en">Junction</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.epanet.org#EPANET_Junction" />
<rdfs:comment>Junction</rdfs:comment>
</rdf:Description>

</rdf:RDF>

Example 1: Retrieve all asset types

The example retrieves a list of all asset types in JSON format. In this example, assume that the service
uses the following URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/asset-types. The
example uses the Method, URL, and Accept request header:
v Method: GET
v Example URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/asset-types
v Accept: application/JSON

In this example, you get the following JSON response
"AssetType": [{

"id": "http://www.epanet.org#EPANET_Link",
"name": "EPANET_Link",
"description": "Super class EPANET Links",
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"parentId": "http://www.epanet.org#EPANET_Entity"
},
{
"id": "http://www.epanet.org#EPANET_Node",
"name": "EPANET_Node",
"description": "Super class EPANET Nodes",
"parentId": "http://www.epanet.org#EPANET_Entity"
},
{
"id": "http://cityName#LiftStation",
"name": "Lift Station",
"description": "Lift Station",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
},
{
"id": "http://cityName#WastewaterPlant",
"name": "Wastewater Plant",
"description": "Wastewater Plant",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
},
......
]
}

Example 2: Retrieve asset types by prefix

The example retrieves a list of asset types with prefix, http://cityName#, in JSON format. In the example,
assume that the service uses the following URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-
service/asset-types?prefix=<prefix>

The example uses the following method, URL, and Accept request-header:
v Method: GET
v Example URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/asset-types?prefix=http%3A

%2F%2FcityName%23
v Accept: application/json

In this example, you get the following JSON response:
{
"AssetType": [{
"id": "http://cityName#LiftStation",
"name": "Lift Station",
"description": "Lift Station",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
},
{
"id": "http://cityName#WastewaterPlant",
"name": "Wastewater Plant",
"description": "Wastewater Plant",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
},
{
"id": "http://cityName#CSODiversionStructure",
"name": "CSO Diversion Structure",
"description": "CSO Diversion Structure",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
},
{
"id": "http://cityName#Pipe",
"name": "Pipe",
"description": "Pipe",
"parentId": "http://www.epanet.org#EPANET_Pipe"
},
{
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"id": "http://cityName#Junction",
"name": "Junction",
"description": "Junction",
"parentId": "http://www.epanet.org#EPANET_Junction"
},
{
"id": "http://cityName#TrunkLineMonitor",
"name": "Trunk Line Monitor",
"description": "Trunk Line Monitor",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
},
{
"id": "http://cityName#RiverGauge",
"name": "River Gauge",
"description": "River Gauge",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
},
{
"id": "http://cityName#RainGauge",
"name": "Rain Gauge",
"description": "Rain Gauge",
"parentId": "http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"
}]

}

Example 3: Retrieve asset type by id

The example retrieves a list of asset types of ID, http://cityName#WastewaterPlant, in XML format. In
this example, assume that the service uses the following URL: http://app-ioc.cn.ibm.com/ibm/water/
api/model-service/asset-types?id=<id>

It uses the method, URL, and Accept header-request as follows:
v Method: GET
v Example URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/asset-types?id=http%3A%2F

%2FcityName%23WastewaterPlant
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<AssetTypeList xmlns="http://www.ibm.com/iss/iow/services/contextualmodel">
<AssetType>
<id>http://cityName#WastewaterPlant</id>
<name>Wastewater Plant</name>
<description>Wastewater Plant</description>
<parentId>http://www.ibm.com/water/wih#WIH_SensorMeter_Asset</parentId>
</AssetType>

</AssetTypeList>

assets:

The assets resource retrieves a list of asset instances. The resource is an instance of the
RSM_WorkEquipment subclass in the Reference Semantic Model (RSM). In the Water REST API, assets is
one of the Model Access Service resources.

Method

GET.

Resource URI
/ibm/water/api/model-service/assets?prefix=<prefix>&assetTypeId=<assetTypeId>&id=<id>
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Request Body

Not applicable.

Response

A list of assets in XML or JSON format.

Resource Parameters

A query resource is represented by the following optional properties.

Optional Property Description

prefix The prefix of the asset; for example, http://cityName#.

id The ID of the asset; for example, http://
cityName#Pipe1336.

assetTypeId The ID of the asset type; for example,
http://cityName#Pipe

Examples

This section provides examples of how you can use the asset resource to retrieve a list of asset instances.

Sample Model

In the examples, you can assume that the model is imported to the model server. The model defines one
instance of an asset type for a waste water plant.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:dm="http://iec.ch/2002/schema/CIM_difference_model#"
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:tns="http://cityName#"
xml:base="http://cityName">

<tns:WastewaterPlant rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP">
<cim:RSM_IdentifiedObject.name>WWTP</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>WWTP</cim:RSM_UnnamedObject.description>
</tns:WastewaterPlant>

<cim:RSM_GeoSpacial rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-Location">
<cim:RSM_IdentifiedObject.name>CityName:AREA.CityName:UNIT.WWTP:WE.WWTPLocation
</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>CityName:AREA.CityName:UNIT.WWTP:WE.WWTPLocation
</cim:RSM_UnnamedObject.description>
<cim:RSM_GeoSpacial.InternalLocation>POINT(-86.268865 41.71947)
</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity
rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP" />
</cim:RSM_GeoSpacial>
</rdf:RDF>

Example 1: Retrieve all assets

This example retrieves a list of all assets in JSON format. Assume that the service uses the following base
URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/assets.

Use the following method, URL, and default content type to get the response:
v Method: GET
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v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/assets
v The default content-type is application/json.

In this example, the following JSON response occurs:
{
"Asset": [{
"id": "http://cityName#Junction878",
"assetTypeId": "http://cityName#Junction",
"name": "Junction878",
"location": "POINT(-86.23678227774798 41.6726297008337)"
},
{
"id": "http://cityName#Junction360",
"assetTypeId": "http://cityName#Junction",
"name": "Junction360",
"location": "POINT(-86.25162264523162 41.6600355330907)"
},
{
"id": "http://cityName#Pipe1336",
"assetTypeId": "http://cityName#Pipe",
"name": "Pipe1336",
"location": "LINESTRING(-86.24302310908904 41.6870486413301,-86.24299651237408 41.6857306029503)"
},
......
]

}

Example 2: Retrieve assets by prefix

This example retrieves a list of assets with the prefix, http://cityName#, in JSON format. You can assume
that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/
assets.

Use the following method, URL, and default content-type to get the response:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/assets?prefix=http%3A%2F

%2FcityName%23
v The default content-type is application/json.

In this example, the following JSON response occurs:
{
"Asset": [{
"id": "http://cityName#Junction878",
"assetTypeId": "http://cityName#Junction",
"name": "Junction878",
"location": "POINT(-86.23678227774798 41.6726297008337)"
},
{
"id": "http://cityName#Junction360",
"assetTypeId": "http://cityName#Junction",
"name": "Junction360",
"location": "POINT(-86.25162264523162 41.6600355330907)"
},
{
"id": "http://cityName#Pipe1336",
"assetTypeId": "http://cityName#Pipe",
"name": "Pipe1336",
"location": "LINESTRING(-86.24302310908904 41.6870486413301,-86.24299651237408 41.6857306029503)"
},
......
]

}
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Example 3: Retrieve assets by asset type

This example retrieves assets with the type, http://cityName#WastewaterPlant, in XML format. You can
assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-
service/assets.

Use the following method, URL, and default content-type to get the response:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/assets?assetTypeId=http%3A%2F

%2FcityName%23WastewaterPlant
v The default content-type is application/xml.

In this example, the following XML response occurs:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<AssetList xmlns="http://www.ibm.com/iss/iow/services/contextualmodel">
<Asset>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</id>
<assetTypeId>http://cityName#WastewaterPlant</assetTypeId>
<name>WWTP</name>
<description>WWTP</description>
<location>POINT(-86.268865 41.71947)</location>
</Asset>
</AssetList>

Example 4: Retrieve an asset by ID

This example retrieves an asset with the following ID, http://cityName#CityName-AREA.CityName-
UNIT.WWTP-WE.WWTP, in JSON format. You can assume that the service uses the following base URL:
http://app-ioc.cn.ibm.com/ibm/water/api/model-service/assets.

The example uses the following method, URL, and Accept header-request:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/assets?id=http%3A%2F%2FcityName

%23CityName-AREA.CityName-UNIT.WWTP-WE.WWTP
v Accept: application/json.

In this example, you get the following JSON response:
{
"Asset": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP",
"assetTypeId": "http://cityName#WastewaterPlant",
"name": "WWTP",
"description": "WWTP",
"location": "POINT(-86.268865 41.71947)"
}]
}

measurements:

The measurements resource retrieves a list of measurements. The resource is an instance of
RSM_Measurement. In the Water REST API, measurements is one of the Model Access Service resources.

Method

GET.
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Resource URI
/ibm/water/api/model-service/measurements?prefix=<prefix>&assetId=<assetId>& id=<id>

Request Body

Not applicable.

Response

A list of measurements in XML or JSON format.

Resource Parameters

The resource has the following optional properties.

Property Description

prefix The prefix of the asset; for example, the city prefix,
http://cityName#.

id The ID of the measurement; for example, the
measurement ID, http://cityName#pipe1_measurement1.

assetId The ID of an asset; for example, the asset ID,
http://cityName#pipe1.

Examples

This section provides examples of how you can use the measurement resource.

Sample Model

In the examples, you can assume that the model is imported to the model server. The model defines
several measurements for the asset, http://cityName#CityName-AREA.CityName-UNIT.WWTP-
WE.WWTP.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:dm="http://iec.ch/2002/schema/CIM_difference_model#"
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#" xmlns:sb=http://cityName#
xml:base="http://cityName">

<sb:WastewaterPlant rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP">
<cim:RSM_IdentifiedObject.name>WWTP</cim:RSM_IdentifiedObject.name>

<cim:RSM_UnnamedObject.description>WWTP</cim:RSM_UnnamedObject.description>
</sb:WastewaterPlant>
<cim:RSM_GeoSpacial rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-Location">

<cim:RSM_IdentifiedObject.name>CityName:AREA.CityName:UNIT.WWTP:WE.WWTPLocation
</cim:RSM_IdentifiedObject.name>

<cim:RSM_UnnamedObject.description>CityName:AREA.CityName:UNIT.WWTP:WE.WWTPLocation
</cim:RSM_UnnamedObject.description>

<cim:RSM_GeoSpacial.InternalLocation>41.71947,-86.268865</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
</cim:RSM_GeoSpacial>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge">
<cim:RSM_IdentifiedObject.name>WWTP-Rain-Gauge-WWTP-RainGuage</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Rain Level Indicator</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>Inches</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Is_Primary_Measurement_Of

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
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<cim:RSM_Measurement.Type>RainGauge</cim:RSM_Measurement.Type>
</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge-MV.WWTP-Rain-Gauge">
<cim:RSM_IdentifiedObject.name>WWTP-RainGuage</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>65##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS">
<cim:RSM_IdentifiedObject.name>WWTP-RAS-RASFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Return Activated Sludge</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>GPM</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>RASFlowMeter</cim:RSM_Measurement.Type>
</cim:RSM_Measurement>
<cim:RSM_MeasurementValue rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS-MV.WWTP-RAS">

<cim:RSM_IdentifiedObject.name>RASFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>17##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow">
<cim:RSM_IdentifiedObject.name>WWTP-TotalFlow-TotalFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Total Flow</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>GPM</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>TotalFlowMeter</cim:RSM_Measurement.Type>
</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow-MV.WWTP-TotalFlow">
<cim:RSM_IdentifiedObject.name>TotalFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>58##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather">
<cim:RSM_IdentifiedObject.name>WWTP-WetWeather-WeatherIndicator</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>WWTP WetWeather Indicator</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>WetWeatherIndicator</cim:RSM_Measurement.Type>

</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather-MV.WWTP-WetWeather">
<cim:RSM_IdentifiedObject.name>WeatherIndicator</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>999994##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-InfluentFlowRate">
<cim:RSM_IdentifiedObject.name>WWTP-InfluentFlowRate</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>WWTP Influent Flow Rate</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>WastewaterPlantWWTPInfluentFlowRate</cim:RSM_Measurement.Type>

</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-InfluentFlowRate-MV.WWTP-InfluentFlowRate">
<cim:RSM_IdentifiedObject.name>InfluentFlowRate</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>999999##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
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<cim:RSM_MeasurementValue.IsA_Measurement
rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-InfluentFlowRate"/>

</cim:RSM_MeasurementValue>
</rdf:RDF>

Example 1: Retrieve all measurements

The example retrieves all measurements in JSON format. You can assume that the service uses the
following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurements.

It uses the following method, URL, and default Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurements
v Accept: application/json.

In this example, you get the JSON response:
{
"Measurement": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.P-LiftStation-WE.P-LiftStation-M.P-Pump3-CRT",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.P-LiftStation-WE.P-LiftStation",
"name": "P-Pump3-CRT-P-Pump3CRT",
"description": "P Pump3 CRT",
"type": "PumpCRT",
"isPrimary": false
},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.CSO021-WE.CSO021-M.CSO021-Overflow_MTD",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO021-WE.CSO021",
"name": "CSO021-Overflow_MTD-CSO021-OverflowVolMTD",
"description": "CSO021",
"unit": "MGallons",
"type": "CSOOverflowVolMTD",
"isPrimary": false
},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP",
"name": "WWTP-TotalFlow-TotalFlowMeter",
"description": "Total Flow",
"unit": "GPM",
"type": "TotalFlowMeter",
"isPrimary": false
},
......
]

}

Example 2: Retrieve measurements by prefix

In this example, you want to retrieve measurements with the prefix, http://cityName#, in JSON format.
You can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/
api/model-service/measurements.

Use the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurements?prefix=http%3A%2F

%2FcityName%23
v The Accept request-header is application/json.

In this example, you get the following JSON response:
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{
"Measurement": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.P-LiftStation-WE.P-LiftStation-M.P-Pump3-CRT",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.P-LiftStation-WE.P-LiftStation",
"name": "P-Pump3-CRT-P-Pump3CRT",
"description": "P Pump3 CRT",
"type": "PumpCRT",
"isPrimary": false
},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.CSO021-WE.CSO021-M.CSO021-Overflow_MTD",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO021-WE.CSO021",
"name": "CSO021-Overflow_MTD-CSO021-OverflowVolMTD",
"description": "CSO021",
"unit": "MGallons",
"type": "CSOOverflowVolMTD",
"isPrimary": false
},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP",
"name": "WWTP-TotalFlow-TotalFlowMeter",
"description": "Total Flow",
"unit": "GPM",
"type": "TotalFlowMeter",
"isPrimary": false
},
......
]
}

Example 3: Retrieve measurements by asset ID

In this example, you want to retrieve all measurements of asset, http://cityName#CityName-
AREA.CityName-UNIT.WWTP-WE.WWTP, in XML format. You can assume that the service uses the
following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurements.

Use the following method, URL, and default content-type to get the response:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurements?assetId=http%3A%2F

%2FcityName%23CityName-AREA.CityName-UNIT.WWTP-WE.WWTP
v The default content-type is application/xml.

In this example, the following XML response occurs:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<MeasurementList xmlns="http://www.ibm.com/iss/iow/services/contextualmodel">
<Measurement>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<name>WWTP-TotalFlow-TotalFlowMeter</name>
<description>Total Flow</description>
<unit>GPM</unit>
<type>TotalFlowMeter</type>
<isPrimary>false</isPrimary>
</Measurement>
<Measurement>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<name>WWTP-WetWeather-WeatherIndicator</name>
<description>WWTP WetWeather Indicator</description>
<type>WetWeatherIndicator</type>
<isPrimary>false</isPrimary>
</Measurement>
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<Measurement>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<name>WWTP-Rain-Gauge-WWTP-RainGuage</name>
<description>Rain Level Indicator</description>
<unit>Inches</unit>
<type>RainGauge</type>
<isPrimary>true</isPrimary>
</Measurement>
<Measurement>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<name>WWTP-RAS-RASFlowMeter</name>
<description>Return Activated Sludge</description>
<unit>GPM</unit>
<type>RASFlowMeter</type>
<isPrimary>false</isPrimary>
</Measurement>
<Measurement>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-InfluentFlowRate</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<name>WWTP-InfluentFlowRate</name>
<description>WWTP Influent Flow Rate</description>
<type>WastewaterPlantWWTPInfluentFlowRate</type>
<isPrimary>false</isPrimary>
</Measurement>

</MeasurementList>

Example 4: Retrieve measurements by ID

In this example, you want to retrieve a measurement of ID, http://cityName#CityName-
AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow, in JSON format. You can assume that the
service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/
measurements.

Use the following method, URL, and default content-type to get the response:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurements?assetId=http%3A%2F

%2FcityName%23CityName-AREA.CityName-UNIT.WWTP-WE.WWTP
v The default content-type is application/json.

In this example, the following JSON response occurs:
{
"Measurement": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP",
"name": "WWTP-TotalFlow-TotalFlowMeter",
"description": "Total Flow",
"unit": "GPM",
"type": "TotalFlowMeter",
"isPrimary": false
}]

}

measurement-values:

The measurement-values resource retrieves a list of measurement values. The resource is an instance of
RSM_MeasurementValue. In the Water REST API, measurement-values is one of the Model Access Service
resources.
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Method

GET.

Resource URI
/ibm/water/api/model-service/measurements-values?prefix=<prefix>&assetId=<assetId>& id=<id>

Request Body

Not applicable.

Response

A list of measurement values in XML or JSON format.

Resource Parameters

The resource has the following optional parameters:

Optional Parameter Description

prefix The prefix of the asset; for example, the city name prefix,
http://cityName#.

id The ID of the measurement value; for example, the asset
ID, http://cityName#pipe1_m1_v1.

assetId The ID of an asset; for example, http://cityName#pipe1

measurementId The ID of a measurement; for example, the measurement
ID, http://cityName#pip1-m1.

Examples

The following examples demonstrate how you can use the measurement-values resource.

Sample Model

In the examples, you can assume that the model is imported to the model server. The model defines
several measurements for the asset, http://cityName#CityName-AREA.CityName-UNIT.WWTP-
WE.WWTP.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:dm="http://iec.ch/2002/schema/CIM_difference_model#"
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:sb=http://cityName# xml:base="http://cityName">

<sb:WastewaterPlant rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP">
<cim:RSM_IdentifiedObject.name>WWTP</cim:RSM_IdentifiedObject.name>

<cim:RSM_UnnamedObject.description>WWTP</cim:RSM_UnnamedObject.description>
</sb:WastewaterPlant>
<cim:RSM_GeoSpacial rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-Location">

<cim:RSM_IdentifiedObject.name>CityName:AREA.CityName:UNIT.WWTP:WE.WWTPLocation
</cim:RSM_IdentifiedObject.name>

<cim:RSM_UnnamedObject.description>CityName:AREA.CityName:UNIT.WWTP:WE.WWTPLocation
</cim:RSM_UnnamedObject.description>

<cim:RSM_GeoSpacial.InternalLocation>41.71947,-86.268865</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
</cim:RSM_GeoSpacial>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge">
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<cim:RSM_IdentifiedObject.name>WWTP-Rain-Gauge-WWTP-RainGuage</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Rain Level Indicator</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>Inches</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Is_Primary_Measurement_Of

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>RainGauge</cim:RSM_Measurement.Type>
</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge-MV.WWTP-Rain-Gauge">
<cim:RSM_IdentifiedObject.name>WWTP-RainGuage</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>65##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS">
<cim:RSM_IdentifiedObject.name>WWTP-RAS-RASFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Return Activated Sludge</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>GPM</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>RASFlowMeter</cim:RSM_Measurement.Type>
</cim:RSM_Measurement>
<cim:RSM_MeasurementValue rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS-MV.WWTP-RAS">

<cim:RSM_IdentifiedObject.name>RASFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>17##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow">
<cim:RSM_IdentifiedObject.name>WWTP-TotalFlow-TotalFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Total Flow</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>GPM</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>TotalFlowMeter</cim:RSM_Measurement.Type>
</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow-MV.WWTP-TotalFlow">
<cim:RSM_IdentifiedObject.name>TotalFlowMeter</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>58##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather">
<cim:RSM_IdentifiedObject.name>WWTP-WetWeather-WeatherIndicator

</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>WWTP WetWeather Indicator

</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.associatedTo_physicalEntity

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>
<cim:RSM_Measurement.Type>WetWeatherIndicator</cim:RSM_Measurement.Type>

</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather-MV.WWTP-WetWeather">
<cim:RSM_IdentifiedObject.name>WeatherIndicator</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>999994##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather"/>
</cim:RSM_MeasurementValue>

<cim:RSM_Measurement rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-InfluentFlowRate">
<cim:RSM_IdentifiedObject.name>WWTP-InfluentFlowRate</cim:RSM_IdentifiedObject.name>
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<cim:RSM_UnnamedObject.description>WWTP Influent Flow Rate
</cim:RSM_UnnamedObject.description>

<cim:RSM_Measurement.associatedTo_physicalEntity
rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP"/>

<cim:RSM_Measurement.Type>WastewaterPlantWWTPInfluentFlowRate</cim:RSM_Measurement.Type>
</cim:RSM_Measurement>
<cim:RSM_MeasurementValue

rdf:ID="CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-InfluentFlowRate-MV.WWTP-InfluentFlowRate">
<cim:RSM_IdentifiedObject.name>InfluentFlowRate</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>999999##TBLFLOAT_RT##Val</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement

rdf:resource="#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-InfluentFlowRate"/>
</cim:RSM_MeasurementValue>
</rdf:RDF>

Example 1: Retrieve all measurement values

In this example, you want to retrieve all measurement values in JSON format. You can assume that the
service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/
measurement-values.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurement-values
v Accept: application/json

In the example, you get the following JSON response:
{
"MeasurementValue": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.B-LiftStation-WE.B-LiftStation-M.B-Pump4-CRT-
MV.B-Pump4-CRT",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.B-LiftStation-WE.B-LiftStation",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.B-LiftStation-WE.B-LiftStation-M.B-
Pump4-CRT",
"name": "B-Pump4CRT",
"alias": "48##TBLFLOAT_RT##Val"
},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.CSO037-WE.CSO037-M.CSO037-MV.CSO037",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO037-WE.CSO037",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.CSO037-WE.CSO037-M.CSO037",
"name": "CSO037LevelIndicator",
"alias": "21805-2##TBLFLOAT_RT##Val"
},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.CSO022-WE.CSO022-M.CSO022-Overflow-MV.CSO022

-Overflow",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO022-WE.CSO022",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.CSO022-WE.CSO022-M.CSO022-Overflow",
"name": "CSO022-OverflowVol",
"alias": "19107-O##TBLFLOAT_RT##Val"
}
......
]
}

Example 2: Retrieve measurement values by prefix

In this example, you want to retrieve measurement values with the prefix, http://cityName#, in JSON
format. You can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/
water/api/model-service/measurement-values.
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Use the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurement-values?prefix=http%3A

%2F%2FcityName%23
v Accept: application/json

In this example, the following JSON response occurs:
{
"MeasurementValue": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.B-LiftStation-WE.B-LiftStation-M.B-Pump4-CRT-

MV.B-Pump4-CRT",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.B-LiftStation-WE.B-LiftStation",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.B-LiftStation-WE.B-LiftStation-M.B-

Pump4-CRT",
"name": "B-Pump4CRT",
"alias": "48##TBLFLOAT_RT##Val"

},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.CSO037-WE.CSO037-M.CSO037-MV.CSO037",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO037-WE.CSO037",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.CSO037-WE.CSO037-M.CSO037",
"name": "CSO037LevelIndicator",
"alias": "21805-2##TBLFLOAT_RT##Val"

},
{
"id": "http://cityName#CityName-AREA.CityName-UNIT.CSO022-WE.CSO022-M.CSO022-Overflow-

MV.CSO022-Overflow",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO022-WE.CSO022",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.CSO022-WE.CSO022-M.CSO022-Overflow",
"name": "CSO022-OverflowVol",
"alias": "19107-O##TBLFLOAT_RT##Val"

}
......
]
}

Example 3: Retrieve measurements by asset ID

In this example, you want to retrieve all measurement values of asset ID, http://cityName#CityName-
AREA.CityName-UNIT.WWTP-WE.WWTP, in XML format. You can assume that the service uses the
following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurement-values.

Use the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurement-values?assetId=http%3A

%2F%2FcityName%23CityName-AREA.CityName-UNIT.WWTP-WE.WWTP
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<MeasurementValueList xmlns="http://www.ibm.com/iss/iow/services/contextualmodel">
<MeasurementValue>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow-MV.WWTP-TotalFlow</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<measurementId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow</measurementId>
<name>TotalFlowMeter</name>
<alias>58##TBLFLOAT_RT##Val</alias>
</MeasurementValue>
<MeasurementValue>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather-MV.WWTP-WetWeather</id>
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<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<measurementId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-WetWeather</measurementId>
<name>WeatherIndicator</name>
<alias>999994##TBLFLOAT_RT##Val</alias>
</MeasurementValue>
<MeasurementValue>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge-MV.WWTP-Rain-Gauge</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<measurementId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-Rain-Gauge</measurementId>
<name>WWTP-RainGuage</name>
<alias>65##TBLFLOAT_RT##Val</alias>
</MeasurementValue>
<MeasurementValue>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS-MV.WWTP-RAS</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<measurementId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-RAS</measurementId>
<name>RASFlowMeter</name>
<alias>17##TBLFLOAT_RT##Val</alias>
</MeasurementValue>
<MeasurementValue>
<id>http://cityName#CityName-AREA.CityName-UNIT.WWTP-
WE.WWTP-M.WWTP-InfluentFlowRate-MV.WWTP-InfluentFlowRate</id>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP</assetId>
<measurementId>http://cityName#CityName-AREA.CityName-UNIT.WWTP-
WE.WWTP-M.WWTP-InfluentFlowRate</measurementId>
<name>InfluentFlowRate</name>
<alias>999999##TBLFLOAT_RT##Val</alias>
</MeasurementValue>
</MeasurementValueList>

Example 4: Retrieve measurements values by measurement ID

The example retrieves measurement values of measurement ID, http://cityName#CityName-
AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow, in JSON format. You can assume that the
service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/
measurement-values.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurement-

values?measurementId=http%3A%2F%2FcityName%23CityName-AREA.CityName-UNIT.WWTP-
WE.WWTP-M.WWTP-TotalFlow

v Accept: application/json

In this example, you get the following JSON response:
{
"MeasurementValue": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow-MV.WWTP-TotalFlow",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow",
"name": "TotalFlowMeter",
"alias": "58##TBLFLOAT_RT##Val"
}]
}

Example 5: Retrieve measurement values by ID

In this example, you want to retrieve a measurement of ID, http://cityName#CityName-
AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow-MV.WWTP-TotalFlow, in JSON format.
You can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/
api/model-service/measurement-values.
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Use the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/measurement-values?id=http%3A%2F

%2FcityName%23CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow-
MV.WWTP-TotalFlow

v Accept: application/json

In this example, you get the following JSON response:
{
"MeasurementValue": [{
"id": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow-MV.WWTP-TotalFlow",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP",
"measurementId": "http://cityName#CityName-AREA.CityName-UNIT.WWTP-WE.WWTP-M.WWTP-TotalFlow",
"name": "TotalFlowMeter",
"alias": "58##TBLFLOAT_RT##Val"
}]

}

connected-assets:

The connected-assets resource retrieves a list of connected assets. The resource is described in the model
using RSM_WorkEquipment.connected_WorkEquipment. In the Water REST API, connected-assets is one of
the Model Access Service resources.

The relationship between connected-assets and connects-assets

The resources connected-assets and connects-assets are inverse to one other. For example, suppose
your infrastructure has pipeline assets called A and B. If A connects to B, in this case the
connected-assets of A is B. Inversely, the connects-assets of B is A. The resources represent the
following relationship in the Reference Semantic Model (RSM):
RSM_WorkEquipment.connected_WorkEquipment and RSM_WorkEquipment.connects_WorkEquipment.

Method

GET.

Resource URI
ibm/water/api/model-service/connected-assets?id=<id>

Request Body

Not applicable.

Response

A list of assets in XML or JSON format.

Resource Parameters

The resource has the following optional properties.

Optional Property Description

id The ID of the asset; for example, the pipe ID,
http://cityName#pipe1.
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Example: Retrieve connected assets

This section provides an example of how you can use the connected-assets resource. The example
retrieves a list of assets that are connected by the ID, http://cityName#Junction700, in JSON format.

Sample Model

In the example, you can assume that the model is imported to the model server. The model defines that
the asset Pipe1000 is connected to the assets Junction699 and Junction700. The following sample model
also indicates that Junction700 is connected by Pipe1000.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:tns="http://cityName#" xml:base="http://cityName">
<tns:Pipe rdf:ID="Pipe1000">
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#Junction700" />
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#Junction699" />
</tns:Pipe>
</rdf:RDF>

In the example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/model-service/connected-assets.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/connected-assets?id=http%3A%2F

%2FcityName%23Junction700
v Accept: application/json

In the example, you get the following JSON response:
{
"Asset": [{
"id": "http://cityName#Pipe1000",
"assetTypeId": "http://cityName#Pipe",
"name": "Pipe1000",
"location":
"LINESTRING(-86.24601906033934 41.6883641803688,-86.24596386291452 41.6870366835013)"
}
]
}

connects-assets:

The connects-assets resource retrieves a list of assets that connect to a specific asset. The resource is
described in the model using RSM_WorkEquipment.connects_WorkEquipment. In the Water REST API,
connects-assets is one of the Model Access Service resources.

The relationship between connects-assets and connected-assets

The resources connects-assets and connected-assets are inverse to one other. For example, suppose
your infrastructure has pipeline assets called A and B. If A connects to B, in this case the
connected-assets of A is B. Inversely, the connects-assets of B is A. The resources represent the
following relationship in the Reference Semantic Model (RSM):
RSM_WorkEquipment.connected_WorkEquipment and RSM_WorkEquipment.connects_WorkEquipment.

Resource URI
/ibm/water/api/model-service/connects-assets?id=<id>
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Request Body

Not applicable.

Response

The response is a list of assets in XML or JSON format.

Resource Parameters

The resource has the following property.

Parameter Description

id The ID of the asset; for example, http://cityName#pipe1.

Example: Retrieve connects assets

This section provides an example of how you can use the connects-assets resource. The example
retrieves a list of assets that connect to the specific asset, http://cityName#Pipe1000, in JSON format.

Sample Model

In the example, you can assume that the model is imported to the model server. The model defines that
Pipe1000 is connected to Junction699 and Junction700.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:tns="http://cityName#" xml:base="http://cityName">
<tns:Pipe rdf:ID="Pipe1000">
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#Junction700" />
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#Junction699" />
</tns:Pipe>

</rdf:RDF>

In this example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/model-service/connects-assets.

Use the following method, URL, and default content-type to get the response:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/connects-assets?id=http%3A%2F

%2FcityName%23Pipe1000
v The default content-type is application/json.

In this example, the following JSON response occurs:
{
"Asset": [{
"id": "http://cityName#Junction699",
"assetTypeId": "http://cityName#Junction",
"name": "Junction699",
"location": "POINT(-86.24596386291452 41.6870366835013)"
},
{
"id": "http://cityName#Junction700",
"assetTypeId": "http://cityName#Junction",
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"name": "Junction700",
"location": "POINT(-86.24601906033934 41.6883641803688)"
}]
}

physical-connected-assets:

The physical-connected-assets resource retrieves a list of assets that are physically connected to
specified asset. The resource, as described in the model, uses RSM connection nodes and connection
points.

Resource URI
/ibm/water/api/model-service/physical-connected-assets?id=<id>

Request Body

Not applicable.

Response

The response is a list of assets in XML or JSON format.

Resource Parameter

The resource has the following property.

Parameter Description

id The ID of the asset; for example, http://cityName#pipe1.

Example: Retrieve physical connects assets

The following example demonstrates how to use the physical-connected-assets resource. The example
model retrieves a list of assets that are connected by the pipe ID, http://cityName#Pipe849, in JSON
format.

Sample Model

In the example, you can assume that the model is imported to the model server. The model defines that
Pipe849 is physically connected to Junction408 and Junction419. The physical connections have no
direction, so the model also indicates that Junction408 and Junction419 are physically connected to
Pipe849. The sample model is as follows:
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#"
<!-- a Line from Pipe849 to Junction408 - START -->
<cim:RSM_ConnectionPoint rdf:ID="Pipe849_CPoint1">
<cim:RSM_ConnectionPoint.belongsTo_PhysicalEntity rdf:resource="#Pipe849"/>
<cim:ISO15926_ConnectionPoint.To_ConnectionNode rdf:resource="#Pipe849_Junction408_CNode"/>
</cim:RSM_ConnectionPoint>
<cim:ISO15926_ConnectionNode rdf:ID="Pipe849_Junction408_CNode">
</cim:ISO15926_ConnectionNode>
<cim:RSM_ConnectionPoint rdf:ID="Junction408_CPoint3">
<cim:RSM_ConnectionPoint.belongsTo_PhysicalEntity rdf:resource="#Junction408"/>
<cim:ISO15926_ConnectionPoint.To_ConnectionNode rdf:resource="#Pipe849_Junction408_CNode"/>
</cim:RSM_ConnectionPoint>
<!-- a Line from Pipe849 to Junction408 - END -->
<!-- a Line from Pipe849 to Junction419 - START -->
<cim:RSM_ConnectionPoint rdf:ID="Pipe849_CPoint2">
<cim:RSM_ConnectionPoint.belongsTo_PhysicalEntity rdf:resource="#Pipe849"/>
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<cim:ISO15926_ConnectionPoint.To_ConnectionNode rdf:resource="#Pipe849_Junction419_CNode"/>
</cim:RSM_ConnectionPoint>
<cim:ISO15926_ConnectionNode rdf:ID="Pipe849_Junction419_CNode">
</cim:ISO15926_ConnectionNode>
<cim:RSM_ConnectionPoint rdf:ID="Junction419_CPoint1">
<cim:RSM_ConnectionPoint.belongsTo_PhysicalEntity rdf:resource="#Junction419"/>
<cim:ISO15926_ConnectionPoint.To_ConnectionNode rdf:resource="#Pipe849_Junction419_CNode"/>
</cim:RSM_ConnectionPoint>
<!-- a Line from Pipe849 to Junction419 - END -->
</rdf:RDF>

In this example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/model-service/physical-connected-assets.

Use the following method, URL, and default content-type to get the response:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/physical-connected-assets?id=http%3A

%2F%2FcityName%23Pipe849
v Default content-type: application/json.

In this example, the following JSON response occurs:
{
"Asset": [{
"id": "http://cityName#Junction419",
"assetTypeId": "http://cityName#Junction",
"name": "Junction419",
"location": "POINT(-86.23816331614161 41.6582141986323)"
},
{
"id": "http://cityName#Junction408",
"assetTypeId": "http://cityName#Junction",
"name": "Junction408",
"location": "POINT(-86.23932975803322 41.6581465539612)"
}]

}

contained-assets:

The contained-assets resource retrieves a list of assets where the specified asset is contained by the
model.The resource, as described in the model, uses RSM_WorkEquipment.ContainedBy_Equipment.

Method

GET.

Resource URI
/ibm/water/api/model-service/contained-assets?id=<id>

Request Body

Not applicable.

Response

The response is a list of assets in XML or JSON format.
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Resource Parameters

The resource has the following optional properties.

Optional Property Description

id The ID of the asset; for example, the pipe ID,
http://cityName#pipe1.

Example: Retrieve contained assets

The following example demonstrates how to use the contained-assets resource. The example model
retrieves a list of assets where the following specified asset, http://cityName#CityName-
AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation, is contained by the model in JSON format.

Sample Model

In the example, you can assume that the model is imported to the model server. The model contains
relationship between pipes and sensors.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:tns="http://cityName#" xml:base="http://cityName">
<tns:Pipe rdf:ID="Pipe588">
<cim:RSM_WorkEquipment.Contains_Equipment
rdf:resource="#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation" />

</tns:Pipe>
<tns:RainGauge
rdf:ID="CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation">
<cim:RSM_WorkEquipment.ContainedBy_Equipment
rdf:resource="#Pipe588" />

</tns:RainGauge>
</rdf:RDF>

In this example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/model-service/contained-assets. It uses the following method, URL and
Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/contained-assets?id=http%3A%2F

%2FcityName%23CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation
v Accept: application/json.

In this example, you get the following JSON response:
{
"Asset": [{
"id": "http://cityName#Pipe588",
"assetTypeId": "http://cityName#Pipe",
"name": "Pipe588",
"location": "LINESTRING(-86.25036834194756 41.676400581511,-86.25034702004082 41.6750618109485)"
}]
}

contains-assets:

The contains-assets resource retrieves a list of assets that a specific asset contains. The resource is a
subclass of RSM_WorkEquipment.Contains_Equipment. In the Water REST API, contains-assets is one of
the Model Access Service resources.
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Method

GET.

Resource URI
/ibm/water/api/model-service/contains-assets?id=<id>

Request Body

Not applicable.

Response

The response is a list of contain relationships in XML or JSON format.

Resource Parameters

The resource has the following property:

Parameter Description

id The ID of the asset; for example, the pipe ID,
http://cityName#pipe1.

Example: Retrieve contained assets

The following example demonstrates how to use the contains-assets resource. The example retrieves a
list of assets with the specified ID, http://cityName#Pipe588, in XML format.

Sample Model

In the example, you can assume that the model is imported to the model server. The model contains the
relationship between pipes and sensors. The sample model is as follows:
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:tns="http://cityName#" xml:base="http://cityName">
<tns:Pipe rdf:ID="Pipe588">
<cim:RSM_WorkEquipment.Contains_Equipment
rdf:resource="#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation" />

</tns:Pipe>
<tns:RainGauge
rdf:ID="CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation">
<cim:RSM_WorkEquipment.ContainedBy_Equipment
rdf:resource="#Pipe588" />

</tns:RainGauge>
</rdf:RDF>

In this example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/model-service/contains-assets.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/contains-assets?id=http%3A%2F

%2FcityName%23Pipe588
v Accept: application/xml
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In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<AssetList xmlns="http://www.ibm.com/iss/iow/services/contextualmodel">
<Asset>
<id>http://cityName#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation</id>
<assetTypeId>http://cityName#LiftStation</assetTypeId>
<name>M-LiftStation</name>
<description>M-LiftStation</description>
<location>POINT(-86.25033 41.68629)</location>
</Asset>
<Asset>
<id>http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation</id>
<assetTypeId>http://cityName#RainGauge</assetTypeId>
<name>I-LiftStation</name>
<description>I-LiftStation</description>
<location>POINT(-86.215158 41.63698)</location>
</Asset>
</AssetList>

connections:

The connections resource retrieves a list of objects that describe assets connection relationships. In the
Water REST API, connections is one of the Model Access Service resources.

Method

GET.

Resource URI
/ibm/water/api/model-service/connections?prefix=<prefix>

Request Body

Not applicable.

Response

The response is a list of connection relationships in XML or JSON format.

Resource Parameters

The resource has the following optional properties.

Optional Property Description

prefix The prefix of the asset; for example, the city name prefix,
http://cityName#.

Examples

The following examples demonstrate how to use the connections resource.

Sample Model

In the example, you can assume that the model is imported to the model server. The model contains
relationship between pipes and junctions.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:cim="http://iec.ch/TC57/CIM-generic#" xmlns:tns="http://cityName#" xml:base="http://cityName">
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<tns:Pipe rdf:ID="Pipe588">
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#Junction265"/>
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#Junction268"/>

</tns:Pipe>
<rdf:RDFf>

Example 1: Retrieve all connection relationships

The example retrieves a list of connection relationships defined in model in JSON format. In this example,
you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/
api/model-service/connections.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/connections
v Accept: application/json.

In this example, you get the following JSON response:
{
"Connection": [

......
{
"sourceId": "http://cityName#Pipe588",
"targetId": "http://cityName#Junction268"
},

......
{
"sourceId": "http://cityName#Pipe588",
"targetId": "http://cityName#Junction265"
},

......
]

}

Example 2: Retrieve connection relationships by prefix

The example retrieves a list of connection relationships of prefix, http://cityName#, in XML format. In
this example, you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/
ibm/water/api/model-service/connections.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/connections?prefix=http%3A%2F

%2FcityName%23
v Accept: application/xml.

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<ConnectionList xmlns="http://www.ibm.com/iss/iow/services/contextualmodel">
......
<Connection>
<sourceId>http://cityName#Pipe588</sourceId>
<targetId>http://cityName#Junction268</targetId>
</Connection>
......
<Connection>
<sourceId>http://cityName#Pipe588</sourceId>
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<targetId>http://cityName#Junction265</targetId>
</Connection>
......
</ConnectionList>

contains:

The contains resource retrieves a list of objects that describe contain relationships for assets. In the Water
REST API, contains is one of the Model Access Service resources.

Method

GET.

Resource URI
/ibm/water/api/model-service/contains?prefix=<prefix>

Request Body

Not applicable.

Response

The response is a list of contain relationships in XML or JSON format.

Resource Parameters

The resource has the following optional properties.

Optional Property Description

prefix The prefix of the asset; for example, the city prefix,
http://cityName#pipe1.

Examples

The following example demonstrates how to use the contains-assets resource.

Sample Model

In the example, you can assume that the model is imported to the model server. The model defines the
contains relationships between pipes and junctions.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:tns="http://cityName#" xml:base="http://cityName">
<tns:Pipe rdf:ID="Pipe588">
<cim:RSM_WorkEquipment.Contains_Equipment
rdf:resource="#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation" />

</tns:Pipe>
<tns:RainGauge
rdf:ID="CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation">
<cim:RSM_WorkEquipment.ContainedBy_Equipment
rdf:resource="#Pipe588" />

</tns:RainGauge>
</rdf:RDF>
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Example 1: Retrieve all contain relationships

The example model retrieves a list of all contain relationships that are defined in model in JSON format.
In this example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/model-service/contains-assets.

It uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/contains
v Accept: application/json

In this example, you get the following JSON response:
{
"Contain": [{
"container": "http://cityName#Pipe588",
"containee": "http://cityName#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation"
},
{
"container": "http://cityName#Pipe588",
"containee": "http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation"
}]

}

Example 2: Retrieve contain relationships by prefix

The example model retrieves a list of contain relationships with the prefix, http://cityName#, in XML
format. In this example, you can assume that the service uses the following base URL:
http://app-ioc.cn.ibm.com/ibm/water/api/model-service/contains.

It uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/model-service/contains?prefix=http%3A%2F

%2FcityName%23
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<ContainList xmlns="http://www.ibm.com/iss/iow/services/contextualmodel">
<Contain>
<container>http://cityName#Pipe588</container>
<containee>http://cityName#CityName-AREA.CityName-UNIT.M-LiftStation-WE.M-LiftStation</containee>
</Contain>
<Contain>
<container>http://cityName#Pipe588</container>
<containee>http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation</containee>
</Contain>

</ContainList>

Reading Service resources
Reading Service resources are used to access reading values. Using the resources, you can query historical
values and get real-time reading values from specified filters.

realtime:

The realtime resource retrieves a list of real-time reading values. In the Water REST API, realtime is one
of the Reading Service resources.
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Method

GET.

Resource URI
/ibm/water/api/reading-service/realtime?prefix=<prefix>&alias=<alias>
&measurementValueId=<measurementValueId>&measurementId=<measurementId>
&assetId=<assetId>&assetTypeId=<assetTypeId>&since=<since>

Request Body

Not applicable.

Response

The response is a list of reading objects in XML or JSON format.

Resource Parameters

The resource has the following optional properties.

Optional Property Description

prefix The prefix of the measurement value; for example,
http://cityName#.

alias The alias of the measurement value.

measurementValueId The ID of the measurement value.

measurementId The ID of the measurement.

assetId The ID of the asset.

assetTypeId The ID of asset type.

since The property that is used to get a changed reading value
in a specified timestamp. For example, the number of
milliseconds since January 1, 1970, 00:00:00 GMT.

Examples

The following examples demonstrate how to use the realtime resource.

Example 1: Retrieve all real-time reading value of a specified prefix

The example model retrieves a list of real-time readings with the prefix, http://cityName#, in JSON
format. In this example, you can assume that the service uses the following base URL:
http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/realtime.

It uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/realtime?prefix=http%3A%2F

%2FcityName%23
v Accept: application/json

In this example, you get the following JSON response:
{
"timestamp": 1359037036432,
"Reading": [{
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"assetTypeId": "http://cityName#CSODiversionStructure",
"assetTypeName": "CSO Diversion Structure",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO026-WE.CSO026",
"assetName": "CSO026",
"measurementId": "http://cityName#CityName-AREA.CityName-

UNIT.CSO026-WE.CSO026-M.CSO026-Overflow_YTD",
"measurementName": "CSO026-Overflow_YTD-CSO026-OverflowVolYTD",
"measurementType": "CSOOverflowVolYTD",
"measurementUOM": "MGallons",
"measurementValueId": "http://cityName#CityName-

AREA.CityName-UNIT.CSO026-WE.CSO026-M.CSO026-Overflow_YTD-MV.CSO026-Overflow_YTD",
"measurementValueName": "CSO026-OverflowVolYTD",
"alias": "29639-O##SB_YTD_V##Val",
"value": "1.0",
"timestamp": 1359037036432,
"threshold": "0",
"trending": "0",
"recordtime": 1359037036432
},
{
"assetTypeId": "http://cityName#CSODiversionStructure",
"assetTypeName": "CSO Diversion Structure",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO004-WE.CSO004",
"assetName": "CSO004",
"measurementId":

"http://cityName#CityName-AREA.CityName-UNIT.CSO004-WE.CSO004-M.CSO004-Overflow",
"measurementName": "CSO004-Overflow-CSO004-OverflowVol",
"measurementType": "CSOOverflowVol",
"measurementUOM": "MGallons",
"measurementValueId":

"http://cityName#CityName-AREA.CityName-
UNIT.CSO004-WE.CSO004-M.CSO004-Overflow-MV.CSO004-Overflow",

"measurementValueName": "CSO004-OverflowVol",
"alias": "33957-O##TBLFLOAT_RT##Val",
"value": "1.0",
"timestamp": 1359037036432,
"threshold": "0",
"trending": "0",
"recordtime": 1359037036432
},

......
]
}

Example 2: Retrieve the real-time reading value of a specified asset

The example model retrieves a list of readings of the asset, http://cityName#CityName-AREA.CityName-
UNIT.CSO003, in XML format. In this example, you can assume that the service uses the following base
URL: http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/realtime.

It uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/realtime ?assetId=http%3A%2F

%2FcityName%23CityName-AREA.CityName-UNIT.CSO003-WE.CSO003
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<ReadingList xmlns="http://www.ibm.com/iss/iow/services/readings">
<Reading>
<assetTypeId>http://cityName#CSODiversionStructure</assetTypeId>
<assetTypeName>CSO Diversion Structure</assetTypeName>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003</assetId>
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<assetName>CSO003</assetName>
<measurementId>

http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003-Overflow-Rate</measurementId>

<measurementName>CSO003-Overflow-Rate-CSO003-OverflowRate</measurementName>
<measurementType>CSOOverflowRate</measurementType>
<measurementUOM>GPM</measurementUOM>
<measurementValueId>

http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003-Overflow-Rate-MV.CSO003-Overflow-Rate
</measurementValueId>

<measurementValueName>CSO003-OverflowRate</measurementValueName>
<alias>19892-R##TBLFLOAT_RT##Val</alias>
<value>1.0</value>
<timestamp>1359037036432</timestamp>
<threshold>0</threshold>
<trending>0</trending>
<recordtime>1359037036432</recordtime>
</Reading>
......
<timestamp>1359037036432</timestamp>
</ReadingList>

Example 3: Retrieve changed real-time reading values

The example model retrieves a list of changed reading values after the timestamp 1356290811000 in XML
format. In this example, you can assume that the service uses the following base URL:
http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/realtime.

It uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/realtime ?since=1356290811000
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<ReadingList xmlns="http://www.ibm.com/iss/iow/services/readings">
<Reading>
<assetTypeId>http://cityName#CSODiversionStructure</assetTypeId>
<assetTypeName>CSO Diversion Structure</assetTypeName>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003</assetId>
<assetName>CSO003</assetName>
<measurementId>

http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003-Overflow-Rate</measurementId>

<measurementName>CSO003-Overflow-Rate-CSO003-OverflowRate</measurementName>
<measurementType>CSOOverflowRate</measurementType>
<measurementUOM>GPM</measurementUOM>
<measurementValueId>

http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003-Overflow-Rate-MV.CSO003-Overflow-Rate</measurementValueId>

<measurementValueName>CSO003-OverflowRate</measurementValueName>
<alias>19892-R##TBLFLOAT_RT##Val</alias>
<value>1.0</value>
<timestamp>1359037036432</timestamp>
<threshold>0</threshold>
<trending>0</trending>
<recordtime>1359037036432</recordtime>
</Reading>
......
<timestamp>1359037036432</timestamp>
</ReadingList>
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historical:

The historical resource retrieves a list of historical reading values. In the Water REST API, historical is
one of the Reading Service resources.

Method

GET.

Resource URI
/ibm/water/api/reading-service/historical?prefix=<prefix>&alias=<alias>
&measurementValueId=<measurementValueId>&measurementId=<measurementId>
&assetId=<assetId>&assetTypeId=<assetTypeId>&from=<from>&to=<to>

Request Body

Not applicable.

Response

The response is a list of reading objects in XML or JSON format.

Resource Parameters

The resource has the following optional properties.

Optional Property Description

prefix The prefix of the measurement value; for example,
http://cityName#.

alias The alias of the measurement value.

measurementValueId The ID of the measurement value.

measurementId The ID of the measurement.

assetId The ID of the asset.

assetTypeId The ID of asset type.

from The timestamp that is used to specify the start time in a
reading value. For example, the number of milliseconds
since January 1, 1970, 00:00:00 GMT.

to The timestamp that is used to specify the end time in a
reading value. For example, the number of milliseconds
since February 1, 1970, 00:00:00 GMT.

Examples

The following examples demonstrate how to use the historical resource.

Example 1: Retrieve all historical reading values of specified measurement value

The example model retrieves a list of historical reading values with the measurement value alias,
11210##TBLFLOAT_RT##Val, in XML format. In this example, you can assume that the service uses the
following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/historical.

The example uses the following method, URL, and Accept request-header:
v Method: GET
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v URL: http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/historical?alias=11210%23
%23TBLFLOAT_RT%23%23Val

v Accept: application/xml

In this example, you get the following XML response:
<ReadingList xmlns="http://www.ibm.com/iss/iow/services/readings">
<Reading>
<assetTypeId>http://cityName#CSODiversionStructure</assetTypeId>
<assetTypeName>CSO Diversion Structure</assetTypeName>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003</assetId>
<assetName>CSO003</assetName>
<measurementId>http://cityName#CityName-AREA.CityName-

UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2</measurementId>
<measurementName>CSO003_C.3b.2-CSO003CLevelIndicator</measurementName>
<measurementType>CSOLevelIndicator</measurementType>
<measurementUOM>Feet</measurementUOM>
<measurementValueId>

http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2-MV.CSO003_C.3b.2</measurementValueId>

<measurementValueName>CSO003CLevelIndicator</measurementValueName>
<alias>11210##TBLFLOAT_RT##Val</alias>
<value>3.0</value>
<timestamp>1355465514199</timestamp>
<recordtime>1355418714340</recordtime>
</Reading>
<Reading>
<assetTypeId>http://cityName#CSODiversionStructure</assetTypeId>
<assetTypeName>CSO Diversion Structure</assetTypeName>
<assetId>http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003</assetId>
<assetName>CSO003</assetName>
<measurementId>http://cityName#CityName-AREA.CityName-

UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2</measurementId>
<measurementName>CSO003_C.3b.2-CSO003CLevelIndicator</measurementName>
<measurementType>CSOLevelIndicator</measurementType>
<measurementUOM>Feet</measurementUOM>
<measurementValueId>

http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2-MV.CSO003_C.3b.2</measurementValueId>

<measurementValueName>CSO003CLevelIndicator</measurementValueName>
<alias>11210##TBLFLOAT_RT##Val</alias>
<value>3.0</value>
<timestamp>1355465514521</timestamp>
<recordtime>1355418714512</recordtime>
</Reading>

......
<timestamp>1358911855750</timestamp>
</ReadingList>

Example 2: Retrieve the historical reading value in a specified time interval

The example model retrieves a list of historical reading values with the measurement value alias,
11210##TBLFLOAT_RT##Val, between the timestamps 1355418714340 and 1355418714512 in JSON format.
In this example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/reading-service/historical.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/reading-service/historical?alias=11210%23

%23TBLFLOAT_RT%23%23Val&from=1355465514199&to=1355465514521
v Accept: application/json

In this example, you get the following JSON response:
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{
"timestamp": 1355465514521,
"Reading": [{
"assetTypeId": "http://cityName#CSODiversionStructure",
"assetTypeName": "CSO Diversion Structure",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003",
"assetName": "CSO003",
"measurementId": "http://cityName#CityName-AREA.CityName-

UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2",
"measurementName": "CSO003_C.3b.2-CSO003CLevelIndicator",
"measurementType": "CSOLevelIndicator",
"measurementUOM": "Feet",
"measurementValueId":

"http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2-MV.CSO003_C.3b.2",

"measurementValueName": "CSO003CLevelIndicator",
"alias": "11210##TBLFLOAT_RT##Val",
"value": "3.0",
"timestamp": 1355465514199,
"recordtime": 1355418714340
},
{
"assetTypeId": "http://cityName#CSODiversionStructure",
"assetTypeName": "CSO Diversion Structure",
"assetId": "http://cityName#CityName-AREA.CityName-UNIT.CSO003-WE.CSO003",
"assetName": "CSO003",
"measurementId": "http://cityName#CityName-AREA.CityName-

UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2",
"measurementName": "CSO003_C.3b.2-CSO003CLevelIndicator",
"measurementType": "CSOLevelIndicator",
"measurementUOM": "Feet",
"measurementValueId":

"http://cityName#CityName-AREA.CityName-
UNIT.CSO003-WE.CSO003-M.CSO003_C.3b.2-MV.CSO003_C.3b.2",

"measurementValueName": "CSO003CLevelIndicator",
"alias": "11210##TBLFLOAT_RT##Val",
"value": "3.0",
"timestamp": 1355465514521,
"recordtime": 1355418714512
}]

}

Render Service resources
The Render Service resources is used to manage map layers and to create, update, and retrieve features in
those layers. For example, after you create a pipeline layer, you can add lines or points as features to the
layer.

layers:

The layers resource is used to retrieve, create, update, and delete layers. In the Water REST API, layers
is one of the Render Service resources.

Using GET to retrieve layers:

The HTTP GET request method is used to retrieve information from a server. In the Water API, you can
use GET with the Render Service resource, layers, to retrieve map layers in a comprehensive list or by
name.

Method

GET.
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Resource URI
/ibm/water/api/render-service/layers?layerName=<layerName>

Request Body

Not applicable.

Response

The response is a list of layer objects in XML or JSON format.

Resource Parameters

The resource has the following optional property.

Optional Property Description

layerName The name of the layer; for example, pipelinelayer.

Examples

The following examples demonstrate how to retrieve map layers by using the GET method with the
layers resource.

Example 1: Retrieve layers by name

The example model retrieves an existing layer by its name in XML format. In this example, you can
assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-
service/layers.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers?layerName=test
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<layers xmlns="http://www.ibm.com/iss/iow/services/renderservice/">
<layer>
<name>test</name>
<description>test</description>
<zIndex>3</zIndex>
<style>{fillColor:&quot;blue&quot;,strokeColor:&quot;blue&quot;,pointRadius:1}
</style>
</layer>
</layers>

Example 2: Retrieve all layers

The example model retrieve a list of layers defined in JSON format. In this example, you can assume that
the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/
layers.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers
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v Accept: application/json

In this example, you get the following JSON response:
{
"layer": [{
"name": "Pipeline Layer",
"description": "pipeline layer",
"style": "{fillColor:\"blue\",strokeColor:\"blue\",pointRadius:1}",
"zIndex": 2
},
{
"name": "test",
"description": "test",
"style": "{fillColor:\"blue\",strokeColor:\"blue\",pointRadius:1}",
"zIndex": 3
}]

}

Using POST to create layers:

The HTTP POST request method is used to request that a web server accepts the data enclosed in the
request message's body for storage. In the Water API, you can use POST with the Render Service
resource, layers, to create new map layers.

Method

POST.

Resource URI
/ibm/water/api/render-service/layers

Request Body

The request includes the map layer object to be created in XML or JSON format. It describes the name,
description, style, and z-index of the layer.

Response

Not applicable.

Resource Parameters

Not applicable.

Examples: Create a new layer

The following examples demonstrate how to create map layers by using the POST method with the
layers resource.

Example 1: JSON

The example model creates a new layer by constructing a request body in JSON format. In this example,
you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/
api/render-service/layers.

The example uses the following method, URL, and Content Type request-header:
v Method: POST
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v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers
v Content Type: application/json

In this example, the following is the JSON request body:
{
"name": "test",
"description": "test",
"style": "{fillColor:\"blue\",strokeColor:\"blue\",pointRadius:1}",
"zIndex": 3
}

Example 2: XML

The example model creates a new layer by constructing a request body in XML format. In this example,
you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/
api/render-service/layers.

The example uses the following method, URL, and Content Type request-header:
v Method: POST
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers
v Content Type: application/xml

In this example, the following is the XML request body:
<layer xmlns="http://www.ibm.com/iss/iow/services/renderservice/">
<name>test</name>
<description>test</description>
<style>{fillColor:"blue",strokeColor:"blue",pointRadius:1}</style>
<zIndex>3</zIndex>
</layer>

Using PUT to update layers:

The HTTP PUT method is used to request that an enclosed entity is stored under the supplied URI. In
the Water API, you can use PUT with the Render Service resource, layers, to update an existing map
layer.

Method

PUT.

Resource URI
/ibm/water/api/render-service/layers?layerName=<layerName>

Request Body

The request includes the map layer object to be updated in XML or JSON format. It describes the name,
description, style, and z-index of the layer.

Response

Not applicable.
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Resource Parameters

The resource has the following parameter:

Parameter Description

layerName The name of the layer; for example, pipelinelayer.

Examples: Update the style of a layer

The following examples demonstrate how to update map layers by using the PUT method with the
layers resource.

Note: A layer style is the default style for features in the layer. The style field is a string in JSON format
that you must encod correctly, as in the following examples. The update style operation will replace the
old style.

Example 1: XML

The example model updates the style property of an existing layer by constructing a request body in
XML format. In this example, you can assume that the service uses the following base URL:
http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers.

The example uses the following method, URL, and Content-Type request-header:
v Method: PUT
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers?layerName=test
v Content Type: application/xml

In this example, you get the following XML response:
<layer xmlns="http://www.ibm.com/iss/iow/services/renderservice/">
<style>{fillColor:"red",strokeColor:"red",pointRadius:1}</style>

</layer>

Example 2: JSON

The example model updates the style property of an existing layer by constructing a request body in
JSON format. In this example, you can assume that the service uses the following base URL:
http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers. The example uses the following
method, URL, and Content-Type request-header:
v Method: PUT
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers?layerName=test
v Content Type: application/json

In this example, you get the following JSON response:
{
"style": "{fillColor:\"red\",strokeColor:\"red\",pointRadius:1}"

}

Using DELETE to remove layers:

The HTTP DELETE method is used to request the web server to delete a resource that is identified by the
Request URI. In the Water API, you can use DELETE with the Render Service resource, layers, to delete
layers.
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Method

DELETE.

Resource URI
/ibm/water/api/render-service/layers?layerName=<layerName>

Request Body

Not applicable.

Response

Not applicable.

Resource Parameter

The resource has the following parameter:

Parameter Description

layerName The name of the layer for deletion; for example,
pipelinelayer.

Example: Delete a layer

The following example demonstrates how to delete a map layer by using the DELETE method with the
layers resource. The example deletes the layer by using the following method and URL:
v Method: DELETE
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/layers?layerName=test

features:

In the Water REST API, features is one of the Render Service resources. The features resource provides
the ability to retrieve, create, update and delete features.

Using GET to retrieve features:

The HTTP GET request method is used to retrieve information from a server. In the Water API, you can
use GET with the Render Service resource, features, to retrieve a list of features.

Method

GET.

Resource URI
/ibm/water/api/render-service/features?layerName=<layerName>
&featureName=<featureName>&area=<area>&level=<level>
&timestamp=<timestamp>&since=<since>&defer=<defer>

Request Body

Not applicable.
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Response

The response is a list of features in XML or JSON format.

Resource Parameters

The resource has the following optional properties:

Optional Property Description

layerName The name of the layer; for example, pipelinelayer.

featureName The name of a feature; for example, http://
cityName#Pipe606.

area A polygon in WKT format, used to filter the features; for
example, “POLYGON((-86.24495744705251
41.67503278023767,-86.22779130935777
41.67503278023767,-86.22779130935777
41.684648463423216,-86.24495744705251
41.684648463423216,-86.24495744705251
41.67503278023767))”

level An integer value that indicate map zoom level, which is
used to filter the features.

timestamp The timestamp that is used to retrieve historical features.
For example, the number of milliseconds since January 1,
1970, 00:00:00 GMT. If not specified, the property will
return the current timestamp of the server (db).

since The property used to get a changed feature value in a
specified timestamp. If specified, only changed features
between “since” and “timestamp” will be returned; for
example, the number of milliseconds since January 1,
1970, 00:00:00 GMT. If not specified, all features will be
returned.

defer The milliseconds used to adjust the timestamp when the
timestamp property is not specified. The property can be
treated as a timestamp that is relative to the current
server (db) timestamp; for example, if defer=-60000, and
the timestamp is not specified, the property returns
features from one minute before.

Examples

The following examples demonstrate how to retrieve a list of features by using the GET method with the
features resource.

Example 1: Retrieve a feature by feature name

The example model retrieves a feature defined in a specific layer in renderService in XML format. In this
example, you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/
water/api/render-service/features.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=mylayer_point

&featureName=point1
v Accept: application/xml

98 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



In this example, you get the following XML response:
<features>
<feature>

<name>point1</name>
<timeStamp>1357614423099</timeStamp>
<geometry>POINT (-86.2353141 41.6792579)</geometry>
<startLevel>0</startLevel>
<endLevel>0</endLevel>
<style>{graphicTitle:"I am a tooltip of point1"}</style>
<deleted>false</deleted>
</feature>
</features>

Example 2: Retrieve all features

The example model retrieves all features defined in a specific layer in renderService in JSON format. In
this example, you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/
ibm/water/api/render-service/features.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=mylayer_point
v Accept: application/json

In this example, you get the following JSON response:
"feature": [

{
"name": "point3",
"timeStamp": 1358151585635,
"geometry": "POINT (-86.2300283 41.6792199)",
"startLevel": 12,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point3\"}",
"deleted": false

},
{

"name": "point4",
"timeStamp": 1358151585635,
"geometry": "POINT (-86.2368666 41.6792301)",
"startLevel": 14,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point4\"}",
"deleted": false

},
{

"name": "point2",
"timeStamp": 1358151585634,
"geometry": "POINT (-86.2330464 41.6792373)",
"startLevel": 10,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point2\"}",
"deleted": false

},
{

"name": "point1",
"timeStamp": 1358151585121,
"geometry": "POINT (-86.2353141 41.6792579)",
"startLevel": 0,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point1\"}",
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"deleted": false
}

]
}

Example 3: Retrieve features in specific areas and levels

The example model retrieves features in a specific area and in a specific level, which are defined in a
specific layer in renderService, in JSON format. In this example, you can assume that the service uses the
following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=mylayer_point

&area=POLYGON((-86.24495744705251%2041.67503278023767,-86.22779130935777
%2041.67503278023767,-86.22779130935777%2041.684648463423216,-86.24495744705251
%2041.684648463423216,-86.24495744705251%2041.67503278023767))&level=10

v Accept: application/json

In this example, you get the following JSON response:
{

"feature": [
{

"name": "point2",
"timeStamp": 1358151585634,
"geometry": "POINT (-86.2330464 41.6792373)",
"startLevel": 10,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point2\"}",
"deleted": false

},
{

"name": "point1",
"timeStamp": 1358151585121,
"geometry": "POINT (-86.2353141 41.6792579)",
"startLevel": 0,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point1\"}",
"deleted": false

}
]

}

Example 4: Retrieve features by timestamp

The example model retrieves features defined in renderService in JSON format. In this example, you can
assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-
service/features.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=pipelinelayer&

timeStamp=1358151585141
v Accept: application/json

In this example, you get the following JSON response:
{

"feature": [
{
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"name": "point1",
"timeStamp": 1358151585121,
"geometry": "POINT (-86.2353141 41.6792579)",
"startLevel": 0,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point1\"}",
"deleted": false

},
{

"name": "point4",
"timeStamp": 1357783017706,
"geometry": "POINT (-86.2368666 41.6792301)",
"startLevel": 14,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point4\"}",
"deleted": true

},
{

"name": "point3",
"timeStamp": 1357783017706,
"geometry": "POINT (-86.2300283 41.6792199)",
"startLevel": 12,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point3\"}",
"deleted": true

},
{

"name": "point2",
"timeStamp": 1357783017705,
"geometry": "POINT (-86.2330464 41.6792373)",
"startLevel": 10,
"endLevel": 0,
"style": "{graphicTitle:\"I am a tooltip of point2\"}",
"deleted": true

}
]

}

Example 5: Retrieve changed features since specify time

The example model retrieves all features defined in a specific layer in renderService in JSON format. In
this example, you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/
ibm/water/api/render-service/features.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/

features?layerName=mylayer_polygon&since=1357614423099
v Accept: application/xml

In this example, you get the following XML response:
<features xmlns="http://www.ibm.com/iss/iow/services/renderservice/">

<feature>
<name>polygon1</name>
<timeStamp>1357614424156</timeStamp>
<geometry>

POLYGON ((-86.2369386 41.6805700, -86.2368743 41.6778456, -86.2316601
41.6778776, -86.2316171 41.6806340, -86.2369386 41.6805700))

</geometry>
<startLevel>0</startLevel>
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<endLevel>0</endLevel>
<deleted>false</deleted>

</feature>
</features>

Example 6: Retrieve changed features since some time before current time

The example model retrieves features defined in renderService in JSON format. In this example, you can
assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-
service/features.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/

features?layerName=mylayer_polygon&defer=-3600
v Accept: application/xml

In this example, you get the following XML response:
<features xmlns="http://www.ibm.com/iss/iow/services/renderservice/">

<feature>
<name>polygon1</name>
<timeStamp>1357614424156</timeStamp>
<geometry>

POLYGON ((-86.2369386 41.6805700, -86.2368743 41.6778456, -86.2316601
41.6778776, -86.2316171 41.6806340, -86.2369386 41.6805700))

</geometry>
<startLevel>0</startLevel>
<endLevel>0</endLevel>
<deleted>false</deleted>

</feature>
</features>

Using POST or PUT to create and update features:

The HTTP POST request method is used to request that a web server accepts the data enclosed in the
request message's body for storage, whereas HTTP PUT method is used to request that an enclosed entity
is stored under the supplied URI. In the Water API, you can use POST or PUT with the Render Service
resource, features, to create and update a list of features.

Methods

POST or PUT.

Resource URI
/ibm/water/api/render-service/features?layerName=<layerName>

Request Body

Not applicable.

Response

The response is a list of features in XML or JSON format.
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Resource Parameters

The resource has the following property:

Parameter Description

layerName The name of the layer; for example, pipelinelayer.

Examples: Create and update features

The following example demonstrates how to create and update features by using the POST and PUT
methods with the features resource.

Example 1: Create features

This example demonstrates how you can create features using the POST or PUT methods. In the example,
you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/
api/render-service/features.

The following default values apply when you create features:
v The name and geometry of a new feature cannot be null.
v The default value of a timestamp is the current time of data base server.
v The startLevel and endLevel default values are 0.
v The style default value is null.

The example uses the following method, URL, and Accept request-header:
v Method: POST
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/

features?layerName=mylayer_polygon
v Accept: application/xml

In the example, you get the following XML response:
<features xmlns="http://www.ibm.com/iss/iow/services/renderservice/">

<feature>
<name>polygon1</name>
<timeStamp>1357614425156</timeStamp>
<geometry>

POLYGON ((-86.2369386 41.6805700, -86.2368743 41.6778456, -86.2316601
41.6778776, -86.2316171 41.6806340, -86.2369386 41.6805700))

</geometry>
<startLevel>0</startLevel>

<endLevel>0</endLevel>
<style>{fillColor:"blue",strokeColor:"blue",pointRadius:3}</style>

</feature>
</features>

Example 2: Update features

The example demonstrates how you can update a features style in a specific layer. In the example, you
can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/
render-service/features.

The example uses the following method, URL, and Accept request-header:
v Method: POST
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=mylayer_point
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v Accept: application/json

In the example, you get the following JSON response:
{

"feature": [
{

"name": "point1",
"style": "{fillColor:"blue",strokeColor:"blue",pointRadius:3}"

},
{

"name": "point4",
"style": "{fillColor:"blue",strokeColor:"blue",pointRadius:3}"

},
{

"name": "point3",
"style": "{fillColor:"blue",strokeColor:"blue",pointRadius:3}"

},
{

"name": "point2",
"style": "{fillColor:"blue",strokeColor:"blue",pointRadius:3}"

}
]

}

Using DELETE to clear features:

The HTTP DELETE method is used to clear some or all features in a specific layer. In the Water API, you
use DELETE with the Render Service resource, features, to delete features. The method does not literally
delete features; rather, it marks features as deleted at a specified timestamp. If necessary, you can use
GET to retrieve a deleted feature by specifying an historical timestamp.

Method

DELETE.

Resource URI
/ibm/water/api/render-service/features?layerName=<layerName>
&featureNames=<featureNames>&clear=<isClear>&timestamp=<timestamp>

Request Body

Not applicable.

Response

Not applicable.

Resource Parameters

The resource has the following parameters:

Parameters Description

layerName The name of the layer for deletion; for example,
pipelinelayer.

featureName The name of the feature for deletion. The property is
optional.
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Parameters Description

clear The clear property is either true or false. The property is
only used if featureNames is not specified. If clear=true,
all features in specified layer are deleted.

timestamp The specific time that the features are deleted. If not
specified, the current timestamp of the server (db) is
used.

Examples

The following example demonstrates how to delete a map layer by using the DELETE method with the
layers resource. In the example, you can assume that the service uses the following base URL:
http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features.

Example: Delete features

The following example demonstrates how to delete features in a specific layer at current time. The
example uses the following method and URL:
v Method: DELETE
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=mylayer_point

&featuresName=point1&featuresName=point2

Example: Clear features in specific layer

The following example demonstrates how to delete all features in a specify layer at current time. The
example uses the following method and URL:
v Method: DELETE
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=mylayer_point

&clear=true

Example: Clear features at a specific time in a specific layer

The following example demonstrates how to delete all features in a specific layer at a specific time. The
example uses the following method and URL:
v Method: DELETE
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/render-service/features?layerName=mylayer_point&

featureName=point3&featureName=point4&timestamp=1357614425156

renderEngine:

You use the command line application, renderEngine, to call the render service REST API. To describe
how to call the Rest Service, you use rule files. The rules files create, delete, update, get, list map layers,
and features. Additionally, renderEngine can import data from an exiting KML file to render the service.

Command-Line syntax:

You run renderEngine in the application node.

To run renderEngine, you use the following command-line syntax:
v To run by rules files, use the syntax: ./renderEngine.sh –rule <rulefile.xml> <rulefile.xml>...

v To import the KML file to a layer, use the syntax:./renderEngine.sh –kml <layerName> <kmlfile.kml>
<kmlfile.kml>...
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Rule files:

You use rule files with renderEngine to call the render service REST API. You must correctly format the
rules files to ensure successful calls. Examples are provided to demonstrate how to create, delete, update,
get, list map layers, and features.

Rule file formats:

Use the following information to understand how to apply the correct format to rule files, which describe
how to call the REST service when using renderEngine. Each rule has a node and associated features.

Rules

Rules is the root node of a rule file. It features one or more rule nodes.

Rule

Rule contains a layer and the operations you can perform on the layer. The layers and operations of rule
are as follows:

Layer Operations

name An attribute that contains the name of the rule.

description A node that describes the rule.

variable A node that defines the variable for other nodes to use.

query A node that contains a SPARQL string that is queried by the
model service. The results are used in the template node.

layer A node that describes the layer that is affected by the rule.

template A node that is a template of the feature that is filled by the query
result of the node query.

feature A node that defines features.

Variable

Variable defines a variable name. The attribute for variable is as follows:

Attribute Feature

name An attribute that contains the name of the variable.

Query

Query defines a query string. The attribute for query is as follows:

Attribute Feature

type An attribute that contains a SPARQL string.
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Layer

Layer defines a layer. The nodes and attributes for layer are as follows:

Node/Attribute Feature

action An attribute that contains the action which is performed on the
layer. The value can be GET, UPDATE, CREATE, DELETE, or
CLEAR.

name A node that is name of the layer.

description A node that describes layer.

z-Index A node that contains the number which defines the order of the
layer.

style A node that is a string in JSON format which defines the default
style of features in the layer.

Template

Template that used to generate a features set. The attribute for template is as follows:

Attribute Feature

name An attribute that contains the name of the variable.

Feature

Feature defines a feature. The nodes and attributes for feature is as follows:

Node/Attribute Feature

action An attribute that contains the action which is performed on the
layer. The value can be GET, UPDATE, CREATE, DELETE, or
CLEAR.

name A node that contains the name of feature.

timestamp A node that contains the timestamp of the feature.

geometry A node that contains a well known text (WKT) to describe point,
line, or polygon.

startlevel A node that contains the start level of the feature.

endlevel A node that contains the end level of the feature.

style A node that contains a string in JSON format which defines the
style of the feature.

Rule file examples:

The examples demonstrate how to manipulate map layers and features by using rule files with the
renderEngine resource.

Example 1: Create layers

The following example creates map layers with renderEngine.

Command
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./renderEngine.sh –rule createLayers.xml

Rule file

createLayers.xml

XML
<?xml version="1.0" encoding="UTF-8"?>
<rules xmlns="http://www.ibm.com/iss/iow/common/renderengine/rule">

<rule name="mylayer_point">
<description>create a point layer</description>
<layer action="CREATE">

<name>mylayer_point</name>
<type>generic</type>
<description>mylayer_point</description>
<zIndex>3</zIndex>

<style>{graphic:true,pointRadius:10,externalGraphic:
"http://openlayers.org/dev/img/marker-gold.png",
graphicXOffset:-10,graphicYOffset:-20,labelAlign:"lt"}</style>

</layer>
</rule>
<rule name="createPolygon">

<description>create a polygon layer</description>
<layer action="CREATE">

<name>mylayer_polygon</name>
<type>generic</type>
<description>mylayer_polygon</description>
<zIndex>1</zIndex>

<style>{fill:true,fillColor:"gray",fillOpacity:0.4,stroke:false,graphic:true}</style>
</layer>

</rule>
</rules>

Example 2: Update layers

The following example updates map layers with renderEngine.

Command

./renderEngine.sh –rule updateLayers.xml

Rule file

updateLayers.xml

XML
<?xml version="1.0" encoding="UTF-8"?>
<rules xmlns="http://www.ibm.com/iss/iow/common/renderengine/rule">

<rule name="mylayer_point">
<description>update a layer's style</description>
<layer action="UPDATE">

<name>mylayer_point</name>
<style>{graphic:true,pointRadius:3,externalGraphic:
"http://openlayers.org/dev/img/marker-gold.png",
graphicXOffset:-10,graphicYOffset:-20,labelAlign:"lt"}</style>

</layer>
</rule>
<rule name="createPolygon">

<description>update a layer's zIndex</description>
<layer action="UPDATE">

<name>mylayer_polygon</name>
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<zIndex>4</zIndex>
</layer>

</rule>
</rules>

Example 3: Delete layers

The following example deletes map layers with renderEngine.

Command

./renderEngine.sh –rule deleteLayers.xml

Rule file

deleteLayers.xml

XML
<?xml version="1.0" encoding="UTF-8"?>
<rules xmlns="http://www.ibm.com/iss/iow/common/renderengine/rule">

<rule name="mylayer_point">
<description>delete a layer</description>
<layer action="DELETE">

<name>mylayer_point</name>
</layer>

</rule>
<rule name="createPolygon">

<description>create a polygon layer</description>
<layer action="DELETE">

<name>mylayer_polygon</name>
</layer>

</rule>
</rules>

Example 4: Create features

The following example creates features with renderEngine.

Command

./renderEngine.sh –rule createFeatures.xml

Rule file

createFeatures.xml

XML
<?xml version="1.0" encoding="UTF-8"?>
<rules xmlns="http://www.ibm.com/iss/iow/common/renderengine/rule">

<rule name="add_points">
<description>demo1</description>
<variable name="layerName">mylayer_point</variable>
<layer action="GET">

<name>${layerName}</name>
</layer>
<feature action="CREATE">

<name>point1</name>
<type>generic</type>
<geometry>POINT(-86.23531405314246 41.67925782340392)</geometry>
<startLevel>0</startLevel>
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<endLevel>0</endLevel>
</feature>

</rule>
</rules>

Example 5: Update features

The following example updates features with renderEngine.

Command

./renderEngine.sh –rule updateFeatures.xml

Rule file

updateFeatures.xml

XML
<?xml version="1.0" encoding="UTF-8"?>
<rules xmlns="http://www.ibm.com/iss/iow/common/renderengine/rule">

<rule name="add_points">
<description>demo1</description>
<variable name="layerName">mylayer_point</variable>
<layer action="GET">

<name>${layerName}</name>
</layer>
<feature action="UPDATE">

<name>point1</name>
<style>{strokeColor:"red",pointRadius:3}</style>

</feature>
</rule>

</rules>

Example 6: Delete features

The following example deletes features with renderEngine.

Command

./renderEngine.sh –rule deleteFeatures.xml

Rule file

deleteFeatures.xml

XML
<?xml version="1.0" encoding="UTF-8"?>
<rules xmlns="http://www.ibm.com/iss/iow/common/renderengine/rule">

<rule name="add_points">
<description>demo1</description>
<variable name="layerName">mylayer_point</variable>
<layer action="GET">

<name>${layerName}</name>
</layer>
<feature action="DELETE">

<name>point1</name>
</feature>

</rule>
</rules>
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style:

You can perform advanced feature styling with properties and rules on vector layers on a GIS map. You
use a simple JSON string to create an Openlayers style object. OpenLayers is an opensource javascript
library that is used to load, display and render maps from multiple sources on web pages. For more
information, you should visit the OpenLayers website: http://docs.openlayers.org/library/
feature_styling.html.

Style objects

OpenLayers Style objects are descriptions of the way that features should be rendered. When a feature is
added to a layer, the layer combines the style property with the feature to create a ‘symbolizer’, which is
a set of style properties that will be used when rendering the layer.

Style properties

You can use the following properties for styling:

Property Description

fill {Boolean} Set to false if no fill is desired.

fillColor {String} Hex fill color. Default is “#ee9900”.

fillOpacity {Number} Fill opacity (0-1). Default is 0.4.

stroke {Boolean} Set to false if no stroke is desired.

strokeColor {String} Hex stroke color. Default is “#ee9900”.

strokeOpacity {Number} Stroke opacity (0-1). Default is 1.

strokeWidth {Number} Pixel stroke width. Default is 1.

strokeLinecap {String} Stroke cap type. Default is “round”. [butt |
round | square]

strokeDashstyle {String} Stroke dash style. Default is “solid”. [dot | dash
| dashdot | longdash | longdashdot | solid]

graphic {Boolean} Set to false if no graphic is desired.

pointRadius {Number} Pixel point radius. Default is 6.

pointerEvents {String} Default is “visiblePainted”.

cursor {String} Default is “”.

externalGraphic {String} URL to an external graphic that will be used for
rendering points.

graphicWidth {Number} Pixel width for sizing an external graphic.

graphicHeight {Number} Pixel height for sizing an external graphic.

graphicOpacity {Number} Opacity (0-1) for an external graphic.

graphicXOffset {Number} Pixel offset along the positive x axis for
displacing an external graphic.

graphicYOffset {Number} Pixel offset along the positive y axis for
displacing an external graphic.

rotation {Number} For point symbolizers, this is the rotation of a
graphic in the clockwise direction about its center point,
or any point off center as specified by graphicXOffset
and graphicYOffset.

graphicZIndex {Number} The integer z-index value to use in rendering.
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Property Description

graphicName {String} Named graphic to use when rendering points.
Supported values include “circle” (default), “square”,
“star”, “x”, “cross”, “triangle”.

Title {String} Tooltip when hovering over a feature.

backgroundGraphic {String} URL to a graphic to be used as the background
under an externalGraphic.

backgroundGraphicZIndex {Number} The integer z-index value to use in rendering
the background graphic.

backgroundXOffset {Number} The x offset (in pixels) for the background
graphic.

backgroundYOffset {Number} The y offset (in pixels) for the background
graphic.

backgroundHeight {Number} The height of the background graphic. If not
provided, the graphicHeight will be used.

backgroundWidth {Number} The width of the background width. If not
provided, the graphicWidth will be used.

label {String} The text for an optional label. For browsers that
use the canvas renderer, this requires either fillText or
mozDrawText to be available.

labelAlign {String} Label alignment. This specifies the insertion
point relative to the text. It is a string composed of two
characters. The first character is for the horizontal
alignment, the second for the vertical alignment. Valid
values for horizontal alignment: “l”=left, “c”=center,
“r”=right. Valid values for vertical alignment: “t”=top,
“m”=middle, “b”=bottom. Example values: “lt”, “cm”,
“rb”. Default is “cm”.

labelXOffset {Number} Pixel offset along the positive x axis for
displacing the label. Not supported by the canvas
renderer.

labelYOffset {Number} Pixel offset along the positive y axis for
displacing the label. Not supported by the canvas
renderer.

labelSelect {Boolean} If set to true, labels will be selectable by using
SelectFeature or similar controls. Default is false.

labelOutlineColor {String} The color of the label outline. Default is ‘white’.
Only supported by the canvas and SVG renderers.

labelOutlineWidth {Number} The width of the label outline. Default is 3, set
to 0 or null to disable. Only supported by the canvas &
SVG renderers.

fontColor {String} The font color for the label, to be provided like
CSS.

fontOpacity {Number} Opacity (0-1) for the label.

fontFamily {String} The font family for the label, to be provided like
in CSS.

fontSize {String} The font size for the label, to be provided like in
CSS.

fontStyle {String} The font style for the label, to be provided like in
CSS.
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Property Description

fontWeight {String} The font weight for the label, to be provided like
in CSS.

display {String} Symbolizers will have no effect if display is set
to “none”. All other values have no effect.

Model Exploration Service resources
Model Exploration Service resources are used to retrieve, create, update, delete, and query topic maps.
You can also use the resources to run impact analysis on the topic maps index.

topicmaps:

The topicmaps resource is used to retrieve, create, update, and delete topic maps. In the Water REST API,
topicmaps is a Model Exploration Service resource.

Using GET to retrieve topic maps and descriptions:

The HTTP GET request method is used to retrieve information from the server. In the Water API, you can
use GET with the Model Exploration Service resource, topicmaps, to retrieve lists of topic maps and
descriptions.

Method

GET.

Resource URI
/ibm/water/api/topicmaps-service/topicmaps

Request Body

Not applicable.

Response

The response is a topic map in XTM 2.0 format. You can find more information about topic map
responses at the website, isotopicmaps.com, at the following URL: http://www.isotopicmaps.org/sam/
sam-xtm/

Resource Parameters

Not applicable.

Examples

The following examples demonstrate how to retrieve map layers and descriptions by using the GET
method with the topicmaps resource.

Example 1: Retrieve a list topic maps

The example model retrieves a list of topic maps in XML format. In this example, you can assume that
the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/
topicmaps.

The example uses the following method, URL, and Accept request-header:
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v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<TopicMapDescriptionList xmlns="http://www.ibm.com/iss/iow/services/topicmaps">
<TopicMapDescription>
<name>default</name>
<description>this is the default topicmaps</description>
</TopicMapDescription>
<TopicMapDescription>
<name>test</name>
<description>A topic map for test</description>
</TopicMapDescription>

</TopicMapDescriptionList>

Example 2: Retrieve all topic map content

The example retrieves content from topic maps named "default" in XML format. In this example, you can
assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/
topicmaps-service/topicmaps.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps/default
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<topicMap xmlns="http://www.topicmaps.org/xtm/" />

Using POST and PUT to create and update topic maps:

The HTTP POST request method is used to request that a web server accepts the data enclosed in the
body of a request message for storage. In the Water API, you can use POST with the Model Exploration
Service resource, topicmaps, to create a new empty topic map with a default name and description, and
use PUT to update the newly created topic maps.

Method

POST and PUT.

Resource URI
/ibm/water/api/topicmaps-service/topicmaps

Request Body

The request is a topic map description object in JSON or XML format.

Response

Not applicable.
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Resource Parameters

Not applicable.

Examples: Create and update topic maps

The following example demonstrates how to create and update topic maps and descriptions by using the
POST and PUT methods with the topicmaps resource.

Example 1: Create a topic map

The following example demonstrates how to create a new empty topic map by using the POST method
with the topicmaps resource. You create the topic maps by taking the following two steps:
1. POST a topic map description object to the URL.
2. PUT topic map content to URL.

Step 1: POST a topic map description object to the URL

To create a topic map, the first step is to post a topic map description object to the example URL,
http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps.

This example uses the following method, URL, and Content-Type request-header:
v Method: POST
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps
v Content-Type: application/xml

In this example, you use the following request entity:
<TopicMapDescription xmlns="http://www.ibm.com/iss/iow/services/topicmaps">
<name>test</name>
<description>A topic map for test</description>
</TopicMapDescription>

Step 2: PUT topic map content to the URL

The second step is to PUT topic map content to the example URL, http://app-ioc.cn.ibm.com/ibm/
water/api/topicmaps-service/topicmaps/test, where test is the name of the newly created topic maps.

This example uses the following method, URL, and Content-Type request-header:
v Method: PUT
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps/test
v Content-Type: application/xml

In this example, you use the following request entity:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<topicMap xmlns="http://www.topicmaps.org/xtm/" />

Example 2: Update a topic map description

The following example demonstrates how to update the description of a topic map named test with the
topicmaps resource. To update the description, you need the PUT method and topic map description
objects in XML or JSON format. The example uses the following URL: http://app-ioc.cn.ibm.com/ibm/
water/api/topicmaps-service/topicmaps.

Use the following method, URL, and Content-Type request-header:
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v Method: PUT
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps
v Content-Type: application/json

In this example, you use the following request entity:
{
"name": "test",
"description": "This is new description"

}

Example 3: Update topic map content

The following example demonstrates how to update the topic map content with the topicmaps resource.
To update topic map content, you PUT the topic map document to the URL, http://app-ioc.cn.ibm.com/
ibm/water/api/topicmaps-service/topicmaps/<name>.

Use the following method, URL, and Content-Type request-header:
v Method: PUT
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps/default
v Content-Type: application/xml

In this example, you use the following request entity:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<topicMap xmlns="http://www.topicmaps.org/xtm/" />

Using DELETE to delete a topic map:

The HTTP DELETE method is used to request the web server to delete a resource that is identified by the
Request URI. In the Water API, you can use DELETE with the Model Exploration Service resource,
topicmaps/<name>, to delete a topic map.

Method

DELETE.

Request URI
/ibm/water/api/topicmaps-service/<name>

Request Body

Not applicable.

Response

Not applicable.

Resource Parameters

Not applicable.

Example: Delete a topic map

The following example demonstrates how to delete a map layer by using the DELETE method with the
topicmaps/<name> resource. In the example, the service uses the following URL: http://app-
ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps.
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The example uses the following method and URL:
v Method: DELETE
v URL: hhttp://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps/test

topicmaps/<name>/topics:

The topicmaps/<name>/topics resource is used to retrieve topics in specified topic maps. In the Water
REST API, topicmaps/<name>/topics is a Model Exploration Service resource.

Using GET to retrieve topics and related associations:

In the Water API, you can use the HTTP GET request topics with the Model Exploration Service resource,
topicmaps/<name>/topics, to get topic maps and related associations.

Method

GET.

Resource URI
/ibm/water/api/topicmaps-service/topicmaps/<name>/
topics?topicId=<topicId>&scope=<scope >&associationType=<associationType

Request Body

Not applicable.

Responses

The response is a topic map in XTM 2.0 format. You can find more information about topic maps at the
website, isotopicmaps.com, at the following URL: http://www.isotopicmaps.org/sam/sam-xtm/.

Resource Parameters

The resource has the following properties.

Property Description

topicId The ID of the start topic.

scope A list of scope topic IDs used to restrict the navigation.
The property is optional.

associationType A list of association type topic IDs used to restrict the
navigation. The property is optional.

depth A number to restrict navigation depth. The default value
is 0 if not specified; therefore, the property only returns
the topic specified in topicId parameter. The property is
optional.

Example: Retrieve topics and associated topics

The following examples demonstrate how to retrieve topics and associated topics by using the GET
method with the topicmaps/<name>/topics resource. The example model retrieves the connected junctions
of the pipe, http://cityName#Pipe1161, with the following parameters:
v “RSM” and “cityName” in scope
v Association type restricted to “rsm-contains” and “rsm-connects”
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v Depth restricted to 1

In this example, you can assume that the service uses the following base URL: http://app-
ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps/default/

topics?topicId=http%3A%2F%2FcityName%23Pipe1161&scope=cityName&scope=RSM
&associationType=rsm-contains&associationType=rsm-connects&depth=1

v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<topicMap xmlns="http://www.topicmaps.org/xtm/">
<topic id="http://cityName#Junction701">
<itemIdentity href="http://cityName#Junction701" />
<instanceOf><topicRef href="http://cityName#Junction" /></instanceOf>
<name>
<scope><topicRef href="#cityName" /></scope>
<value>Junction701</value>
</name>
<occurrence>
<type><topicRef href="#GIS" /></type>
<resourceData datatype="http://www.w3.org/2001/XMLSchema#string">POINT(-86.24710578612327
41.6883944550089)</resourceData>

</occurrence>
</topic>
<topic id="http://cityName#Pipe1161">
<itemIdentity href="http://cityName#Pipe1161" />
<instanceOf><topicRef href="http://cityName#Pipe" /></instanceOf>
<name>
<scope><topicRef href="#cityName" /></scope>
<value>Pipe1161</value>
</name>
<occurrence>
<type>
<topicRef href="#GIS" />
</type>
<resourceData datatype="http://www.w3.org/2001/XMLSchema#string">LINESTRING(-86.24705431019666
41.6897564042222,-86.24710578612327 41.6883944550089)</resourceData>

</occurrence>
</topic>
<topic id="http://cityName#Junction">
<itemIdentity href="http://cityName#Junction" />
<instanceOf><topicRef href="#iso13250-topic-type" /></instanceOf>
<name>
<scope> <topicRef href="#cityName" /></scope>
<value>Junction</value>
</name>
</topic>
<topic id="http://cityName#Junction643">
<itemIdentity href="http://cityName#Junction643" />
<instanceOf><topicRef href="http://cityName#Junction" /></instanceOf>
<name>
<scope><topicRef href="#cityName" /></scope>
<value>Junction643</value>
</name>
<occurrence>
<type>
<topicRef href="#GIS" />
</type>
<resourceData datatype="http://www.w3.org/2001/XMLSchema#string">POINT(-86.24705431019666
41.6897564042222)</resourceData>
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</occurrence>
</topic>
<topic id="rsm-connects-source">
<instanceOf><topicRef href="#iso13250-association-role-type" /></instanceOf>
</topic>
<topic id="rsm-connects-target">
<instanceOf><topicRef href="#iso13250-association-role-type" /></instanceOf>
</topic>
<topic id="rsm-connects">
<instanceOf><topicRef href="#iso13250-association-type" /></instanceOf>
</topic>
<topic id="cityName">
<instanceOf><topicRef href="#iso13250-scope" /></instanceOf>
<name><value>cityName</value></name>
</topic>
<topic id="http://cityName#Pipe">
<itemIdentity href="http://cityName#Pipe" />
<instanceOf><topicRef href="#iso13250-topic-type" /></instanceOf>
<name>
<scope><topicRef href="#cityName" /></scope>
<value>Pipe</value>
</name>
</topic>
<association
reifier="cityName-rsm-connects-http://cityName#Pipe1161-http://cityName#Junction701">
<type><topicRef href="#rsm-connects" /></type>
<scope><topicRef href="#cityName" /></scope>
<role>
<type><topicRef href="#rsm-connects-source" /></type>
<topicRef href="http://cityName#Pipe1161" />
</role>
<role>
<type><topicRef href="#rsm-connects-target" /></type>
<topicRef href="http://cityName#Junction701" />
</role>
</association>
<association
reifier="cityName-rsm-connects-http://cityName#Pipe1161-http://cityName#Junction643">
<type><topicRef href="#rsm-connects" /></type>
<scope><topicRef href="#cityName" /></scope>
<role>
<type><topicRef href="#rsm-connects-source" /></type>
<topicRef href="http://cityName#Pipe1161" />
</role>
<role>
<type><topicRef href="#rsm-connects-target" /></type>
<topicRef href="http://cityName#Junction643" />
</role>
</association>
</topicMap>

topicmaps/<name>/search:

The topicmaps/<name>/search resource is used to search topic maps. In the Water REST API,
topicmaps/<name>/search is a Model Exploration Service resource.

Using GET to search topics by name:

In the Water API, you can use the HTTP GET request method with the Model Exploration Service
resource, topicmaps/<name>/search, to get topic and related associations.

Method

GET.

Chapter 4. Integrating the solution 119



Resource URI
/ibm/water/api/topicmaps-service/topicmaps/<name>/search?keyword=<keyword>&scope=<scope>

Request Body

Not applicable.

Response

The response is a topic map in XTM 2.0 format, which you can find more information on
isotopicmaps.com at the following URL: http://www.isotopicmaps.org/sam/sam-xtm/

Resource Parameters

The resource has the following properties.

Property Description

keyword The search key word.

scope A list of scope topic ids used to restrict the navigation.
The property is optional.

Example: Search topics in scope

The example model searches the topics with names that contain the keyword, pipe, in scope, RSM. In this
example, you can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/
water/api/topicmaps-service/topicmaps.

The example uses the following method, URL, and Accept request-header:
v Method: GET
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps/default/

search?keyword=pipe&scope=RSM
v Accept: application/xml

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<topicMap xmlns="http://www.topicmaps.org/xtm/">
<topic id="CIM-EPANET_Pipe">
<itemIdentity href="http://www.epanet.org#EPANET_Pipe" />
<instanceOf><topicRef href="#iso13250-topic-type" /></instanceOf>
<name>
<scope><topicRef href="#RSM" /></scope>
<value>EPANET_Pipe</value>
</name>
</topic>
<topic id="CIM-WIH_Pipeline_Asset">
<itemIdentity href="http://www.ibm.com/water/wih#WIH_Pipeline_Asset" />
<instanceOf><topicRef href="#iso13250-topic-type" /></instanceOf>
<name>
<scope> <topicRef href="#RSM" /></scope>
<value>WIH_Pipeline_Asset</value>
</name>
</topic>

</topicMap>
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topicmaps/<name>/impact:

The topicmaps/<name>/impact resource is used to run impact analysis on the topic map index. In the
Water REST API, topicmaps/<name>/impact is a Model Exploration Service resource.

Using GET to run impact analysis on topic maps:

In the Water API, you can use the HTTP GET request method with the Model Exploration Service
resource, topicmaps/<name>/impact, to run impact analysis on topics maps.

Method

GET.

Request URI
/ibm/water/api/topicmaps-service/topicmaps/<name>/impact?topicId=<topicId>&scope=<scope>&associationType=
<associationType>&depth=<depth>

Request Body

Not applicable.

Response

The response is a topic map in XTM 2.0 format. You can find more information about topic maps at the
website, isotopicmaps.com, at the following URL: http://www.isotopicmaps.org/sam/sam-xtm/.

Resource Parameters

The resource has the following properties.

Property Description

topicId The ID of the start topic.

scope The list of scope topic IDs used to restrict the navigation.
The property is optional.

associationType A list of association type topic IDs used to restrict the
navigation. The property is optional.

depth A number to restrict navigation depth. The default value
is 0 if not specified; therefore, the property returns only
the topic that is specified in topicId parameter. The
property is optional.

Example: Run impact analysis on topic maps

The example model gets all the measurements, CIM-RSM_Measurement, of the asset,
http://cityName%23CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation. In this example, you
can assume that the service uses the following base URL: http://app-ioc.cn.ibm.com/ibm/water/api/
topicmaps-service/topicmaps.

The example uses the following method, Accept request-header and URL:
v Method: GET
v Accept: application/xml
v URL: http://app-ioc.cn.ibm.com/ibm/water/api/topicmaps-service/topicmaps/default/

impact?topicId=http%3A%2F%2FcityName%23CityName-
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AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation&topicId=CIM-RSM_Measurement&depth=3

In this example, you get the following XML response:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<topicMap xmlns="http://www.topicmaps.org/xtm/">
<topic id="CIM-RSM_Measurement">
<itemIdentity href="http://iec.ch/TC57/CIM-generic#RSM_Measurement" />
<instanceOf>
<topicRef href="#iso13250-topic-type" />
</instanceOf>
<name>
<scope><topicRef href="#RSM" /></scope>
<value>RSM_Measurement</value>
</name>
</topic>
<topic id="http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation">
<itemIdentity uref="http://cityName#CityName-AREA.CityName-

UNIT.I-LiftStation-WE.I-LiftStation" />
<instanceOf><topicRef href="http://cityName#RainGauge" /></instanceOf>
<name>
<scope><topicRef href="#cityName" /></scope>
<value>I-LiftStation</value>
</name>
</topic>
<topic id="http://cityName#CityName-AREA.CityName-

UNIT.I-LiftStation-WE.I-LiftStation-M.I-RainGauge">
<itemIdentity href="http://cityName#CityName-AREA.CityName-

UNIT.I-LiftStation-WE.I-LiftStation-M.I-RainGauge" />
<instanceOf><topicRef href="http://iec.ch/TC57/CIM-generic#RSM_Measurement" /></instanceOf>
<name>
<scope><topicRef href="#cityName" /></scope>
<value>I-RainGauge</value>
</name>
</topic>
......
<association>
<type><topicRef href="http://psi.topicmaps.org/iso13250/model/type-instance" /></type>
<scope><topicRef href="#cityName" /></scope>
<role>
<type><topicRef href="http://psi.topicmaps.org/iso13250/model/type" /></type>
<topicRef href="#CIM-RSM_Measurement" />
</role>
<role>
<type><topicRef href="http://psi.topicmaps.org/iso13250/model/instance" /></type>
<topicRef href="#http://cityName#CityName-AREA.CityName-

UNIT.I-LiftStation-WE.I-LiftStation-M.I-RainGauge" />
</role>
</association>
<association reifier=

"cityName-rsm-has-measurement-http://cityName#CityName-AREA.CityName-
UNIT.I-LiftStation-WE.I-LiftStation-
http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation-M.I-RainGauge">

<type><topicRef href="#rsm-has-measurement" /></type>
<scope><topicRef href="#cityName" /></scope>
<role>
<type><topicRef href="#rsm-has-measurement-asset" /></type>
<topicRef href="http://cityName#CityName-AREA.CityName-UNIT.I-LiftStation-WE.I-LiftStation" />
</role>
<role>
<type><topicRef href="#rsm-has-measurement-measurement" /></type>
<topicRef href="http://cityName#CityName-AREA.CityName-

UNIT.I-LiftStation-WE.I-LiftStation-M.I-RainGauge" />
</role>
</association>
......

</topicMap>
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Running the Index Engine:

Index Engine is a command line tool that is used to generate topic maps by using a template. In the
template, you can either write the topics and associations directly, or query the model server to generate
the topics and associations.

To run the Index Engine on the application node, you take the following steps:
1. Go to the directory, /opt/IBM/iss/iow/apps.
2. Run the command by using the following rule files: /index.sh <topic_map_name>

<topic_map_description> topicmaps\rules_core.xml <custom_rule_file> <custom_rule_file>...

Example XML response

The following XML response demonstrates how to find example custom rule files in the
directory, /opt/IBM/iss/iow/apps/topicmaps:
<?xml version="1.0" encoding="UTF-8"?>
<rules xmlns="http://www.ibm.com/iss/iow/common/topicmap/rule">
<rule>
<name>Custom Scope</name>
<description>Create custom scope topics</description>
<variable name="namespace">http://cityName#</variable>
<variable name="scopeName">cityName</variable>
<template>
<topicMap xmlns="http://www.topicmaps.org/xtm/">
<topic id="${scopeName}">
<instanceOf><topicRef href="#iso13250-scope"/></instanceOf>
<name><value>${scopeName}</value></name>
</topic>
</topicMap>
</template>
</rule>

<rule>
<name>Index Custom Classes</name>
<description>Index Custom Classes</description>
<variable name="namespace">http://cityName#</variable>
<variable name="scopeName">cityName</variable>
<query datasource="" type="SPARQL">
<![CDATA[
PREFIX owl:<http://www.w3.org/2002/07/owl#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX rdf:<http://www.w3.org/1999/02/22-rdf-syntax-ns#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
SELECT ?classID ?classLabel
WHERE {

?classID a owl:Class .
?classID rdfs:label ?classLabel .
FILTER regex(str(?classID), ’^${namespace}’, ’i’)

}
]]&gt;
</query>
<template>
<topicMap xmlns="http://www.topicmaps.org/xtm/">
<topic id="${classID}">
<itemIdentity href="${classID}"/>
<instanceOf><topicRef href="#iso13250-topic-type"/></instanceOf>
<name>
<scope><topicRef href="#${scopeName}"/></scope>
<value>${classLabel}</value>
</name>
<occurrence>
<type><topicRef href="#ModelAccessService"/></type>
<resourceData datatype="http://www.w3.org/2001/XMLSchema#string">${classID}</resourceData>
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</occurrence>
</topic>
</topicMap>
</template>
</rule>

......

ASK Service resources
The Analytics Solution Kit (ASK) is designed to simplify the deployment and management of analytic
models. It is a middleware server that enriches enterprise applications with descriptive, predictive, and
prescriptive capabilities. ASK analytical and optimization solutions are built with advanced IBM software.

Understanding ASK:

The Analytics Solution Kit (ASK) is a J2EE-based framework that enables seamless management of
complex mathematical programs that are built with IBM products. Using ASK, you can manage the
deployment and execution of analytical and optimization models.

Using IBM products with ASK

Within the ASK framework, you can build complex mathematical modeling with rigorous
industry-leading software standards. To do so, you use IBM products such as ILOG CPLEX Optimization
Studio and SPSS PASW Modeler.

Building and deploying analytical models with IBM products requires high skill, high value resources. As
such, these resources are scarce. When the analytic models are built, it takes considerable time and
resources to integrate the models into an enterprise environment.

Typically, the analytic model expert is not skilled in integration. Likewise, the enterprise IT developer
seldom has the expertise in the interface API to the analytical tools. The result is a skill deficiency. This
issue becomes a barrier-of-entry for enterprise applications that seek to use predictive and prescriptive
capabilities within an enterprise application.

Furthermore, for each class of problem there are standard algorithms and models that can be used across
domains.

Therefore, rather than building one-off models for each industry and customer, analytic experts can build
a set of reusable analytical models within the ASK framework. These models can be used in any industry
domain.

Example of an analytical model

Suppose you want to optimally route a set of crews to distant locations to fix problems with assets. In
this scenario, you can build mathematical programming models to power distribution from the water
domain to the rail domain. Generic and configurable analytical models can be coupled with a common
industry-based data model for analytics. They provide a solution that is ready for immediate use. This
solution is a key value proposition to repeatable solution deployment.

Running ASK on WebSphere Application Server

ASK runs on top of WebSphere Application Server. You can register a data schema for a model, deploy
the model, and associate it with a particular technology. ASK is designed to allow for the support of any
analytic engine. The installation and configuration of the analytic engines is contained within the ASK
installation. Therefore, you do not have to perform these tasks.

ASK V4 is named Lurch and supports analytical models from Cognos, ILOG, SPSS, and custom analytics
engines.
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Choosing a metadata repository

ASK contains a metadata repository that can be a file system or relational database. The choice is left to
the ASK user. For less complex installs, you might elect to use a file-based repository. For more complex,
enterprise-wide installs you can use a database. ASK currently supports DB2. The metadata repository
contains information about the models, analytic engines, and data schemas that are registered in the
system.

Working with the administrative console

ASK provides an administrative console for data modelers and analytic modelers to register, deploy, and
run their models by using a graphical user interface. ASK also provides RESTful web services. By using
web services, an enterprise application can start the execution of a model and have the model results
returned and displayed in the enterprise application.

Using ASK web services:

Analytics Solution Kit (ASK) web services are available in the following four methods: GET, POST, PUT,
and DELETE.

Web service methods

The ASK web services methods are described as follows:
v GET: This method retrieves information, returning JSON. The form of the GET method is similar to a

SELECT statement. The parameters of the method are typically appended to the request URI.
v POST: This method creates, updates, or deletes data. When you call POST, you pass in JSON, which

contains the parameters of the method.
v PUT: This method creates or updates data. As with POST, you pass in JSON with the parameters of the

method.
v DELETE: This method deletes data. The parameters of the method are typically appended to the

request.

Resource URI

The endpoint that is used for the web service is the end of the resource URI. The form of the URI begins
with the URL of the ASK instance and includes the general address of REST web services in ASK. You
use both together to form the URI to request resources. In this way, the URI uses the following syntax:
http://<host_name>:<port_number>/<context>/rest/<endpoint>.

Example URI

Suppose you want to retrieve a list of all the schemas that are installed on the server and your domain is
analytics41.watson.ibm.com. In this scenario, you create the following resource URI: http://
analytics41.watson.ibm.com:9080/askws/rest/dataService/schemas.

The root of the URL hierarchy represents the catalog of folders and services that are published by using
the ASK Server. Each folder in turn represents a catalog of services that are published within that folder.

Web service hierarchy

The ASK REST system of endpoints is a hierarchy of resources. The following is a description of the
services within the hierarchy.
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Service Hierarchy Description

catalog The root of the URL hierarchy. The syntax for catalog is
as follows: http://<host>/<instance>/<services>.

Data Service The Data Service installs, uninstalls, activates,
deactivates, and updates the schemas and models in the
database. The visual editor is used to install solutions.
Solutions can be uninstalled. The syntax for the service is
as follows: /<get>/<servicename>.

Validation Service The Validation Service validates the input data, input
parameter, and models. The syntax for the service is as
follows: /<validate>/<servicename>.

Execution Service The Execution Service provides the methods to run the
models and sequence solutions. The syntax for the
service is as follows: /<execute>/<servicename>.

Configuration Service The Configuration Service defines the methods to
manage the system properties. The syntax for the service
is as follows: /<config>/<servicename>.

Logging Service The Logging Service provides the methods to retrieve the
logs and set the logging level. The syntax for the service
is as follows: /<log>/<servicename>.

Tutorials
IBM Intelligent Operations for Water Interim Feature 2 provides a sample application that you can use to
familiarize yourself with the SDK and the REST API services. Using the sample application, you can learn
the process of building integrated applications with IBM Intelligent Operations for Water.

The sample application provides a simulated environment that you can use to perform application
development in IBM Intelligent Operations for Water. When you select to install IBM Intelligent
Operations for Water Interim Feature 2, a sample application environment is loaded in the following
directory: /opt/IBM/iss/iow/samples.

The application is a Rational Application Developer workspace that you import into a Rational
Application Developer development environment.

Note: You must have an Rational Software Architect for WebSphere Software and Rational Application
Developer application development environment to import the workspace and start using the sample
application.

Using the sample application to create your own web application

The sample application source code and web services are provided to facilitate the deployment of
customized web applications in IBM Intelligent Operations for Water. The sample includes the following
assets to facilitate deployment:
v Project toolkit for Rational Software Architect (RSA) and Rational Application Development (RAD).
v Sample custom semantic model to import into the model server. This includes sample OWL and RDF

files for pipeline and meter types and instances.
v Sample scripts to configure a pipe network for use by the Render Service.
v Sample scripts to create a topic map index on the asset model.
v Sample application source code.

In the tutorial in this section, the sample application is used extensively to share knowledge on the IBM
Intelligent Operations for Water application development process.
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Scenario
Before building an application on the IBM Intelligent Operations for Water platform, you must have a
clear view of what the application is to provide. Define the challenges to overcome and the skills
available in your team to build the application. The scenario determines what application environment
you must set up and configure, and also determines how you build your application.

For the purpose of this tutorial, the following scenario is used.

Situation
Sunshine Water Group manage a water network for a regional council. The water network
contains a number of sensors that monitor measurements. Sunshine Water Group have been
experiencing challenges with water pressure measurements in their pipe infrastructure. Each
pipeline asset in the water network has the following managed components: pipes, junctions,
reservoirs, valves and tanks. Each managed component has an associated measurement. For
example, both junctions and valves have pressure readings, measured in psi (force per square
inch). Sunshine Water Group use valves to set pressure readings.

Complication
There has been significant expansion in the Sunshine Water Group water network. Economic
growth has brought new residential and commercial development in the managed region. The
water infrastructure has expanded accordingly and Sunshine Water Group are challenged to
maintain constant water pressure in their evolving infrastructure.

Proposal
Sunshine Water Group need an application in IBM Intelligent Operations for Water to optimize
pressure management in the pipe infrastructure.

Outcome
Sunshine Water Group hope that by optimizing pressure management they will satisfy customer
demands, improve infrastructure efficiencies, and ensure that service level agreements and the
requirements of regional water consumption and conservation policies are met.

Using the information above, the application developer addresses the problem in the context of services
offered by the IBM Intelligent Operations for Water SDK and REST API. For example:
v Use the Model Access Service to get the infrastructure element types from the Water Information Hub.

For example, get a list of pressure critical points and valves and add a pressure critical point as input.
v Use the Model Exploration Service to run an impact analysis and retrieve a list of valves that impact

this pressure critical point. By getting the infrastructure elements from the Water Information Hub, and
running an impact analysis, a water asset graph is returned.

v Use the Reading Service to get the current pressure value of pressure critical points and the current
setting value of valves. The Reading Service enables post processing of the water asset graph.

v Use the ASK Service to use embedded analytics offered by the IBM Intelligent Operations for Water to
optimize pressure management. By calling the pressure optimization analytics, you gain insight from
the data available to help make better decisions. The ASK Service is used to post process the water
asset graph.

v Use the Render Service to render the optimization results to a map for display in the interface and test
the application.

Once the scenario is defined, continue by setting up and configuring the environment for application
development.

Configuring the application setup
Before you can begin to build the application, you must create your application environment by using the
assets provided by the sample application. Use the tutorials to configure the application setup.
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Configuration Tasks

To set up the application, you must complete the following configuration tasks:
v Import the sample projects
v Extend the water semantic model
v Create index for the Model Exploration Service
v Generate custom map layers
v Verify the configuration
v Create sample reading data to verify event flow

The tasks are described in the tutorials.

Importing the sample projects:

Import the prerequisites and sample projects.

Installing prerequisites

As a prerequisite, you need to install the following systems:
1. Install IBM Intelligent Operations Center 1.5.
2. Install IBM Intelligent Operations for Water 1.5.
3. Install IBM Intelligent Operations for Water Interim Feature 2.
4. Deploy the Rational Application Developer (RAD) Development Environment. For information on

installing and using RAD, see the Rational Application Developer information center. RAD is included
with the IBM Intelligent Operations Center on separate DVDs or images.

Downloading and importing the projects

You download and import the sample project files as follows:
1. Go to the sample project at the application node in the following directory: /opt/IBM/iss/iow/

samples.
2. Download and import the following projects in to your Rational Application Developer workspace:

water_sdk_sample_model and water_sdk_sample_app.
3. After you import the projects, you will find them in your development environment.

Extending the water semantic model:

Configure the asset model by using the model provided with the sample application. You can extend the
water semantic model to define the custom pipeline, sensor, and meter asset types.

Custom asset types

In the example, the RSM is extended to define the new custom asset types, including Pipe, Junction,
Reservoir, Valve, and Tank.

Source code files

You can find the following model source code files in the Rational Application Developer workspace:
v sunshine_meter_instances.rdf
v sunshine_meter_type.owl
v sunshine_pipeline_instances.rdf
v sunshine_pipeline_instances.owl
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Importing custom asset types:

Use the instructions to import and verify the registration of the custom asset types.

Importing the custom model

Follow the steps to import the custom model to the model server:
1. Open the Model Manager console at the URL, http://<mgmt_node>:82/iic/console.
2. Go to Model Manager > Ontologies.
3. Click Browse and locate the asset type OWL file, sunshine_pipeline_type.owl.
4. Click Load to upload the asset type OWL file. When you have successfully registered the asset type,

you will see the OWL file uploaded in the list.
5. Repeat above steps to import sunshine_meter_type.owl.

Verifying registration

To verify that the custom model successfully registered, take the following steps:
1. Go to Model Manager > Query.
2. Run the following SPARQL query:

PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX wih:<http://www.ibm.com/water/wih#>
SELECT ?object_ID ?object_Name ?object_Comment
WHERE {

?object_ID rdfs:subClassOf wih:WIH_Pipeline_Asset; rdfs:label ?object_Name.
OPTIONAL { ?object_ID rdfs:comment ?object_Comment. }

}

3. Verify that object_Name, object_ID and object_Comment are correct in the result list.

Importing custom asset instances:

Use the instructions to import and verify custom asset instances.

Importing the custom model instance

Follow the steps to import the custom model instance to the model server:
1. Open the Model Manager console at the URL, http://<mgmt_node>:82/iic/console.
2. Go to Model Manager > Load.
3. Click Browse and locate the asset type OWL file, sunshine_pipeline_instance.owl.
4. Click Load to upload the instance RDF file. When you successfully register the asset metadata, the

graph is displayed in the console.
5. Repeat above steps to import sunshine_meter_instance.owl.

Verifying registration

To verify that the custom model successfully registered, take the following steps:
1. Go to Model Manager > Query.
2. Run the following SPARQL query:

PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX wih:<http://www.ibm.com/water/wih#>
SELECT *
WHERE {

Chapter 4. Integrating the solution 129



?asset_ID a wih:WIH_Pipeline_Asset; a ?asset_Type_ID.
?asset_ID cim:RSM_IdentifiedObject.name ?asset_Name.
OPTIONAL { ?asset_ID cim:RSM_UnnamedObject.description ?asset_Description. }
}

3. View the result to check if asset is in the result list.

Verifying using the Model Access Service:

Use the instructions to verify the Model Access Service.

Verifying custom asset types

To verify that you imported the custom asset types successfully, open the URL, http://<application-
node>/ibm/water/api/model-service/asset-types.

The asset types are defined as follows:
<AssetTypeList>
<AssetType>
<id>http://www.epanet.org#EPANET_Link</id>
<name>EPANET_Link</name>
<description>Super class EPANET Links</description>
<parentID>http://www.epanet.org#EPANET_Entity</parentID>
</Asset Type>
<AssetType>
<id>http://www.epanet.org#EPANET_Node</id>
<name>EPANET_Node</name>
<description>Super class EPANET Nodes</description>
<parentID>http://www.epanet.org#EPANET_Entity</parentID>
</AssetType>
<AssetType>
<id>http://water.sdk.sample#EPANET_Entity</id>
<name>EPANET_Entity</name>
<description>Super class EPANET entities</description>
<parentID>http://www.ibm.com/water/wih#WIH_SensorMeter_Asset</parentID>
</AssetType>

Verifying custom asset instances

To verify custom asset instances imported successfully, open the URL, http://<application-node>ibm/
water/api/model-service/assets.

The asset instances are defined as follows:
<AssetList>
<Asset>
<id>http://ibm.com/iss/iic/sample/IBMOilDownstreamSampleRDF#IBM_OIL_DS.WE.NAT-201-HE-105</id>
<assetTypeID>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment</assetTypeId>
<name>NAT-201-HE-105</name>
<description>ShellTube_2 HeatExchanger</description>
</Asset>
<Asset>
<id>http://ibm.com/iss/iic/sample/IBMOilDownstreamSampleRDF#IBM_OIL_DS.WE.NAT-201-TD-105</id>
<assetTypeID>http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment</assetTypeId>
<name>NAT-201-TD-105</name>
<description>Drum Tank</description>
<parentID>http://www.epanet.org#EPANET_Entity</parentID>
</Asset>

Synchronizing the model to the database:

Use the instructions to synchronize the model to the database.
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After you import the models into the model sever, take the following steps to synchronize the semantic
model to the database:
1. Log in to the application node.
2. Run the syncModelToDB.sh command as follows:

[root@app-ioc ~]# cd /opt/IBM/iss/iow/apps
[root@app-ioc apps]# ./syncModelToDB.sh <DB Node host name> <DB Port>

<DB username > <DB password > http://SunshineWaterGroup#

Creating the index for the Model Exploration Service:

Use the instructions to create the index for the Model Exploration Service.

Copying files to the application node

Copy the following files from your Rational Application Developer workspace to the application node:
v water_sdk_sample_model\topicmap\rules_core.xml
v water_sdk_sample_model\topicmap\rules_custom.xml

Running the command

Log in to the application node, and run the following command to create the index for the Model
Exploration Service:

/opt/IBM/iss/iow/apps/index.sh custom custom rules_core.xml rules_custom.xml

Generating custom map layers:

Use the procedures to generate custom map layers.

Copying files to the application node

Copy the following files from your Rational Application Developer workspace into the application node:
water_sdk_sample_model\render\rule_import_renderservice_data.xml

Running the command

Log in to the Application node, and run the following command to generate the custom map layers:

/opt/IBM/iss/iow/apps/renderEngine.sh -rule rule_import_renderservice_data.xml

Verifying the configuration:

Use the instructions to verify the Logical Map configuration settings.

Map Portlet settings

The Logical Map configuration settings are as follows:

Configuration Items Description

Enable Logic Map The setting that you use to display the map.

Logical Map Name The setting for the name that you specify when generating a topic map
index.

Model Prefix The setting that controls the prefix of model that you want to display.
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Configuring the map portlet

You must configure the map portlet as follows:
1. Configure the map portlet to set the model prefix, enable the logic map, and set the logical map name

as follows.
a. Open the following URL, http://<application-node>/wpsv70/wps/myportal.
b. Navigate to Water > Operator:Operations.
c. Click the Down Arrow button on the top right-hand side of the page.
d. Select Configure from the resulting menu.
e. In the configuration page, enter the Logical Map configuration items as follows:

1) Enable Logic Map: true
2) Logical Map Name: custom
3) Model Prefix: http://water.sdk.sample.

f. Click Save.
g. Verify that the Sunshine Water model and custom layers are shown in the map.
h. Click Logical Map to change to the logical map view. Verify that the Model Exploration Service

index is created successfully.
2. Click the Select Content menu.
3. Select Search for another asset on which to focus.

a. Enter a keyword and click Search.
b. Select a result item to display the related asset on the logical map.
c. Double-click an item on the logical map to display all related items.

Creating sample reading data to verify event flow:

Use the instructions to create sample CSV reading data to verify the event flow.

Sample reading data

The following is sample CSV reading data:
PRV19_Setting_Value,100,2013-01-11T07:00:00.00+08:00
PRV24_Setting_Value,40,2013-01-11T07:00:00.00+08:00
PRV18_Setting_Value,40,2013-01-11T07:00:00.00+08:00
Pressure_Value_J604_MV,21.50,2013-01-11T01:00:00.00+08:00
Pressure_Value_J599_MV,28.98,2013-01-11T12:00:00.00+08:00
Pressure_Value_J599_MV,28.67,2013-01-11T13:00:00.00+08:00
Pressure_Value_J553_MV,41.24,2013-01-11T01:00:00.00+08:00
Pressure_Value_J553_MV,45.33,2013-01-11T02:00:00.00+08:00
Pressure_Value_J553_MV,37.22,2013-01-11T03:00:00.00+08:00

Importing the reading data

To import the sample CSV reading data in to the IBM Intelligent Operations for Water, take the following
steps:
1. Log in to the application node.
2. Copy the CSV file to the directory, /opt/IBM/iss/iow/apps/simulator/incoming

Verifying the reading data

To verify the reading data has been processed, go to /opt/IBM/iss/iow/apps/simulator/processed.

The suffix must be a file with the latest time.
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Running the sample application
Use the instructions to run the sample application.
1. Create a new Ajax Test Server, or open an existing Ajax Test Server, in your Rational Application

Developer workspace.
2. Click Configure Proxy URLs. Change the configuration to the XML script below. Replace the

<hostname-of-application-node> to the host name of your application node:
<?xml version="1.0" encoding="UTF-8"?>
<proxy:proxy-rules
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:proxy="http://www.ibm.com/xmlns/prod/sw/ajax/proxy-config/1.1">
<proxy:mapping contextpath="http/*" />
<proxy:mapping contextpath="https/*" />
<proxy:mapping url="http://www.ibm.com" contextpath="us/en" />
<proxy:mapping url="http://<hostname-of-application-node>:10039" contextpath="ibm/*" />
<proxy:mapping url="http://<hostname-of-application-node>:10039" contextpath="iocbase/*" />
<proxy:policy url="*" acf="none" basic-auth-support="true">
<proxy:actions>
<proxy:method>GET</proxy:method>
<proxy:method>POST</proxy:method>
<proxy:method>PUT</proxy:method>
<proxy:method>DELETE</proxy:method>
<proxy:method>HEAD</proxy:method>
</proxy:actions>
<proxy:headers></proxy:headers>
<proxy:mime-types></proxy:mime-types>
<proxy:cookies></proxy:cookies>
<proxy:users></proxy:users>
</proxy:policy>
<proxy:ipfilter></proxy:ipfilter>
<proxy:meta-data>
<proxy:name>unsigned_ssl_certificate_support</proxy:name>
<proxy:value>true</proxy:value>
</proxy:meta-data>
<proxy:meta-data>
<proxy:name>forward-http-errors</proxy:name>
<proxy:value>true</proxy:value>
</proxy:meta-data>
</proxy:proxy-rules>

3. Right-click Ajax Test Server, select Add and Remove, and add the application, water_sdk_sample_app,
to the application node.

4. Right-click Ajax Test Server, and start the Ajax Test Server.
5. Open the URL, http://localhost:8080/water_sdk_sample_app/. Verify that the application runs.

Assume that the application has a simple widget to enable you to input and view results.
6. In the widget, you can implement the following logic in JavaScript:

a. Call the Model Access Service to list Pressure Critical Point (PCP) and Pressure Reducing Valve
(PRV) files.

b. Select PCP as the target and call the Topic Maps service to run impact analysis. The result of the
impact analysis is a list of PRV files.

c. Using the resulting PRV list and the PCP as input, call the custom service to start the pressure
optimization.

d. Call the custom service to get the optimization results.

Security
The IBM Intelligent Operations for Water REST API is secured by WebSEAL authentication.

You require a specific security role to access the IBM Intelligent Operations for Water REST API as
described in the table.
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Table 12. Security roles and HTTP Methods

GET POST PUT DELETE

Water Executive Yes No No No

Water Operator Yes No No No

Water Administrator Yes Yes Yes Yes
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Chapter 5. Customizing the solution

You can customize some aspects of the user interface and system settings of IBM Intelligent Operations
for Water to suit your operational requirements and users. By working with the sample content, you can
become familiar with system capabilities when customizing the solution.

Customizing data integration
The IBM Intelligent Operations for Water solution provides extension options that you can use to
customize the data that is made visible to users. Working with the model manager, you can define what
infrastructure, assets, measurements, and values are presented in the interface, and determine how to
integrate that data with components in the solution. Use the information in this topic to familiarize with
model customization and extensions.
Related concepts:
Chapter 4, “Integrating the solution,” on page 45
Products and services can be integrated with IBM Intelligent Operations for Water.

Customizing the model
By extending the IBM Intelligent Operations for Water semantic model, you can build a customized
model to meet your requirements. Use the information in this section to customize the semantic model.

IBM Intelligent Operations for Water uses the IBM Integrated Information Core as a core component of
IBM Intelligent Operations Center 1.5. IBM Integrated Information Core provides a framework to create
water-based applications that are centered on a semantic model of the real world, and that support
integration of real-time operational data and related enterprise applications.

The key component of the IBM Integrated Information Core architecture supporting this goal is the
semantic model that, based on industry standards (centered largely on ISA-95 and ISA-88), supports the
definition of an enterprise model down to assets and associated measurements

Central to IBM Intelligent Operations for Water is a semantic model called the Reference Semantic Model
(RSM). The RSM is a semantic model because it provides a real world abstraction of the enterprise and
assets in a graphical model. Through it, applications can access information from disparate systems with
various access methods. IBM Intelligent Operations for Water extends the RSM with water-specific
content.

The information model in IBM Integrated Information Core contains named entities based on industry
standards (today, primarily including ISA-95, ISA-88, and ISO15926) and relationships either defined by
those standards or implied by combining the standards into one, homogenous model.

The Reference Semantic Model is queried through services or (based on the deployment) through a
SPARQL interface.

Another key component of the IBM Integrated Information Core architecture is the model aware adapters
layer that supports integration of various types of endpoints (OPC, databases, and web services accessible
applications), and maps of the information flowing between those endpoints and elements of the model.

There are really two views of the IBM Integrated Information Core semantic model:
v Reference model
v Instantiated model
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Reference model (ontology)

This view defines the classes that exist in the model and the relations between them, but does not
correspond to any particular enterprise or asset.

Instantiated model

This view includes instances of the classes that have a direct mapping to real-world entities. They are
populated with a set of properties (for example, location, temperature) and with relationships to other
instantiated entities in the model.
Related concepts:
“Customizing the connected resource network” on page 146
A connected resource network is a network of connected pipes, sewers, or other nodes. Examples of a
connected resource network are a pipe network and a sewer network. By extending the IBM Intelligent
Operations for Water semantic model, you can customize the connected resource network to meet your
requirements.

Customizing asset types and instance
Assets types such as sensors and meters are central to the infrastructure of water management systems.
Using the IBM Intelligent Operations for Water semantic model, you can distinguish between asset types.
Changes to the infrastructure, for example adding asset types, requires that you update the model
instance. Use the tasks in this section to customize the IBM Intelligent Operations for Water semantic
model to your implementation.
Related concepts:
“Samples” on page 6
IBM Intelligent Operations for Water provides samples that show the features that are available in IBM
Intelligent Operations for Water, and how to use them.

Defining asset types:

Use the information in this section to define asset types.

Operators use the Map portlet and Details portlet to work with asset types. A number of asset types are
packaged in the IBM Intelligent Operations for Water content pack. For example, Trunk Line Monitor,
Wastewater Plant, River Gauge, Lift Station, Rain Gauge, CSO Diversion Structure. To view the packaged
asset types on the IBM Intelligent Operations for Water interface, open the Map portlet, and navigate to
the Select Content: Asset Types option. Asset types are displayed in the Asset Type column on the
Assets tab of the Details portlet. You can define your own asset types, as the topics in this section
describe.
Related concepts:
“Samples” on page 6
IBM Intelligent Operations for Water provides samples that show the features that are available in IBM
Intelligent Operations for Water, and how to use them.

Modifying the packaged asset types:

You can update the asset types that are packaged with IBM Intelligent Operations for Water.

Before you begin

To perform any model management tasks in IBM Intelligent Operations for Water you must be logged on
as administrator and have access to the IBM Integrated Information Core administrative console on the
application server.
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About this task

To modify the existing asset type ontology, you must export the packaged asset type ontology.

Procedure

1. Open your web browser.
2. Enter the web address supplied by your system administrator that points to the application server

that is running the IBM Integrated Information Core administrative console software. For example:
http://management node:82/iic/console. The administrative console login window is displayed.

3. Select the Model Manager tab. The Model Manager tab displays consolidated model management
data and provides options to change, query, and manage the semantic model.

4. Click Ontologies from the options on the left side of the tab. The asset type ontology is initially
named asset_type.owl. The output of the file is an RDF file with the xml extension. You can use a
plain text editor or an RDF editor to edit the file.

5. Right-click the asset type ontology from the list, and click Export. The asset type ontology is initially
named asset_type.owl. The output of the file is an RDF file with the .xml extension. You can edit the
file with a plain text editor or an RDF editor.

6. Select the destination folder for the ontology.

What to do next

The packaged ontology is now available for subsequent customization.

Defining a new asset type:

When you define a new asset type, you modify the owl ontology and then add the new asset type.

Before you begin

Before extending the model, consider the classes that already exist and consider extending the most
appropriate subtype. WIH itself has two specific extension points: WIH_SensorMeter_Asset, which can be
used for any kind of water sensor or meter, and WIH_PipelineAsset, which can be used for pipes or other
connectable asset. Both of these extension points are subclassed from RSM_WorkEquipment.

Additionally, IBM Intelligent Operations for Water loads several classes that map to EPANET types. These
include the following class hierarchy, starting with WIH_PipelineAsset and extending through the EPANET
classes:
v + WIH_PipelineAsset

– + EPANET_Entity

- + EPANET_Link

v + EPANET_Pipe

v + EPANET_Pump

v + EPANET_Valve

- + EPANET_Node

v + EPANET_Junction

v + EPANET_Reservoir

v + EPANET_Tank

Procedure

1. Open the exported owl ontology file in any text editor.
2. Modify the owl ontology to add the new asset type. For example, to add a water usage meter type to

the WIH_SensorMeter_Asset class:
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a. Open the ontology file in any text editor.
b. Go to the section below of the ontology file.
c. Add a phrase similar to the following example to the file.

<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#" xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xml:base="http://SunshineWaterGroup" >

<rdf:Description rdf:about="http://SunshineWaterGroup#WaterUsageMeter">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Water Usage Meter</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_SensorMeter_Asset"/>

<rdfs:comment>Water Usage Meter</rdfs:comment>
</rdf:Description>

</rdf:RDF>

Note: The namespace http://SunshineWaterGroup must be unique and applied to all models for a
customer. The namespace is used in subsequent configuration.

3. Save your changes to the file.

What to do next

The updated ontology is now ready to import into the model manager.

Adding the new asset type:

When you add a new asset type, you import the updated asset type ontology into the model manager.

Procedure

1. Log on to the IBM Integrated Information Core administrative console software. For example:
http://management node:82/iic/console. The administrative console login window is displayed.

2. Select the Model Manager tab.
3. Click Load from the options on the left side of the tab. Select the owl file to load into the model

manager.
4. Perform a SPARQL query of the model to verify asset type updates have been registered in the model

manager.
a. Select the Model Manager tab and click Query.
b. Enter the following SPARQL input in the upper part of the tab.

PREFIX cim:http://iec.ch/TC57/CIM-generic#
PREFIX rdfs:http://www.w3.org/2000/01/rdf-schema#
PREFIX wih:http://www.ibm.com/water/wih#
SELECT ?object_ID ?object_Name ?object_Comment
WHERE {

?object_ID rdfs:subClassOf wih:WIH_SensorMeter_Asset; rdfs:label ?object_Name.
OPTIONAL { ?object_ID rdfs:comment ?object_Comment. }

}

5. Perform the check. The query results are displayed in the lower part of the tab.
Related tasks:
“Configuring the IBM Intelligent Operations for Water database with the new asset type”
When you configure the IBM Intelligent Operations for Water database with a new asset type, you
update the table to add the new namespace URL in the model.

Configuring the IBM Intelligent Operations for Water database with the new asset type:

When you configure the IBM Intelligent Operations for Water database with a new asset type, you
update the table to add the new namespace URL in the model.
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Procedure

1. Log on to the Data server.
2. Open the database table: WIH_GLOBAL_CONFIG. See the related task.
3. Update the value of the RDF_PREFIX configuration key with the value that was used when adding

the new asset type. For example, http://SunshineWaterGroup. See the related task.

Note: The value in the RDF_PREFIX field must match the namespace URL in the model.
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#"
xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xml:base="http://SunshineWaterGroup" >

4. Open the IBM Intelligent Operations Center application at http://host/wpsv70/wps/portal, select the
Water tab, and click Select Content to ensure that the additional types you defined appear in the
Asset Type list. If the additional types do not appear in the Asset Type list, review the related task
and confirm that the correct definition is included.

Results

The database table recognizes the new asset type.
Related tasks:
“Adding the new asset type” on page 138
When you add a new asset type, you import the updated asset type ontology into the model manager.
“Opening the database table”
If an IBM Intelligent Operations for Water procedure instructs you to open the database table and you are
uncertain about how to perform that step, follow the steps in this topic.

Opening the database table:

If an IBM Intelligent Operations for Water procedure instructs you to open the database table and you are
uncertain about how to perform that step, follow the steps in this topic.

Procedure

1. Log on to the database server as root, type xhost +, and press Enter.
2. Change to user db2inst1, type su - db2inst1, and press Enter.
3. Type db2cc to open the DB2® Connect Client.
4. In All Databases, select the WIHDB database.
Related tasks:
“Configuring the IBM Intelligent Operations for Water database with the new asset type” on page 138
When you configure the IBM Intelligent Operations for Water database with a new asset type, you
update the table to add the new namespace URL in the model.

Creating an asset model instance:

IBM Intelligent Operations for Water requires metadata to provide context and value to information
displayed in portals. When customizing the model, you must also add metadata specific to sensors and
meters including information such as asset type, asset name, asset description, measurement types and so
on. Use the information in this topic to create an asset model instance with model metadata.

Modifying the packaged asset model:

When you modify the existing asset model, you must export the packaged asset model.
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Before you begin

To perform any model management tasks in IBM Intelligent Operations for Water you must be logged on
as administrator and have access to the IBM Integrated Information Core administrative console on the
application server.

Procedure

1. Open your web browser.
2. Enter the web address supplied by your system administrator that points to the application server

that is running the IBM Integrated Information Core administrative console software. For example:
http://management node:82/iic/console. The administrative console login window is displayed.

3. Select the Model Manager tab. The Model Manager tab displays consolidated model management
data and provides options to change, query, and manage the semantic model.

4. Click Graphs from the options on the left side of the tab.
5. Right-click the graph from the list, and click Export.
6. Select the destination folder for the model instance

What to do next

The model instance is now available for subsequent customization.

Defining a new asset instance:

When you define a new asset instance, the model instance metadata is captured in the RDF file.

Procedure

1. Open the exported model instance RDF file.
2. To modify the model namespace.

a. Navigate to the section below of the file.
b. Add a phrase similar to the following example.

<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:cim="http://iec.ch/TC57/CIM-generic#" xmlns:dm="http://iec.ch/2002/schema
/CIM_difference_model#" xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:tns="http://SunshineWaterGroup#" xml:base="http://SunshineWaterGroup">

Note: The namespace must be unique and applied to all models for a customer.
3. To define an asset in the model instance.

a. Navigate to the section below of the file.
b. Add a phrase similar to the following example.

<tns:WaterUsageMeter rdf:ID="WaterUsageMeter_1">
<cim:RSM_IdentifiedObject.name>Water Usage Meter 1</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Water Usage Meter 1</cim:RSM_UnnamedObject.description>

</tns:WaterUsageMeter>

4. To define an asset location in the model instance.
a. Navigate to the section below of the file.
b. Add a phrase similar to the following example.

<cim:RSM_GeoSpacial rdf:ID="WaterUsageMeter_1_Location">
<cim:RSM_IdentifiedObject.name>WaterUsageMeter_1_Location</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>WaterUsageMeter_1_Location</cim:RSM_UnnamedObject.description>
<cim:RSM_Location.TypeOfLocation>ISO6709</cim:RSM_Location.TypeOfLocation>
<cim:RSM_GeoSpacial.InternalLocation>41.69974,-86.31132</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#WaterUsageMeter_1"/>

</cim:RSM_GeoSpacial>
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5. To define a measurement provided by an asset.
a. Navigate to the section below of the file.
b. Add a phrase similar to the following example.

<cim:RSM_Measurement rdf:ID="WaterUsageMeter_1_WaterUsage">
<cim:RSM_IdentifiedObject.name>Water Usage</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Water Usage</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>tons</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#WaterUsageMeter_1"/>
<cim:RSM_Measurement.Type>WaterUsage</cim:RSM_Measurement.Type>

</cim:RSM_Measurement>

6. To define a measurement value provided by an asset.
a. Navigate to the section below of the file.
b. Add a phrase similar to the following example.

<cim:RSM_MeasurementValue rdf:ID="WaterUsageMeter_1_WaterUsage_Value">
<cim:RSM_IdentifiedObject.name>WaterUsageMeter_1_WaterUsage_Value</cim:RSM_IdentifiedObject.name>

<cim:RSM_UnnamedObject.alias>water_usage_1</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement rdf:resource="#WaterUsageMeter_1_WaterUsage"/>

</cim:RSM_MeasurementValue>
</rdf:RDF>

Note: The alias of the measurement value must be unique as the IBM Intelligent Operations for
Water event flow uses the alias to identify and read data related to the measurement.

7. Save your model instance metadata updates by saving the file.

Importing asset data into the model instance:

When you update the model instance with new asset data, you must import the updated model instance
into the model manager.

Procedure

1. Log on to the IBM Integrated Information Core administrative console software. For example:
http://management node:82/iic/console. The administrative console login window is displayed.

2. Select the Model Manager tab.
3. Click Load from the options on the left side of the tab. Select the RDF file to load into the model

manager.
4. Perform a SPARQL query of the model to verify the data has loaded in the model manager.

a. Select the Model Manager tab and click Query.
b. Enter the following SPARQL input in the upper part of the tab.

PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX wih:<http://www.ibm.com/water/wih#>
SELECT *
WHERE {
?asset_ID a wih:WIH_SensorMeter_Asset; a ?asset_Type_ID.
?asset_ID cim:RSM_IdentifiedObject.name ?asset_Name.
OPTIONAL { ?asset_ID cim:RSM_UnnamedObject.description ?asset_Description. }
}

5. Perform the check. The query results are displayed in the lower part of the tab.

Updating the database with model changes:

When you update the database with model changes, you synchronize model instance changes to the
database.
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About this task

To update the database with model instance changes, a script is available.

Procedure

1. Log on to the application server and go the following folder:/opt/IBM/iss/iow/apps
2. Run the following command to update the database with model changes.

./syncModelToDB.sh MGMT_NODE_HOSTNAME 82 DB_NODE_HOSTNAME 50000 db2inst1 DB_PASSWORD PREFIX

where
v MGMT_NODE_HOSTNAME is the fully qualified host name of the management node.
v DB_NODE_HOSTNAME is the fully qualified host name of the database node.
v DB_PASSWORD is the password of the DB2 user db2inst1.
v PREFIX is the namespace URL of the model. For example, http://SunshineWaterGroup.

Note: When you update the model, you must run the command in Step 2 to synchronize model
changes to the database.

Results

The database is updated with model instance changes.

Configuring the interface to display model changes:

To view the underlying model changes in IBM Intelligent Operations for Water interface, you need to
perform the configuration steps in this section.

About this task

Both the Map portlet and the Details portlet are used to represent the underlying model in the IBM
Intelligent Operations for Water interface. When you add new logical zones, change geographic areas,
create new assets types, add new measurements, or set new thresholds for indicators, you must configure
the interface for those model changes. Use the steps in this task to configure the interface for model
changes.

Defining an icon to represent the asset type:

When you create a new asset type you must assign an icon to that asset type so that the asset can be
viewed in the portlets, and be distinguished from other assets in the IBM Intelligent Operations for Water
interface.

About this task

To define an icon to represent an asset type:

Procedure

1. Go to the database server.
2. Open the IOW database: WIHDB. DB2 instance: db2inst1.
3. Use the script to insert the image configured for the new asset into the CONFIG_ASSET_IMAGE

table.
INSERT INTO WIH.CONFIG_ASSET_IMAGE (ASSETTYPE,SMALLICONURL,LARGEICONURL,HIGHLIGHTICONURL,GREYICONURL)
VALUES (

’http://SunshineWaterGroup#WaterUsageMeter’,
’/water_wih_common_widgets_web/images/Small/FlowMeter.General_16.png’,
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’/water_wih_common_widgets_web/images/Large/FlowMeter.General_38.png’,
’/water_wih_common_widgets_web/images/Hilite/FlowMeter.General_38_HILITE.png’,
’/water_wih_common_widgets_web/images/Grey/FlowMeter.General_38_GREY.png’

);

Note: If you need to create new icons, use the size and style of the existing icons. The packaged icons
are available in the water_wih_common_widgets_web/images folder.

Configuring asset key measurements:

Asset may contain a number of measurements. In the IBM Intelligent Operations for Water interface, one
is selected as the key measurement. Use the information in this topic to configure asset measurements.

About this task

To configure asset measurements.

Procedure

1. Go to the database server.
2. Open the IOW database: WIHDB.
3. Open the KEY_MEASUREMENT_CONFIG database table.
4. Create a mapping in a table row between the work equipment and the key measurement.

a. WORKEQUIPMENT_RDFID = <namespaceURL>#<ID of asset>

b. KEY_MEASUREMENT_RDFID = <namespaceURL>#<ID of measurement>

For example: WORKEQUIPMENT_RDFID = http://cityName#LiftStation1 and
KEY_MEASUREMENT_RDFID = http://cityName# LiftStation1-M.Pump1-CRT.

Setting thresholds for asset measurements:

Measuring the performance of assets in the infrastructure is important to determine operational efficiency.
By setting the thresholds for asset measurements, you can monitor the status of assets and define
acceptable and unacceptable boundaries for measurement values. The Details portlet uses these
measurements to indicate when status values are acceptable (green), warrant caution (yellow), or are
critical (red) and require immediate attention. Use the information in this topic to set thresholds for asset
measurements.

Procedure

1. Locate the asset and measurement value for which you want to set thresholds, described in the
related task. Read the value from the Alias field of the Measurement Details dialog.

2. Go to the database server.
3. Open the Water Information Hub database: WIHDB.
4. Open the MEASUREMENT_VALUE database table.
5. In the MEASUREMENT_VALUE_ALIAS column, search for the alias identified in step 1. Note the

value in the MEASVAL_ID column for the measurement.
6. Open the THRESHOLD_CONFIG table. In the MEASVAL_ID column, search for the measurement

value identified in step 5.
7. Edit the threshold values in the row to update range start and end.

Valid threshold values are as follows:
v 0 (Acceptable)
v 1 (Caution)
v 2 (Critical)
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Related information:
Displaying measurement values for assets
Use the information in this topic to display measurement values for water assets and equipment on the
Operator: Operations view.

Specifying settings when reading no measurement data:

Use the information in this topic to specify timeout settings when there are no measurement data
readings. By setting the timeout value, you can configure when the status notifications are displayed on
the Details portlet in the event that no measurement reading is received from a sensor or asset.

Procedure

1. Go to the database server.
2. Open the Water Information Hub database: WIHDB.
3. Open the NO_DEVICE_READING_CONFIG database table.
4. In the MEASVAL_ID column, search for the measurement value you want to update.
5. Edit the timeout value for the selected measurement value. Enter the measurement in milliseconds.

Note: When the timeout value is specified, if no new data is read after the specified time interval, the
measurement status in the Assets tab of the Details portlet displays NO READING (grey
background).

Setting up logical zones for assets:

Logical zone settings are displayed on the Map portlet. Use the information in this topic to configure
logical zones to filter assets by geographical location.

Procedure

1. Go to the database server.
2. Open the Water Information Hub database: WIHDB.
3. Open the ZONES database table.
4. Add a new entry to the zone table using the following sample SQL.

INSERT INTO WIH.ZONES(PREFIX, NAME, DESCRIPTION, LOCATION)
VALUES (
’http://sampleCity’,
’Test Zone 1’,
’Test Zone 1’,
db2gse.ST_Polygon (’polygon ((-86.25021 41.72178, -86.24953 41.60175, -86.17674 41.59815,
-86.16301 41.73511, -86.25021 41.72178))’, 1003)
);

Configuring the Map portlet default location:

Use the information in this topic to configure the longitude and latitude settings for the Map portlet.

Before you begin

You must be logged on as administrator to configure the default location.

About this task

To configure the default location.
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Procedure

1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. Select Edit > Configure on the Map portlet.
4. Change the values in the Center latitude and Center longitude fields as required.

Verifying data flow using the Simulator:

IBM Intelligent Operations for Water provides a simulation tool that monitors incoming folders, parses
CSV files, and sends data readings. You can use the Simulator to check operational data flows sourced
from external systems.

Before you begin

The Simulator is installed on the application server in the directory: /opt/IBM/iss/iow/apps/simulator.
Before you start the Simulator, please check you have configuration settings as follows in the
simulator.properties file.
[root@icpvm19671 simulator]
# cat simulator.properties
#This file is use to define properties for CSV simulator

#WAS Server host name where JMS Connection Factory is configured.
hostname=icpvm19671.cn.ibm.com

#WAS Server port where JMS Connection Factory is configured.
port=10035

#Queue connection factory JNDI name
target.queue.connection.factory=jms/wih.mb.con.factory

#Queue JNDI Name
target.queue=jms/water.wih.reading.in.q

#The directory where the incoming message file is put.
#Once new files are copied into this folder, the file will processed.
incoming.message.dir=/opt/IBM/iss/iow/apps/simulator/incoming

#After new files are processed, the processed files will be copied into this directory.
processed.message.dir=/opt/IBM/iss/iow/apps/simulator/incoming/processed

# In millisecond. This configuration is used to define the scan interval.
By default, incoming.message.dir will be scanned every 5 seconds.
scan.interval=5000

# In millisecond. This configuration is used to define the message sending interval.
The message found will be sent every configured milliseconds.
send.interval=10000

Procedure

1. Start the Simulator by running the following command:
nohup ./run_simulator.sh > simulator.log &

Note: Check the Simulator is not already running. To check the startup status, view the Simulator log
by entering the command: tail –f simulator.log. If the Simulator is running, you will need to stop
and restart if you have made any changes to the configuration.

2. Create and send the sample reading data.
a. Locate a measurement reading in the IBM Intelligent Operations for Water interface as described

in the link below. Remember the alias of the selected measurement.
b. Create a new CSV file to simulate a new measurement reading. For example:
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water_usage_4,1.0,2012-05-23T14:30:01.0+08:00

c. Send the reading to IBM Intelligent Operations for Water. Copy the CSV to the Simulator by
running the following command.
cp Reading1.csv /opt/IBM/iss/iow/apps/simulator/incoming/

3. Verify the value, status trending, and send time in the IBM Intelligent Operations for Water interface
has changed.

Related tasks:
“Verifying the message flow” on page 153
You can verify that the measurement reading event flows are forwarded to the WATER.USAGE.INI queue.
Related information:
Displaying measurement values for assets
Use the information in this topic to display measurement values for water assets and equipment on the
Operator: Operations view.

Customizing the connected resource network
A connected resource network is a network of connected pipes, sewers, or other nodes. Examples of a
connected resource network are a pipe network and a sewer network. By extending the IBM Intelligent
Operations for Water semantic model, you can customize the connected resource network to meet your
requirements.

See the related link for information about the semantic network.
Related concepts:
“Customizing the model” on page 135
By extending the IBM Intelligent Operations for Water semantic model, you can build a customized
model to meet your requirements. Use the information in this section to customize the semantic model.

Defining the customized connected resource network asset type
When you define a customized connected resource network asset type, you import the asset type into the
model manager.

Before you begin

To perform any model management tasks in IBM Intelligent Operations for Water you must be logged on
as administrator and have access to the IBM Integrated Information Core administrative console on the
application server.

Procedure
1. Define the new customized connected resource network asset type.

a. Open the exported owl ontology file in any text editor
b. Modify the owl ontology to add the new asset type. To add a customized connected resource

network asset type to the WIH_Pipeline_Asset class:
1) Open the ontology file in any text editor.
2) Go to the section below of the ontology file.
3) Add a phrase similar to the following example to the file.

<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#" xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xml:base="http://SunshineWaterGroup" >
<rdf:Description rdf:about="http://SunshineWaterGroup#Pipe">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Pipe</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_Pipeline_Asset"/>
<rdfs:comment>Pipe</rdfs:comment>
</rdf:Description>
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<rdf:Description rdf:about="http://SunshineWaterGroup#Junction">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/
<rdfs:label xml:lang="en">Junction</rdfs:label>
<rdfs:subClassOf rdf:resource="http://www.ibm.com/water/wih#WIH_Pipeline_Asset"/
<rdfs:comment>Junction</rdfs:comment>
</rdf:Description>
</rdf:RDF>

Note: The namespace http://SunshineWaterGroup must be unique and applied to all models
for a customer. The namespace is used in subsequent configuration.

c. Save your changes to the file.
2. Import the updated asset type ontology into the model manager.

a. Log on to the IBM Integrated Information Core administrative console software. For example:
http://management node:82/iic/console. The administrative console login window is displayed.

b. Select the Model Manager tab.
c. Click Load from the options on the left side of the tab. Select the owl file to load into the model

manager.
d. Perform a SPARQL query of the model to verify asset type updates have been registered in the

model manager.
1) Select the Model Manager tab and click Query.
2) Enter the following SPARQL input in the upper part of the tab.

PREFIX cim:http://iec.ch/TC57/CIM-generic#
PREFIX rdfs:http://www.w3.org/2000/01/rdf-schema#
PREFIX wih:http://www.ibm.com/water/wih#
SELECT ?object_ID ?object_Name ?object_Comment
WHERE {

?object_ID rdfs:subClassOf wih:WIH_SensorMeter_Asset; rdfs:label ?object_Name.
OPTIONAL { ?object_ID rdfs:comment ?object_Comment. }

}

e. Perform the check. The query results are displayed in the lower part of the tab.

Creating the connected resource network model instance
The connected resource network asset instances define the resources, the junctions of the connected
resource network, and their relationship. Use the information in this topic to create a connected resource
network model instance.

About this task

The model instance metadata is captured in the RDF file. Use the RSM_ConnectionPoint and
ISO15926_ConnectionNode classes to define the assets and to describe the connections between assets.

Procedure
1. Open the exported model instance RDF file.
2. Define the asset instances in the connected resource network.

a. Navigate to the section below of the file.
b. Add content similar to the following example.

<?<?xml version="1.0" encoding="UTF-8"?"?>
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:cim="http://iec.ch/TC57/CIM-generic#" xmlns:dm="http://iec.ch/2002
/schema/CIM_difference_model#"
xmlns:tns="http://sampleCity#" xml:base="http://SunshineWaterGroup">
<!-a Tank segment - START ->
<tns:Junction rdf:ID="Junction1">

<cim:RSM_IdentifiedObject.name>Junction1</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.mrid>Junction1</cim:RSM_UnnamedObject.mrid>
<cim:RSM_PhysicalEntity.TypeOfPhysicalEntity>WorkEquipment
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</cim:RSM_PhysicalEntity.TypeOfPhysicalEnt>
<cim:RSM_WorkEquipment.TypeOfEquipment>Tank</cim:RSM_WorkEquipment.TypeOfEquipment>

</tns:Junction>
<cim:RSM_GeoSpacial rdf:ID="Junction1-Location>
<cim:RSM_IdentifiedObject.name>Junction1-Location</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Junction1-Location/<cim:RSM_UnnamedObject.description>
<cim:RSM_Location.TypeOfLocation>ISO6709</cim:RSM_Location.TypeOfLocation>
<cim:RSM_GeoSpacial.InternalLocation>41.70158782221015,-86.2688320725981
</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#Junction1"/>
</cim:RSM_GeoSpacial>
<tns:Pipe rdf:ID="Pipe1">
<cim:RSM_IdentifiedObject.name>Pipe1</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.mrid>Pipe1</cim:RSM_UnnamedObject.mrid>
<cim:RSM_PhysicalEntity.TypeOfPhysicalEntity>WorkEquipment
</cim:RSM_PhysicalEntity.TypeOfPhysicalEntity>
<cim:RSM_WorkEquipment.TypeOfEquipmen>Pipeline</cim:RSM_WorkEquipment.TypeOfEquipment>
</tns:Pipe>
<cim:RSM_GeoSpacial rdf:ID="Pipe1-Location">
<cim:RSM_IdentifiedObject.name>Pipe1-Location</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Pipe1-Location</cim:RSM_UnnamedObject.description>
<cim:RSM_Location.TypeOfLocation>ISO6709</cim:RSM_Location.TypeOfLocation>
<cim:RSM_GeoSpacial.InternalLocation>41.671220788544815,-86.23071260541845
</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#Pipe1"/>
</cim:RSM_GeoSpacial>

3. Define the connection points of the asset instances.
a. Navigate to the section below of the file.
b. Add content similar to the following example.

<cim:RSM_ConnectionPoint rdf:ID="Pipe1_CPoint1">
<cim:RSM_IdentifiedObject.name>Pipe1_CPoint1</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.mrid>Pipe1_CPoint1</cim:RSM_UnnamedObject.mrid>
<cim:RSM_ConnectionPoint.belongsTo_PhysicalEntity rdf:resource="#Pipe1"/>
<cim:ISO15926_ConnectionPoint.To_ConnectionNode rdf:resource="#Pipe1_Junction1_CNode"/>
</cim:RSM_ConnectionPoint>
<cim:RSM_ConnectionPoint rdf:ID="Junction1_CPoint1">
<cim:RSM_IdentifiedObject.name>Junction1_CPoint1</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.mrid>Junction1_CPoint1</cim:RSM_UnnamedObject.mrid>
<cim:RSM_ConnectionPoint.belongsTo_PhysicalEntity rdf:resource="#Junction1"/>
<cim:ISO15926_ConnectionPoint.To_ConnectionNode rdf:resource="#Pipe1_Junction1_CNode"/>
</cim:RSM_ConnectionPoint>

4. Define the connection node that connect two connection points.
a. Navigate to the section below of the file.
b. Add a phrase similar to the following example.

<cim:ISO15926_ConnectionNode rdf:ID="Pipe1_Junction1_CNode">
<cim:RSM_IdentifiedObject.name>Pipe1_Junction1_CNode</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.mrid>Pipe1_Junction1_CNode</cim:RSM_UnnamedObject.mrid>
Pipe1_Junction1_CNode>
</cim:ISO15926_ConnectionNode>

5. Save your model instance metadata updates by saving the file.
6. Import the customized resource network instances into model server.

a. Log on to the IBM Integrated Information Core administrative console software. For example:
http://management node:82/iic/console. The administrative console login window is displayed.

b. Select the Model Manager tab.
c. Click Load from the options on the left side of the tab. Select the owl file to load into the model

manager.
d. Perform a SPARQL query of the model to verify asset type updates have been registered in the

model manager.
1) Select the Model Manager tab and click Query.
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2) Enter the following SPARQL input in the upper part of the tab.
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX wih:<http://www.ibm.com/water/wih>
SELECT *
WHERE {
?asset_ID a wih:WIH_Pipeline_Asset; a ?asset_Type_ID.
?asset_ID cim:RSM_IdentifiedObject.name ?asset_Name.
OPTIONAL { ?asset_ID cim:RSM_UnnamedObject.description ?asset_Description. }

e. Perform the check. The query results are displayed in the lower part of the tab.

Using the command line to generate connected resource network asset instances:

You can use the command line to create a new RDF file. Use the information in this topic to generate
connected resource network asset instances.

Procedure

1. Log on to the WebSphere Application Server administrative console at http://
APPLICATION_SERVER_HOST:9060/admin using the WebSphere Application Server Administrative ID
admin and password. APPLICATION_SERVER_HOST is the host name for the application server.

2. Select the /opt/IBM/iss/iow/apps folder, and submit the following command:
opt/IBM/WebSphere/AppServer/java/bin/java -jar ModelUtil.jar pipe_asset_csv_file
pipe_link_csv_file rdf_filebase_namespacebase_namespace_name,
where
v pipe_asset_csv_file is a file that defines the connected resource network assets in CSV format. The

first column is the unique ID of the asset, the second column is the custom-defined type ID, and
the third column is the asset location.
For example,
sunshine_pipeline_assets.csv:
Name,Type,Location
Junction_26103,Junction,"25.769364482651095,-80.23951063848175"
Junction_26103xexe1,Junction,"25.77021366468323,-80.24000354629214"
Pipe_610e1,Pipe,"25.769789073667162,-80.23975709238695"

v pipe_link_csv_file is a file that defines the connection between assets. The first column is the unique
ID of the asset, and the second column is the unique ID of the junction.
sunshine_pipeline_connections.csv:
Pipe_610e1,Junction_26103
Pipe_610e1,Junction_26103xexe1

v rdf_file is the file name of the generated RDF file.
v base_namespace is the namespace URL of the generated RDF file.
v base_namespace_name is the prefix of the generated RDF file.
The following example shows the output of a generated .rdf file.
root@app-ioc apps# /opt/IBM/WebSphere/AppServer/java/bin/java -jar ModellUtil.jar
/root/sunshine_pipeline_assets.csv /root/sunshine_pipeline_connections.csv
/root/sunshine_pipeline_instances.rdf http://SunshineWaterGroup tns
RDF file /root/sunshine_pipeline_instances.rdf is generated successfully.

3. Modify the generated .rdf file as needed, or import the generated file directly into the model server.
Follow these steps to import the .rdf file into the model server:
a. Open the model manager console at http://<mngt_node>:82/iic/console.
b. Select Model Manager > Load, and upload the .rdf file.
Follow these steps to upload the modified .rdf file into the model server:
a. Open the model manager console at http://<mngt_node>:82/iic/console.
b. Select Model Manager > Graphs, and delete the original .rdf graph.
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c. Select Model Manager > Load, and upload the updated .rdf file.

Note: You cannot use the command line to modify an existing .rdf file.

Generating a KML file from the connected resource network asset instance
You use a Keyhole Markup Language (KML) file to view the pipe network on the Map portlet. Use the
information in this topic to generate a KML file from the connected resource network asset instance.

Procedure
1. Log on to the WebSphere Application Server administrative console at http://

APPLICATION_SERVER_HOST:9060/admin using the WebSphere Application Server Administrative ID
admin and password. APPLICATION_SERVER_HOST is the host name for the application server.

2. Submit the following command:
/opt/IBM/iss/iow/lib/water_wih_common_utils.jar:/opt/IBM/iss/iow/lib/
water_wih_common_resources_utils.jar:/opt/IBM/iss/common/lib/iss_common.jar:/opt/IBM/iss/
common/lib:/opt/IBM/iss/common/lib/CDI_ModelServer_EJBClient.jar
com.ibm.iss.water.wih.util.KMLGenerator mgmt_node_hostname82targetFolder nameSpacePrefix

For example,
/opt/IBM/WebSphere/AppServer/java/bin/java -cp /opt/IBM/iss/iow/lib/
water_wih_common_utils.jar:/opt/IBM/iss/iow/lib/water_wih_common_resources_utils.jar:/opt/
IBM/iss/common/lib/iss_common.jar:/opt/IBM/iss/common/lib:/opt/IBM/iss/common/lib/
CDI_ModelServer_EJBClient.jar com.ibm.iss.water.wih.util.KMLGenerator mgmt-ioc.cn.ibm.com 82
/tmp http://SunshineWaterGroup A generated KML file named pipenetwork.kml appears in the /tmp
folder.

Configuring the interface to display the generated KML file
After you generate the KML file, you must add it into an existing application. Use the information in this
topic to add the KML file.

Procedure
1. Log on to the WebSphere Application Server administrative console at http://

APPLICATION_SERVER_HOST:9060/admin using the WebSphere Application Server Administrative ID
admin and password. APPLICATION_SERVER_HOST is the host name for the application server.

2. Copy the generated KML file into the following folder:
/opt/IBM/WebSphere/wp_profile1/installedApps/cell1/water_wih_portal_ear.ear/
water_wih_asset_service_web.war/

3. Log on to the IBM Intelligent Operations for Water user interface as operator.
4. Select the Operator: Operations view.
5. Check that the connected resource network appears in the Map portlet.

Customizing data import and operational storage
With IBM Intelligent Operations for Water, you can build a customized data consolidation plan to gather
and reconcile data from many sources. Use the information in this section to customize data population.

IBM Intelligent Operations for Water uses the middleware components provided by IBM Intelligent
Operations Center 1.5 to manage and process data streams sourced from external systems. IBM Intelligent
Operations for Water works with data that is extracted from sources such as sensor systems, meter
systems, or enterprise asset management systems. The extracted data is transformed using WebSphere
Message Broker and then loaded into operational data stores for use by IBM Intelligent Operations for
Water.
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The middleware components accept common separated value (CSV) data feeds. Using the CSV data feed,
IBM Intelligent Operations for Water generates an RDF model that is imported into the model manager.
The model instance is extendable, and describes the water network, assets, connection points and
geographic locations. Working with WebSphere Message Broker, you can create a schedule to connect to
SCADA systems historians.
Related concepts:
Chapter 4, “Integrating the solution,” on page 45
Products and services can be integrated with IBM Intelligent Operations for Water.

Importing data from external systems
WebSphere Message Broker connects applications together, regardless of the message formats or protocols
that they support. For IBM Intelligent Operations for Water, data that is exported from external systems is
available as CSV files. Data that is imported to IBM Intelligent Operations for Water through WebSphere
Message Broker is validated, enriched, transformed, and then routed to the appropriate data stores.

IBM Intelligent Operations for Water uses a common data ingest mechanism. Sensor or meter data that is
exported from data management systems as CSV files is ingested into IBM Intelligent Operations for
Water internal data stores. When the CSV file is exported from the data management system, the data is
placed on a WebSphere Message queue: Water.Usage.IN. WebSphere Message Broker applications monitor
the queue. When a message that contains water usage reading data is placed on the queue, the data in
the queue is updated in the IBM Intelligent Operations for Water analytic data stores. When the
WebSphere Message Broker data consolidation is completed, data is forwarded to the WIH.READING.IN
queue for operational processing by IBM Intelligent Operations for Water.

Checking extended model data is in the operational database
Use the information in this task to check extended model data is in the operational database.

Before you begin

Ensure that you have completed any customization steps to extend the model. The operational database
must be configured with the required asset types. Review the steps described in “Customizing asset types
and instance” on page 136 to ensure that the operational database is updated with model instance
changes.

About this task

Procedure
1. Log in to the database server as root and enter xhost +.
2. Change to user db2inst1 and enter su - db2inst1.
3. Enter db2cc to open the DB2 Control Center.
4. Select the All Databases option to view the availableIBM Intelligent Operations for Water orIBM

Intelligent Operations Center databases. Select WIHDB to view the IBM Intelligent Operations for
Water database.

Working with imported data
Use the information in this topic to work with imported data.

WebSphere Message Broker integrates the applications that supply and use data in the operational store.
WebSphere Message Broker routes data to a number of locations.
v Data is routed to the operational store for use by the model manager.
v Data is routed to the geo-spatial store where sensor data resides.
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v Data is routed to the reporting and analytical store where custom report and advanced analytic data
resides.

v Data is routed to the IBM Intelligent Operations Center event and KPI subsystems for impact analysis
and event correlation.

Preparing for the analytical database
To prepare the analytical database, you must create and catalog the database.

Before you begin

Ensure that database connections have been established before you run the scripts provided by IBM
Intelligent Operations for Water.

Procedure
1. Create the database on the database server.
2. Insert the sample data.
3. Catalog the WIHANLDB database to the event server.

a. Create the ODBC source on the Event server.
b. Edit the /var/mqm/odbc.ini file to add the following stanza

;# DB2 stanza
[WIHANLDB]
;#DRIVER=libdb2Wrapper.so
DRIVER=/opt/IBM/DB2/lib64/libdb2.so
Description=WIHANLDB DB2 ODBC Database
Database=WIHANLDB

Defining the message flow
To define the message flow, you must be familiar with WebSphere Message Broker and know how to
create the queue and import the required data to create the message flow.

Procedure
1. Create Queue WATER.USAGE.IN in WIH.MB.QM queue manager in WebSphere MQ Explorer.
2. Install the WebSphere Message Broker Toolkit 8.0.
3. Import the required code to WebSphere Message Broker Toolkit 8.0 to create the message flow

WATER.USAGE.IN ---> Compute ---> WIH.READING.IN

Related information:

WebSphere Message Broker information center

Deploying the message flow
To deploy the message flow, you must be familiar with WebSphere Message Broker commands required
to associate a specific user ID and password with one or more resources that are accessed by the broker.

Procedure
1. Set up security credentials for WIHANLDB using the WebSphere Message Broker command.

mqsisetdbparms WIH_BROKER -n WIHANLDB -u db2inst1 -p passw0rd

2. Deploy the message flow directly using the WebSphere Message Broker Toolkit.
a. Select the required flow.
b. Open the Deploy window.
c. Click Finish to deploy.

3. Optionally, you can deploy the generated bar file directly using the following command.
${MB_HOME}/bin/mqsideploy WIH_BROKER –e default –a <barfile_path>
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4. Restart WebSphere Message Broker.
Related information:

WebSphere Message Broker information center

Working with the message queues
Create the Java Message Service (JMS) queue on the Portal server by updating resource settings using the
WebSphere Application Server administrative console.

Procedure
1. Log on to the WebSphere Application Server administrative console at the following URL:

https://appserver:9043/ibm/console

2. Select Resources > JMS > Queues.
3. Modify the Scope to read Cluster=Portal and click New.
4. Click WebSphere MQ messaging provider when selecting the JMS resource provider.
5. Create a JMS queue for the WATER.USAGE.INI message queue with the following entries.

a. Name: water.usage.in.q

b. JNDI name: jms/water.usage.in.q

c. Queue name: WATER.USAGE.IN

d. Queue manager: WIH.MB.QM

6. Go to Servers > Clusters > WebSphere application server clusters. Restart the Portal server.

Verifying the message flow
You can verify that the measurement reading event flows are forwarded to the WATER.USAGE.INI queue.

Procedure
1. Perform the verification steps in the linked topic.
2. Set the target queue in the simulator.properties file.

target queue = jms/water.usage.in.q

3. Log on to the WebSphere Application Server administrative console at the following URL:
https://appserver:9060/ibm/console

4. Go to Servers > Clusters > WebSphere application server clusters.
5. Restart the Portal cluster.
Related tasks:
“Verifying data flow using the Simulator” on page 145
IBM Intelligent Operations for Water provides a simulation tool that monitors incoming folders, parses
CSV files, and sends data readings. You can use the Simulator to check operational data flows sourced
from external systems.

Customizing data processing
You can customize data processing in IBM Intelligent Operations for Water to suit the requirements of
your operational and executive staff. By specifying and implementing user specific Key Performance
Indicators (KPIs), you can establish service level agreements and key measurements to meet the
performance needs of your organization and key stakeholders.

Customizing data processing involves working with IBM Intelligent Operations Center to build and
deploy customized KPIs that are used in IBM Intelligent Operations for Water. You should be familiar
with the following tasks.

Defining the KPI CAP Event
Before defining or modifying a KPI you must understand the Common Alerting Protocol (CAP)
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alert on which the KPI is based. For example, if you are defining a KPI that tracks the status of
water pressure sensors, you must know the CAP elements to track (water sensor name, reading
time, reading status, reading value).

Creating a KPI Model
With your understanding of the Common Alerting Protocol (CAP) alert and purpose of the KPI,
you can begin to model the KPI using available tooling.

Creating a KPI Policy
The KPI policy sets the framework for when KPI processing is triggered, when data consolidation
happens, when KPI CAP events are built and sent to the IBM Intelligent Operations Center.

This section provides guidelines on how to create and deploy a customized KPI using the samples
provided in the IBM Intelligent Operations for Water content pack.
Related concepts:
Chapter 4, “Integrating the solution,” on page 45
Products and services can be integrated with IBM Intelligent Operations for Water.

Defining a KPI CAP event
Events are received by IBM Intelligent Operations for Water in the Common Alerting Protocol (CAP)
format. The events are displayed on both the Map and Details portlets.

About this task

The WebSphere Message Broker, which is provided with IBM Intelligent Operations Center, accepts CAP
event messages and uses the data in KPI calculations. KPI definitions determine how events are
displayed. For example, if a KPI threshold is exceeded, the event might be flagged with a higher urgency
or severity. The following is a sample KPI CAP event definition.
<?xml version="1.0" encoding="UTF-8"?>
<cap:alert xmlns:cap="urn:oasis:names:tc:emergency:cap:1.2"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance“ xsi:schemaLocation="urn:oasis:names
:tc:emergency:cap:1.2 CAP-v1.2-os.xsd ">
<cap:identifier>c329ac4e-c9e0-47d7-85b6-369d242ad2b1</cap:identifier>
<cap:sender>My_KPI_Policy</cap:sender>
<cap:sent>2012-03-07T12:30:00-05:00</cap:sent>
<cap:status>Actual</cap:status>
<cap:msgType>Alert</cap:msgType>
<cap:scope>Public</cap:scope>
<cap:code>KPI</cap:code>
<cap:info>
<cap:category>Infra</cap:category>
<cap:event>water_pressure_kpi</cap:event>
<cap:urgency>Unknown</cap:urgency>
<cap:severity>Unknown</cap:severity>
<cap:certainty>Unknown</cap:certainty>
<cap:eventCode>
<cap:valueName>OwningOrg</cap:valueName>
<cap:value>Water</cap:value>
</cap:eventCode>
<cap:parameter>
<cap:valueName>Alias</cap:valueName>
<cap:value>water_pressure_1</cap:value>
</cap:parameter>
<cap:parameter>
<cap:valueName>Reading Time</cap:valueName>
<cap:value>2012-06-27T119:00:00.000+08:00</cap:value>
</cap:parameter>
<cap:parameter>
<cap:valueName>Reading Value</cap:valueName>
<cap:value>1</cap:value>
</cap:parameter>
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<cap:parameter>
<cap:valueName>Reading Status</cap:valueName>
<cap:value>1</cap:value>
</cap:parameter>

</cap:info>
</cap:alert>

Related information:
Integrating with the Common Alerting Protocol
CAP structure
Event types
Using CAP for KPI events

Creating a KPI model
KPIs are modeled using Rational Application Developer or WebSphere Integration Developer with the
IBM WebSphere Business Monitor Developers toolkit. For more information on using these tools, see the
information centers for these products.

Procedure

See the IBM Intelligent Operations Center information center for detail about creating a KPI model.
Related information:
Creating and Integrating KPIs
Modeling KPIs

WebSphere Business Monitor information center

IBM developerWorks article: Developing KPIs (Part 1)

IBM developerWorks article: Developing KPIs (Part 2)

Deploying the KPI model to Intelligent Operations Center
After defining key performance indicators (KPIs) and their monitor models, the monitor models need to
be deployed to the IBM WebSphere Business Monitor running on the IBM Intelligent Operations Center
analytic server.

About this task

To deploy a monitor model that will be used by the IBM WebSphere Business Monitor, Java™ Enterprise
Edition (JEE) projects must be generated from the defined models. When the JEE projects are generated,
the model application can be exported as an EAR file. The EAR file can then be deployed into the IBM
WebSphere Business Monitor running on the IBM Intelligent Operations Center analytic server.

Procedure
1. Log on to the WebSphere Application Server administrative console.
2. Select Applications > Application Type > WebSphere Enterprise Applications > Install New

Application.
3. Map the KPI model to the appropriate server. For example, deploy the KPI model EAR file

Water_PressureApplication.ear to target cluster WBM_DE.AppTarget. When the installation is complete,
you receive a notification that the application installed successfully.

4. Go to Applications > Monitor Models to verify the model has been deployed.
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Attention: When deploying the KPI model, a message may be displayed by the WebSphere
Application Server administrative console stating that 'No application modules were mapped to Web
servers. The plug-in configuration file (plugin-cfg.xml) for each Web server is generated based on the
application modules which are mapped to it, therefore no Web server will route requests to this
application. To change this option, select the Map modules to servers step.' You can ignore this
message.

5. To verify that the Water_PressureApplication is started, go to Applications > Application Types >
WebSphere Enterprise Applications and check that the application status is green.

Related information:
Deploying monitor models

Configuring a KPI
Using the IBM Intelligent Operations Center tools, you can customize the Key Performance Indicator
(KPI) models to suit your business processes.

About this task

Use the Key Performance Indicators portlet to customize KPIs in the IBM Intelligent Operations Center.
The Key Performance Indicators portlet is provided for the administrator as one of the Solution
Customization Tools options. Using the portlet, you can view KPI properties; create, copy, or modify
KPIs; and view or change the hierarchical displays for KPI models.

Procedure
1. Log on to IBM Intelligent Operations Center as administrator.
2. Navigate to Administration > Solution Customization Tools > Key Performance Indicators.
3. Use the tree to select the KPI and modify settings as required.

a. Click Add Owning Organization to associate an organization to the KPI.
b. Set the KPI levels as required

4. Click Save.
5. Return to the Executive: Status view.
6. Verify that the KPI is displayed in the Key Performance Indicator Drill Down portlet.

What to do next

Sample KPIs and monitor models are provided with IBM Intelligent Operations Center. The KPIs are
designed to provide guidance for implementing different types of KPIs using the IBM WebSphere
Business Monitor.

The IBM Intelligent Operations Center resource bundles can be used to provide alternate display values
from those values provided by the IBM WebSphere Business Monitor models. For more information on
sample KPIs and customizing display values, read the linked IBM Intelligent Operations Center topics.
Related information:
Customizing KPIs in Intelligent Operations Center
KPI Display values in Intelligent Operations Center
Sample KPIs in Intelligent Operations Center

Checking the KPI
Using the IBM Intelligent Operations Center tools, you can check the Key Performance Indicator (KPI)
models to suit your business processes.
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Procedure
1. In the WebSphere Portal Administration interface, click Intelligent Operations > Demonstration Tools

> Sample Event Publisher.
2. Click the Event Form tab.
3. Click the Event CAP tab.
4. From the Category list, select an event category.
5. For the Event Message field, choose one of the following options:

v To insert the XML for the corresponding pre-written CAP message automatically into the Event
Message field, from the Sample Event list, select an event. If you want, edit the XML to suit your
requirements.

v In the Event Message field, manually enter the XML for the CAP message from scratch.
6. In the Event Instance Count field, either enter the number of messages required, or use the arrows to

select the number of messages required. You can submit a single CAP message or an automated
sequence of messages.

7. Optional: Select the Randomize Events check box. If you select Randomize Events, a sequence of
CAP messages is published with random IDs applied. The messages are published at incremental
time intervals, and in random locations within a range.

8. Click Submit Event.

Results

The Sample Publisher populates the IBM Intelligent Operations Center with events and can trigger KPIs.
Related information:
Creating and publishing test events
Working with the Sample Publisher

Creating a KPI policy
Using Tivoli Netcool/Impact, you can create a customized KPI policy.
Related tasks:
“Creating an event policy” on page 167
An event policy determines when to trigger standard operating procedure processing. A policy also
encompasses event data consolidation, CAP event construction, and sending a CAP event to the IBM
Intelligent Operations Center.

Setting up the project
When you create a KPI policy, the first step is to create a new project in Tivoli Netcool/Impact.

Procedure
1. Log on to Tivoli Netcool/Impact as administrator.
2. On the Projects tab, click the plus sign (+) at the top right.
3. In the Project Name field, type a project name. For example, type My Project.
4. From the List By Section: list, select Data Sources.

a. From the Global Repositories list, select IOC_CAP_IN, click Add, and click OK.
5. From the List By Section: list, select Services.

a. From the Global Repositories list, select WIH_Event_Reader, click Add, and click OK.
6. To verify that the project settings are created correctly, select the project from the Projects: list. For

example, select My Project.
a. Verify that IOC_CAP_IN appears in the List by Section: > Data Sources list.
b. Verify that WIH_Event_Reader appears in the List by Section: > Services list.
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Creating the policy framework
You create a customized KPI policy within the newly created Tivoli Netcool/Impact project.

Procedure
1. Log on to Tivoli Netcool/Impact as administrator.
2. On the Properties tab, select the new impact project and expand the Policies menu.
3. From the Template drop-down list, select Custom and click the plus sign (+) to create a new policy.
4. In the Policy Name field of the Custom tab, type a name for the newly created policy and click Save.

The Tivoli Netcool/Impact policy editor displays content similar to the following example. In the
example, the name of the policy is My_KPI_Policy.
Log(3, "Entry: My_KPI_Policy");
Log(3, "Exit: My_KPI_Policy");

Adding a KPI CAP alert to the policy
If a sensor exceeds a threshold, an event Common Alerting Protocol (CAP) alert is sent to IBM Intelligent
Operations Center to trigger a KPI calculation in IBM WebSphere Business Monitor.

Procedure
1. Log on to Tivoli Netcool/Impact as administrator.
2. Create a CAP event. Select the My_KPI_Policy tab.
3. Retrieve data required from external data sources by using the EventContainer global variable.

IBM Intelligent Operations for Water provides basic variable definitions in the EventContainer global
variable. To access the EventContainer global variable, add content similar to the following example:
Log(3, "Entry:My_KPI_Policy"):
If(EventContainer.MEASUREMENT_TYPE 1= "WaterPressure"){
Log(3, EventContainer.MEASUREMENT_VALUE_ALIAS+ "is not WaterPressure");

You can also retrieve data from any external source. See the following example script.
DataType = "SysProp";
Filter ="Realm = ’System’ AND Subject = ’*’ AND Name = ’EventContainerDeleteEvent’";
CountOnly = False;
SystemProps = GetByFilter(DataType, Filter, CountOnly);

Table 1 lists the event container variables.

Table 13. Event Container Variables

Variable Type Columns

MEASVAL_ID Integer Internal ID of measurement value

PREFIX String Model prefix of the customer, e.g.
http://cityName

ASSET_RFID String Asset ID in model, e.g.
http://cityName#assetId

ASSET_TYPE String Asset Type label in model

ASSET_NAME String Asset Name in model

ASSET_LOCATION String Asset Location in WKT, e.g. POINT
(-86.2103940 41.6611900)

MEASUREMENT_RFID String Measurement ID in model

MEASUREMENT_NAME String Measurement name in model

MEASUREMENT_TYPE String Measurement type in model

MEASUREMENT_UOM String Measurement unit in model

MEASUREMENT_VALUE_RFID String Measurement value ID in model
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Table 13. Event Container Variables (continued)

Variable Type Columns

MEASUREMENT_VALUE_NAME String Measurement value name in model

MEASUREMENT_VALUE_ALIAS String Measurement value alias in model

READING_VALUE String Current reading value

READING_THRESHOLD Integer Threshold status of reading,
0:Acceptable, 1:Caution, 2:Critical

READING_TRENDING Integer Trending of the reading, -1:Down,
0:Flat, 1: Up

READING_TIME String Current reading time in format of
xsd:dataTime, e.g.
2012-06-24T04:02:13.000+08:00

READING_TIME_UTC_MILLIS Long Reading time in milliseconds

READING_TIME_SQL_TIMESTAMP java.sql.Timestamp Reading time in java.sql.Timestamp

Sending the CAP alert to IBM Intelligent Operations Center triggers a KPI calculation in IBM
WebSphere Business Monitor.
The following is an example KPI CAP alert.
Log(3, "Entry:My_KPI_Policy"):
If(EventContainer.MEASUREMENT_TYPE 1= "WaterPressure"){
Log(3, EventContainer.MEASUREMENT_VALUE_ALIAS+ "is not WaterPressure");
Log(3, "Exit: My_KPI_Policy");
}

WIH_KPI_UTILS.GenerateUUID(CAPIdentifier);
CAP_Alert = "<?xml version=\"1.0\"encoding=\"UTF-8\"?>n"
<cap:alert xmlns:cap=\um:oasis:names:tc:emergency:cap:1.2\" xmlns:xsi=\http
<cap:identifier>" + CAPIdentifier + "</cap:identifier>\n"
<cap:sender>My_KPI_Policy</cap:sender>\n"
<cap:sent>2012-03-07T12:30:00-05:00</cap:sent>\n"
<cap:status>Actual</cap:status>\n"
<cap:msgType>Alert</cap:msgType>\n"
<cap:scope>Public</cap:scope>\n"
<cap:code>KPI</cap:code>\n"
<cap:info>\n"
<cap:category>Infra</cap:category>\n"
<cap:urgency>Future</cap:urgency\n">
<cap:severity>Minor</cap:severity>\n"
<cap:certainty>Likely</cap:certainty>\n"
<cap:event>water_pressure_event</cap:event>\n"
<cap:headline>water pressure event</cap:headline>\n"
</cap:info>\n"
</cap:alert>;

Log(3, CAP_Alert);
Log(3, "Sending CAP Alert to IOC");
JMSDateSource = "IOC_CAP_IN";
MsgProps = NewObject( );
SendJMSMessage(JMSDataSource,MsgProps,Cap_Alert);

Log(3, "Exit:My_KPI_Policy");

Binding the KPI policy to the event
After you create the new Tivoli/Impact project, the customized KPI policy, and the KPI CAP alert in the
policy, you bind the KPI policy to the Water Information Hub reader service.

Chapter 5. Customizing the solution 159



Procedure
1. Log on to Tivoli Netcool/Impact as administrator.
2. On the Projects tab, expand the Services menu and select WIH_Event_Reader.
3. On the Event Mapping tab, select New Mapping:New.
4. In the Create a New Event Filter: area, click the down arrow beside Policy to Run: and locate the

new policy
For example, the name of the new policy that you previously created is My_KPI_Policy.

5. Select Active and Chain.
6. On the Server Status tab, click Stop and then click Start to restart WIH_Event_Reader.

Checking the KPI policy
After you create a customized KPI policy, you can check the policy to ensure that messages are
successfully sent.

Procedure
1. Log on to Tivoli Netcool/Impact as administrator.
2. On the Service Status tab, select Policy Logger.
3. In the PolicyLogger Service: area, use the Highest Log Level drop-down list to change the logging

level as needed. Level 3 is recommended.
4. Use the simulator to send several readings to trigger the KPI policy.
5. Go to event host, and check the log file: /opt/IBM/netcool/impact/log/NCI_policylogger.log.
6. If the IBM Intelligent Operations Center XML probe on event-ioc.cn.ibm.com is not already

running, submit the following command:
export OMNIHOME="/opt/IBM/netcool/omnibus"
nohup /usr/bin/nohup $OMNIHOME/probes/nco_p_xml -name ioc_xml -propsfile
$OMNIHOME/probes/linux2x86/ioc_xml.props > /dev/null 2>&1 &

7. Log on to app-ioc.cn.ibm.com and locate the /opt/IBM/iss/water/wih/apps/simulator folder.
8. Create the following reading CSV file: water_pressure_1,100,2012-06-26T14:35:11.000+08:00.
9. Submit the following command to send the message to the IBM Intelligent Operations Center: cp

reading.csv incoming/.
10. Log on to the IBM Intelligent Operations for Water interface as wpsadmin.

If you are unfamiliar with logging on to the IBM Intelligent Operations for Water user interface, see
the related task.

11. Select the Key Performance Indicator Drill Down.
12. Check the KPI activities in the portlet.

Customizing business reporting
IBM Intelligent Operations for Water supports the generation of many types of business relevant custom
reports.

Using the reporting capabilities that are provided by IBM Intelligent Operations Center, you can create
new reports or customize the predefined reports installed with the solution to suit the requirements of
your water network. The IBM Intelligent Operations Center provides a reporting subsystem that uses
IBM Cognos® Business Intelligence to create and manage reports. The reporting subsystem is installed on
the analytic server.

To customize business reporting in IBM Intelligent Operations for Water, you should be familiar with IBM
Cognos Business Intelligence and be able to complete the following steps.
v Import the water usage metadata.
v Define the data model.
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v Define the report.
v Import the report package on the IBM Intelligent Operations for Water Cognos server
v Integrate the report page with the IBM Intelligent Operations for Water portal.
Related information:

IBM Cognos Business Intelligence information center

Importing water metadata
Before creating reports in IBM Intelligent Operations for Water, you must import metadata. Using the
IBM® Cognos® Framework Manager metadata modeling tool, you can import metadata from a variety of
data sources. Framework Manager is part of IBM Cognos Business Intelligence, the reporting subsystem
used by IBM Intelligent Operations Center.

Before you begin

Before you can import metadata, you must create a project in IBM® Cognos® Framework Manager. IBM®

Cognos® Framework Manager provides a Metadata Wizard used to import metadata from data sources.
The prerequisite DB2 Client software must be installed and the database must be cataloged.

About this task

Procedure
1. Click the namespace, folder, or segment that you want to import into, and from the Actions menu,

click Run Metadata Wizard.
2. Click the data source that you want to import. For sample water usage data, select the Water

Information Hub Analytic data store: WIHANLDS.
3. Proceed through the steps presented by the Metadata Wizard to select the objects you want to import.

A list of created objects is displayed in the Project Viewer.

Defining the metadata model
Using the IBM® Cognos® Framework Manager metadata modeling tool, you can define the metadata for
your project. IBM Intelligent Operations for Water provides a sample water analytic usage metamodel. A
metamodel defines the language and processes from which to form a model.

About this task

The IBM Intelligent Operations for Water data model is organized as layers. The following views are
available in the sample water analytic usage metamodel :

Database View
This view contains database tables and can not be changed by report authors.

Business View
This view contains dictionaries, filters, and data and can not be changed by report authors.

Dimension View
This view contains dimensions for reports and analysis to customize time, account, measurement,
and location dimensions and can not be changed by report authors.

Presentation View
This view contains namespaces that are made available to report authors to create customized
reports.

Creating the custom report
Using Report Studio in IBM Cognos Connection, you can create new reports and modify existing reports.

Chapter 5. Customizing the solution 161

http://publib.boulder.ibm.com/infocenter/cbi/v10r1m0/index.jsp?topic=%2Fcom.ibm.swg.im.cognos.cbi.doc%2Fwelcome.html


About this task

Using the objects that are available in the Presentation View of the metadata model, you can create
customized reports.

Procedure
1. Open IBM Cognos Connection.
2. From the Launch menu, select Report Studio.
3. Select the Water Information Hub package to access the presentation view of the metamodel.
4. Click Create New.
5. Select the type of report type to build.
6. Click OK.

Working with the sample reports
Use the information in this topic to import a new report or import a report that is packaged with IBM
Intelligent Operations for Water.

Before you begin

Using IBM® Cognos® Administration available from the launch menu in IBM Cognos Connection, you
can import the sample business report. You must have the required permissions to access IBM Cognos
Administration.

About this task

To import the report, you must prepare the business report database setup, catalog the database, and
create a datasource for the report on the Cognos Administration console.

Procedure
1. Set up the business report database.

a. Run the create_WIH_ANALYSIS_DB.ddl script to create WIHANLDB database on the database node
as db2inst1 instance user.

b. Run the create_WIHANALYSIS_DB_tables.ddl script to create the tables in the database
WIHANLDB.

2. Register the WIHANLDB database on the analytic server node
a. Run the db2 catalog database wihanldb as wihanldb at node db2node script on the Cognos

node.
3. Create the WIHANLDS datasource for the report on the Cognos Administration web console with the

following details:
Type: IBM DB2
DB2 database name: WIHANLDB
Name: WIHANLDS
UserID/Password: db2inst1/password

Note: The DB2 administrator provides the password.
4. Import the report to the Cognos Administration console.

a. Copy the water_usage_report.zip file to cognos_home/deployment/.
b. Go to Configuration > Content Administration.
c. Click New Import, and select the water_usage_report deployment archive.
d. Accept the default settings, and click Next to complete the remaining configuration.
e. Click Finish to import the report.
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Configuring a portlet to display reports
Use the information in this topic to configure a portlet to display reports.

About this task

Using WebSphere Portal, you can use standard portlet configuration options to create a reports portlet in
IBM Intelligent Operations for Water that can reference a URL.

Procedure
1. Log on to the solution portal as an administrator.
2. Navigate to Administration > Portlet Management > Web Modules

3. Navigate to Administration > Portlet Management > Portlets.
4. On the Manage Portlets screen, search for Reports and click Copy to create a duplicate of that portlet.
5. Copy the link from the Cognos web console and paste the link into the newly created report portlet in

the portal application.

Customizing business processes
IBM Intelligent Operations for Water supports the generation of many types of business processes
including standard operating procedures in response to systems alerts and event.

Using the business process capabilities that are provided by IBM Intelligent Operations Center, you can
create new business processes or customize the predefined standard operating procedures to suit the
requirements of your operations. The IBM Intelligent Operations Center provides capabilities to manage
alerts, including those requiring immediate or standard responses.

Customizing standard operating procedure
A standard operating procedure defines a sequence of activities that are triggered in response to an event
in which parameters meet certain predefined conditions, where each activity corresponds to either a
manual or an automated task. You can customize standard operating procedure and activities to manage
events that come into the IBM Intelligent Operations Center.

Use the standard operating procedure portlet to access the standard operating procedure, standard
operating procedure selection matrix, and Workflow Designer applications in Tivoli Service Request
Manager®. To launch the standard operating procedure portlet, in the WebSphere Portal Administration
interface, click Administration > Solution Customization Tools > Standard Operating Procedures. To
customize standard operating procedure, click the down arrow in the upper right corner of the portlet to
see your portlet menu customization options.

Creating standard operating procedures
Create a standard operating procedure, and assign it to an owner group. Users are assigned to an owner
group through their membership of a person group.

Procedure
1. To open the Standard Operating Procedures portlet, in the WebSphere Portal Administration

interface, click Intelligent Operations > Customization Tools > Standard Operating Procedures.
2. To open the standard operating procedure application, click Standard Operating Procedures.
3. In the Standard Operating Procedure window, on the List tab, click the New SOP icon. A blank

standard operating procedure is displayed on the Standard Operating Procedure tab.
4. For SOP Name, enter a name, and in the field next to SOP Name, enter a description. For the names

of standard operating procedures, use a consistent format that is similar to the names of the sample
standard operating procedures; for example, Prepare for severe weather evacuation (Prepare).
Also, if the last character of the name is a closing parenthesis, append the left-to-right mark (LRM)
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character to prevent potential problems related to the rendering of bidirectional text. For example,
enter the name used in the previous example as Prepare for severe weather evacuation
(Prepare)&#x200E;. The LRM character is not displayed in the user interface after you save the
standard operating procedure. Also, if you add a common prefix to the names of all your standard
operating procedures, it is easier to filter your standard operating procedures in a search. For
example, for customer projects, use the common prefix CX.

5. To enter a longer description, click the icon next to the description field and enter a description in
the window that is displayed.

6. Under Details, from the Template Type list, select Activity.
7. Under Details, assign an owner group to the standard operating procedure:

a. Click the icon next to the Owner Group field.
b. In the Select Value window, select PLUSIWTO.

8. Optional: For Duration, enter a time limit that the standard operating procedure must be completed
in. The format for the time limit is hh:mm, where hh is the number of hours and mm is the number of
minutes. The due date is calculated based on the duration.

9. Add tasks to the standard operating procedure, as required:
a. Near the lower right of the Tivoli Service Request Manager user interface, click New Row. Under

SOP Steps, a new task row is appended to the task sequence list.
b. For Sequence, and for Task, enter the same number. Number tasks with the following pattern:

10, 20, 30, and so on. If you use this pattern, you have more flexibility to add and remove tasks
later.

c. For Instruction, enter a task description. To select from descriptions that you have entered
previously, click the icon next to the description field.

d. Optional: Assign a workflow:
1) For Workflow Name, click the Select Value icon.
2) In the Select Value window, click a value in the list to select it. To narrow down the list, in

the filter field that is displayed at the top of the list, enter the first few letters of the name of
a workflow that you want to use.

3) Expand the task row and, under Details, enter more details as required. If you want, you can
specify an owner group, and flow control settings. If you do not specify an owner group and
flow control settings for the task, the task inherits the settings from the parent standard
operating procedure.

10. To save the standard operating procedure, near the top of the Tivoli Service Request Manager user
interface, click the Save SOP icon.

11. For the standard operating procedure to be applied to the events specified in the standard operating
procedure selection matrix, ensure that you change the status from DRAFT to ACTIVE:
a. Click the Change Status icon.
b. In the Change Status window, from the New Status list, select Active.
c. Optional: Enter values for As Of Date and Memo.
d. Click OK.

12. To review the available standard operating procedures, do the following steps:
a. Click the List tab.
b. Under SOP Job Plans, choose one of the following options:

v In the filter field, press Enter to view all the available standard operating procedures.
v In the filter field, enter the first few letters of the name of a standard operating procedure.

c. To view the details for a standard operating procedure, click the name of the standard operating
procedure in the list. The details are displayed on the Standard Operating Procedure tab.
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What to do next

If you want to be able to specify the order in which some or all of the activities in a standard operating
procedure are executed, under Details, select the Flow Controlled? check box. For more information
about how to order the activities that are assigned to users or groups based on standard operating
procedures, see the Maximo® Asset Management information center and search for flow control.

In the standard operating procedure selection matrix, define the event parameters that determine for
which events the standard operating procedure is selected.

Reviewing entries in the standard operating procedure selection matrix
In the standard operating procedure selection matrix, review the selection criteria for each standard
operating procedure. The selection criteria are based on event parameters.

Procedure
1. To open the Standard Operating Procedures portlet, in the WebSphere Portal Administration interface,

click Intelligent Operations > Customization Tools > Standard Operating Procedures.
2. To open the Standard Operating Procedure Selection Matrix application, click Standard Operating

Procedures Selection Matrix.
3. In the Standard Operating Procedure Selection Matrix window, to display the filter row, click the

Filter icon.
4. Determine which filter field to use:

v Category
v Severity
v Urgency
v Certainty
v SOP Name

5. Choose one of the following options:
v In the filter field, press Enter to view all the existing entries that relate to your chosen parameter or

standard operating procedure name.
v In the filter field, enter the first few letters of a value to filter on.
v If you are filtering on a parameter value, enter values through the Select Value window:

a. Next to the filter field, click the Select Value icon.
b. In the Select Value window, click a value in the list to select it.

v To select the name of a standard operating procedure to filter on through the Standard Operating
Procedure window:
a. Next to the SOP NAME filter field, click the Detail Menu icon, and then click Go To Standard

Operating Procedure.
b. In the Standard Operating Procedure window, click the List tab.
c. Under SOP Job Plans, in the filter field, enter the first few letters of the name of a standard

operating procedure.
d. To view the details for a standard operating procedure, click the name of the standard operating

procedure in the list. The details are displayed on the Standard Operating Procedure tab.
e. To return the name of the standard operating procedure that is displayed on the Standard

Operating Procedure tab, in the upper right corner, click Return With Value. The name is
displayed in the SOP Name filter field in the selection matrix.

6. To further refine the list of displayed selection criteria entries, repeat Step 5 using one of the other
filter fields listed in Step 4.
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Defining parameters in the standard operating procedure selection matrix
In the standard operating procedure selection matrix, define the event parameters that determine whether
a standard operating procedure is selected for a particular event.

About this task

You cannot save a standard operating procedure selection matrix that contains two rows of identical
selection criteria. If appropriate, a validation message is displayed that informs you that you must define
a unique set of selection criteria for a standard operating procedure.

Procedure
1. To open the Standard Operating Procedures portlet, in the WebSphere Portal Administration interface,

click Intelligent Operations > Customization Tools > Standard Operating Procedures.
2. To open the Standard Operating Procedure Selection Matrix application, click Standard Operating

Procedures Selection Matrix.
3. In the Standard Operating Procedure Selection Matrix window, to display the filter row, click the

Filter icon.
4. In the SOP Selection Matrix window, in the lower right corner, click New Row. A new row is

appended to the selection matrix.
5. Enter values for each of the following parameters:

v Category
v Severity
v Urgency
v Certainty

Use one of the following options to enter values for each of the parameters:
v To enter values through the Select Value window:

a. Next to the parameter field, click the Select Value icon.
b. In the Select Value window, click a value in the list to select it.

v To enter the name of the parameter manually:
a. Enter the first few letters of the value of the parameter in the field.
b. Press the TAB key to move the cursor to the next field, and the value of the parameter is

automatically completed.
6. To enter the name of the standard operating procedure in the SOP Name field, choose one of the

following options:
v To enter the name of the standard operating procedure through the Standard Operating Procedure

window:
a. Next to the SOP NAME field, click the Detail Menu icon, and then click Go To Standard

Operating Procedure.
b. In the Standard Operating Procedure window, click the List tab.
c. Under SOP Job Plans, in the filter field, enter the first few letters of the name of a standard

operating procedure.
d. To view the details for a standard operating procedure, click the name of the standard operating

procedure in the list. The details are displayed on the Standard Operating Procedure tab.
e. To return the name of the standard operating procedure that is displayed on the Standard

Operating Procedure tab, in the upper right corner, click Return With Value. The name is
displayed in the SOP Name field of the new row in the selection matrix.

v Enter the name of the standard operating procedure manually.
7. Click the Save matrix icon.

166 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



Creating an event policy
An event policy determines when to trigger standard operating procedure processing. A policy also
encompasses event data consolidation, CAP event construction, and sending a CAP event to the IBM
Intelligent Operations Center.

About this task

When you create an event policy, you first create a new Tivoli Netcool/Impact project. Then you create
the customized event policy, construct an event CAP alert in the customized event policy, and bind the
customized event to the hub event reader. Finally, you debug the customized event policy.
Related concepts:
“Creating a KPI policy” on page 157
Using Tivoli Netcool/Impact, you can create a customized KPI policy.

Creating a project:

When you create an event policy, the first step is to create a new project in Tivoli Netcool/Impact.

Before you begin

Obtain the URL for your Tivoli Netcool/Impact server.

Procedure

1. Go to Tivoli Netcool/Impact and log on as admin. For example, http://event_host:9080/nci.
The default password is netcool.

2. On the Projects tab, click the plus sign (+) at the top right.
3. In the Project Name field, type a project name. For example, type My Project.
4. From the List By Section: list, select Data Sources.

a. From the Global Repositories list, select IOC_CAP_IN, click Add, and click OK.
5. From the List By Section: list, select Services.

a. From the Global Repositories list, select WIH_Event_Reader, click Add, and click OK.
6. To verify that the project settings are created correctly, select the project from the Projects: list. For

example, select My Project.
a. Verify that IOC_CAP_IN appears in the List by Section: > Data Sources list.
b. Verify that WIH_Event_Reader appears in the List by Section: > Services list.

Related tasks:
“Creating a customized event policy”
You create a customized event policy within the newly created Tivoli Netcool/Impact project.

Creating a customized event policy:

You create a customized event policy within the newly created Tivoli Netcool/Impact project.

Before you begin

Obtain the URL for your Tivoli Netcool/Impact server.

Procedure

1. If you are not already logged on, go to Tivoli Netcool/Impact and log on as admin. For example,
http://event_host:9080/nci.
The default password is netcool.

Chapter 5. Customizing the solution 167



2. On the Properties tab, select the new impact project and expand the Policies menu.
3. From the Template drop-down list, select Custom and click the plus sign (+) to create a new policy.
4. In the Policy Name field of the Custom tab, type a name for the newly created policy and click Save.
Related tasks:
“Creating a project” on page 167
When you create an event policy, the first step is to create a new project in Tivoli Netcool/Impact.
“Constructing an event CAP alert”
If a sensor exceeds a threshold, an event Common Alerting Protocol (CAP) alert is sent to IBM Intelligent
Operations Center to trigger standard operating procedure processing. The related activities are then
displayed in the My Activities portlet of the IBM Intelligent Operations for Water interface so that the
operator can address them. You construct an event CAP alert within the newly created Tivoli
Netcool/Impact event policy.

Constructing an event CAP alert:

If a sensor exceeds a threshold, an event Common Alerting Protocol (CAP) alert is sent to IBM Intelligent
Operations Center to trigger standard operating procedure processing. The related activities are then
displayed in the My Activities portlet of the IBM Intelligent Operations for Water interface so that the
operator can address them. You construct an event CAP alert within the newly created Tivoli
Netcool/Impact event policy.

Before you begin

Obtain the URL for your Tivoli Netcool/Impact server.

Procedure

1. If you are not already logged on, go to Tivoli Netcool/Impact and log on as admin. For example,
http://event_host:9080/nci.
The default password is netcool.

2. In the Tivoli Netcool/Impact policy editor, define the CAP event.
a. Ensure that the value of the code parameter is event.
b. Specify a value for the following parameters:

v Category (possible values include env, fire, geo, health, infra, met, other, rescue, safety, security,
transport)

v Urgency (possible values include expected, future, immediate, past, unknown)
v Severity (possible values include extreme, minor, moderate, severe, unknown)
v Certainty (possible values include likely, observed, possible, unknown, unlikely)

Note: The Tivoli Service Request Manager determines which standard operating procedures to
apply by checking the received CAP event data and comparing these parameters to the standard
operating procedure selection matrix records.

See the following example CAP event.
<?xml version="1.0" encoding="UTF-8"?>
<cap:alert xmlns:cap="urn:oasis:names:tc:emergency:cap:1.2"
xmlns:xsi="http://www.w3.org/2001/XMLSchemainstance“
xsi:schemaLocation="urn:oasis:names:tc:emergency:cap:1.2
CAP-v1.2-os.xsd ">
<cap:identifier>c329ac4e-c9e0-47d7-85b6-369d242ad2b1</cap:identifier>
<cap:sender>My_Event_Policy</cap:sender>
<cap:sent>2012-03-07T12:30:00-05:00</cap:sent>
<cap:status>Actual</cap:status>
<cap:msgType>Alert</cap:msgType>
<cap:scope>Public</cap:scope>
<cap:code>Event</cap:code>
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<cap:info>
<cap:category>Infra</cap:category>
<cap:urgency>Future</cap:urgency>
<cap:severity>Minor</cap:severity>
<cap:certainty>Likely</cap:certainty>
<cap:event>water_pressuer_event</cap:event>
<cap:headline>water pressure event</cap:headline>
</cap:info>
</cap:alert>

3. Construct the event CAP alert in the customized event policy and send the CAP alert to the
Intelligent Operations Center.
Sending the CAP alert to the Intelligent Operations Center triggers the appropriate standard
operating procedure in Tivoli Service Request Manager.
See the following example CAP event.
Log(3, "Entry: My_Event_Policy");
If(EventContainer.MEASUREMENT_TYPE != "WaterPressure"){
Log(3, EventContainer.MEASUREMENT_VALUE_ALIAS + " is not WaterPressure");
Log(3, "Exit: My_Event_Policy");
Exit();
}
WIH_KPI_UTILS.GenerateUUID(CAPIdentifier);
CAP_Alert = "<?xml version=\"1.0\" encoding=\"UTF-8\"?>\n"
+ "<cap:alert xmlns:cap=\"urn:oasis:names:tc:emergency:cap:1.2\"
xmlns:xsi=\"http://www.w3.org/2001/XMLSchema-instance\"
xsi:schemaLocation=\"urn:oasis:names:tc:emergency:cap:1.2 CAP-v1.2-os.xsd \">\n"
+ "<cap:identifier>" + CAPIdentifier + "</cap:identifier>\n"
+ "<cap:sender>My_KPI_Policy</cap:sender>\n"
+ "<cap:sent>2012-03-07T12:30:00-05:00</cap:sent>\n"
+ "<cap:status>Actual</cap:status>\n"
+ "<cap:msgType>Alert</cap:msgType>\n"
+ "<cap:scope>Public</cap:scope>\n"
+ "<cap:code>Event</cap:code>\n"
+ "<cap:info>\n"
+ "<cap:category>Infra</cap:category>\n"
+ "<cap:urgency>Future</cap:urgency>\n"
+ "<cap:severity>Minor</cap:severity>\n"
+ "<cap:certainty>Likely</cap:certainty>\n"
+ "<cap:event>water_pressure_event</cap:event>\n"
+ "<cap:headline>water pressure event</cap:headline>\n"
+ "</cap:info>\n"
+ "</cap:alert>";

Log(3, CAP_Alert);
Log(3, "Sending CAP Alert to IOC");
JMSDataSource = "IOC_CAP_IN";
MsgProps = NewObject();
SendJMSMessage(JMSDataSource, MsgProps, CAP_Alert);

Log(3, "Exit: My_Event_Policy");

IBM Intelligent Operations for Water provides basic variable definitions in the EventContainer global
variable. To access the EventContainer global variable, add content similar to the following example:
Log(3, "Entry:My_Event_Policy"):
If(EventContainer.MEASUREMENT_TYPE 1= "WaterPressure"){
Log(3, EventContainer.MEASUREMENT_VALUE_ALIAS+ "is not WaterPressure");

You can also retrieve data from any external source. See the following example script.
DataType = "SysProp";
Filter ="Realm = ’System’ AND Subject = ’*’ AND Name = ’EventContainerDeleteEvent’";
CountOnly = False;
SystemProps = GetByFilter(DataType, Filter, CountOnly);
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Related tasks:
“Creating a customized event policy” on page 167
You create a customized event policy within the newly created Tivoli Netcool/Impact project.

Binding the customized event policy to the hub reader service:

After you create the new Tivoli Netcool/Impact project, the customized event policy, and the event CAP
alert in the policy, you bind the event policy to the hub reader service.

Before you begin

Obtain the URL for your Tivoli Netcool/Impact server.

Procedure

1. If you are not already logged on, go to to Tivoli Netcool/Impact and log on as admin. For example,
http://event_host:9080/nci.
The default password is netcool.

2. On the Projects tab, expand the Services menu and select WIH_Event_Reader.
3. On the Event Mapping tab, select New Mapping:New.
4. In the Create a New Event Filter: area, click the down arrow beside Policy to Run: and locate the

new policy
For example, the name of the new policy that you previously created is My_Event_Policy.

5. Select Active and Chain.
6. On the Server Status tab, click Stop and then click Start to restart WIH_Event_Reader.

Verifying the customized standard operating procedure and the customized event
policy
After you create a customized event policy, you check the policy to verify both the customized standard
operating procedure and the customized event policy.

Before you begin

Obtain the URL for your Tivoli Netcool/Impact server.

Procedure
1. If you are not already logged on, navigate to Tivoli Netcool/Impact and log on as admin. For

example, http://event_host:9080/nci..
The default password is netcool.

2. On the Service Status tab, select Policy Logger.
3. In the PolicyLogger Service: area, use the Highest Log Level drop-down list to change the logging

level as needed. Level 3 is recommended.
4. If the IBM Intelligent Operations Center XML probe on event-ioc.cn.ibm.com is not already

running, submit the following command:
export OMNIHOME="/opt/IBM/netcool/omnibus"
nohup /usr/bin/nohup $OMNIHOME/probes/nco_p_xml -name ioc_xml -propsfile
$OMNIHOME/probes/linux2x86/ioc_xml.props > /dev/null 2>&1 &

5. Log on to app-ioc.cn.ibm.com and locate the /opt/IBM/iss/water/wih/apps/simulator folder.
6. Create the following reading CSV file: water_pressure_1,100,2012-06-26T14:35:11.000+08:00.
7. Submit the following command to send the message to the IBM Intelligent Operations Center: cp

reading.csv incoming/.
8. Log on to the IBM Intelligent Operations for Water interface as wpsadmin.
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If you are unfamiliar with logging on to the IBM Intelligent Operations for Water user interface, see
the related task.

9. Select Operator: Operations.
10. Check the activities in the My Activities portlet and select the new activity.
11. Click Start and then click Finish. When you click Finish, the activity is processed and removed from

the My Activities portlet. The related KPI is updated.
Related tasks:
“Logging on” on page 179
Log on to access the IBM Intelligent Operations for Water user interface.

Customizing the user interface
You can customize some elements of the IBM Intelligent Operations for Water user interface to suit your
operation.
Related information:
Customizing the user interface in Intelligent Operations Center

IBM WebSphere Portal product documentation

List of portlets
IBM Intelligent Operations for Water is a portlet-based solution using portal technology.

The following portlets are provided with IBM Intelligent Operations for Water out of the box.

Table 14. List of portlets

Name Description Page

Map v Displays the geographical region
with event and resource markers.

v Provides a filter form to select the
categories of the events to be
shown.

Operations

Details v Linked to the Map portlet.

v Provides an interactive and
detailed list of events, incidents
and assets that you are authorized
to view.

Operations

Status v Provided by IBM Intelligent
Operations Center displaying an
executive-level summary of the
status of KPIs across the
organizations that you have
permission to view.

v Used to view up-to-date changes
in the KPI status so that you can
plan and take action if necessary.

Executive

Key Performance Indicator Drill
Down

v Provided by IBM Intelligent
Operations Center and offering
drill down capabilities on a specific
KPI category.

v Used to inspect the underlying
KPIs until you reach details of the
KPI that caused the status change.

Executive
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Table 14. List of portlets (continued)

Name Description Page

Notifications v Portlet provided by IBM Intelligent
Operations Center displaying a
dynamic, interactive list of alerts
that result from changing KPIs and
correlated events.

v Highlights changes in KPI or event
status and shows key details for
each of the alerts.

Operations and Executive

My Activities v Portlet provided by IBM Intelligent
Operations Center displaying a list
of activities that are owned by the
team member logged in.

v Lists each activity ID and the
related incident information.

Operations and Executive

Sametime v Portlet provided by IBM Intelligent
Operations Center and provides a
customizable contact list organized
by group.

v Used to communicate and
collaborate with team members.

Operations and Executive

Related concepts:
“Guidelines for customizing portlets”
You can reposition and customize the portlets on the Operator: Operations or Executive: Status views.

Guidelines for customizing portlets
You can reposition and customize the portlets on the Operator: Operations or Executive: Status views.

Repositioning the portlets

Use the following procedure to move a portlet from its default location to a new location on the same
portal page. You can move a portlet up, down, left, or right, depending on its current location. You must
have administrative role permissions to reposition the portlets on the page.
1. Log on to the solution portal as an administrator.
2. Open the portal page that you would like to customize.
3. Go to the portlet that you would like to move and click the portlet display menu.
4. Select one of the following options:

v Move Up

v Move Down

v Move Left

v Move Right

Note: Only the options applicable to the current position of the portlet are available.

Resizing the portlets

All users of IBM Intelligent Operations for Water can resize a portlet, which is useful for viewing the
map or graph portlets in more detail.
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To resize a portlet, click the upper right corner of the portlet, and select options from the menu that is
displayed, as follows:
v To expand the portlet to fill the page, click Maximize.
v To hide the portlet contents, other than its title bar, click Minimize.
v To restore a minimized or maximized portlet to its default view, click Restore.

Note: Resizing a portlet clears the current filter query and results from the map and list.

Customizing the map

You can configure the base geographical information system (GIS) map used by IBM Intelligent
Operations for Water. You can also configure the default starting point for the map for each component of
the solution. See the related links at the end of this topic for more information about the GIS server
requirements for IBM Intelligent Operations for Water and also how to configure the map service.

Customizing the reports

The graph and table summaries generated in the reports portlets of IBM Intelligent Operations for Water
are determined by the type of query submitted from the map. You cannot customize the reports in IBM
Intelligent Operations for Water. Customized reports are outside the scope of the solution. For more
information, contact your IBM Intelligent Water Family representative and arrange a Lab Services
engagement.
Related concepts:
“List of portlets” on page 171
IBM Intelligent Operations for Water is a portlet-based solution using portal technology.
Related information:
Customizing the user interface in Intelligent Operations Center

IBM WebSphere Portal product documentation
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Chapter 6. Managing the solution

The topics in this section describe how to perform administrative tasks for IBM Intelligent Operations for
Water.

Verifying the version
You can verify the version of IBM Intelligent Operations for Water that you have deployed by using the
Intelligent Operations Center - About portlet in the Administration portal. You can also verify the version
of the IBM Intelligent Operations Center and other integrated IBM Smarter Cities Software Solutions that
you have deployed in this environment.

For more information about the Intelligent Operations Center - About portlet, see the IBM Intelligent
Operations Center Information Center.
Related information:
Verifying the version of the IBM Intelligent Operations Center and integrated solutions

Controlling the services
IBM Intelligent Operations for Water runs on top of the IBM Intelligent Operations Center production
environment. The IBM Intelligent Operations Center server cluster provides the middleware and base
architecture for the solution. The services for IBM Intelligent Operations for Water are run and managed
from the servers of the IBM Intelligent Operations Center.

For information about how to stop and start the IBM Intelligent Operations Center servers that IBM
Intelligent Operations for Water runs on, see the Related information link in the IBM Intelligent
Operations Center Information Center.
Related information:
Controlling the IBM Intelligent Operation Center servers
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Chapter 7. Maintaining the solution

Perform the tasks described in this section to keep your solution running smoothly.

Tuning performance
You can enhance the performance of the product after you have completed the installation.

IBM Intelligent Operations for Water runs on top of the IBM Intelligent Operations Center. For details on
tuning performance in IBM Intelligent Operations for Water, see the section of the IBM Intelligent
Operations Center Information Center.
Related information:
Tuning performance in the IBM Intelligent Operations Center

Backing up data
To prevent the loss of valuable data in IBM Intelligent Operations for Water, back up certain files,
directories, and databases.

Ensure that the IBM Intelligent Operations for Water database used to store production data and
information generated by the solution, is backed up on a regular basis.

Database name Location Format

WIHDB IBM Intelligent Operations Center
database server

DB2

IBM Intelligent Operations for Water is integrated with IBM Intelligent Operations Center. When backing
up data, ensure that you also backup the IBM Intelligent Operations Center database: IOCDB.

Some data, for example event data that is used by IBM Intelligent Operations for Water, is stored in the
IBM Intelligent Operations Center database. There are other files, directories, and databases provided by
the IBM Intelligent Operations Center architecture and base platform that must also be backed up
regularly. For more information about backing up the IBM Intelligent Operations Center, see the related
information.
Related information:
Backing up data in the IBM Intelligent Operations Center

Maintenance tips
Additional tips for maintaining the solution are documented in the form of individual technotes in the
IBM Support Portal.

The following link launches a customized query of the live Support knowledge base for IBM Intelligent
Operations for Water:

IBM Intelligent Operations for Water technotes and APARs (problem reports)
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Chapter 8. Using the solution interface

IBM Intelligent Operations for Water is a product of the IBM Intelligent Water Family that enables water
companies to monitor water assets. With IBM Intelligent Operations for Water you can monitor operating
alerts and key performance indicators to get a summary and detailed view of water assets. IBM
Intelligent Operations for Water aggregates data from water monitoring systems and other asset
management systems into a centralized, configurable dashboard that provides valuable information to
support water management. IBM Intelligent Operations for Water is a web-based solution that uses portal
technology. You can access the solution with any of the supported web browsers.

For details of which browsers are supported, see the detailed system requirements.
Related information:
IBM Intelligent Operations Center browser requirements

Logging on
Log on to access the IBM Intelligent Operations for Water user interface.

Before you begin

Contact your administrator to obtain a user ID and password. Your administrator is responsible for
making sure that you have the required system security access level appropriate to your role in your
organization. Your administrator also provides you with the web address (URL) for accessing the
solution.

About this task

On the main navigation bar at the top of the portal, select Water to access the solution from the IBM
Intelligent Operations Center or other IBM Smarter Cities Software Solutions installed in this
environment. Use the following procedure to start a new browser session and access IBM Intelligent
Operations for Water.

Procedure
1. Enter the web address URL into the address field of your web browser. The fully qualified domain

name is required in the URL. For example, http://servername.domainname/wpsv70/wps/myportal.
2. On the server home page, enter your user ID and password.
3. Click Sign In.
4. Select Water from the navigation bar at the top of the portal.

Results

The IBM Intelligent Operations for Water home page is displayed in the web browser. Only the pages,
features, and data that you have permission to access are displayed. Contact your administrator if you
need additional access.
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Related tasks:
“Verifying the customized standard operating procedure and the customized event policy” on page 170
After you create a customized event policy, you check the policy to verify both the customized standard
operating procedure and the customized event policy.
“Logging off”
Log off to exit the IBM Intelligent Operations for Water user interface and end the server session.
“Viewing or editing your user profile”
Click Edit My Profile to access your user profile for the portal server. From your user profile you can
modify some of your personal user settings, including password, name, email, and language preferences.

Logging off
Log off to exit the IBM Intelligent Operations for Water user interface and end the server session.

Procedure

To log off from the solution, click Log Out. By default, the Log Out link is in the upper right corner of
the IBM Intelligent Operations for Water interface.
Related tasks:
“Logging on” on page 179
Log on to access the IBM Intelligent Operations for Water user interface.

Viewing or editing your user profile
Click Edit My Profile to access your user profile for the portal server. From your user profile you can
modify some of your personal user settings, including password, name, email, and language preferences.

Procedure

See the IBM Intelligent Operations Center help and documentation for more information about viewing
or editing your user profile.
Related information:
Viewing or editing your user profile in the IBM Intelligent Operations Center

Using pages
The IBM Intelligent Operations for Water user interface is a role-based dashboard for consolidating data.
Below the navigation bar are two pages. Each page consists of portlets that you can interact with to
access the information you need. Each page provides a consolidated view of water operations that enable
specific roles to monitor, manage, and respond to key areas that impact water organizational
performance.

Operator: Operations view
Use the Operator: Operations view to maintain awareness of the status of water assets, measurement
readings, water events, and their location. The Operator: Operations view is intended for operators,
managers, or others monitoring and responding to current water infrastructure events.

The Operator: Operations view is an interactive web page. The view contains the following portlets,
which you can think of as independent sections of the page that cooperate with one another to provide
comprehensive information and interaction at the operations level.
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Table 15. Operator: Operations view portlets

Portlet Description

“Map” on page 186 A Geospatial Map of the geographical region that
contains event and resource markers, water asset and
status, logical zones and layers.

A filter form to select the categories of events to be
shown on the map and in the Events and Incidents
tab on the Details portlet.

A filter form to select the asset types to be shown on
the map and in the Assets tab on the Details portlet.

A filter form to select the logical zones to be shown
on the map.

A filter form to select the layers to be shown on the
map. The layers allow you to filter assets to display
on the map, for example by virtual group or pipe
network.

A Logical Map of the logical structure that contains a
graphical view of the model. The model shows
topics, topic associations, and linkages in the model.

“Details” on page 193 The Details portlet is an interactive list portlet. All
the events that you are authorized to see are visible
on the events list and on any map portlet linked to
the Details portlet. Events and incidents and asset
details are displayed. Resources in the vicinity of an
event can be displayed in a resource list and on a
map. Key asset measurements, including current and
historical values can be displayed.

“Notifications” on page 198 The Notifications portlet provides a dynamic,
interactive list of alerts that result from changing
KPIs and correlated events. The role of this portlet is
to draw attention to changes in KPI or event status.
The list contains key details for each of the alerts.

“My Activities” on page 199 The My Activities portlet displays a list of activities
that are owned by the person who is currently
logged on to IBM Intelligent Operations for Water. In
the My Activities portlet, the activities are grouped
by their parent Standard Operating Procedures. Each
Standard Operating Procedure corresponds to an
individual event.

“Contacts” on page 201 The Sametime portlet provides a contacts list
organized by group. It can be customized based on
the people you need to communicate with. You can
chat with people and modify your online status,
contacts, or groups.

For help using each portlet, click the upper right corner of the portlet, and select Help from the menu
displayed.

To resize a portlet, click the upper right corner of the portlet, and select options from the menu that is
displayed, as follows:
v To expand the portlet to fill the page, click Maximize.
v To hide the portlet contents, other than its title bar, click Minimize.
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v To restore a minimized or maximized portlet to its default view, click Restore.

Customizing a portlet

As an administrator you can change portlet settings by clicking the upper right corner of the portlet, and
selecting an option from the portlet menu.

There are two possible modes of customization, each changing the portlet settings for all users:
v Edit Shared Settings changes the portlet only for the instance of the portlet you are in when you

change the settings.
v Configure changes the portlet's global settings for all instances of the portlet wherever those instances

occur.

The modes of customization that are available to you depend on the permissions associated with your
user ID. Global settings are superseded by shared settings.

The portlets that are supplied with the IBM Intelligent Operations Center have some settings that are
specific to a portlet type, for example, set the default zoom level for a map. In addition, you can set
generic portlet parameters that are common across the portlets supplied, for example, the portlet title.

Customizing a page

As an administrator you can access the WebSphere Portal options for managing pages. Click the right
side of the page name tab and select an option from the page menu.

Executive: Status view
Use the Executive: Status view to obtain a consolidated view of key performance indicators (KPIs) and
key events. The Executive view enables users with cross-organization responsibility to monitor, manage,
and respond to status changes in key areas of organizational performance.

The Executive: Status view is an interactive web page. The view contains the following portlets, which
you can think of as independent sections of the page that cooperate with one another to provide
comprehensive information and interaction at the executive level.

Table 16. Executive: Status view portlets

Portlet Description

“Status” on page 196 The Status portlet provides an executive-level summary
of the status of KPIs across the organizations that you
have permission to view. Use this portlet to view
up-to-date changes in the KPI status so that you can plan
and act if necessary.

“Key Performance Indicator Drill Down” on page 198 To focus on a specific KPI category, click the category in
the Status portlet. This category is then displayed in the
Key Performance Indicator Drill Down portlet. You can
use the list to inspect the underlying KPIs until you
reach details of the KPI that caused the status change.

“Notifications” on page 198 The Notifications portlet provides a dynamic, interactive
list of alerts that result from changing KPIs and
correlated events. The role of this portlet is to draw
attention to changes in KPI or event status. The list
contains key details for each of the alerts.
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Table 16. Executive: Status view portlets (continued)

Portlet Description

“My Activities” on page 199 The My Activities portlet displays a list of activities that
are owned by the person who is currently logged on to
IBM Intelligent Operations for Water. In the My
Activities portlet, the activities are grouped by their
parent Standard Operating Procedures. Each Standard
Operating Procedure corresponds to an individual event.

“Contacts” on page 201 The Sametime portlet provides a contacts list organized
by group. It can be customized based on the people you
need to communicate with. You can chat with people
and modify your online status, contacts, or groups.

For help using each portlet, click the upper right corner of the portlet, and select Help from the menu
displayed.

To resize a portlet, click the upper right corner of the portlet, and select options from the menu that is
displayed, as follows:
v To expand the portlet to fill the page, click Maximize.
v To hide the portlet contents, other than its title bar, click Minimize.
v To restore a minimized or maximized portlet to its default view, click Restore.

Customizing a portlet

As an administrator you can change portlet settings by clicking the upper right corner of the portlet, and
selecting an option from the portlet menu.

There are two possible modes of customization, each changing the portlet settings for all users:
v Edit Shared Settings changes the portlet only for the instance of the portlet you are in when you

change the settings.
v Configure changes the portlet's global settings for all instances of the portlet wherever those instances

occur.

The modes of customization that are available to you depend on the permissions associated with your
user ID. Global settings are superseded by shared settings.

The portlets that are supplied with the IBM Intelligent Operations Center have some settings that are
specific to a portlet type, for example, set the default zoom level for a map. In addition, you can set
generic portlet parameters that are common across the portlets supplied, for example, the portlet title.

Customizing a page

As an administrator you can access the WebSphere Portal options for managing pages. Click the right
side of the page name tab and select an option from the page menu.

City: Water Conservation
Use the City: Water Conservation view to obtain a consolidated view of resource consumption and use in
a city. The City: Water Conservation view enables users with cross-organization responsibility to monitor,
manage, and respond to status changes in key areas of organizational performance.
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The City: Water Conservation view is an interactive web page. The view contains the following
independent sections that cooperate with one another to provide comprehensive information on resource
consumption in a city.

Table 17. City: Water Conservation view

Section Description

Map A map of the geographical region that contains resource
markers (households, parks, assets, zones). Shows your
monitored community area.

A filter to select the view. You can toggle between the
Map or List view.

The resources are shown on the map, for example
household. Click the resource to determine the associated
metrics for that resource. The metrics are displayed in a
popup and consumptions trends are displayed in
theTrend section of the view.

List A table that contains a list of resource markers
(households, parks, assets, zones) in the geographic map
and their associated properties (name, number of meters,
location, contact).

Trend Compares and charts historic with current usage data for
a monitored resource in a monitored community,
displayed in either a chart or table view.

For help using each portlet, click the upper right corner of the portlet, and select Help from the menu
displayed.

To resize a portlet, click the upper right corner of the portlet, and select options from the menu that is
displayed, as follows:
v To expand the portlet to fill the page, click Maximize.
v To hide the portlet contents, other than its title bar, click Minimize.
v To restore a minimized or maximized portlet to its default view, click Restore.

Customizing a portlet

As an administrator you can change portlet settings by clicking the upper right corner of the portlet, and
selecting an option from the portlet menu.

There are two possible modes of customization, each changing the portlet settings for all users:
v Edit Shared Settings changes the portlet only for the instance of the portlet you are in when you

change the settings.
v Configure changes the portlet's global settings for all instances of the portlet wherever those instances

occur.

The modes of customization that are available to you depend on the permissions associated with your
user ID. Global settings are superseded by shared settings.

The portlets that are supplied with the IBM Intelligent Operations Center have some settings that are
specific to a portlet type, for example, set the default zoom level for a map. In addition, you can set
generic portlet parameters that are common across the portlets supplied, for example, the portlet title.
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Customizing a page

As an administrator you can access the WebSphere Portal options for managing pages. Click the right
side of the page name tab and select an option from the page menu.

Citizen: Water Conservation
Use the Citizen: Water Conservation view to obtain a consolidated view of resource consumption and
use. The Citizen: Water Conservation view enables users to analyze individual consumption and monitor
water leakages. The view provides a water report. By using the report, you can plan for changes to
behavior, usage patterns, or changes to individual water equipment to actively engage in water
conservation.

The Citizen: Water Conservation view is an interactive web page. The view contains the following
independent sections of the page that cooperate with one another to provide comprehensive information
on resource consumption for a citizen.

Table 18. Water Conservation Portal: Citizen view

Portlet Description

Profile area Shows the profile name for the report. The profile name
might be a park, a marina or a household. You can select
from the list. Below the profile name is the one or
multiple meters in the account. If you have multiple
meters, you can select from the list to see the
consumption of each meter.

Progress area Shows your progress, such as your Usage Trend,
Monthly Year to Date Variance in dollars and in gallons.
Shows your water conservation progress in relation to
other participants . The Rank shows your position in
relation to other participants in your community. The
Green Points shows the number of points earned. Green
points are awarded for reductions in water consumption
and determined by weekly readings from your water
meter.

Daily usage area Shows your water usage each day for the past several
months in two usage units: gallons and dollars. Using
the slider bar, you can move along a 12 month calendar
to see the total water consumption each day. When you
move the slider bar, the data and usage unit also change
in the two views in the Details area: Hourly Usage and
Weekly Usage. Hover over each bar to see the actual
amount for Weekly Usage

Details area Compares hourly and weekly usage in a chart. The
following views are available for display:

v Hourly Usage

v Weekly Usage

v Compare

v This weeks game

Team Chat / Pilot Chat Used to foster communications and collaboration
between teams and communities.

For help using each portlet, click the upper right corner of the portlet, and select Help from the menu
displayed.

Chapter 8. Using the solution interface 185



To resize a portlet, click the upper right corner of the portlet, and select options from the menu that is
displayed, as follows:
v To expand the portlet to fill the page, click Maximize.
v To hide the portlet contents, other than its title bar, click Minimize.
v To restore a minimized or maximized portlet to its default view, click Restore.

Customizing a portlet

As an administrator you can change portlet settings by clicking the upper right corner of the portlet, and
selecting an option from the portlet menu.

There are two possible modes of customization, each changing the portlet settings for all users:
v Edit Shared Settings changes the portlet only for the instance of the portlet you are in when you

change the settings.
v Configure changes the portlet's global settings for all instances of the portlet wherever those instances

occur.

The modes of customization that are available to you depend on the permissions associated with your
user ID. Global settings are superseded by shared settings.

The portlets that are supplied with the IBM Intelligent Operations Center have some settings that are
specific to a portlet type, for example, set the default zoom level for a map. In addition, you can set
generic portlet parameters that are common across the portlets supplied, for example, the portlet title.

Customizing a page

As an administrator you can access the WebSphere Portal options for managing pages. Click the right
side of the page name tab and select an option from the page menu.

Using portlets
A portlet provides access to information that you can view and interact with on a portal page. With IBM
Intelligent Operations for Water, you can use portlets to monitor water infrastructure, assets,
measurements, and key performance indicators to get a summary and detailed view of water agency
performance.

Map
Use the Map portlet to see events and assets on a map.

The Map portlet interacts with the Details portlet. The Map portlet provides you with a visual
representation of events and assets on a map. Use the Map portlet together with the Details portlet to
identify location patterns, conflicts, issues, and synergies.

The Map portlet can also be used to update the content of the Details portlet. You can select in the Map
portlet the categories of events, asset types, and zones you want to view. Your selection affects what is
displayed in both the Map portlet and the corresponding Details portlet on the portal page.

Map interface

The Map portlet has two views: Geospatial Map and Logical Map.

The Geospatial Map has the interactive interface elements as shown in the following table:
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Table 19. Map portlet - Geospatial Map interfaces

Interface element Description

Map A map of the geographical region provides event and associated resource locations.

Select Content: Event
Categories

A filter form to select the categories of the events to be shown on the map and in the
Events and Incidents tab on the Details portlet.

Select Content: Asset Type A filter form to select the asset types to be shown on the map and in the Assets tab on
the Details portlet.

Select Content: Logical
Zone

A filter form to select the zone to be shown on the map and in the Assets tab on the
Details portlet.

Select Content: Other
Layers A filter form to select the layers to be shown on the map. Using the layers, you

can filter assets to display on the map, for example by virtual group or pipe network.

The Logical Map has two interactive interface elements as shown in the following table:

Table 20. Map portlet - Logical Map interfaces

Interface element Description

Map A logical map of the model provides topics in the model and associations.

Select Content A filter form to customize the display in the logical map. Use the options to set the
number of items that are displayed, the depth of impact analysis, the type of
associations, and the nature of relationships.

Initially, the page opens with the Geospatial Map view that shows all the events and asset types that are
relevant to you.

Note: To enable the Logical Map view, you must select the Edit Shared Settings option on the Map
portlet, scroll to Enable the Logical Map field, and enter True.

The Geospatial Map map uses latitude and longitude values specified in the event record or asset type to
show the location. A point marker or shape outlines the area. You can display more detail on an event
headline or asset type by clicking the marker on the map. If there is more than one event or asset
clustered at the same location, the number is indicated and when you click the marker. The headline of
each event or asset is also displayed.

There is a limit to the number of markers that can be shown on the Geospatial Map. If the number of
markers in the area in view exceeds the threshold, the markers are not shown. You receive a message
with the number of markers available and the number of the threshold. You are given two options to
display all available markers:
v Zoom in or pan to an area of the map with the number of markers below the threshold.
v Click Load all items in view.

If you choose the second option, you might notice that markers are displayed on the Geospatial Map at a
slower rate.

When you select View Nearby Resources for an event in the Details portlet, resources are shown on the
map based on the radius and capabilities you selected.

The map keeps you up-to-date by adding new events, subject to any filters you set to limit the categories
shown.
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Note: If an event or asset type has no coordinates it is displayed only in the Details portlet list; it is not
displayed in the Map portlet.

Geospatial Map markers

The map represents the location of events or assets with one of the following types of marker:

Table 21. Map markers

Marker Type Description

Icon Pinpoints on the map the location of an event or asset by using a unique icon for each.

Polygon Outlines on the map the area associated with a particular event or asset.

Cluster Indicates more than one event or asset at the same location with a number that
represents the number of events or assets at that location

Radius Outlines on the map the area you select for View Nearby Resources.

The icon that represents an event type is defined in the category field of the event details on the Events
and Incidents tab in the Details portlet. When an event is escalated to an incident, the icon displayed on
the map retains its category-specific symbol. A red margin around the icon displays that it is an incident.
Clicking an event marker on the map highlights the associated event or events in the Details portlet.

The icon that represents an asset is shown on the Assets tab in the Details portlet.

Table 22. Geospatial Map: Water asset icons

Icon Represents

Waste water plant

Waste water plant

Level indicator

Level indicator

River gauge

River gauge

Rain gauge

Rain gauge

Position indicator

Position indicator

Asset

Asset

Lift station

Lift station

Recorder level

Recorder level

Trunk line monitor

Trunk line monitor
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Table 22. Geospatial Map: Water asset icons (continued)

Icon Represents

Combined Sewer Overflow diversion structure

Combined Sewer Overflow diversion structure

Well head

Well head

Selecting event categories for the Geospatial Map
Use the Event Categories filter to select by category which events are displayed on the map.

To view the filter form, click Select Content. The categories of events displayed on the map and in the
Details portlet can be changed based upon the filter form selection that you make. You can focus on the
categories of event you want to analyze by using the filter to hide the event categories you do not need.
The map responds to any change on the filter form. When a selection is changed, the map is updated and
only the locations of events within the selected categories are plotted on the map. Change the categories
of event displayed by selecting or clearing check boxes on the filter form. To close the filter form, click
Select Content. If you leave the portal page and return, the filter is reset to the default which is all
categories selected.

You can focus on individual events you want to analyze by ticking check boxes in the Details portlet.
These events are highlighted on the map.

Selecting asset types for the Geospatial Map
Use the Asset Type filter to select by category the assets to display on the map.

To view the filter form, click Select Content. The types of assets displayed on the map and in the Details
portlet can be changed based upon the filter form selection that you make. You can focus on the
categories of assets you want to analyze by using the filter to hide the assets you do not need. The map
responds to any change on the filter form. When a selection is changed, the map is updated and only the
locations of assets within the selected categories are plotted on the map. Change the types of asset
displayed by selecting or clearing check boxes on the filter form. To close the filter form, click Select
Content. If you leave the portal page and return, the filter is reset to the default which is all categories
selected.

You can focus on individual assets you want to analyze by ticking check boxes in the Details portlet.
These assets are highlighted on the map.

Selecting logical zones for the Geospatial Map
Use the Logical Zones filter to select by category which zones are displayed on the map.

To view the filter form, click Select Content. The categories of zones displayed on the map can be
changed based upon the filter form selection that you make. You can focus on the zones you want to
analyze by using the filter to hide the zones you do not need. The map responds to any change on the
filter form. When a selection is changed, the map is updated and only the zones selected are plotted on
the map. Change the zones displayed by selecting or clearing check boxes on the filter form. To close the
filter form, click Select Content. If you leave the portal page and return, the filter is reset to the default
which is all categories selected.

Selecting layers for the Geospatial Map
Use the Other Layers filter to select by category which layers are displayed on the map.
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To view the filter form, click Select Content. The categories of layers displayed on the map can be
changed based upon the filter form selection that you make. You can focus on the layers you want to
analyze by using the filter to hide the layers you do not need. The map responds to any change on the
filter form. When a selection is changed, the map is updated and only the layers selected are plotted on
the map. Change the layers displayed by selecting or clearing check boxes on the filter form. To close the
filter form, click Select Content. If you leave the portal page and return, the filter is reset to the default
which is all categories selected.

Selecting resource capabilities for the Geospatial Map
When you select View Nearby Resources on the Details portlet, the Event Categories filter is replaced by
the Resources filter. Use the Resources filter to select which resources are displayed on the map.

To view the filter form, click Select Content. The capabilities of resources displayed on the map and in
the Details portlet can be changed based upon the filter form selection that you make. You can focus on
the capability you want to analyze by using the filter to hide the capabilities you do not need. The map
responds to any change on the filter form.

When a selection is changed, the map is updated and only the locations of the resources with the selected
capabilities are plotted on the map. Change the capability of resources displayed by selecting or clearing
a check box on the filter form. To close the filter form, click Select Content. If you leave the portal page
and return, the filter is reset to default which is all capabilities selected. The capabilities selected by
default depend on the category of the event and how that category is mapped to capabilities.

Adding an event
You can create an event, adding it to the Map portlet map and the Details portlet list at the same time.
The map and the list provide two ways of looking at the same content.

About this task

Use the Add Event dialog to specify event properties.

Procedure
1. Right-click a location on the map and click Create a new event to start the Add Event dialog. Some

of the event properties are completed automatically.
2. Specify the remaining event properties. Properties marked with an asterisk are required for the

successful creation of a new event, those properties not marked with an asterisk are optional.
3. Click OK to save the event or Cancel to stop adding the event.

Results

An icon that represents the category of the new event is displayed in the requested location on the map
and its details in the Details portlet list.

Note: In the Map portlet, you cannot create an event at a location where an icon or polygon is already
displayed. To create an event for a location already occupied by an event on the map, hide the event
category by using the filter and right-click the location. Alternatively, you can use the Details portlet to
add an event at that location.

Using the Geospatial Map controls
You can move the cursor around the map by using your mouse or keyboard.
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The map controls are on the upper left side of the map

The map controls are on the upper left side of the map. They consist of:
v Pan arrows (up, down, left, right)
v Zoom in
v World view (zooms out to the maximum extent)
v Zoom out

Pan controls for moving around the map

To move around the map you can:
v Click and drag the map by using the mouse
v Press the up pan arrow, or the up arrow key on the keyboard, to pan north
v Press the down pan arrow, or the down arrow key on the keyboard, to pan south
v Press the right pan arrow, or the right arrow key on the keyboard, to pan east
v Press the left pan arrow, or the left arrow key on the keyboard, to pan west

Zoom controls for magnifying or reducing the scale of the map

To zoom in and out of the map you can:
v Click the + map icon to zoom in, or the - map icon to zoom out of the center of the map
v Double-click the mouse to center the map and zoom in to the selected location
v Click the World view icon to maximize the zoom out to show the world view
v Press the + key on the keyboard to zoom in
v Press the - key on the keyboard to zoom out
v Press Shift while you use the mouse to draw a rectangle around the area to zoom in on

Resetting the Geospatial Map
The Map portlet can be reset to the default view configured for the system.

Procedure
1. On the Map portlet, click Reset the Map.
2. Select one of the following options.

v Reset the Map to zoom and center the map to the default setting.
v Reset the Map and Clear Filters to zoom and center the map to the default setting and reset the

values set in Select Content to the default values.

Navigating the Logical Map
Use the Logical Map on the Map portlet to browse topics and associations in the model.

Before you begin

Before you can view the Logical Map view, you must select the Edit Shared Settings option on the Map
portlet, scroll to Enable the Logical Map field, and enter True.

Procedure
1. On the Map portlet, toggle the Logical Map view.
2. To browse the model, select one of the following options.

v Click a topic in the Logical Map view.
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v Expand the topic to view associations.
v Right click the topic to select from a list of browse options. For example, you can select to Expand,

Focus, Hide, View Details or Perform Impact Analysis. Select the Focus option to centralize your
view of the graph on the selection.

Customizing the Logical Map
The Map portlet can be customized to limit the number of items that are displayed in the Logical Map.

Procedure
1. On the Map portlet, select the Logical Map view.
2. Click the Select Content option and customize your settings using the following options.

v Enter a number in Limit item count to: to set the maximum number of items to display in the map.
v Enter a number in Limit impact analysis depth to: to set how deep within the layers in the map

you want to allow impact analysis to be performed.
v Select from the available options to customize the display of relationships in the model.

Type instance shows relationships of type instance, for example, where Pipe 1 is an instance of
Pipe.
Connects shows the connection relationship between assets.
Has measurement shows the relationship between assets and measurements.
Contains shows the contain relationship between two assets.
Supertype Subtype shows the class inherent relationship between two asset types.

v Select from the available options to restrict the scope of relationships displayed in the map. The
settings are based on the topic map index rule and can be limited to City Name or Reference
Semantic Model.

v Select to focus your analysis on a specific asset.
v Select to search for an alternate asset by entering the asset name or selecting an item from the

available list.
v Select the Reset Map option on the upper right of the portlet to reset the graph to the initial state

and clear any navigation that is displayed.
v Select the Reset the Map > Change Layout option on the upper right of the portlet to change the

layout of the graph. Select from the Forced Directed Layout, Circular Layout, Tree Layout, or
Hierarchical Layout, Long Link Layout,Short Link Layout options.

Customizing the Map portlet - Geospatial Map

An administrator can change Map portlet settings by clicking the upper right corner of the portlet, and
selecting options from the menu that is displayed.
v To change settings for all users and all instances of the Map portlet, click Configure.
v To change settings for all users and the instance of the Map portlet on the current portal page, click

Edit Shared Settings.

Any settings that you change by using the Edit Shared Settings option override settings that are changed
by using the Configure option.

The settings that you can change for the map are as follows:
v Reset the default center point and zoom level for the map.
v Select a new base map.
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v Add to the map geographic annotation and visualization layers in Keyhole Markup Language (KML),
to represent additional data.

v Set a threshold for the markers that can be displayed without a warning message.
v Set the default selection on the map filters to be displayed when you click Select Content.

Select to enable the Logical Map view and associated settings. To enable the display, select Edit
Shared Settings. Go to the Enable the Logical Map field and enter the value True. Optionally, you can
specify a map name in the Logical Map Name field, and set a prefix for the model the Model Prefix
field.

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.

Details
Use the Details portlet to view, monitor, and manage events and assets in the IBM Intelligent Operations
for Water.

The Details portlet is an interactive list portlet. All the events and assets that you are authorized to see
are visible on the tabs and on any map portlet linked to the Details portlet. Assets in the vicinity of an
event can be displayed in a resource list and on a map.

Events and assets

The Details portlet has two interactive interface elements as shown in the following table:

Table 23. Details portlet display

Interface element Description

Events and Incidents The list contains key details for each event. You can display a more detailed
description of an event by hovering over the row in the list.

Assets The list contains key details for each asset types. You can display a more detailed
description of the asset by hovering over the row in the list.

Initially, when you open IBM Intelligent Operations for Water, the Details portlet shows all the events and
assets that are relevant to you.

In the Map portlet, you select the categories of events and the asset types to be shown. The categories of
events shown on the Events and Incidents tab and the assets shown on the Assets tab correspond to
events and assets displayed on the Map portlet.

The lists are refreshed on a regular basis with updates, subject to any filters you set to limit the categories
shown.

A counter in the left corner of the action bar at the end of the list indicates the number of items displayed
and the total number of items. In the center of the action bar, you can select the number of items to be
displayed at one time. If there are more rows than can be displayed at one time, you can page forward or
backward by clicking the buttons in the right corner of the action bar.
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Event properties

The following table outlines the properties that describe an event.

Table 24. Event properties

Property Content

Who

Sender Source or user ID

Contact name Person to contact for additional information

Contact e-mail Email address of contact person

Contact telephone Telephone number

What

Event type* Event classification below category level

Event status* Event handling instructions

Event scope* Intended audience for the message

Restriction Additional information required when Event scope is 'Restricted'

Headline* Short description of the event

Category* High-level event classification

Severity* Intensity of the impact of the event

Certainty* Confidence in the event prediction

Urgency* Timeframe for action in response to the event

Message type Nature of the message

Description Additional description of the event

Web address Web address for additional information about the event

When

Sent date and time Date and time the message was submitted or sent

Effective date and time Date and time the message is effective

Onset date and time Date and time the event is expected to begin

Expiration date and time Date and time the event is expected to end

Where

Area description Description of the affected area

Latitude / Longitude Coordinates of the event location

Note: Properties marked with an asterisk in the table are required for the successful creation of a new
event. Properties not marked with an asterisk are optional when creating an event.

Managing events and incidents
In the Details portlet, you can perform various actions on the events in the list on the Events and
Incidents tab. In the Map portlet, you can add an event that is shown on both the map and the events
list of the Details portlet.

Procedure

On the Events and Incidents tab, right-click a row in the events list and select an option from the menu:
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v To update the information about an event, click Update Event. You can enter your changes in a
window with fields that contain information about the event. When an event record is updated the
message type property changes to Update.

v To change an event status to incident, click Escalate to Incident to display a window and enter your
contact details. When an event record is escalated there is a change to the properties and to the icon on
the map.

v To remove an event from the list and the map, click Cancel Event to display a window and enter your
contact details.

v To view the standard operating procedure and workflow activities associated with an event, click View
Activity Summary and History. If there are no standard operating procedures associated with an
event, this option is not available. If there is an associated standard operating procedure, it is displayed
in Maximo Asset Management, in the SOP Activities tab. Use the My Activities portlet to manage the
workflow activities associated with a standard operating procedure.

v To view a list of the resources in the vicinity of an event, click View Nearby Resources and select the
radius of the area you want to focus on. A list of resources is displayed on the Resources tab.

v To view the information about an event, click Properties to display a window that contains information
about the event.

Managing assets
In the Details portlet, you can perform various actions on the assets in the list on the Assets tab.

Procedure

On the Assets tab, right-click a row in the assets list and select an option from the menu:
v To view current and historical measurement details associated with an asset, click View Details. Table

3 displays the measurement details shown for selected assets.

Note: The measurement detail that is provided on the Assets tab is for the default measurement
associated with that particular asset. If you right-click and select to view details, a list of other
measurements associated with the asset are displayed if available. Selecting any one of the options
displays associated properties.

Table 25. Measurement Details

Property Description

Current Value

ID Source of measurement

Name Name of asset

Type Asset type

Alias Asset alias

Description Asset description

Value KPI value

Unit Measurement unit

Threshold Critical, Warning, Normal, No Reading

Trend Up, Down, Unchanged

Sent Time Date and timestamp

Historical Values

Graphs Two reports are displayed. Click Recent Historical Values to set the time range
and level of granularity for recent historical report display. Click Aggregate
Historical Values to view aggregate historical values.
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v To view the properties of an asset, click Properties. Table 4 describes asset properties.

Table 26. Asset properties

Property Description

What

ID Source or user ID

Name Asset name

Type Asset type

Description Asset description

Where

Latitude / Longitude Coordinates of the asset location

Whichever option you choose, the measurement details or properties of the asset are displayed.

Customizing the Details portlet

As an administrator, you can customize the portlet by clicking the menu on the upper right corner of the
portlet and configuring the portlet settings.

Setting parameters for the Details portlet you can:
v Specify column layout, headings, sort order, and priority.
v Specify the additional conditions to filter the events or resources displayed.
v Specify a group name to enables communication with other map and Details portlets.
v Acknowledge or ignore event creation.

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.

Status
Use the Status portlet to see the status of key performance indicators (KPIs) for a single organization or
across organizations.

The Status portlet provides an executive-level summary of the status of KPIs across the organizations that
you have permission to view. Use this portlet to view up-to-date changes in the KPI status so that you
can plan and take action if necessary.

KPI color code

Each column contains KPI information about an organization that is named at the top of the column. The
KPI categories that are associated with each organization are represented by colored cells. The
background color for a KPI category reflects its status. If there are more than six KPIs to be displayed in a
column, the size of each individual cell is reduced to accommodate the extra KPIs.

The background color code that is supplied with the solution’s sample KPIs is as follows:
v Green indicates that the status is acceptable, based on the parameters for that KPI.
v Yellow indicates that caution or monitoring is required.
v Red indicates that action is recommended.
v Gray indicates that there is insufficient data available to calculate the KPI status.
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The color code is defined in the legend at the top of the portlet.

An undetermined status indicates that there is no KPI value available in the time period that is defined
for that KPI. This situation occurs when the solution does not receive any messages for the KPI in the
specified time period. For example, the water level for a water source is calculated daily. If no water level
message for that water source is received on a particular day, then there is no data to determine the KPI
value.

To see the KPI name and a definition of the status that is represented by the color of a KPI, hover over
the cell with your cursor.

KPI updates

When an underlying KPI changes, the change is reflected in the Status portlet. For example, one of the
sample KPIs that determine the status of the Water Quality KPI changes status from acceptable to
caution. The change is reflected in the portlet by a change in the background color of the Water Quality
cell from green to yellow. In addition, the Notifications portlet indicates that a KPI changed.

When the solution receives a message that is related to the calculation of a KPI, there is an instant color
change. This feature is an advantage when the KPI category is one that is likely to receive changes in real
time, for example, airport delays. It is not relevant to those categories that contain historical KPIs, for
example, flood control. For those categories of KPI, regular daily measurements are taken and there is
unlikely in the interim to be a sudden change that affects status.

For each KPI, you can see all of the underlying KPIs and details in the Key Performance Indicator Drill
Down portlet that is linked to the Status portlet.

To focus only on a specific KPI in the Key Performance Indicator Drill Down portlet, click the KPI cell in
the table in the Status portlet. You can also click the owning organization title, for example, for example
"Water", to see all related KPIs.

Customizing the Status portlet

If you have administrator access, you can customize this portlet. Click the button in the upper right
corner of the portlet to see your portlet menu customization options. Shared settings affect the content of
this portlet for all users, but only for this occurrence of the portlet.

By setting parameters for the Status portlet you can:
v Customize KPI colors.
v Enable an additional KPI filter.
v Show or hide the KPI legend.
v Define how the KPIs are sorted.
v Specify a group name to enable communication with a Key Performance Indicator Drill Down portlet.

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.

Customizing KPIs

A set of sample KPIs is provided with the solution. These KPIs are designed to provide guidance for
planning and implementing different types of KPIs to suit your organization. Examples are provided in
the areas of water, transportation, and public safety.
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Key Performance Indicator Drill Down
Use the Key Performance Indicator Drill Down portlet to see more information about a KPI category, the
status of its underlying KPIs.

The Key Performance Indicator Drill Down portlet shows all of the underlying KPIs associated with an
organization or KPI category that is shown on the Status portlet. The KPIs are displayed in the form of a
nested list that can be expanded or collapsed. The status of each underlying KPI is represented by color,
in the same way that color is used for the KPI categories that are displayed in the Status portlet. The
values of the underlying KPIs control the color of the parent KPI. To display the status of the KPI, hover
over the KPI with your cursor.

To focus on a specific KPI category in the Key Performance Indicator Drill Down portlet, click the
category in the Status portlet. This category is then displayed on its own in the Key Performance
Indicator Drill Down portlet. You can use the list to inspect the underlying KPIs until you reach details of
the KPI that caused the status change.

Customizing the Key Performance Indicator Drill Down portlet

If you have administrator access, you can customize this portlet. Click the button in the upper right
corner of the portlet to see your portlet menu customization options. Shared settings affect the content of
this portlet for all users, but only for this occurrence of the portlet.

By setting parameters for the Key Performance Indicator Drill Down portlet you can:
v Specify column layout, headings, sort order, and priority.
v Customize KPI colors.
v Enable an additional KPI filter.
v Show or hide the toolbar at the top of the list.
v Specify a group name to enable communication with a Key Performance Indicator Drill Down portlet.

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.

Notifications
Use the Notifications portlet to view your alert messages and their details.

The Notifications portlet is an interactive window that contains a list of all the current alerts relevant to
you. You see those only alerts sent to the user groups you are a member of. Alerts are notifications that
received when:
v Multiple events are happening in the same vicinity and at a similar time, thus might be in conflict or

require coordination
v A predefined key performance indicator (KPI) value change occurs, where that change is defined as an

alert trigger by your administrator

You can also use the portlet to display further details of an alert.

Notifications list

The Notifications portlet provides a dynamic, interactive list of alerts that result from changing KPIs and
correlated events. The role of this portlet is to draw attention to changes in KPI or event status. The list
contains key details for each of the alerts.
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To show a more detailed description of an alert, hover over the row with the cursor. To see all the
information that is associated with that alert in a window, right-click the row and select Properties.

Initially, when you open the portal page, the portlet displays all of your current alerts. Remove any alert
from the portlet by right-clicking the row and selecting Close alert. It is possible to close multiple alerts
in this way by selecting multiple rows. Close an alert only after you have handled it appropriately
because the alert is removed for all recipients when you close it.

Click the button in the upper right corner of the window to cancel it and take you back to the list.

A counter in the left corner of the action bar at the end of the list indicates the number of items displayed
and the total number of items. In the center of the action bar, you can select the number of items to be
displayed at one time. If there are more rows than can be displayed at one time, you can page forward or
backward by clicking the buttons in the right corner of the action bar.

Alert Properties

The window for alert details displays the following properties:

Table 27. Alert properties

Property Content

Headline Short description of the alert

Category High-level classification of event or KPI

Sender Source of the alert

Sent to Groups Groups to whom the alert was sent

Sent Date and time the alert was sent

Description Additional description of the alert

Refers to Alerts Event identifier, if the alert is caused by correlated events

Refers to KPIs Name of the KPI, if the alert is caused by a changing KPI value

Customizing the Notifications portlet

If you have administrator access, you can customize this portlet. Click the button in the upper right
corner of the portlet to see your portlet menu customization options. Shared settings affect the content of
this portlet for all users, but only for this occurrence of the portlet.

By setting parameters for the Notifications portlet you can:
v Specify column layout, headings, sort order, and priority.
v Show or hide the toolbar at the top of the list.

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.

My Activities
The My Activities portlet displays a dynamic list of activities that are owned by the group of which the
user, who is logged on to the interface, is a member.

Each time an event triggers a standard operating procedure according to the selection criteria defined in
the standard operating procedure selection matrix, the associated activities are assigned to owners.
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A user who is logged on can view the activities that are assigned to them in the My Activities portlet. In
the My Activities portlet, the activities are grouped by their parent standard operating procedures. Each
standard operating procedure corresponds to an individual event.

For each standard operating procedure, the My Activities portlet displays only open activities, and not
closed or completed activities. Open activities include those activities that are already started, and those
activities that are eligible to be started. For example, if one or more of the activities that are specified in a
standard operating procedure are ordered in a sequence, only the current activity in the sequence is
displayed. If a particular activity relies on the completion of a predecessor activity, it is not displayed
until the predecessor activity is complete or skipped.

The following activity due icons are displayed near the top of the My Activities portlet:

Past Due
Activities whose completion is past due.

Today Activities that are due to be completed today.

Future Activities whose completion is due in the future.

When an activity is started, the due date is calculated by adding the start time to the duration of the
activity. The activity due dates are used to calculate the number that is displayed in each of the activity
due icons.

In the My Activities portlet, standard operating procedures that have past due activities are displayed
first, and the remaining standard operating procedures are displayed in alphabetical order.

Next to each standard operating procedure in the list that has past due activities, a red icon indicates the
number of activities that are past due. The standard operating procedures with past due activities are
sorted according to the number of past due activities they contain. The standard operating procedure that
has the most past due activities is displayed at the top of the list.

Managing activities in the My Activities portlet

Manage your activities in the My Activities portlet:
v To view details about a standard operating procedure, expand the name of the standard operating

procedure.
– The name of the event that triggered the standard operating procedure is displayed. Hover over the

event name to view hover help information that includes the event start date and time, and the
category, severity, certainty, and urgency of the event.

– If the Details portlet is displayed on the page, to view the event properties, click the event name.
The event Properties window is displayed.

– Steps that are in progress or eligible to be started are displayed. Also, the status and due date of
each step is displayed.

v To view further details about a step, including comments and references that users added to the step,
expand the name of the step.

v To start, finish, or skip a step, expand the name of the step, and then choose one of the following
options:
– To start a step, from the list, select Start. If the step is defined as an automated task in the standard

operating procedure, the workflow that is assigned to the task is started automatically, and the step
is finished automatically. The user who starts a step becomes the owner of that step, and the name
of the user is displayed in the Owner field.

– To skip a step, from the list, select Skip.
– To finish a step, from the list, select Finish.

v To add a comment to a step, use the following substeps:
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1. Expand the name of the step.
2. From the list, select Add Comment.
3. In the Add Comment window, enter a comment in the Comment field. Commentator name and

Activity name are read-only fields and contain automatically entered values.
4. Click OK.
5. Expand the name of the step again. The new comment is displayed at the end of the list of existing

comments and references for the step.
v To add a reference to a step, use the following substeps:

1. Expand the name of the step.
2. From the list, select Add Reference.
3. In the Add Reference window, enter values for Reference name and Reference URI. Activity name

is a read-only field that contains an automatically entered value.
4. Click OK.
5. Expand the name of the step again. The new reference is displayed as a link at the end of the list of

existing comments and references for the step.
v To view the details for a standard operating procedure, click the i icon next to the name of the

standard operating procedure. In the Standard Operating Procedure Details window, all the activity
steps that are included in the standard operating procedure are displayed, including those steps that
are in progress, eligible to be started, completed, and closed. The status and due date of each step is
also displayed. To view further details about a step, expand the step name.

Customizing the My Activities portlet

If you have administrator access, you can customize this portlet. Click the button in the upper right
corner of the portlet to see your portlet menu customization options. Shared settings affect the content of
this portlet for all users, but only for this occurrence of the portlet.

For the My Activities portlet, you can specify a group name to enable communication with other portlets;
for example, Details portlets.

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.
Related information:
Standard Operating Procedures

Enabling the events record
Using administrative tools, you can enable record event management in order to manage event activity in
IBM Intelligent Operations for Water. Use the information in this task to enable event monitoring on the
application server.

Procedure
1. Log on to WebSphere Application Server at the following URL:

https://appserver:9043/ibm/console

2. Select Applications > Monitor Services > Recorded Events Management > Enable/Disable Events
Record.

3. Select the local host and click Enable Events Record to enable event monitoring.

Contacts
Use the Contacts portlet to send instant messages within the solution.
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The Contacts portlet can display a list of your contacts that are organized by category. You can organize
contacts in categories that are based on the people you need to communicate with. For example, you can
have a category for general work contacts and another category for project work contacts. With the
Contacts portlet, you can communicate with people and modify your online status, contacts, or groups.

Click the menus at the top of the portlet:
v File to add contacts, modify groups or log out
v Tools to set up a chat, meeting, or announcement; or to change your privacy settings
v Help to get more detailed information about how to use the portlet

Click your status to modify your status and message. The default status indicates that you are available.
You can change your status to indicate that you are away from your computer, in a meeting, or that you
do not want to be disturbed.

Note: For this portlet to work as expected, you must log on to the solution portal by using the fully
qualified domain name of the IBM Intelligent Operations Center application server. If you log on to the
portal by using an IP address or a host name alias instead of the registered fully qualified domain name,
this portlet does not display correctly.

If you have administrator access, you can customize this portlet. Click the button in the upper right
corner of the portlet to see your portlet menu customization options. Shared settings affect the content of
this portlet for all users, but only for this occurrence of the portlet.

The settings that you can change for the Contacts portlet are:
v Help file
v Portlet height
v Portlet height when maximized
v Portlet title
v Resource bundle

Customize Asset
Use the Customize Asset portlet to set thresholds for sensor readings.

Measuring the performance of multiple asset instances in the infrastructure is important to determine
operational efficiency. By setting the thresholds for multiple asset instances, you can monitor the status of
assets and define acceptable and unacceptable boundaries for measurement values. The Customize Asset
portlet uses these measurements to indicate when status values are acceptable, warrant caution, or are
critical and require immediate attention.

Threshold events help you determine when the measurements obtained from a sensor or other source
move outside the normal range. Basic threshold events are comparisons that compare two or more
measures and report a trend. More sophisticated threshold events can compare measures against a
threshold that is created by historical information. An example of threshold events are high and low
water levels. The IBM Intelligent Operations Center can manage such events in the form of key
performance indicators (KPIs).

Using the Customize Asset portlet, role-specific users can perform the following actions:
v View threshold list by measurement type.
v Create thresholds for a measurement type.
v Update thresholds across multiple asset instances.
v Delete thresholds for a measurement type.
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The Customize Asset portlet has three interactive interface elements as shown in the following table:

Table 28. Customize Asset portlet interfaces

Interface element Description

Default configuration List of configuration items - measurement status

Configure by Measurement
Type

List of measurement types to configure

Measurement Status Table to set and display thresholds for measurement types

Viewing or modifying threshold values
To view or modify the threshold values for a measurement type, use the following procedure.

Procedure
v To start the Customize Asset portlet, in the WebSphere Portal Administration interface, click Intelligent

Operations > Customization Tools > Asset Measurements for Water.
v In Customize Asset page, in the Configure a Measurement Type field, enter an asset measurement

type, or select an option from the drop-down menu, and expand the Measurement Status section. The
threshold table is displayed.

v In the table, you can perform the following actions in relation to thresholds:
– You can view thresholds for a list of measurements. For every asset instance, the threshold table can

display the threshold values and its corresponding measurements status, which can be Acceptable,
Caution, or Critical. You can view threshold values across multiple asset instances. If you change
the Measurement Type in the Configure A Measurement Type field, the table resets with the
threshold values for the selected measurement type.

– To add a threshold status and data range to the table, click Add Threshold. Select a measurement
status, and add valid threshold values for the start and end of the data range.

– To update threshold values for the selected measurement type, click the Range Starts and Range
Ends cells for the threshold and enter valid threshold values. The columns accept numerical values
only. Ensure that there is no difference between the Range End value and Range Start value of the
subsequent row. If there is a gap between the data values, a warning message displays. In such
cases, you must modify the range to remove the difference between the end range and start range
on the subsequent row.

– To remove the threshold setting for a measurement, select the threshold row and click Remove in its
Actions column or Remove Selected Thresholds at the bottom of the table.

– To revert the table to the last saved version, click Reset at the bottom of the table.
– To save the table for the selected measurement type, click Save at the bottom of the table.

City: Water Conservation
Use the City: Water Conservation portal to obtain a consolidated view of resource consumption and use
in a city. The City: Water Conservation portal enables users with cross-organization responsibility to
monitor, manage, and respond to status changes in key areas of organizational performance.

The City: Water Conservation portal is an interactive web page and provides you with a visual
representation of water consumers on a map or list and information about their consumption behavior.
Use the City: Water Conservation portal together with the Citizen: Water Conservation portal to identify
locations, patterns of consumption, conflicts, issues, and synergies.

You can select in the City: Water Conservation portal the household you want to view from the Map.
Your selection affects what is displayed in the other sections of the portal.
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Interface element

The City: Water Conservation portal has interactive interface elements as shown in the following table:

Table 29. City: Water Conservation interfaces

Interface element Description

Map A map of the geographical region that contains resource markers (households, parks,
assets, zones). Shows your monitored community area.

A filter to select the view. You can toggle between the Map or List view.

The resources are shown on the map, for example household. Click the resource to
view the metrics for that resource. A popup is displayed when the resource is selected.
The popup contains the key metrics for the monitored resource that includes number
of meters, home owner, location, last weekly usage and trend as a percentage, last
daily usage trend as a percentage (use today), average usage, peak time, and number
of leaks reported.

List A table that contains a list of resource markers (households, parks, assets, zones) in the
geographic map and their associated properties (name, number of meters, location,
contact).

Trend Compares and charts historic with current usage data for a monitored resource in a
monitored community. You can toggle between the Chart View and Table View.

Initially, the page opens with the City: Water Conservation portal that shows all the households that are
relevant to you. The map uses latitude and longitude values to show the location. A point marker or
shape outlines the household. You can display more detail on a household by clicking the marker on the
map. If there is more than one household clustered at the same location, the number is indicated when
you click the marker. The headline of each household is also displayed.

You can use the List view to see the household information in table format.

Note: If a household has no coordinates, it is displayed only in the portlet list; it is not displayed in the
Map.

Map markers

The map represents the location of households with the following type of marker.

Table 30. Map markers

Marker Type Color Description

Icon Red or Green Pinpoints on the map the location of a household by using a circular
icon for each. A red icon indicates that there is an incident associated
with the household, for example a water leak. A green margin icon
indicates that there are no incidents associated with the household.

Selecting the households on the map
To review water consumption in a household, use the following procedure.

Procedure
1. Select the City: Water Conservation.
2. In the City: Water Conservation, select the household in the map.
3. In the City: Water Conservation, view the key metrics in the popup to review consumption measures.
4. In the City: Water Conservation, view the Trend area to review the two-year trend charts.
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Detecting leaks
To detect water leaks in a household, use the following procedure.

Procedure
1. Select the City: Water Conservation.
2. In the City: Water Conservation, select the household in the map.
3. In the City: Water Conservation, view the key metrics in the popup to review the number of detected

leaks.

Viewing household consumption data
To view household consumption data, use the following procedure.

Procedure
1. Select the City: Water Conservation.
2. In the City: Water Conservation, select the household in the map.
3. In the City: Water Conservation, view the key metrics in the popup to review household consumption

data.
4. In the City: Water Conservation, view the Trend area to review the two-year trend charts.

Viewing consumption trends
To view household consumption trends, use the following procedure.

Procedure
1. Select the City: Water Conservation.
2. In the City: Water Conservation, select the household in the map.
3. In the City: Water Conservation, view the Trend area to review consumption measures.

Using the map controls
You can move the cursor around the map by using your mouse or keyboard.

The map controls are on the upper left side of the map

The map controls are on the upper left side of the map. They consist of:
v Pan arrows (up, down, left, right)
v Zoom in
v World view (zooms out to the maximum extent)
v Zoom out

Pan controls for moving around the map

To move around the map you can:
v Click and drag the map by using the mouse
v Press the up pan arrow, or the up arrow key on the keyboard, to pan north
v Press the down pan arrow, or the down arrow key on the keyboard, to pan south
v Press the right pan arrow, or the right arrow key on the keyboard, to pan east
v Press the left pan arrow, or the left arrow key on the keyboard, to pan west
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Zoom controls for magnifying or reducing the scale of the map

To zoom in and out of the map you can:
v Click the + map icon to zoom in, or the - map icon to zoom out of the center of the map
v Double-click the mouse to center the map and zoom in to the selected location
v Click the World view icon to maximize the zoom out to show the world view
v Press the + key on the keyboard to zoom in
v Press the - key on the keyboard to zoom out
v Press Shift while you use the mouse to draw a rectangle around the area to zoom in on

Customizing the City: Water Conservation

An administrator can change City: Water Conservation settings by clicking the upper right corner of the
portlet, and selecting options from the menu that is displayed.
v To change settings for all users and the instance of the City: Water Conservation portlet on the current

portal page, click Edit Shared Settings.

The settings that you can change for the portlet are as follows:
v Default help
v Portlet height
v Portlet maximum height
v Portlet title
v Report URL

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.

Citizen: Water Conservation
Use the Citizen: Water Conservation portal to obtain a consolidated view of resource consumption and
use. The Citizen: Water Conservation portal enables users to analyze individual consumption and
monitor water leakages. The view provides a water report. By using the report, you can plan for changes
to behavior, usage patterns, or changes to individual water equipment to actively engage in water
conservation.

The Citizen: Water Conservation portal is an interactive web page. The view contains the following
independent sections of the page that cooperate with one another to provide comprehensive information
about resource consumption for a citizen.

Interface elements

The Citizen: Water Conservation portlet has interactive interface elements as shown in the following
table.

Table 31. Citizen: Water Conservation portal display

Interface element Description

Profile area Shows the profile name for the report. The profile name might be a park, a marina, or
a household. You can select from the list. Below the profile name is the one or multiple
meters in the account. If you have multiple meters, you can select from the list to see
the consumption of each meter.
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Table 31. Citizen: Water Conservation portal display (continued)

Interface element Description

Progress area Shows your progress, such as your Usage Trend, Monthly Year to Date Variance in
dollars and in gallons. Shows your water conservation progress in relation to other
participants. The Rank shows your position in relation to other participants in your
community. The Green Points shows the number of points earned. Green points are
awarded for reductions in water consumption and determined by weekly readings
from your water meter.

Daily usage area Shows your daily water usage for the past several months in 2 usage units: gallons
and dollars. Using the slider bar, you can move along a 12 month calendar to see the
total water consumption each day. When you move the slider bar, the data and usage
unit also change in the two views in the Details area: Hourly Usage and Weekly
Usage. Hover over each bar to see the actual amount for weekly usage

Details area Compares hourly and weekly usage in a chart. The following views are available for
display:

v Hourly Usage - toggle to display in a graph or table the hourly water usage in a
specific day.

v Weekly Usage - toggle to display in a graph or table the water usage for a four week
period.

v Compare Usage - toggle to display in a graph or table a comparison of water usage
for each day over weekly intervals.

v This weeks game - toggle to display in a graph or table a comparison of your water
usage with usage by others in your community.

Team Chat / Pilot Chat Communications facility to chat with other users and pilot participants in your
community.

Initially, when you open Citizen: Water Conservation, the portal shows your household data. If your
household comprises a number of accounts, you can select to display the data for each account.

The lists are refreshed regularly with updates, subject to any filters you set to limit the categories that are
shown.

Comparing usage
In the Citizen: Water Conservation portal, you can monitor and compare resource usage.

Procedure
v Log on to the Citizen: Water Conservation portal.
v View the water report to review the Usage trend and Monthly Variance figures.
v Drag the slider to view the water usage by day.
v Toggle to select to view data in gallons or dollars.
v Select the Hourly Usage tab to view hourly usage.
v Select the Weekly Usage tab to view weekly usage.

Customizing the Citizen: Water Conservation

As an administrator, you can customize the portlet by clicking the menu on the upper right corner of the
portlet and configuring the portlet settings.

Click the Edit Shared Settings option to set the following parameters.
v Default help JSP
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v Portlet height, titles
v Report URL
v Resource bundle
v Show URL field on page

When you set parameters for the Citizen: Water Conservation portal you can
v Specify the Cognos Report URL.
v Specify column layout, headings, sort order, and priority.
v Specify the additional conditions to filter the events or resources displayed.
v Specify a group name to enables communication with other map and Details portlets.
v Acknowledge or ignore event creation.

You can set generic portlet parameters that are common across portlets: help file location, portlet height,
portlet title, and resource bundle.

Operator tasks
Use the information in this topic to perform operator tasks using IBM Intelligent Operations for Water.

The Operator: Operations view provides a visual representation of water data enabling you to perform
the following actions:
v View current water levels, devices, and events, on a geographical information system (GIS) map and

accompanying table.
v Navigate around the GIS map, zooming in and out of water infrastructure networks to view pipe

infrastructure, asset types and locations within the network.
v View graphical reports summarizing recent water events.
v Monitor specific pipe networks and areas of interest.
v Customize the water data you would like to monitor on the GIS maps.

Use the Operator: Operations view to monitor and analyze current water data available in the IBM
Intelligent Operations for Water solution.

If you have administrator access, you also can perform some configuration and customization actions
from this view.

Displaying the Map portlet
Use the information in this topic to monitor the status and performance of water infrastructure and
assets. The map contains geo-spatial and system data collected from subsystems and external data
sources. The map provides a single view of infrastructure, assets, devices, and events sourced from
SCADA, meter, or sensor systems that are configured in the water network.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges.
The subsystems, for example GIS and SCADA subsystems, and all external data feeds must be
operational.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the filter options on the Map portlet to refine your view by:
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a. Event category
b. Asset type
c. Logical zone

5. Use the pan or zoom options to navigate and refine your view of the map.

Showing the pipe network on the map
Use the information in this topic to display the pipe network on the Map portlet.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the pan or zoom options to refine your view of the map.
5. Use the filtering options on the map to view the asset types.
6. Select the pipe network to display all assets graphically on the map.

Viewing water assets and equipment
Use the information in this topic to display water assets and equipment on the Operator: Operations
view.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the pan or zoom options to refine your view of the map.
5. Use the filtering options on the map to view the asset types.
6. Select the asset or equipment item in the map.
7. View the status of the asset on the Details portlet.

Displaying measurement values for assets
Use the information in this topic to display measurement values for water assets and equipment on the
Operator: Operations view.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.
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Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the pan or zoom options to refine your view of the map.
5. Use the filtering options on the map to view the asset types.
6. Select the asset or equipment item. Hover over the asset to view critical information about the asset

(for example, the location of the device or the last reading/historical reading from the device).
7. View the status of the asset on the Details portlet.
8. Right-click the asset to display the Measurement Details dialog.

Note: If the default measurement displayed for the asset in the Details portlet is not what you
require, right-click on the asset to select an associated measurement from the list.

9. Use the scroll bar to navigate to the Value and Unit fields to view the measurement details.

View historical data records for an asset measurement
Use the information in this topic to display past measurement values for water assets and equipment on
the Operator: Operations view. By reading historical measurement values and readings from water
network sensors or meters, you can monitor the performance water infrastructure more effectively.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the pan or zoom options to refine your view of the map.
5. Use the filtering options on the map to view the asset types.
6. Select the asset or equipment item in the map.
7. View the status of the asset on the Details portlet.
8. Right-click the asset to display the Measurement Details dialog.

Note: If the default measurement displayed for the asset in the Details portlet is not what you
require, right-click on the asset on the Details portlet to select an associated measurement from the
list.

9. Use the scroll bar to navigate to the Historical Values section.
10. Click the Date Time (All) field on the x-axis to toggle views of historical values.

Selecting an asset type
Use the information in this topic to display the assets of a specific asset type on the Map portlet.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the pan or zoom options to refine your view of the map.
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5. Use the filtering options on the map to view the asset types.
6. Navigate to the Select Content: Asset Types option, and select an asset type from the available list.
7. View the refined asset type display in the map.
8. View the status of the asset on the Details portlet.
9. Right click the asset to display the Properties dialog.

Displaying assets in a domain or zone
Use the information in this topic to display assets in a domain or zone on the Map portlet. By selecting a
zone, you can get a clearer view of the assets and equipment that are displayed on a map.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the pan or zoom options to refine your view of the map.
5. Use the filtering options on the map to view the asset types.
6. Navigate to the Select Content: Logical Zone option, and select a logical zone from the available list.
7. View the asset or equipment in the logical zone.
8. View the status of the asset on the Details portlet.

Adding water events
Use the information in this topic to add water events on the Operator: Operations view.

Before you begin

Use the Zoom and Pan map controls to find the exact location on the map where the new water event
has occurred. Otherwise, you need to know the latitude and longitude coordinates of the event location
before you begin.

Procedure
1. Open the Add Event window by using one of the following options:

v Go to the Map portlet, right-click the map, then click Add Event.
v Go to the Details portlet, click Add Event.

2. In the Add Event window, enter a Name to identify the event.
3. Enter the details of the event, by completing the required Who, What, Where, and When fields.
4. Click OK.

Water event properties
Water events include properties for identifying the individual event, its type, and its location.

To display a more detailed description of a water event, hover over the location of the event in the Map
portlet, or the row in the Details portlet.

The following table outlines the properties of a water event.

Table 32. Water event properties

Label Description

ID Unique identifier that is used to identify the event in the water system and subsystems. The
syntax and format of the ID are specific to the organization requirements.

Name Meaningful name to identify the event.
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Table 32. Water event properties (continued)

Label Description

Type Detailed classification of the event, specific to the general classification.

Description Additional details and information to describe the event.

Latitude / Longitude Geographical coordinates of the event location.

Viewing key alerts and notification messages
Use the information in this topic to understand how to view key alerts on the Operator: Operations view.
Managing alerts requires that you regularly evaluate and monitor received alerts to identify recurring
performance problems.

About this task

The Notifications portlet provides a dynamic, interactive list of alerts that result from changing KPIs and
correlated events. For example if multiple events are happening in the same vicinity and at a similar
time, there might be a conflict that requires coordination. In a similar way, a predefined key performance
indicator (KPI) value that changes might trigger an alert where such a change is defined for notification
by your administrator.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. View the Notifications portlet to view your current alerts.
4. View the properties associated with the alert. Right click the alert and select Properties. Hover over

the selected alert in the Notifications portlet to view more detail on the alert.

Notifying stakeholders of water network events
Use the information in this topic to understand how to notify stakeholders of water network events.

About this task

Use the Sametime portlet to collaborate with key stakeholders to manage water network events.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. Go to the Sametime portlet to view your current contacts.
4. Use the capabilities to notify the relevant parties of water network events by sending a broadcast or

instant message.

Building a list of key contacts
Use the information in this topic to build a list of contact to collaborate with when managing water
network events.

About this task

Use the Sametime portlet to build a list of key contacts to collaborate with when managing water
network events.
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Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. Go to the Sametime portlet to view your current contacts.
4. Use the People menu to add contacts to your available list.

Displaying the logical map
Use the information in this topic to monitor the IBM Intelligent Operations for Water semantic model in a
map. The model is a real world abstraction of the water infrastructure, assets, and measurements
represented in a graph. Working with the graph, you can explore the model and analyze integration
points and impacts.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges.
You must load the model with the required OWL and RDF files. You must also select to enable the
Logical Map view and associated settings. To enable the display, select Edit Shared Settings in the upper
right of the portlet. Go to the Enable the Logical Map field and enter the value True. Optionally, you can
specify a map name in the Logical Map Name field, and set a prefix for the model in the Model Prefix
field.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. Select the Logical Map link.
4. Use the filter options on the Map portlet to refine your view of the map.

v Enter a number in Limit item count to: to set the maximum number of items to display in the map.
v Enter a number in Limit impact analysis depth to: to set how deep within the layers in the map

you want to allow impact analysis to be performed.
v Select from the available options to customize the display of relationships in the model.

Type instance shows relationships of type instance, for example, where Pipe 1 is an instance of
Pipe.
Connects shows the connection relationship between assets.
Has measurement shows the relationship between assets and measurements.
Contains shows the contain relationship between two assets.
Supertype Subtype shows the class inherent relationship between two asset types.

v Select from the available options to limit the scope of relationships displayed in the map. The
settings are based on the topic map index rule and can be limited to City Name or Reference
Semantic Model.

v Select to focus your analysis on a specific asset.
v Select to search for an alternate asset by entering the asset name or selecting an item from the

available list.
v Select the Reset the Map > Change Layout option on the upper right of the portlet to change the

layout of the graph. Select from the Force Directed Layout, Circular Layout, Tree Layout, or
Hierarchical Layout, Long Link Layout,Short Link Layout options.

Performing impact analysis
Use the information in this topic to perform impact analysis on model artifacts.
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About this task

Use the Logical Map to perform impact analysis, for example, on a measurement in the model.

Procedure
1. Log on to IBM Intelligent Operations for Water as operator.
2. Select the Operator: Operations view.
3. Select the Logical Map option to view the logical map.

Note: To enable the Logical Map view, you must select the Edit Shared Settings option on the Map
portlet, scroll to Enable the Logical Map field, and enter True.

4. Navigate the Logical Map to find the asset that you want to analyze. Right click and select the
Perform Impact Analysis option.

Executive tasks
Use the information in this topic to perform executive tasks with IBM Intelligent Operations for Water.

Use the Executive: Status view to obtain a consolidated view of key performance indicators (KPIs) and
key events. The Executive: Status view provides a visual representation of water infrastructure and
organizational efficiency.

If you have administrator access, you can perform configuration and customization actions.

Displaying Key Performance Indicators
Use the information in this topic to monitor the overall health of the water network. Using the heat map
displayed on the Status portlet on the Executive: Status view, you can monitor system health for
performance categories that are configured in your system.

Procedure
1. Log on to IBM Intelligent Operations for Water as executive.
2. Select the Executive: Status view.
3. View the Status portlet to display key performance indicator categories. The background color options

and legends indicate the performance status.
4. Hover over the key performance indicator to display more information. Click the key performance

indicator to display more information in the Key Performance Indicator Drill Down portlet.
Related information:
Key Performance Indicators

Viewing Key Performance Indicator details
Use the information in this topic to get a detailed view of the health of the water network. By drilling
down on performance indicators in the heat map displayed on the Status portlet on the Executive: Status
view, you can get a detailed view of system health. You can expand nested Key Performance Indicators
that monitor system health for additional diagnosis.

Procedure
1. Log on to IBM Intelligent Operations for Water as Executive.
2. Select the Executive: Status view.
3. View the Status portlet to display Key Performance Indicator categories. The background color

options and legends indicate the performance status.
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4. Double-click the key performance indicator to drill down for more information. The detail is
displayed in the Key Performance Indicator Drill Down portlet.

What to do next

Switch to the Operator: Operations view to locate the key performance indicator abnormality
geo-spatially and display it on the map. Alerts are also posted on the Notifications portlet.

Note: All key performance indicators that are beyond the normal range are displayed on the Map Details
portlet and reported to the Executive: Status dashboard.
Related information:
Key Performance Indicators

Monitoring changes to Key Performance Indicators
The Notifications portlet provides a dynamic interactive list of alerts that result from changing KPIs and
correlated events.

Procedure
1. Log on to IBM Intelligent Operations for Water as executive.
2. Select the Executive: Status view.
3. View the Notifications portlet to view your current alerts.
4. View the properties associated with the alert by right clicking the alert and selecting Properties.

Hover over the selected alert in the Notifications portlet to view more detail on the alert.
Related information:
Key Performance Indicators

Working with Standard Operating Procedures
The My Activities portlet provides a dynamic table of open activities that are owned by the person who
logged on to IBM Intelligent Operations for Water. Standard Operating Procedures are provided to
respond to changing KPIs and correlated events.

Procedure
1. Log on to IBM Intelligent Operations for Water as executive.
2. Navigate to the My Activities portlet to view the procedural response to your current alerts. Counters

are displayed for past, present, and future activities.
3. Expand the procedure to view the steps. Click Start to begin the procedure. Click the information icon

for more information about the procedure.
Related information:
Standard Operating Procedures
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Chapter 9. Troubleshooting and support for IBM Intelligent
Operations for Water

To isolate and resolve problems with your IBM products, you can use the troubleshooting and support
information. This information contains instructions for using the problem-determination resources that are
provided with your IBM products, including IBM Intelligent Operations for Water from the IBM
Intelligent Water Family of solutions.

Techniques for troubleshooting problems
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine
why something does not work as expected and how to resolve the problem. Certain common techniques
can help with the task of troubleshooting.

The first step in the troubleshooting process is to describe the problem completely. Problem descriptions
help you and the IBM technical-support representative know where to start to find the cause of the
problem. This step includes asking yourself basic questions:
v What are the symptoms of the problem?
v Where does the problem occur?
v When does the problem occur?
v Under which conditions does the problem occur?
v Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem, which can then lead
you to a problem resolution.

What are the symptoms of the problem?

When starting to describe a problem, the most obvious question is “What is the problem?” This question
might seem straightforward; however, you can break it down into several more-focused questions that
create a more descriptive picture of the problem. These questions can include:
v Who, or what, is reporting the problem?
v What are the error codes and messages?
v How does the system fail? For example, is it a loop, hang, crash, performance degradation, or incorrect

result?

Where does the problem occur?

Determining where the problem originates is not always easy, but it is one of the most important steps in
resolving a problem. Many layers of technology can exist between the reporting and failing components.
Networks, disks, and drivers are only a few of the components to consider when you are investigating
problems.

The following questions help you to focus on where the problem occurs to isolate the problem layer:
v Is the problem specific to one platform or operating system, or is it common across multiple platforms

or operating systems?
v Is the current environment and configuration supported?
v Do all users have the problem?
v (For multi-site installations.) Do all sites have the problem?
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If one layer reports the problem, the problem does not necessarily originate in that layer. Part of
identifying where a problem originates is understanding the environment in which it exists. Take some
time to completely describe the problem environment, including the operating system and version, all
corresponding software and versions, and hardware information. Confirm that you are running within an
environment that is a supported configuration; many problems can be traced back to incompatible levels
of software that are not intended to run together or have not been fully tested together.

When does the problem occur?

Develop a detailed timeline of events leading up to a failure, especially for those cases that are one-time
occurrences. You can most easily develop a timeline by working backward: Start at the time an error was
reported (as precisely as possible, even down to the millisecond), and work backward through the
available logs and information. Typically, you need to look only as far as the first suspicious event that
you find in a diagnostic log.

To develop a detailed timeline of events, answer these questions:
v Does the problem happen only at a certain time of day or night?
v How often does the problem happen?
v What sequence of events leads up to the time that the problem is reported?
v Does the problem happen after an environment change, such as upgrading or installing software or

hardware?

Responding to these types of questions can give you a frame of reference in which to investigate the
problem.

Under which conditions does the problem occur?

Knowing which systems and applications are running at the time that a problem occurs is an important
part of troubleshooting. These questions about your environment can help you to identify the root cause
of the problem:
v Does the problem always occur when the same task is being performed?
v Does a certain sequence of events need to happen for the problem to occur?
v Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in which the problem occurs
and correlate any dependencies. Remember that just because multiple problems might have occurred
around the same time, the problems are not necessarily related.

Can the problem be reproduced?

From a troubleshooting standpoint, the ideal problem is one that can be reproduced. Typically, when a
problem can be reproduced you have a larger set of tools or procedures at your disposal to help you
investigate. Consequently, problems that you can reproduce are often easier to debug and solve.

However, problems that you can reproduce can have a disadvantage: If the problem is of significant
business impact, you do not want it to recur. If possible, re-create the problem in a test or development
environment, which typically offers you more flexibility and control during your investigation.
v Can the problem be re-created on a test system?
v Are multiple users or applications encountering the same type of problem?
v Can the problem be re-created by running a single command, a set of commands, or a particular

application?
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Related tasks:
“Searching knowledge bases”
You can often find solutions to problems by searching IBM knowledge bases. You can optimize your
results by using available resources, support tools, and search methods.

Searching knowledge bases
You can often find solutions to problems by searching IBM knowledge bases. You can optimize your
results by using available resources, support tools, and search methods.

About this task

You can find useful information by searching the information center for IBM Intelligent Operations for
Water. However, sometimes you need to look beyond the information center to answer your questions or
resolve problems.

Procedure

To search knowledge bases for information that you need, use one or more of the following approaches:
v Find the content that you need by using the IBM Support Portal.

The IBM Support Portal is a unified, centralized view of all technical support tools and information for
all IBM systems, software, and services. The IBM Support Portal lets you access the IBM electronic
support portfolio from one place. You can tailor the pages to focus on the information and resources
that you need for problem prevention and faster problem resolution. Familiarize yourself with the IBM
Support Portal by viewing the demo videos (https://www.ibm.com/blogs/SPNA/entry/
the_ibm_support_portal_videos) about this tool. These videos introduce you to the IBM Support Portal,
explore troubleshooting and other resources, and demonstrate how you can tailor the page by moving,
adding, and deleting portlets.

v Search for content about IBM Intelligent Operations for Water by using one of the following additional
technical resources:
– IBM Intelligent Water Support Portal page
– IBM Intelligent Water system requirements

v Search for content by using the IBM masthead search. You can use the IBM masthead search by typing
your search string into the Search field at the top of any ibm.com® page.

v Search for content by using any external search engine, such as Google, Yahoo, or Bing. If you use an
external search engine, your results are more likely to include information that is outside the ibm.com
domain. However, sometimes you can find useful problem-solving information about IBM products in
newsgroups, forums, and blogs that are not on ibm.com.

Tip: Include “IBM” and the name of the product in your search if you are looking for information
about an IBM product.

Related concepts:
“Techniques for troubleshooting problems” on page 217
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine
why something does not work as expected and how to resolve the problem. Certain common techniques
can help with the task of troubleshooting.

Getting fixes from Fix Central
You can use Fix Central to find the fixes that are recommended by IBM Support for a variety of products,
including IBM Intelligent Operations for Water. With Fix Central, you can search, select, order, and
download fixes for your system with a choice of delivery options. A product fix for IBM Intelligent
Operations for Water might be available to resolve your problem.
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Procedure

To find and install fixes:
1. Obtain the tools that are required to get the fix. If it is not installed, obtain your product update

installer. You can download the installer from Fix Central. This site provides download, installation,
and configuration instructions for the update installer.

2. Select IBM Intelligent Operations for Water as the product, and select one or more check boxes that
are relevant to the problem that you want to resolve.

3. Identify and select the fix that is required.
4. Download the fix.

a. Open the download document and follow the link in the “Download Package” section.
b. When downloading the file, ensure that the name of the maintenance file is not changed. This

change might be intentional, or it might be an inadvertent change that is caused by certain web
browsers or download utilities.

5. To apply the fix, follow the instructions in the "Installation Instructions" section of the download
document.

6. Optional: Subscribe to receive weekly email notifications about fixes and other IBM Support updates.
Related tasks:
“Subscribing to Support updates” on page 222
To stay informed of important information about the IBM products that you use, you can subscribe to
updates.

Contacting IBM Support
IBM Support provides assistance with product defects, answers to FAQs, and helps users resolve
problems with the product.

Before you begin

After trying to find your answer or solution by using other self-help options such as technotes, you can
contact IBM Support. Before contacting IBM Support, your company or organization must have an active
IBM software subscription and support contract, and you must be authorized to submit problems to IBM.
For information about the types of available support, see the Support portfolio topic in the Software
Support Handbook.

Procedure

To contact IBM Support about a problem:
1. Define the problem, gather background information, and determine the severity of the problem. For

more information, see the Getting IBM support topic in the Software Support Handbook.
2. Gather diagnostic information.
3. Submit the problem to IBM Support in one of the following ways:

v Online through the IBM Support Portal: You can open, update, and view all of your service
requests from the Service Request portlet on the Service Request page.

v By phone: For the phone number to call in your region, see the Directory of worldwide contacts
web page.

Results

If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM
Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in
detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR
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is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support website daily, so
that other users who experience the same problem can benefit from the same resolution.
Related concepts:
“Known problems and solutions” on page 223
Some common problems with IBM Intelligent Operations for Water are documented, along with their
solutions or workarounds. If you have a problem with IBM Intelligent Operations for Water, review the
problem-solution topics to determine if a solution is available to the problem that you are experiencing.
The problem-solution topics are categorized according to the type of issue.
Related tasks:
“Exchanging information with IBM”
To diagnose or identify a problem, you might need to provide IBM Support with data and information
from your system. In other cases, IBM Support might provide you with tools or utilities to use for
problem determination.

Exchanging information with IBM
To diagnose or identify a problem, you might need to provide IBM Support with data and information
from your system. In other cases, IBM Support might provide you with tools or utilities to use for
problem determination.
Related tasks:
“Contacting IBM Support” on page 220
IBM Support provides assistance with product defects, answers to FAQs, and helps users resolve
problems with the product.

Sending information to IBM Support
To reduce the time that is required to resolve your problem, you can send trace and diagnostic
information to IBM Support.

Procedure

To submit diagnostic information to IBM Support:
1. Open a problem management record (PMR).
2. Collect the diagnostic data that you need. Diagnostic data helps reduce the time that it takes to

resolve your PMR. You can collect the diagnostic data manually or automatically:
v Collect the data manually.
v Collect the data automatically.

3. Compress the files by using the .zip or .tar file format.
4. Transfer the files to IBM. You can use one of the following methods to transfer the files to IBM:

v The Service Request tool
v Standard data upload methods: FTP, HTTP
v Secure data upload methods: FTPS, SFTP, HTTPS
v Email
All of these data exchange methods are explained on the IBM Support website.

Receiving information from IBM Support
Occasionally an IBM technical-support representative might ask you to download diagnostic tools or
other files. You can use FTP to download these files.
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Before you begin

Ensure that your IBM technical-support representative provided you with the preferred server to use for
downloading the files and the exact directory and file names to access.

Procedure

To download files from IBM Support:
1. Use FTP to connect to the site that your IBM technical-support representative provided and log on as

anonymous. Use your email address as the password.
2. Change to the appropriate directory:

a. Change to the /fromibm directory.
cd fromibm

b. Change to the directory that your IBM technical-support representative provided.
cd nameofdirectory

3. Enable binary mode for your session.
binary

4. Use the get command to download the file that your IBM technical-support representative specified.
get filename.extension

5. End your FTP session.
quit

Subscribing to Support updates
To stay informed of important information about the IBM products that you use, you can subscribe to
updates.

About this task

By subscribing to receive updates about IBM Intelligent Operations for Water, you can receive important
technical information and updates for specific IBM Support tools and resources. You can subscribe to
updates by using one of two approaches:

RSS feeds and social media subscriptions
The following RSS feed is available for IBM Intelligent Operations for Water: IBM Intelligent
Water RSS feed

For general information about RSS, including steps for getting started and a list of RSS-enabled
IBM web pages, visit the IBM Software Support RSS feeds site.

My Notifications
With My Notifications, you can subscribe to Support updates for any IBM product. (My
Notifications replaces My Support, which is a similar tool that you might have used in the past.)
With My Notifications, you can specify that you want to receive daily or weekly email
announcements. You can specify what type of information you want to receive (such as
publications, hints and tips, product flashes (also known as alerts), downloads, and drivers). My
Notifications enables you to customize and categorize the products about which you want to be
informed and the delivery methods that best suit your needs.

Procedure

To subscribe to Support updates:
1. To subscribe to the IBM Intelligent Operations for Water RSS feed, use the following substeps:

a. Open the link: IBM Intelligent Water RSS feed.
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b. In the Subscribe with Live Bookmark window, select a folder in which to save the RSS feed
bookmark and click Subscribe.

For more information on subscribing to RSS feeds, see the IBM Software Support RSS feeds link in the
Related information section at the end of the topic.

2. Subscribe to My Notifications by going to the IBM Support Portal and click My Notifications in the
Notifications portlet.

3. Sign in using your IBM ID and password, and click Submit.
4. Identify what and how you want to receive updates.

a. Click the Subscribe tab.
b. Select IBM Intelligent Water RSS feed and click Continue.
c. Select your preferences for how to receive updates, whether by email, online in a designated

folder, or as an RSS or Atom feed.
d. Select the types of documentation updates that you want to receive, for example, new information

about product downloads and discussion group comments.
e. Click Submit.

Results

Until you modify your RSS feeds and My Notifications preferences, you receive notifications of updates
that you have requested. You can modify your preferences when needed (for example, if you stop using
one product and begin using another product).
Related tasks:
“Getting fixes from Fix Central” on page 219
You can use Fix Central to find the fixes that are recommended by IBM Support for a variety of products,
including IBM Intelligent Operations for Water. With Fix Central, you can search, select, order, and
download fixes for your system with a choice of delivery options. A product fix for IBM Intelligent
Operations for Water might be available to resolve your problem.

Related information

IBM Software Support RSS feeds

Subscribe to My Notifications support content updates

My Notifications for IBM technical support

My Notifications for IBM technical support overview

Known problems and solutions
Some common problems with IBM Intelligent Operations for Water are documented, along with their
solutions or workarounds. If you have a problem with IBM Intelligent Operations for Water, review the
problem-solution topics to determine if a solution is available to the problem that you are experiencing.
The problem-solution topics are categorized according to the type of issue.

Cannot reinstall custom KPI model on the application server

If you cannot reinstall a custom key performance indicator (KPI) model on the application server,
uninstall the monitor models and data and then reinstall the models. For information about uninstalling a
single version of a monitor model, see the related task.
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No message is displayed when using the command line to install IBM Intelligent
Operations for Water 1.5 on top of an existing IBM Intelligent Operations for Water
deployment

Because IBM Intelligent Operations for Water is already installed, the status of all components in the
topology files is ready. Therefore, no messages from the new installation are displayed. This behavior
differs from the graphical user interface (GUI) installation, which allows separate checking to determine if
the solution is already installed.

After an IBM Installation Manager installation failed, the reinstallation attempt also
fails

If, after an IBM Installation Manager installation of IBM Intelligent Operations for Water fails and you
manually fix a problem and want to continue the installation, run the command-line installer. See the
related task for more information.

If the IBM Installation Manager installation failed because you manually canceled the IBM Installation
Manager, use the command line to continue the installation.

After a command-line installation failed, the reinstallation attempt also fails

Check the log file for a message similar to the following:
Command failed: The following error occurred while executing this line:
/opt/IBM/IOC/BA/ioc/spec/SOLUTION/portal_content/build.xml:16:
Command failed with code 1

If you want more detailed operation messages, please check
/opt/IBM/IOC/BA/ioc/log/installSolution_water_wih...log

Review the problem details and attempt to manually fix the problem. Then use the command line to
continue the installation.

If problems persist, you can take one of the following actions:
v Recover the system to the IBM Intelligent Operations Center status and then reinstall IBM Intelligent

Operations for Water.
v Contact IBM Support for help. See the related task.

The launchpad shows an authentication rejected error

This issue is environmental and not launchpad-specific. No method is currently available to suppress the
error message, but the functionality or display of the launchpad is not affected. This issue is being
addressed.

After clicking Sign in at http://app-ioc.cn.ibm.com, the following message
appears: Access Manager WebSEAL could not complete your request due to an
unexpected error.

Ensure that the amount of free disk space on the servers is sufficient.

Nothing happens when I select Add Event from the map in the IBM Intelligent
Operations for Water portal

This issue is being addressed. Until it is resolved, go to Citywide > Operator to create the event.
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After setting up the new IBM Intelligent Operations for Water 1.5 and trying to log
on through Tivoli Access Manager WebSEAL, the following message appears:
Third-party server not responding.

The portal server and the Tivoli Service Request Manager server did not start properly. The Tivoli Service
Request Manager port conflict issue is resolved.

When I send a .csv file to the simulator in the app-ioc host, two messages with the
same title and time are displayed in My Activities portlet

Another simulator process is running on either a PuTTY or VNC client. Stop that process.

An activity does not appear in My Activities portlet, as specified in the standard
operating procedure policy, even though the Tivoli Service Request Manager
service displays as ON in the IOCControl.sh script for services status

Log on to https://event_server: :9044/ibm/console/ and restart the MXServer, or start the MXServer if
it is not running. Select Servers > Application servers > MXServer. To verify that the Tivoli Service
Request Manager cluster is running, select Servers > Clusters > TSRMCluster. If the cluster is running,
you see a green icon.
Related tasks:
“Contacting IBM Support” on page 220
IBM Support provides assistance with product defects, answers to FAQs, and helps users resolve
problems with the product.
“Deploying from the command line” on page 25
The IBM Intelligent Operations for Water solution package can be deployed when the IBM Intelligent
Operations Center base architecture is deployed.
Related information:

Uninstalling a single version of a monitor model

Problem starting the simulator when the property file is updated with a
new JMS Queue
When you create a new JMS Queue in the Portal Server, you must update the target.queue parameter in
the simulator.properties file with a new JMS Queue. An error may be displayed in the simulator.log
file when you attempt to start the simulator. You must restart the Portal Server before you start the
simulator.

Procedure
1. Log on to WebSphere Application Server at the following URL:

https://appserver:9043/ibm/console

2. Select Servers > Clusters > WebSphere Application Server clusters.
3. Select the PortalCluster.
4. Click Stop and wait until the red icon is displayed.
5. Click Start and wait until the green icon is displayed.
6. Log off WebSphere Application Server and run the command to start the simulator.

#nohup ./run_simulator.sh > simulator.log &

Cannot select IBM Intelligent Operations for Water assets from the
Categories menu
If you cannot select IBM Intelligent Operations for Water assets from the Categories menu, check the
status of the DB2 server.
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Procedure
1. Log on to the management server as ibmadmin.
2. Type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status db24po topology_password

If the portal is running, you see a message similar to the following:
Executing query command....completed.
IBM DB2 Enterprise server for WebSphere Portal Extend [ on ]
Command completed successfully.

3. If the DB2 server is not running, type ./iopmgmt.sh start db24pe topology_password

Note: To check the status of all DB2 instances, type ./iopmgmt.sh status all topology_password.

Authentication mechanism not available
If you receive the HPDIA0119W Authentication mechanism is not available error message after you log
on to the WebSphere Portal, check the status of the Tivoli Directory Server and the Tivoli Directory Server
Proxy for the application server.

Procedure
1. Log on to the management server as ibmadmin and type the following commands:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tds topology_password

If the server is running, a message similar to the following example is displayed:
Executing query command.....completed.
IBM Tivoli Directory Server [ on ]
Command completed successfully.

2. If the server is not running, type./iopmgmt.sh start tds topology_password

3. If the server is not running after you complete Steps 1 and 2, log on to the management server as
ibmadmin and type the following commands:
su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tdspxyapp topology_password

If the server is running, a message similar to the following example is displayed:
Executing query command.....completed.
IBM Tivoli Directory Server [ on ]
Command completed successfully.

4. If the server is not running, type ./iopmgmt.sh start tdspxyapptopology_password

Third-party server not responding
If you receive the Third-party server not responding error message after you log on to theWebSphere
Portal portal, check the status of the WebSphere Portal.

Procedure
1. Log on to the management server as ibmadmin and type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status wpe topology_password

If the portal is running, a message similar to the following is displayed:
Executing query command.....completed.
IBM WebSphere Portal Extend [ on ]
Command completed successfully.
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2. If the portal is not running, type ./iopmgmt.sh start wpe topology_password.

Cannot access portal
If you cannot access the portal at http://portal_URL/wpsv70/wps/myportal, check the status of the
Tivoli Access Manager WebSEAL.

Procedure
1. Log on to the application server as root and type pd_start status. The status of the Tivoli Access

Manager WebSEAL is displayed. If the Tivoli Access Manager WebSEAL is not running, type pd_start
start to start the Tivoli Access Manager WebSEAL server.

2. You can also check the Tivoli Access Manager WebSEAL status by logging on to the management
server as ibmadmin and typing the following command:
su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tamweb topology_password

If the server is running, you see a message similar to the following:
Executing query command.....completed.
IBM Tivoli Access Manager WebSEAL [ on ]
Command completed successfully.

If the status is [ off ], type ./iopmgmt.sh start tamweb topology_password.

Authentication failed
If you receive an error 403: authenticationFailed message after you log on to the portal, check the
status of the Tivoli authorization server and the Tivoli Access Manager policy server.

Procedure
1. Log on to the management server as root and type pd_start status. You see results similar to the

following. Ensure that the status of each component is yes.
Tivoli Access Manager servers
Server Enabled Running
-------------------------------------------
pdmgrd yes yes
pdacld yes yes
pdmgrproxyd no no

Note: pdmgrd refers to the Tivoli authorization server, and pdacld refers to the Tivoli Access Manager
policy server.
If the Tivoli authorization server and the Tivoli Access Manager policy server are not running, type
pd_start start.

2. You can also check the status of the Tivoli authorization server and the Tivoli Access Manager policy
server by typing the following commands on the management server:
./iopmgmt.sh status tamas topology_password

If the Tivoli authorization server is running, you see a message similar to the following:
Executing query command...completed.
IBM Tivoli Access Manager Authorization Server [ on ]
Command completed successfully.

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tamps topology_password

If the Tivoli Access Manager policy server is running, you see a message similar to the following:
Executing query command...completed.
IBM Tivoli Access Manager Policy Server [ on ]
Command completed successfully.

If the Tivoli authorization server is not running, type ./iopmgmt.sh start tamas topology_password.
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If the Tivoli Access Manager policy server is not running, type ./iopmgmt.sh start tamps
topology_password.

Cannot access IBM Cognos Business Intelligence reports, and receive
error message
If you cannot access IBM Cognos Business Intelligence reports and you receive An error occurred while
retrieving content error message, check the status of IBM Cognos Business Intelligence.

Procedure
1. Log on to the management server as ibmadmin and type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status cognos topology_password

If IBM Cognos Business Intelligence is running, you see a message similar to the following:
Executing query command...completed.
IBM COGNOS Business Intelligence [ on ]
Command completed successfully.

2. If IBM Cognos Business Intelligence is not running, type ./iopmgmt.sh start cognos
topology_password.

KPIs are not triggered
If Key Performance Indicators (KPIs) are not triggered, check the status of the WebSphere Message
Broker.

Procedure
1. Log on to the management server as ibmadmin and type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status wmb topology_password

If WebSphere Message Broker is running, you see a message similar to the following:
Executing query command....completed.
IBM WebSphere Message Broker [ on ]
Command completed successfully.

2. If WebSphere Message Broker is not running, type ./iopmgmt.sh start wmb topology_password.

Measurements in the user interface are not changing
If you know the queue manager and broker are started, are running the simulator, and are trying to
simulate measurements, but you do not see the measurements changing in the user interface, check the
status of the IBM Intelligent Operations Center XML probe and the IBM Intelligent Operations for Water
XML probe.

Procedure
1. Log on to the event server as root and check the status of the water_wih Tivoli Netcool/OMNIbus

probe and the ioc_xml Tivoli Netcool/OMNIbus probe. Type the following commands:
ps auxww |grep water_wih
ps auxww |grep ioc_xml

Note: If you cannot log on to the event server as root, log on as an administrator and use the sudo
command to issue the required commands.

2. If no processes are running, you must manually start the probes.
a. To start the ioc_xml probe, type the following command:

/opt/IBM/netcool/omnibus/probes/nco_p_xml -name ioc_xml -propsfile
/opt/IBM/netcool/omnibus/probes/linux2x86/ioc_xml.props &
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b. To start the water_wih probe, type the following command:
/opt/IBM/iss/iow/omnibus/startXmlProbe.sh

Measurements are changing but KPIs and standard operating
procedures are not triggered
If measurements in the user interface are changing but Key Performance Indicators (KPIs) and standard
operating procedures do not seem to be triggering, check your Tivoli Service Request Manager password.

Procedure
1. Log on to the Tivoli Netcool/Impact administrative console at http://event_host:9080/nci/main

where event_host is the host name of the event server. Log on as the admin user with the netcool
password.

2. Click IOC Project.
3. In the Policies section, double-click the policy IOC_Sample_Password_Encoder. The policy is

opened in the Policy Editor window.
4. In the Enter Password Here field, enter the password for Maxadmin.
5. To save the policy, click Save.
6. Click the Trigger Policy icon.
7. Click Execute.
8. In the Service Status section, scroll to PolicyLogger, click View log for PolicyLogger (icon with the

down arrow).
9. In the policy logger window, locate the statement that is similar to the following statement:

11 May 2012 14:19:12,260: [IOC_Sample_Password_Encoder][pool-1-thread-46]Parser log: {aes}FF877B74ADF4DF1C2002F94ACB38FAFF

10. Copy the encrypted Maxadmin password from the statement, for example:
{aes}FF877B74ADF4DF1C2002F94ACB38FAFF

11. In the Tivoli Netcool/Impact administrative console, in the Policies section, double-click the policy
UTILS_LIBRARY_IOC_TSRM. The policy is opened in the Policy Editor window.

12. Replace the value of MAXAdminPassword with the encrypted value that you copied in Step 10:
MAXAdminPassword = "{aes}FF877B74ADF4DF1C2002F94ACB38FAFF";

13. Click Save.
14. Return to the policy IOC_Sample_Password_Encoder that you accessed in Step 3 and remove your

unencoded password.
You can leave the field blank or you can type a text string.

Important: Ensure that the string does not contain any spaces. Check for spaces at the beginning
and end of the string.

Log files
To troubleshoot a problem in IBM Intelligent Operations for Water, you might need to analyze log files on
several systems on the IBM Intelligent Operations Center servers.

See the related link for a list of the log files that are available for each of the IBM Intelligent Operations
Center servers.
Related information:
IBM Intelligent Operations Center server log files
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Chapter 10. Reference

These topics contain additional reference information to help you.

PDF library
This topic provides links to the information center content in PDF format.

The information center content is available in the following PDF for convenient printing:
v IBM Intelligent Water Family: IBM Intelligent Operations for Water information center

Additional information
The following additional resources are available online.

WebSphere Portal
v WebSphere Portal product support page: http://www.ibm.com/support/entry/portal/Overview/

Software/WebSphere/WebSphere_Portal
v WebSphere Portal information library: http://www.ibm.com/software/genservers/portal/library/
v WebSphere Portal wiki: http://www.lotus.com/ldd/portalwiki.nsf

WebSphere Application Server
v WebSphere Application Server product support page: http://www.ibm.com/software/webservers/

appserv/was/support/
v WebSphere Application Server information library: http://www.ibm.com/software/webservers/

appserv/was/library/index.html
v WebSphere Application Server 7.0.x Information Center: http://publib.boulder.ibm.com/infocenter/

wasinfo/v7r0/index.jsp

Redbooks®

v Smarter Cities Series Redguide: http://www.redbooks.ibm.com/abstracts/redp4736.html
v Redbooks Domain: http://publib-b.boulder.ibm.com/Redbooks.nsf

Tivoli software
v Tivoli training and certification: http://www.ibm.com/software/tivoli/education/

Cognos software
v IBM Cognos Business Intelligence: http://www-01.ibm.com/software/analytics/cognos/business-

intelligence/
v IBM Cognos Business Intelligence Information Center: http://publib.boulder.ibm.com/infocenter/c8bi/

v8r4m0/index.jsp

Web resources
v JAWS Screen Reading Software: http://www.freedomscientific.com/products/fs/jaws-product-page.asp

Information centers
v IBM Smarter Cities Software Solutions Information Center: http://publib.boulder.ibm.com/infocenter/

cities/v1r0m0/index.jsp
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v WebSphere Application Server 7.0.x Information Center: http://publib.boulder.ibm.com/infocenter/
wasinfo/v7r0/index.jsp

v IBM WebSphere Business Monitor Information Center: http://publib.boulder.ibm.com/infocenter/
dmndhelp/v7r0mx/index.jsp?topic=/com.ibm.btools.help.monitor.doc/home/home.html

v Rational Application Developer Information Center: http://publib.boulder.ibm.com/infocenter/
radhelp/v7r5/index.jsp?topic=/com.ibm.rad.legal.doc/helpindex_rad.html

Related information:
IBM Intelligent Operations Center reference information

Copyright notice and trademarks

Copyright notice
© Copyright IBM Corporation 2013. All rights reserved. May only be used pursuant to an IBM software
license agreement. No part of this publication may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any computer language, in any form or by any means, electronic,
mechanical, magnetic, optical, chemical, manual, or otherwise, without prior written permission of IBM
Corporation. IBM Corporation grants you limited permission to make hardcopy or other reproductions of
any machine-readable documentation for your own use, provided that each such reproduction shall carry
the IBM Corporation copyright notice. No other rights under copyright are granted without prior written
permission of IBM Corporation. The document is not intended for production and is furnished “as is”
without warranty of any kind. All warranties on this document are hereby disclaimed, including the
warranty of non-infringement and the implied warranties of merchantability and fitness for a
particular purpose.

U.S. Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corporation.

Trademarks
IBM, WebSphere, DB2, Rational, Cognos, Jazz, Netcool, Tivoli, ibm.com, Passport Advantage, Smarter
Cities, Sametime, and Redbooks are trademarks of the IBM Corporation in the United States, other
countries, or both.

Microsoft, Internet Explorer, Windows, and the Windows logo are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Pentium is a registered trademark of Intel Corporation or its subsidiaries in the United States and other
countries

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

Oracle, Javascript, and Java are registered trademarks of Oracle and/or its affiliates.

ArcGIS, EDN, StreetMap, @esri.com, and www.esri.com are trademarks, registered trademarks, or service
marks of Esri in the United States, the European Community, or certain other jurisdictions.

Other names may be trademarks of their respective owners. Other company, product, and service names
may be trademarks or service marks of others.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM web sites are provided for convenience only and do not in
any manner serve as an endorsement of those web sites. The materials at those web sites are not part of
the materials for this IBM product and use of those web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
Department T81B F6/Building 503
4205 S. Miami Boulevard
Durham NC 27709-9990
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademarks
IBM, WebSphere, DB2, Rational, Cognos, Jazz, Netcool, Tivoli, ibm.com, Passport Advantage, Smarter
Cities, Sametime, and Redbooks are trademarks of the IBM Corporation in the United States, other
countries, or both.

Microsoft, Internet Explorer, Windows, and the Windows logo are trademarks of Microsoft Corporation in
the United States, other countries, or both.
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Pentium is a registered trademark of Intel Corporation or its subsidiaries in the United States and other
countries

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

Oracle, Javascript, and Java are registered trademarks of Oracle and/or its affiliates.

ArcGIS, EDN, StreetMap, @esri.com, and www.esri.com are trademarks, registered trademarks, or service
marks of Esri in the United States, the European Community, or certain other jurisdictions.

Other names may be trademarks of their respective owners. Other company, product, and service names
may be trademarks or service marks of others.
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Readers’ Comments — We'd Like to Hear from You

IBM Intelligent Water
IBM Intelligent Operations for Water
Product Documentation
Version 1 Release 5

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy,
organization, subject matter, or completeness of this book. The comments you send should pertain to only the
information in this manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your
IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use
the personal information that you supply to contact you about the issues that you state on this form.

Comments:

Thank you for your support.

Submit your comments using one of these channels:
v Send your comments to the address on the reverse side of this form.
v Send a fax to the following number: 1-800-227-5088 (US and Canada)

If you would like a response from IBM, please fill in the following information:

Name Address

Company or Organization

Phone No. Email address



Readers’ Comments — We'd Like to Hear from You
����

Cut or Fold
Along Line

Cut or Fold
Along Line

Fold and Tape Please do not staple Fold and Tape

Fold and Tape Please do not staple Fold and Tape

NO POSTAGE
NECESSARY
IF MAILED IN THE
UNITED STATES

BUSINESS REPLY MAIL
FIRST-CLASS MAIL PERMIT NO. 40 ARMONK, NEW YORK

POSTAGE WILL BE PAID BY ADDRESSEE

IBM
Information Development Department DLUA
P.O. Box 12195
Research Triangle Park, NC
USA 27709-9990

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_





����

Printed in USA


	Contents
	Figures
	Chapter 1. Solution overview
	Intended audience
	Features
	Users and benefits
	Components
	Samples
	Asset samples
	Alert and event samples
	KPI samples
	Standard operating procedure samples


	Chapter 2. Installing and configuring
	Preparing for installation
	System configuration
	Hardware requirements
	Software requirements
	Media packaging
	Installing the IBM Intelligent Operations Center
	Preparing the IBM Intelligent Operations Center servers
	Preparing the installation management server
	Preparing the installation media
	Preparing the installation DVD
	Preparing the downloaded installation package

	Installing and configuring semantic model services
	Configuring the Jazz team server
	Installing semantic model services
	Verifying semantic model services configuration
	Improving semantic model services performance


	Installing the solution
	Deploying the solution
	Deploying from the command line
	Verifying the deployment

	Post-installation configuration
	Starting WebSphere Message Broker processes
	Checking the Queue Manager and Message Broker status
	Checking the Netcool/OMNIbus probes
	Enabling the events record
	Configuring the timezone of the monitoring model
	Deleting sample users

	Getting started with the solution
	Checking the sample system is operational
	Extracting the demonstration scripts
	Starting the Simulator
	Loading the KPI thresholds
	Checking mapped key measurements
	Checking that servers are operational
	Checking Message Queue Manager Broker is running
	Checking Message Queue SI Broker is started
	Checking Netcool probes are running

	Running a demonstration using the sample
	Preparing to run the scripts
	Familiarizing with the solution interface
	Triggering a changing event
	Viewing the response to events in the solution interface

	Resetting the sample demonstration


	Chapter 3. Securing the solution
	User roles and responsibilities
	Adding users and groups
	Viewing or modifying group membership
	Removing users or groups
	Sample users
	Viewing or modifying user profiles
	Setting the password policy

	Chapter 4. Integrating the solution
	Software Development Kit (SDK) Overview
	Web Service Interface
	Overview
	Using the REST API
	Model Access Service resources
	query
	update
	properties
	asset-types
	assets
	measurements
	measurement-values
	connected-assets
	connects-assets
	physical-connected-assets
	contained-assets
	contains-assets
	connections
	contains

	Reading Service resources
	realtime
	historical

	Render Service resources
	layers
	Using GET to retrieve layers
	Using POST to create layers
	Using PUT to update layers
	Using DELETE to remove layers

	features
	Using GET to retrieve features
	Using POST or PUT to create and update features
	Using DELETE to clear features

	renderEngine
	Command-Line syntax
	Rule files

	style

	Model Exploration Service resources
	topicmaps
	Using GET to retrieve topic maps and descriptions
	Using POST and PUT to create and update topic maps
	Using DELETE to delete a topic map

	topicmaps/<name>/topics
	Using GET to retrieve topics and related associations

	topicmaps/<name>/search
	Using GET to search topics by name

	topicmaps/<name>/impact
	Using GET to run impact analysis on topic maps

	Running the Index Engine

	ASK Service resources
	Understanding ASK
	Using ASK web services


	Tutorials
	Scenario
	Configuring the application setup
	Importing the sample projects
	Extending the water semantic model
	Importing custom asset types
	Importing custom asset instances
	Verifying using the Model Access Service
	Synchronizing the model to the database

	Creating the index for the Model Exploration Service
	Generating custom map layers
	Verifying the configuration
	Creating sample reading data to verify event flow

	Running the sample application

	Security


	Chapter 5. Customizing the solution
	Customizing data integration
	Customizing the model
	Customizing asset types and instance
	Defining asset types
	Modifying the packaged asset types
	Defining a new asset type
	Adding the new asset type
	Configuring the IBM Intelligent Operations for Water database with the new asset type

	Creating an asset model instance
	Modifying the packaged asset model
	Defining a new asset instance
	Importing asset data into the model instance
	Updating the database with model changes

	Configuring the interface to display model changes
	Defining an icon to represent the asset type
	Configuring asset key measurements
	Setting thresholds for asset measurements
	Specifying settings when reading no measurement data
	Setting up logical zones for assets
	Configuring the Map portlet default location

	Verifying data flow using the Simulator


	Customizing the connected resource network
	Defining the customized connected resource network asset type
	Creating the connected resource network model instance
	Using the command line to generate connected resource network asset instances

	Generating a KML file from the connected resource network asset instance
	Configuring the interface to display the generated KML file


	Customizing data import and operational storage
	Importing data from external systems
	Checking extended model data is in the operational database
	Working with imported data
	Preparing for the analytical database
	Defining the message flow
	Deploying the message flow
	Working with the message queues
	Verifying the message flow


	Customizing data processing
	Defining a KPI CAP event
	Creating a KPI model
	Deploying the KPI model to Intelligent Operations Center
	Configuring a KPI
	Checking the KPI
	Creating a KPI policy
	Setting up the project
	Creating the policy framework
	Adding a KPI CAP alert to the policy
	Binding the KPI policy to the event
	Checking the KPI policy


	Customizing business reporting
	Importing water metadata
	Defining the metadata model
	Creating the custom report
	Working with the sample reports
	Configuring a portlet to display reports

	Customizing business processes
	Customizing standard operating procedure
	Creating standard operating procedures
	Reviewing entries in the standard operating procedure selection matrix
	Defining parameters in the standard operating procedure selection matrix
	Creating an event policy
	Creating a project
	Creating a customized event policy
	Constructing an event CAP alert
	Binding the customized event policy to the hub reader service

	Verifying the customized standard operating procedure and the customized event policy


	Customizing the user interface
	List of portlets
	Guidelines for customizing portlets


	Chapter 6. Managing the solution
	Verifying the version
	Controlling the services

	Chapter 7. Maintaining the solution
	Tuning performance
	Backing up data
	Maintenance tips

	Chapter 8. Using the solution interface
	Logging on
	Logging off
	Viewing or editing your user profile
	Using pages
	Operator: Operations view
	Executive: Status view
	City: Water Conservation
	Citizen: Water Conservation

	Using portlets
	Map
	Selecting event categories for the Geospatial Map
	Selecting asset types for the Geospatial Map
	Selecting logical zones for the Geospatial Map
	Selecting layers for the Geospatial Map
	Selecting resource capabilities for the Geospatial Map
	Adding an event
	Using the Geospatial Map controls
	Resetting the Geospatial Map
	Navigating the Logical Map
	Customizing the Logical Map
	Customizing the Map portlet - Geospatial Map
	Details
	Managing events and incidents
	Managing assets
	Customizing the Details portlet
	Status
	Key Performance Indicator Drill Down
	Notifications
	My Activities
	Enabling the events record

	Contacts
	Customize Asset
	Viewing or modifying threshold values
	City: Water Conservation
	Selecting the households on the map
	Detecting leaks
	Viewing household consumption data
	Viewing consumption trends
	Using the map controls
	Customizing the City: Water Conservation
	Citizen: Water Conservation
	Comparing usage
	Customizing the Citizen: Water Conservation

	Operator tasks
	Displaying the Map portlet
	Showing the pipe network on the map
	Viewing water assets and equipment
	Displaying measurement values for assets
	View historical data records for an asset measurement
	Selecting an asset type
	Displaying assets in a domain or zone
	Adding water events
	Water event properties

	Viewing key alerts and notification messages
	Notifying stakeholders of water network events
	Building a list of key contacts
	Displaying the logical map
	Performing impact analysis

	Executive tasks
	Displaying Key Performance Indicators
	Viewing Key Performance Indicator details
	Monitoring changes to Key Performance Indicators
	Working with Standard Operating Procedures


	Chapter 9. Troubleshooting and support for IBM Intelligent Operations for Water
	Techniques for troubleshooting problems
	Searching knowledge bases
	Getting fixes from Fix Central
	Contacting IBM Support
	Exchanging information with IBM
	Sending information to IBM Support
	Receiving information from IBM Support

	Subscribing to Support updates
	Known problems and solutions
	Problem starting the simulator when the property file is updated with a new JMS Queue
	Cannot select IBM Intelligent Operations for Water assets from the Categories menu
	Authentication mechanism not available
	Third-party server not responding
	Cannot access portal
	Authentication failed
	Cannot access IBM Cognos Business Intelligence reports, and receive error message
	KPIs are not triggered
	Measurements in the user interface are not changing
	Measurements are changing but KPIs and standard operating procedures are not triggered

	Log files

	Chapter 10. Reference
	PDF library
	Additional information
	Copyright notice and trademarks
	Copyright notice
	Trademarks

	Notices
	Trademarks

	Index
	N
	T

	Readers’ Comments — We'd Like to Hear from You

